
  

  

MONICOVIEW  

USER MANUAL 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



  

Copyright © 2003-2006 Monico Inc. 
All Rights Reserved Worldwide. 

The information contained herein is provided in good faith, but is subject to change without 
notice. It is supplied with no warranty whatsoever, and does not represent a commitment on 
the part of Monico Inc. Companies, names and data used as examples herein are fictitious 
unless otherwise stated. No part of this document may be reproduced or transmitted in any 
form or by any means, electronic or mechanical, without the express written permission of 
Monico Inc 

All trademarks are acknowledged as the property of their respective owners. 

Written by Mike Granby and Jesse Benefiel. 

 



 TABLE OF CONTENTS 

REVISION 12 PAGE I 

TABLE OF CONTENTS 
GETTING STARTED ..........................................................................................1 

SYSTEM REQUIREMENTS .................................................................................... 1 
INSTALLING THE SOFTWARE ............................................................................... 1 
CHECKING FOR UPDATES ................................................................................... 1 
INSTALLING THE USB DRIVERS ........................................................................... 2 

QUICK START .................................................................................................3 
SELECTING THE HMI ........................................................................................ 3 
COMMUNICATIONS ........................................................................................... 3 
MAPPING DATA .............................................................................................. 5 
USER INTERFACE ............................................................................................. 7 
DOWNLOADING .............................................................................................. 9 
CONNECT THE TWO ......................................................................................... 9 
COMMUNICATIONS (G3 AS A SLAVE) ....................................................................10 

MONICOVIEW BASICS .................................................................................... 14 
MAIN SCREEN ICONS .......................................................................................14 

COMMUNICATIONS .......................................................................................................................... 14 
DATA TAGS ................................................................................................................................... 14 
USER INTERFACE ............................................................................................................................ 15 
PROGRAMMING .............................................................................................................................. 15 
DATA LOGGER ............................................................................................................................... 15 
WEB SERVER ................................................................................................................................. 15 
SECURITY MANAGER ....................................................................................................................... 15 

SELECTING A TERMINAL ...................................................................................16 
USING BALLOON HELP .....................................................................................16 
WORKING WITH DATABASES..............................................................................16 
DOWNLOADING TO A TERMINAL .........................................................................17 

CONFIGURING THE LINK ................................................................................................................... 17 
VERIFYING THE USB LINK ................................................................................................................ 17 
SETTING THE IP ADDRESS ................................................................................................................ 18 
SENDING THE DATABASE .................................................................................................................. 18 
EXTRACTING DATABASES .................................................................................................................. 18 
MOUNTING THE COMPACTFLASH ........................................................................................................ 19 
FORMATTING THE COMPACTFLASH ...................................................................................................... 20 
SENDING THE TIME AND DATE ........................................................................................................... 20 

USING THE EMULATOR .....................................................................................20 
UPDATING VIA COMPACTFLASH ..........................................................................21 
GURU MEDITATION CODES ...............................................................................22 

CONFIGURING COMMUNICATIONS .................................................................... 23 
SERIAL PORT USAGE .......................................................................................23 
SELECTING A PROTOCOL ..................................................................................24 
PROTOCOL OPTIONS .......................................................................................24 
WORKING WITH DEVICES .................................................................................25 



TABLE OF CONTENTS CRIMSON USER MANUAL 

PAGE II www.monicoinc.com/support 

ETHERNET CONFIGURATION ............................................................................. 25 
IP PARAMETERS ............................................................................................................................. 26 
IP ROUTING .................................................................................................................................. 26 
PHYSICAL LAYER ............................................................................................................................ 26 
REMOTE UPDATE ............................................................................................................................ 26 
PROTOCOL SELECTION ..................................................................................................................... 26 

SLAVE PROTOCOLS ........................................................................................ 27 
SELECTING THE PROTOCOL ............................................................................................................... 28 
ADDING GATEWAY BLOCKS ............................................................................................................... 28 
ADDING ITEMS TO A BLOCK .............................................................................................................. 29 
ACCESSING INDIVIDUAL BITS ............................................................................................................ 29 

PROTOCOL CONVERSION ................................................................................. 30 
MASTER AND SLAVE ........................................................................................................................ 30 
MASTER AND MASTER ...................................................................................................................... 30 
WHICH WAY AROUND? .................................................................................................................... 31 

DATA TRANSFORMATION ................................................................................. 31 
NOTES FOR EDICT USERS ................................................................................ 31 

ADVANCED COMMUNICATIONS ........................................................................ 33 
USING EXPANSION CARDS ............................................................................... 33 
SHARING SERIAL PORTS .................................................................................. 34 

ENABLING TCP/IP .......................................................................................................................... 34 
SHARING THE REQUIRED PORT .......................................................................................................... 34 
CONNECTING VIA ANOTHER PORT ...................................................................................................... 34 
CONNECTING VIA ETHERNET ............................................................................................................. 35 
PURE VIRTUAL PORTS ..................................................................................................................... 36 
LIMITATIONS ................................................................................................................................. 37 

USING ELECTRONIC MAIL ................................................................................ 37 
CONFIGURING SMTP ...................................................................................................................... 37 
CONFIGURING SMS ........................................................................................................................ 39 
THE ADDRESS BOOK ....................................................................................................................... 40 

WORKING WITH MODEMS ................................................................................ 40 
SOME TYPICAL APPLICATIONS ........................................................................................................... 41 
ADDING A DIAL-IN CONNECTION ........................................................................................................ 41 
ADDING A DIAL-OUT CONNECTION ..................................................................................................... 44 
ADDING AN SMS CONNECTION .......................................................................................................... 45 
SMS MESSAGE PROCESSING ............................................................................................................. 46 
USING MULTIPLE INTERFACES ........................................................................................................... 46 
CHECKING THE MODEM STATUS ......................................................................................................... 47 
MODEM INITIALIZATION SEQUENCE .................................................................................................... 48 
TROUBLESHOOTING MODEM COMMUNICATION ...................................................................................... 49 

OPC COMMUNICATION ................................................................................... 50 
OPC SERVER SETTINGS ................................................................................................................... 50 
OPC AND SCADA .......................................................................................................................... 51 
OPC LINK (MONICO PRODUCTS DATA EXCHANGE) ................................................................................. 51 

USING TIME MANAGEMENT .............................................................................. 53 
CONFIGURING THE TIME MANAGER ..................................................................................................... 53 
SELECTING AN SNTP SERVER ............................................................................................................ 55 
TIME-ZONE CONFIGURATION ............................................................................................................ 55 



 TABLE OF CONTENTS 

REVISION 12 PAGE III 

CONFIGURING THE SYNCHRONIZATION MANAGER (FTP) ...........................................56 
SYNCHRONIZATION MANAGER SETTINGS .............................................................................................. 56 
AUTOMATIC LOG SYNCHRONIZATION ................................................................................................... 57 
ADVANCED FTP EXCHANGE FUNCTIONS ............................................................................................... 58 

CONFIGURING THE FTP SERVER .........................................................................58 
FTP SERVER SETTINGS .................................................................................................................... 58 
FTP SECURITY............................................................................................................................... 59 
ACCESSING THE SERVER ................................................................................................................... 59 

CONFIGURING DATA TAGS .............................................................................. 61 
ALL ABOUT TAGS ...........................................................................................61 

TYPES OF TAGS .............................................................................................................................. 61 
TAGS? ......................................................................................................................................... 63 

CREATING TAGS ............................................................................................64 
EDITING TAGS ...............................................................................................64 
EDITING PROPERTIES ......................................................................................64 

EXPRESSION PROPERTIES ................................................................................................................. 65 
TRANSLATABLE STRINGS .................................................................................................................. 65 
COLOR PROPERTIES ........................................................................................................................ 66 

EDITING FLAG TAGS .......................................................................................67 
THE DATA TAB (VARIABLES) ............................................................................................................. 67 
THE DATA TAB (FORMULAE) ............................................................................................................. 69 
THE DATA TAB (ARRAYS) ................................................................................................................. 69 
THE FORMAT TAB ........................................................................................................................... 70 
THE COLORS TAB ........................................................................................................................... 71 
THE ALARMS TAB ........................................................................................................................... 72 
THE TRIGGERS TAB ........................................................................................................................ 73 

EDITING INTEGER TAGS ...................................................................................74 
THE DATA TAB (VARIABLES) ............................................................................................................. 74 
THE DATA TAB (FORMULAE) ............................................................................................................. 75 
THE DATA TAB (ARRAYS) ................................................................................................................. 76 
THE FORMAT TAB ........................................................................................................................... 76 
THE COLORS TAB ........................................................................................................................... 78 
THE ALARM TABS ........................................................................................................................... 78 
THE TRIGGERS TAB ........................................................................................................................ 79 

EDITING MULTI TAGS ......................................................................................80 
THE DATA TAB (VARIABLES) ............................................................................................................. 80 
THE DATA TAB (FORMULAE) ............................................................................................................. 81 
THE DATA TAB (ARRAYS) ................................................................................................................. 81 
THE FORMAT TAB ........................................................................................................................... 82 
THE COLORS TAB ........................................................................................................................... 83 
THE ALARM TABS ........................................................................................................................... 84 
THE TRIGGERS TAB ........................................................................................................................ 84 

EDITING REAL TAGS .......................................................................................85 
EDITING STRING TAGS ....................................................................................85 

THE DATA TAB (VARIABLES) ............................................................................................................. 85 
THE DATA TAB (FORMULAE) ............................................................................................................. 86 
THE DATA TAB (ARRAYS) ................................................................................................................. 86 
THE FORMAT TAB ........................................................................................................................... 87 



TABLE OF CONTENTS CRIMSON USER MANUAL 

PAGE IV www.monicoinc.com/support 

THE COLORS TAB ........................................................................................................................... 88 
MORE THAN TWO ALARMS ............................................................................... 88 
VALIDATING TAGS ......................................................................................... 89 
EXPORTING TAG MAPPINGS .............................................................................. 89 
LOGGING EVENT MESSAGES ............................................................................. 89 
NOTES FOR EDICT USERS ................................................................................ 89 

CONFIGURING THE G303 USER INTERFACE ....................................................... 91 
CONTROLLING THE VIEW ................................................................................. 91 

OTHER VIEW OPTIONS .................................................................................................................... 91 
USING THE PAGE LIST .................................................................................... 92 
DISPLAY EDITOR TOOLBOXES ........................................................................... 92 

THE DRAWING TOOLBOX .................................................................................................................. 92 
THE FILL FORMAT TOOLBOX ............................................................................................................. 92 
THE LINE FORMAT TOOLBOX ............................................................................................................. 92 
THE TEXT FORMAT TOOLBOX ............................................................................................................ 93 
THE FOREGROUND TOOLBOX ............................................................................................................. 93 
THE BACKGROUND TOOLBOX ............................................................................................................. 93 

ADDING DISPLAY PRIMITIVES ........................................................................... 93 
SMART ALIGNMENT ......................................................................................................................... 93 
KEYBOARD OPTIONS ....................................................................................................................... 94 
LOCK INSERT MODE ........................................................................................................................ 94 

SELECTING PRIMITIVES ................................................................................... 94 
MOVING AND RESIZING ................................................................................... 95 
REORDERING PRIMITIVES ................................................................................ 95 
EDITING PRIMITIVES ...................................................................................... 96 
PRIMITIVE DESCRIPTIONS ................................................................................ 96 

THE LINE PRIMITIVE ....................................................................................................................... 96 
THE SIMPLE GEOMETRIC PRIMITIVES .................................................................................................. 96 
THE TANK PRIMITIVES ..................................................................................................................... 97 
THE SIMPLE BAR-GRAPH PRIMITIVES ................................................................................................... 97 
THE FIXED TEXT PRIMITIVE .............................................................................................................. 98 
THE AUTO TAG PRIMITIVE ................................................................................................................ 99 
THE TAG TEXT PRIMITIVES ............................................................................................................. 100 
EDITING THE UNDERLYING TAG ....................................................................................................... 102 
THE TIME AND DATE PRIMITIVE ....................................................................................................... 103 
THE RICH BAR-GRAPH PRIMITIVES ................................................................................................... 104 
THE SYSTEM PRIMITIVES ................................................................................................................ 106 

DEFINING PAGE PROPERTIES ........................................................................... 107 
DEFINING SYSTEM ACTIONS ............................................................................ 108 
DEFINING KEY BEHAVIOR ............................................................................... 108 
ENABLING ACTIONS ...................................................................................... 109 
ACTION DESCRIPTIONS .................................................................................. 109 

THE GOTO PAGE ACTION ............................................................................................................... 109 
THE PUSH BUTTON ACTION ............................................................................................................ 110 
THE CHANGE INTEGER VALUE ACTION ............................................................................................... 110 
THE RAMP INTEGER VALUE ACTION .................................................................................................. 111 



 TABLE OF CONTENTS 

REVISION 12 PAGE V 

THE PLAY TUNE ACTION ........................................................................................................... 111 
THE USER DEFINED ACTION ........................................................................................................... 112 
BLOCK DEFAULT ACTION ................................................................................................................ 112 

CHANGING THE LANGUAGE .............................................................................. 113 
ADVANCED TOPICS ....................................................................................... 113 

ACTION PROCESSING..................................................................................................................... 113 
DATA AVAILABILITY ...................................................................................................................... 114 

NOTES FOR EDICT USERS ............................................................................... 114 
CONFIGURING A COLOR USER INTERFACE ........................................................ 117 

CONTROLLING THE VIEW ................................................................................ 117 
ZOOM FUNCTION .......................................................................................................................... 117 
OTHER VIEW OPTIONS .................................................................................................................. 118 

USING THE PAGE LIST ................................................................................... 118 
WORKING WITH THE GRID .............................................................................. 119 
THE DRAWING TOOLBOX ................................................................................ 119 
ADDING DISPLAY PRIMITIVES .......................................................................... 120 

SMART ALIGNMENT ....................................................................................................................... 120 
KEYBOARD OPTIONS ..................................................................................................................... 121 
LOCK INSERT MODE ...................................................................................................................... 121 

USING THE IMAGE LIBRARY ............................................................................. 121 
SELECTING PRIMITIVES .................................................................................. 122 
MOVING AND RESIZING .................................................................................. 122 
ALIGNING PRIMITIVES ................................................................................... 123 
SPACING PRIMITIVES..................................................................................... 123 
REORDERING PRIMITIVES ............................................................................... 123 
GROUPING PRIMITIVES .................................................................................. 124 
EDITING PRIMITIVES ..................................................................................... 124 
DEFINING COLORS........................................................................................ 124 
DEFINING FILL PATTERNS ............................................................................... 125 
DEFINING ACTIONS ...................................................................................... 126 
ENABLING ACTIONS ...................................................................................... 126 
ACTION DESCRIPTIONS .................................................................................. 126 

THE GOTO PAGE ACTION ............................................................................................................... 127 
THE PUSH BUTTON ACTION ............................................................................................................ 128 
THE CHANGE INTEGER VALUE ACTION ............................................................................................... 129 
THE RAMP INTEGER VALUE ACTION .................................................................................................. 129 
THE PLAY TUNE ACTION ........................................................................................................... 130 
THE USER DEFINED ACTION ........................................................................................................... 130 

USING DEFAULT SETTINGS ............................................................................. 131 
PRIMITIVE DESCRIPTIONS............................................................................... 131 

THE LINE PRIMITIVE ..................................................................................................................... 131 
THE SIMPLE GEOMETRIC PRIMITIVES ................................................................................................ 131 
THE TANK PRIMITIVES ................................................................................................................... 132 
THE SIMPLE BAR PRIMITIVES .......................................................................................................... 132 
THE BAR-GRAPH PRIMITIVES .......................................................................................................... 133 



TABLE OF CONTENTS CRIMSON USER MANUAL 

PAGE VI www.monicoinc.com/support 

THE SCATTER GRAPH PRIMITIVE ...................................................................................................... 134 
THE SCALE PRIMITIVES .................................................................................................................. 137 
THE FIXED TEXT PRIMITIVE ............................................................................................................ 138 
THE AUTO TAG PRIMITIVE .............................................................................................................. 139 
THE TAG TEXT PRIMITIVES ............................................................................................................. 140 
EDITING THE UNDERLYING TAG ....................................................................................................... 143 
THE MULTI-LINE TEXT PRIMITIVES ................................................................................................... 144 
THE TIME AND DATE PRIMITIVE ....................................................................................................... 144 
THE RICH BAR PRIMITIVES ............................................................................................................. 146 
THE RICH SLIDER PRIMITIVES ......................................................................................................... 148 
THE ALARM VIEWER PRIMITIVE ....................................................................................................... 150 
THE ALARM TICKER PRIMITIVE ........................................................................................................ 155 
THE EVENT VIEWER PRIMITIVE ........................................................................................................ 157 
THE FILE VIEWER PRIMITIVE ........................................................................................................... 157 
THE REMOTE DISPLAY PRIMITIVE ..................................................................................................... 158 
THE CAMERA PRIMITIVE ................................................................................................................. 159 
THE TRENDING PRIMITIVES ............................................................................................................ 160 
THE GENERAL BUTTON PRIMITIVE .................................................................................................... 164 
THE RICH BUTTON PRIMITIVE ......................................................................................................... 165 
THE SELECTOR PRIMITIVES ............................................................................................................. 167 
THE PICTURE PRIMITIVE ................................................................................................................ 169 
THE CF IMAGE PRIMITIVE .............................................................................................................. 173 
THE DIAL GAUGE PRIMITIVES .......................................................................................................... 174 

SYSTEM PRIMITIVES ...................................................................................... 176 
THE TOUCH TEST PRIMITIVE ........................................................................................................... 177 
THE TOUCH CALIBRATION PRIMITIVE ................................................................................................ 177 

DEFINING PAGE PROPERTIES ........................................................................... 178 
DEFINING SYSTEM ACTIONS ............................................................................ 179 
ADDITIONAL SYSTEM PROPERTIES ..................................................................... 179 
SELECTING LANGUAGES .................................................................................. 181 
CHANGING THE LANGUAGE .............................................................................. 182 
SIMULATING LANGUAGES IN MONICOVIEW .......................................................... 182 
DEFINING KEY BEHAVIOR ............................................................................... 183 
BLOCKING DEFAULT ACTIONS .......................................................................... 183 
DATA AVAILABILITY ...................................................................................... 184 
NOTES FOR EDICT USERS ............................................................................... 184 

CONFIGURING PROGRAMS ............................................................................ 185 
USING THE PROGRAM LIST .............................................................................. 185 
EDITING PROGRAMS ...................................................................................... 185 
PROGRAM PROPERTIES .................................................................................. 186 
ADDING COMMENTS ...................................................................................... 187 
RETURNING VALUES ...................................................................................... 188 

HERE BE DRAGONS! ...................................................................................................................... 188 
PASSING ARGUMENTS .................................................................................... 188 
PROGRAMMING TIPS ..................................................................................... 189 

MULTIPLE ACTIONS ....................................................................................................................... 189 



 TABLE OF CONTENTS 

REVISION 12 PAGE VII 

IF STATEMENTS ........................................................................................................................... 189 
SWITCH STATEMENTS .................................................................................................................... 190 
LOCAL VARIABLES ......................................................................................................................... 191 
LOOP CONSTRUCTS ....................................................................................................................... 191 

NOTES FOR EDICT USERS ............................................................................... 194 
CONFIGURING DATA LOGGING ....................................................................... 197 

BATCH LOGGING .......................................................................................... 197 
CONTROLLING A BATCH ................................................................................................................. 198 

CREATING DATA LOGS ................................................................................... 198 
USING THE LOG LIST..................................................................................... 198 
DATA LOG PROPERTIES .................................................................................. 199 
LOG FILE STORAGE ....................................................................................... 200 
THE LOGGING PROCESS ................................................................................. 201 
ACCESSING LOG FILES ................................................................................... 201 
USING WEBSYNC ......................................................................................... 202 

WEBSYNC SYNTAX ........................................................................................................................ 202 
OPTIONAL SWITCHES .................................................................................................................... 202 
EXAMPLE USAGE........................................................................................................................... 203 

NOTES FOR EDICT USERS ............................................................................... 203 
CONFIGURING THE WEB SERVER .................................................................... 205 

WEB SERVER PROPERTIES .............................................................................. 205 
ADDING WEB PAGES ..................................................................................... 207 
USING A CUSTOM WEB SITE ........................................................................... 208 

CREATING THE SITE ...................................................................................................................... 208 
EMBEDDING DATA ........................................................................................................................ 208 
DEPLOYING THE SITE .................................................................................................................... 208 

COMPACTFLASH ACCESS ................................................................................. 208 
ACCESSING THE WEB SERVER .......................................................................... 209 

USING ETHERNET ......................................................................................................................... 209 
USING MODEMS ........................................................................................................................... 209 

WEB SERVER SAMPLES .................................................................................. 210 
USING THE SECURITY SYSTEM ....................................................................... 215 

SECURITY BASICS ......................................................................................... 215 
OBJECT-BASED SECURITY ............................................................................................................... 215 
NAMED USERS ............................................................................................................................. 215 
USER RIGHTS .............................................................................................................................. 215 
ACCESS CONTROL ......................................................................................................................... 216 
WRITE LOGGING .......................................................................................................................... 216 
DEFAULT ACCESS ......................................................................................................................... 216 
ON-DEMAND LOGON ..................................................................................................................... 217 
MAINTENANCE ACCESS .................................................................................................................. 217 

SECURITY SETTINGS ..................................................................................... 217 
CREATING USERS ......................................................................................... 218 
SPECIFYING TAG SECURITY ............................................................................. 219 
SPECIFYING PAGE SECURITY ............................................................................ 219 



TABLE OF CONTENTS CRIMSON USER MANUAL 

PAGE VIII www.monicoinc.com/support 

THE SECURITY MANAGER PRIMITIVE .................................................................. 219 
SECURITY RELATED FUNCTIONS ....................................................................... 219 

WRITING EXPRESSIONS ............................................................................... 220 
DATA VALUES .............................................................................................. 220 

CONSTANTS ................................................................................................................................ 220 
TAG VALUES................................................................................................................................ 221 
COMMUNICATIONS REFERENCES ....................................................................................................... 222 

SIMPLE MATH.............................................................................................. 222 
OPERATOR PRIORITY ..................................................................................... 222 
TYPE CONVERSION ....................................................................................... 223 
COMPARING VALUES...................................................................................... 223 
TESTING BITS ............................................................................................. 224 
MULTIPLE CONDITIONS .................................................................................. 224 
CHOOSING VALUES ....................................................................................... 225 
MANIPULATING BITS ..................................................................................... 225 

AND, OR AND XOR ....................................................................................................................... 225 
SHIFT OPERATORS ........................................................................................................................ 225 
BITWISE NOT ............................................................................................................................. 226 

INDEXING ARRAYS ........................................................................................ 226 
INDEXING STRINGS ....................................................................................... 226 
ADDING STRINGS ......................................................................................... 226 
CALLING PROGRAMS ...................................................................................... 226 
USING FUNCTIONS........................................................................................ 226 
PRIORITY SUMMARY ...................................................................................... 227 
NOTES FOR EDICT USERS ............................................................................... 227 

WRITING ACTIONS ..................................................................................... 229 
CHANGING PAGE .......................................................................................... 229 
CHANGING NUMERIC VALUES ........................................................................... 229 

SIMPLE ASSIGNMENT ..................................................................................................................... 229 
COMPOUND ASSIGNMENT ............................................................................................................... 229 
INCREMENT AND DECREMENT .......................................................................................................... 229 

CHANGING BIT VALUES .................................................................................. 229 
RUNNING PROGRAMS .................................................................................... 230 
USING FUNCTIONS........................................................................................ 230 
OPERATOR PRIORITY ..................................................................................... 230 
NOTES FOR EDICT USERS ............................................................................... 230 

USING RAW PORTS ..................................................................................... 231 
CONFIGURING A SERIAL PORT .......................................................................... 231 
CONFIGURING A TCP/IP SOCKET ...................................................................... 231 
READING CHARACTERS .................................................................................. 232 
READING ENTIRE FRAMES ............................................................................... 232 
SENDING DATA ............................................................................................ 233 
NOTES FOR EDICT USERS ............................................................................... 233 



 TABLE OF CONTENTS 

REVISION 12 PAGE IX 

SYSTEM VARIABLE REFERENCE ...................................................................... 235 
HOW ARE SYSTEM VARIABLES USED .................................................................. 235 
ACTIVEALARMS ............................................................................................ 236 
COMMSERROR ............................................................................................. 237 
DISPBRIGHTNESS ......................................................................................... 238 
DISPCONTRAST ........................................................................................... 239 
DISPCOUNT ................................................................................................ 240 
DISPUPDATES ............................................................................................. 241 
ISSIRENON ................................................................................................ 242 
PI ............................................................................................................ 243 
TIMEZONE ................................................................................................. 244 
TIMEZONEMINS ........................................................................................... 245 
USEDST .................................................................................................... 246 

PROGRAMMING REFERENCE .......................................................................... 247 
EXPRESSION OPERATORS................................................................................ 247 
ACTION OPERATORS ..................................................................................... 248 
PROGRAMMING STATEMENTS ........................................................................... 249 

FUNCTION REFERENCE ................................................................................. 251 
NOTES FOR EDICT USERS ............................................................................... 251 
ABS(VALUE) ................................................................................................ 252 
ACOS(VALUE) .............................................................................................. 253 
ALARMACCEPTALL() ...................................................................................... 254 
ASIN(VALUE) ............................................................................................... 255 
ATAN(VALUE) .............................................................................................. 256 
ATAN2(A, B) ............................................................................................... 257 
BEEP(FREQ, PERIOD) ..................................................................................... 258 
CLEAREVENTS() ........................................................................................... 259 
CLOSEFILE(FILE).......................................................................................... 260 
COMMITANDRESET() .................................................................................... 261 
COMPACTFLASHEJECT() ................................................................................. 262 
COMPACTFLASHSTATUS() ............................................................................... 263 
CONTROLDEVICE(DEVICE, ENABLE) ................................................................... 264 
COPY(DEST, SRC, COUNT) .............................................................................. 265 
COS(THETA) ............................................................................................... 266 
CREATEDIRECTORY(NAME) ............................................................................. 267 
CREATEFILE(NAME) ...................................................................................... 268 
DATATOTEXT(DATA, LIMIT) ............................................................................ 269 
DATE(Y, M, D) ............................................................................................ 270 
DECTOTEXT(DATA, SIGNED, BEFORE, AFTER, LEADING, GROUP) ................................ 271 
DEG2RAD(THETA) ........................................................................................ 272 
DELETEDIRECTORY(NAME) ............................................................................. 273 



TABLE OF CONTENTS CRIMSON USER MANUAL 

PAGE X www.monicoinc.com/support 

DELETEFILE(FILE) ........................................................................................ 274 
DEVCTRL(DEVICE, FUNCTION, DATA) ................................................................. 275 
DISABLEDEVICE(DEVICE) ................................................................................ 276 
DISPOFF() ................................................................................................. 277 
DISPON() .................................................................................................. 278 
DRVCTRL(PORT, FUNCTION, DATA OR VALUE???) .................................................. 279 
EMPTYWRITEQUEUE (DEV) ............................................................................. 280 
ENABLEDEVICE(DEVICE) ................................................................................. 281 
ENDBATCH() ............................................................................................... 282 
EXP(VALUE) ................................................................................................ 283 
EXP10(VALUE) ............................................................................................. 284 
FILL(ELEMENT, DATA, COUNT) ......................................................................... 285 
FIND(STRING,CHAR,SKIP) ............................................................................... 286 
FINDFILEFIRST(DIR) ..................................................................................... 287 
FINDFILENEXT() .......................................................................................... 288 
FINDTAGINDEX(LABEL) .................................................................................. 289 
FORCE(TAG, VALUE) ..................................................................................... 290 
FORCECOPY(DEST, SRC, COUNT) ...................................................................... 291 
FORMATCOMPACTFLASH() .............................................................................. 292 
FTPGETFILE(SERVER, LOC, REM, DELETE) ........................................................... 293 
FTPPUTFILE(SERVER, LOC, REM, DELETE) ............................................................ 294 
GETALARMTAG(INDEX) .................................................................................. 295 
GETBATCH() ............................................................................................... 296 
GETCAMERADATA(PORT, CAMERA, PARAM) .......................................................... 297 
GETDATE (TIME) AND FAMILY .......................................................................... 298 
GETDISKFREEBYTES(DRIVE) ........................................................................... 299 
GETDISKFREEPERCENT(DRIVE) ........................................................................ 300 
GETDISKSIZEBYTES(DRIVE) ............................................................................ 301 
GETFORMATTEDTAG(INDEX) ........................................................................... 302 
GETINTERFACESTATUS(PORT) ......................................................................... 303 
GETINTTAG(INDEX) ...................................................................................... 304 
GETMAXTAGINT(INDEX) ................................................................................ 305 
GETMAXTAGREAL(INDEX) .............................................................................. 306 
GETMINTAGINT(INDEX) ................................................................................. 307 
GETMINTAGREAL(INDEX) ............................................................................... 308 
GETMONTHDAYS(Y, M) .................................................................................. 309 
GETNETGATE(PORT) ..................................................................................... 310 
GETNETID(PORT) ........................................................................................ 311 
GETNETIP(PORT) ......................................................................................... 312 
GETNETMASK(PORT) .................................................................................... 313 
GETNOW() ................................................................................................. 314 



 TABLE OF CONTENTS 

REVISION 12 PAGE XI 

GETNOWDATE() .......................................................................................... 315 
GETNOWTIME() .......................................................................................... 316 
GETPORTCONFIG(PORT, PARAM) ...................................................................... 317 
GETREALTAG(INDEX) .................................................................................... 318 
GETSTRINGTAG(INDEX) ................................................................................. 319 
GETTAGLABEL(INDEX) ................................................................................... 320 
GETUPDOWNDATA(DATA, LIMIT) ..................................................................... 321 
GETUPDOWNSTEP(DATA, LIMIT) ...................................................................... 322 
GOTOPAGE(NAME) ....................................................................................... 323 
GOTOPREVIOUS() ........................................................................................ 324 
HASACCESS (RIGHTS) ................................................................................... 325 
HIDEPOPUP() ............................................................................................. 326 
INTTOTEXT(DATA, RADIX, COUNT) ................................................................... 327 
ISDEVICEONLINE(DEVICE) .............................................................................. 328 
ISPORTREMOTE(PORT) .................................................................................. 329 
ISWRITEQUEUEEMPTY(DEV) ........................................................................... 330 
LEFT(STRING, COUNT) ................................................................................... 331 
LEN(STRING) .............................................................................................. 332 
LOADCAMERASETUP(PORT, CAMERA, INDEX, FILE) ................................................. 333 
LOG(VALUE) ............................................................................................... 334 
LOG10(VALUE) ............................................................................................ 335 
LOGSAVE()................................................................................................. 336 
MAKEFLOAT(VALUE) ..................................................................................... 337 
MAKEINT(VALUE) ......................................................................................... 338 
MAX(A, B) .................................................................................................. 339 
MEAN(ELEMENT, COUNT) ................................................................................ 340 
MID(STRING, POS, COUNT) ............................................................................. 341 
MIN(A, B) .................................................................................................. 342 
MULDIV(A, B, C) .......................................................................................... 343 
MUTESIREN() ............................................................................................. 344 
NEWBATCH(NAME) ....................................................................................... 345 
NOP() ....................................................................................................... 346 
OPENFILE(NAME, MODE) ................................................................................ 347 
PI() ......................................................................................................... 348 
PLAYRTTTL(TUNE) ...................................................................................... 349 
POPDEV(ELEMENT, COUNT) ............................................................................. 350 
PORTCLOSE(PORT) ....................................................................................... 351 
PORTGETCTS(PORT) .................................................................................... 352 
PORTINPUT(PORT, START, END, TIMEOUT, LENGTH) ............................................... 353 
PORTPRINT(PORT, STRING) ............................................................................ 354 
PORTREAD(PORT, PERIOD) ............................................................................. 355 



TABLE OF CONTENTS CRIMSON USER MANUAL 

PAGE XII www.monicoinc.com/support 

PORTSETRTS(PORT, STATE) ........................................................................... 356 
PORTWRITE(PORT, DATA) .............................................................................. 357 
POSTKEY(CODE, TRANSITION) ......................................................................... 358 
POWER(VALUE, POWER) ................................................................................. 359 
RAD2DEG(THETA) ........................................................................................ 360 
RANDOM(RANGE) ......................................................................................... 361 
READDATA(DATA, COUNT) .............................................................................. 362 
READFILE(FILE, CHARS) ................................................................................. 363 
READFILELINE(FILE) ..................................................................................... 364 
RENAMEFILE(HANDLE, NAME) .......................................................................... 365 
RIGHT(STRING, COUNT) ................................................................................. 366 
SAVECAMERASETUP(PORT, CAMERA, INDEX, FILE) ................................................. 367 
SCALE(DATA, R1, R2, E1, E2) .......................................................................... 368 
SENDFILE(RCPT, FILE) ................................................................................... 369 
SENDMAIL(RCPT, SUBJECT, BODY) .................................................................... 370 
SET(TAG, VALUE) ......................................................................................... 371 
SETINTTAG(INDEX, VALUE) ............................................................................. 372 
SETLANGUAGE(CODE) .................................................................................... 373 
SETNETCONFIG(PORT, ADDR, MASK, GATE) ......................................................... 374 
SETNOW(TIME) ........................................................................................... 375 
SETPORTCONFIG(PORT, PARAM, VALUE) ............................................................. 376 
SETREALTAG(INDEX, VALUE) ........................................................................... 378 
SETSTRINGTAG(INDEX, VALUE) ........................................................................ 379 
SGN(VALUE) ............................................................................................... 380 
SHOWMENU(NAME) ...................................................................................... 381 
SHOWPOPUP(NAME) ..................................................................................... 382 
SIN(THETA) ................................................................................................ 383 
SIRENON() ................................................................................................. 384 
SLEEP(PERIOD) ............................................................................................ 385 
SQRT(VALUE) .............................................................................................. 386 
STDDEV(ELEMENT, COUNT) ............................................................................. 387 
STOPSYSTEM() ............................................................................................ 388 
STRIP(TEXT, TARGET).................................................................................... 389 
SUM(ELEMENT, COUNT) ................................................................................. 390 
TAN(THETA)................................................................................................ 391 
TESTACCESS(RIGHTS, PROMPT) ........................................................................ 392 
TEXTTOADDR(ADDR) .................................................................................... 393 
TEXTTOFLOAT(STRING) ................................................................................. 394 
TEXTTOINT(STRING, RADIX) ........................................................................... 395 
TIME(H, M, S) ............................................................................................. 396 
USECAMERASETUP(PORT, CAMERA, INDEX) .......................................................... 397 



 TABLE OF CONTENTS 

REVISION 12 PAGE XIII 

USERLOGOFF() ........................................................................................... 398 
USERLOGON() ............................................................................................ 399 
WAITDATA(DATA, COUNT, TIME) ...................................................................... 400 
WRITEFILE(FILE, TEXT) ................................................................................. 401 
WRITEFILELINE(FILE, TEXT) ........................................................................... 402 

TROUBLESHOOTING ..................................................................................... 403 
GENERAL ................................................................................................... 403 
MONICOVIEW MESSAGES ............................................................................... 406 
SERIAL COMMUNICATION ............................................................................... 407 
ETHERNET COMMUNICATION ........................................................................... 408 
PROGRAMS ................................................................................................. 409 
WEB SERVER .............................................................................................. 410 





  

  

MONICOVIEW  
USER MANUAL 

 

 





GETTING STARTED SYSTEM REQUIREMENTS 

REVISION 12 PAGE 1 

GETTING STARTED 
Welcome to MonicoView —the latest operator interface configuration package from Monico 
Inc. MonicoView is designed to provide quick and easy access to the features of the Gateway 
series of operator panels, while still allowing the advanced user to take advantage of high-end 
features, such as MonicoView’s unique programming support. 

SYSTEM REQUIREMENTS 

MonicoView  is designed to run on PCs with the following specifications… 

• A Pentium class processor as required by the chosen operating system. 

• RAM and free disk space as required by the chosen operating system. 

• An additional 50MB of disk space for software installation. 

• A display of at least 800 by 600 pixels (1024 by 768 for G308 and G310), with 
256 or more colors. 

• An RS-232 or USB port for downloading to a G3 panel. 

MonicoView  is designed to operate with all versions of Microsoft Windows from Windows 
95 upwards. If you want to take advantage of the USB port provided by the G3 operator 
panels, you will need to use, as a minimum, Windows 98. If you intend to use the USB port to 
remotely access the G3’s CompactFlash card, we recommend that you use Windows 2000 or 
Windows XP. While Windows 98 is capable of accessing the card, the later versions of the 
operating system provide more robust operation, and are much better about when they choose 
to lock the card, thereby preventing the C2 runtime from writing data. 

INSTALLING THE SOFTWARE 

If you downloaded the MonicoView software from Monico’s website, simply execute the 
download file, and follow the instructions. If you received a copy of MonicoView on CD, 
place the CD in your system’s CDROM drive, and follow the instructions that will appear. If 
no instructions appear, you may have auto-run disabled. In that case, select the Run option 
from the Start menu, and enter x:\setup, where x is the drive letter of your CDROM drive. 
Again, follow the resulting instructions, and the software will be installed. 

CHECKING FOR UPDATES 

If you have an Internet connection, you can use the Check for Update command in the Help 
menu to scan Monico’s web site for a new version of MonicoView. If a later version than the 
one you are using is found, MonicoView will ask if it should download the upgrade and 
update your software automatically. You may also manually download the upgrade from 
Monico’s website by visiting the Downloads page within the Support section. Either way, 
when the upgrade package executes, be sure to select the Repair option to update your 
installation. 
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INSTALLING THE USB DRIVERS 

When you first connect a G3 panel to your PC using a USB cable, Windows will prompt you 
for the location of the drivers for the device. The default location for these drivers is 
C:\Program Files\Monico Controls\MonicoView.0\Device. When the Hardware Setup Wizard 
appears, choose the Browse option, and either point the Wizard at that location or whatever 
other location you specified during installation of the software. It is important that you 
perform this step correctly, or you may have to manually remove the drivers using the Device 
Manager, and repeat the installation once more. Windows XP users should note that 
MonicoView’s USB drivers have not been digitally signed by Microsoft, and you will 
therefore a dialog offering you the chance to stop the installation. You should be sure to select 
the Continue option to indicate that you do indeed wish to install the drivers. 
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QUICK START 
G3 HMIs are versatile operator interfaces, truly requiring a 300+ page manual. However, 
you’ll no doubt want to jump right into programming before reading it in its entirety. The 
following section provides you with enough information to develop a basic working system. 

This quick start is using a G310 color touchscreen HMI with an Allen Bradley PLCs as an 
example. Other HMI setup would be very similar.  

Tutorials can be found on www.monicoinc.com/supportfeatures/ to easily set up other basic 
features such as protocol conversion, Ethernet communication and multiple languages. Just 
click on the “All G3 Features Link” to get to the selection of features and related tutorials. 

SELECTING THE HMI 

When MonicoView is started for the first time, a new G303 database is created. In 
MonicoView and throughout this manual, the term database means a complete setup and 
configuration file for a Monico product. 

For this quick start, a new database as to be created for a G310 HMI. The panel has to be 
selected before any programming is started. Click on File > New to obtain the New Database 
dialog box. 

 

Select G3 Series HMI in the product family and G310 for the model. Click OK to create this 
new G310 database. 

For most applications, only the first three icons are required: Communications, Data Tags and 
User Interface. 

 

COMMUNICATIONS 

Next, you’ll want to configure a port to communicate data to your PLC, PC, etc. The ports are 
configured under the Communications window of the software.  

http://www.redlion.net/g3features/�
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This window displays all the communication ports available on the device. In this example, as 
in most applications, the G310 will be the communication master, thus avoiding extra PLC 
programming for communication. 

To setup a G3 as a slave, please refer to the Communication setup at the end of this chapter. 

 

Select the communication port your PLC should be connected to (in this example, the RS232 
Comms Port) and click the Edit button in the driver selection area to choose a protocol. In this 
example, Allen Bradley DF1 Master has been selected as the protocol.  

 

By doing so, a device called PLC1 has been created.  

When the communication port is selected, the right hand pane displays the communication 
driver properties for this port, e.g. the parity, baud rate, G3 address if required, etc. You 
should verify that the driver properties make sense for your application. 

When the device (here PLC1) is selected, the right hand pane displays the communication 
settings for this specific target device, e.g. the device type, address, etc. 
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You can add an additional device by selecting the communication port and clicking on the 
Add Additional Device button as shown below. A new device called PLC2 will be created. 
Select that device to change its settings. 

 

MAPPING DATA 

Once the Communications settings are completed, click close to go back to the main menu 
and enter the Data Tags window. Data tags are variables that can be mapped (linked) to PLC 
registers and then available anywhere in the database. 

Create an integer variable by clicking the Integer button in the Create New Variable group. 

 

This creates a new variable called Var1. That variable can be renamed to a more meaningful 
name for your application.  

Select the variable to show its settings and make sure you are on the data tab. Click on the 
Internal button next to Mapping. A drop down menu shows the devices previously created in 
communication. 



MAPPING DATA CRIMSON USER MANUAL 

PAGE 6 www.monicoinc.com/support 

 

When you select the device (Here PLC1), a dialog box prompts you to select the register 
address to access in that device. Since the protocol selected was Allen Bradley DF1, the 
addresses available here are native Allen Bradley registers. Select for example the prefix N for 
integer and the address 0007 : 0001. Var1 will thus be the same as N7:1 in the PLC. 

 

Create another integer variable (Available from the Tags tree root) and map it to N7:2. You 
now have two variables, Var1 mapped to N7:1 and Var2 mapped to N7:2. 

Both variables are in red meaning you can read and write information from the PLC. To limit 
the access to Read Only (so the G3 cannot overwrite some information in the PLC), select the 
tag and change the Access to Read Only under the Data Tab. The variable symbol will turn 
green. In the image below, Var1 is in Read Only and Var2 in Read and Write access. 
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USER INTERFACE 

Close the Data Tags window and open the User Interface to create display screens. 

The first time the G310 user interface is open, you won’t be able to access the screen (when 
you click in the black area), as your screen resolution might be too small. 

 

To avoid this, change the panel view by selecting View > Panel > Display Only. 

 

Click on the black screen so the Drawing toolbox appears. To insert the tags on the screen 
simply click the tag icon  in the drawing toolbox. In the Select Tag dialog box, select one 
of the tags and click ok. 
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The tag is ready to be inserted. Just click, hold and drag the mouse cursor across the screen to 
insert the tag. Repeat the same operation for all the tags you whish to display in that page. 

 

To be able to change the data in the PLC from the G310 HMI screen, for example Var2, 
double click Var2 in the User Interface to access the primitive properties and change Data 
Entry to yes on the Properties Tab as shown below. 

NOTE: Nothing else is required to enable data entry on this tag. DO NOT put any 
information in the Data Entry tab; these are for data entry checking only. 

 

 

Double-click the 
primitive. 
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Your G3 setup is now complete and ready for download. The entire configuration is done 
offline so the database has to be downloaded in the HMI to see the result of your setup. 

DOWNLOADING 

To download to the G3 via serial is trivial. Simply make sure you’ve selected the proper 
COM port under Link-Options. 

 

If you plan to use the USB port to download to the HMI, you should take the time to read the 
section titled Installing the USB Drivers. The Ethernet port isn’t configured from the factory, 
so it can’t be used as a means to download an initial database. 

CONNECT THE TWO 

That’s it. Connect the device to the G3 HMI, and if you’ve selected a master protocol, the G3 
will do the rest. If the target registers are changing in the device, values will automatically be 
updated on the display. 

By touching the register set up as a data entry (Var2) on the G3 display, a keypad will 
automatically pop up so you can change the data. As soon as the enter key is pressed, the 
change will be sent to the target device and the reading should now display the new value. 
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COMMUNICATIONS (G3 AS A SLAVE) 

Some applications require the G3 to be set up as a slave. The following steps describe how to 
expose data to the master device. All slave protocols use this setup apart of some drivers such 
as Profibus DP that can be setup like a master protocol. 

First, Data Tags have to be created. In the main menu, enter the Data Tags window and create 
four integer variables by clicking the Integer button in the Create New Variable group. 

 

Close the Data Tags window and open the Communications. 

Select the communication port your PLC should be connected to (in this example, the RS232 
Comms Port) and click the Edit button in the driver selection area to choose a protocol. In this 
example, Modbus RTU Slave has been selected as the protocol.  

 

By doing so, a device called PLC1 has been created. 

When the communication port is selected, the right hand pane displays the communication 
driver properties for this port, e.g. the parity, baud rate, G3 address, etc. You should verify 
that the driver properties make sense for your application. 
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To expose data for the master device for read and write access, you’ll need to create two so-
called Gateway Blocks; one so the master can only get data from the G3 and one so the 
master can get and change data in the G3. 

To create a Gateway Block, click PLC1, and then click the Add Gateway Block button on the 
right hand pane. This creates a single gateway block for mapping data. 

 

Next, you’ll need to identify the register locations that you wish to map data to or from, 
starting with a register address. Click the Edit button to see the registers supported by 
MonicoView for the selected protocol. Select a starting address and click OK. 

 

Enter the desired number of registers in the Block Size property (in this example; 5), as well 
as the desired direction using the Direction property (In this example; G3 to Device). 

In our example below, registers 400001 through 400005 have been allocated. 
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To map data tags variables, select one of the registers. A list of available tags will be shown 
in the right hand pane. 

 

To map items from the right hand pane to the items on the left, simply double click them, one 
at a time. The cursor will automatically move to the next consecutive register, allowing you to 
quickly map all of the items. Instead of clicking the data in the right hand pane, you may also 
drag and drop the data onto specific registers. 
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In the example above, tags Var1 and Var2 have been mapped to registers 400001 through 
400002. The direction of the arrows indicates that the G3 provides these values into the PLC 
(So the PLC can only read them). 

Next, another block is created so the PLC can write data in the G3. This is done by changing 
the block’s Direction property to Device to G3. In the example below, Var3 and Var4 are 
mapped to registers 400010 through 400011 

 

Note the color of the block is red telling you the PLC can write data in any registers linked to 
this block. The arrows also indicate that the PLC can also read data from the block, so this 
block has a Read/Write access. 

NOTE: Make sure block starting addresses are far enough so no common address can exist 
between blocks. A register address (for example 400010) has to be unique for all blocks used 
under a single protocol. 

Communications are now ready; refer to the chapter User Interface above to finish this Quick 
Start tutorial. 
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MONICOVIEW BASICS 
To run MonicoView, select the MonicoView icon from the Monico Controls folder on the 
Programs section of your Start Menu. The main C2 screen will appear, showing the icons that 
are used to configure the various aspects of the operator panel’s behavior… 

 

The software is designed such that the first three icons are the only ones required for the 
majority of simple applications. The remainder of the icons provide access to the terminal’s 
more advanced features, such as programming, data logging and the G3’s web server. 

MAIN SCREEN ICONS 

The sections below provide an overview of each icon in turn… 

COMMUNICATIONS 

This icon is used to specify which protocols are to be used on the G3’s serial 
ports and on the Ethernet port. Where master protocols are used (ie. 
protocols by which the G3 initiates data transfer to and from a remote 
device) you can also use this icon to specify one or more devices to be 
accessed. Where slave protocols are used (ie. protocols by which the G3 

receives and responds to requests from remote devices or computer systems) you can specify 
which data items are to be exposed for read or write access. You can also use this icon to 
move data between one remote device and another via MonicoView’s protocol converter. 

DATA TAGS 

This icon is used to define the data items to be accessed within the remote 
devices, or to define internal data items to store information within the 
terminal itself. Each tag has a variety of properties associated with it. The 
most basic property is formatting data, which is used to specify how the data 
held within a tag is to be shown on the terminal’s display, and on such 

things as web pages. By specifying this information within the tag, MonicoView removes the 
need for you to re-enter formatting data each time a tag is displayed. More advanced tag 
properties include alarms that may activate when various conditions relating to the tag occur, 
or triggers, which perform programmable actions on similar conditions. 
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USER INTERFACE 

This icon is used to create and edit display pages, and to specify what 
actions should be taken when the operator panel’s keys are pressed, released 
or held down. The page editor allows you to display various graphical items 
known as primitives. These vary from simple items, such as rectangles and 
lines, to more complex items that can be tied to the value of a particular tag 
or expression. By default, such primitives use the formatting information 

defined when the tag was created, but this information can be overridden if required. 

PROGRAMMING 

This icon is used to create and edit programs using C2’s unique C-like 
programming language. These programs can perform complex decision 
making or data manipulation operations based upon any data items within 
the system. They serve to extend the functionality of MonicoView beyond 
that of the standard functions included in the software, thereby ensuring that 

even the most complex applications can be tackled with ease. 

DATA LOGGER 

This icon is used to create and manage data logs, each of which can record 
any number of variables to the G3’s CompactFlash card. Data may be 
recorded as quickly as once per second. The recorded values will be stored 
in CSV (comma separated variable) files that can easily be imported into 
applications such as Microsoft Excel. The files can be accessed by 

swapping-out the CompactFlash card, by mounting the card as a drive on a PC connected on 
the G3’s USB port, or by accessing them via MonicoView’s web server via the Ethernet port. 

WEB SERVER 

This icon is used to configure MonicoView’s web server and to create and 
edit web pages. The web server is capable of providing remote access to the 
G3 via a number of mechanisms. First, you can use MonicoView to create 
automatic web pages which contain lists of tags, each formatted according to 
the tag’s properties. Second, you can create a custom site using a third party 

HTML editor such as Microsoft FrontPage, and then include special text to instruct 
MonicoView to insert live tag values. Finally, you can enable C2’s unique remote access and 
control feature, which allows a web browser to view the G3’s display and control its 
keyboard. The web server can also be used to access CSV files from the Data Logger. 

SECURITY MANAGER 

This icon is used to create and manage the various users of the panel, as well 
as the access rights granted to them. Real names may also be given, which 
allows the security logger to record not only what data was changed and 
when, but also by whom the data was changed. The rights required to 
modify a particular tag, or to access a page, are set via the security 

properties of the individual item. 
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SELECTING A TERMINAL 

When MonicoView first starts, it will assume that you are continuing to work with the same 
model of operator panel as was used by the last loaded database. If MonicoView has not been 
previously executed, it will assume you are working with a G303. If you want to select a new 
model, select the New command from the File menu. The following dialog will appear… 

  

The dialog lists the models supported by the current version of the software, providing a 
description of each terminal and the dimensions of its display. Selecting a terminal will create 
a blank database, and reconfigure MonicoView to work with that specific model. 

USING BALLOON HELP 

MonicoView provides a useful feature called Balloon Help... 

 

This feature allows you to see help information for each icon in the main menu, or for each 
field in a dialog box or window. It is controlled via the icon at the right-hand edge of the 
toolbar, and can be configured to three modes, namely “Do Not Display”, in which case 
balloon help is disabled; “When Mouse Over”, in which case help is displayed when the 
mouse pointer is held over a particular field for a certain period of time; or “When Selected”, 
in which case help is always displayed for the currently selected field. 

WORKING WITH DATABASES 

MonicoView stores all the information about a particular panel’s configuration in what is 
called a database file. These files have the extension of CD2, although Windows Explorer will 
hide this extension if it is left in its default configuration. MonicoView database files differ 



MONICOVIEW BASICS DOWNLOADING TO A TERMINAL 

REVISION 12 PAGE 17 

from those used by previous Monico operator panels, in that they are text files which are thus 
far easier to recover in the case of accidental corruption. Databases are manipulated via the 
commands found on the File menu. These commands are standard for all Windows 
applications, and need no further explanation. The exception is Save Image, which will be 
covered later. 

DOWNLOADING TO A TERMINAL 

MonicoView database files are downloaded to the G3 panel by means of the Link menu. The 
download process typically takes only a few seconds, but can take somewhat longer on the 
first download if MonicoView has to update the firmware in the operator panel, or if the panel 
does not contain an older version of the current database. After this first download, however, 
MonicoView uses a process known as incremental download to ensure that only changes to 
the database are transferred. This means that changes can be made in seconds, thereby 
reducing your development cycle time and simplifying the debugging process. 

CONFIGURING THE LINK 

The programming link between the PC and the G3 is made using an RS-232 serial port, a 
USB port or a TCP/IP connection. While TCP/IP connections are typically made via the 
panel’s Ethernet port, they may also be established via a dial-in link. Before downloading, 
you should use the Link-Options command to ensure that you have the method selected… 

 

VERIFYING THE USB LINK 

If you are using USB, you might also want to ensure that the G3’s USB drivers have been 
correctly installed. To do this, connect the G3 panel, and, if the drivers have not previously 
been installed, follow the instructions at the start of this manual. Then, open the Device 
Manager for your operating system, and expand the USB icon to show the icon for the G3 
Panel device. Ensure that this icon does not display a warning symbol. If it does, remove the 
device, unplug and reconnect the G3 panel, and verify that you have correctly followed the 
driver installation procedure. The illustrations below show typical Device Manager views 
with the CompactFlash dismounted and mounted, respectively…. 
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SETTING THE IP ADDRESS 

If you are using a TCP/IP connection, you should enter the IP address of the target device in 
the appropriate field in the dialog box. If you leave the IP address as 0.0.0.0, MonicoView 
will examine the currently loaded database to see if the panel’s address can be determined 
from the configuration information. This feature removes the need to change the IP addresses 
when switching between databases intended for different terminals. 

SENDING THE DATABASE 

Once the link is configured, the database can be downloaded using either the Link-Send or 
Link-Update commands. The former will send the entire database, whether or not individual 
objects within the file have changed. The latter will only send changes, and will typically take 
a much shorter period of time to complete. The Update command is typically the only one 
that you will need, as MonicoView will automatically fall-back to a complete send if the 
incremental download fails for any reason. As a shortcut, note that you can access Link 
Update via the lightning-bolt symbol on the toolbar, or via the F9 key on the PC. 

 

Note that downloading via TCP/IP relies on a CompactFlash card being installed in the panel 
if the device’s firmware is to be upgraded. Since you may want to perform such upgrades at 
some point in time, it is highly recommended that you install a CompactFlash card in any 
device to which TCP/IP downloads are likely to be performed. 

EXTRACTING DATABASES 

The Link-Support Upload command can be used to instruct MonicoView whether or not it 
should include the information necessary to support database upload when sending a database 
to a G3 panel. Supporting upload will slow the download process somewhat and may fail 
with extremely large databases containing many embedded images, but it will ensure that 
should you lose your database file, you will be able to extract an editable image from the 
terminal. 
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Note that if you lose your database file and you do not have upload support enabled, you will 
not be able to reconstruct your file without starting from scratch. To extract a database from a 
panel, use the Link-Extract command. This command will upload the database, and then 
prompt you for a name under which to save the file. The file will then be opened for editing. 

MOUNTING THE COMPACTFLASH 

If you are connected to a G3 panel via the USB port, you can instruct MonicoView to mount 
the G3’s CompactFlash card as a drive within Windows Explorer. You can use this 
functionality to save files to the card or to read information from the Data Logger. The drive 
is mounted and dismounted by sending commands using the Mount Flash and Dismount 
Flash options on the Link menu. Once a command has been sent, the G3 panel will be reset, 
and Windows will refresh the appropriate Explorer windows to show or hide the 
CompactFlash drive. 

 

Note that some caution is required when mounting the CompactFlash card... 

• When the card is mounted, the G3 will periodically inform the PC if data on the 
card has been modified. This means that both the PC and the G3 will suffer 
performance hits if the card is mounted during data logging operations for longer 
than necessary. 

• If you write to the CompactFlash card from your PC, the G3 will not be able to 
access the card until Windows releases its “lock” on the card’s contents. This 
may take up to a minute, and will restrict data logging operations during that 
time, and prevent access to custom web pages. MonicoView will use the G3’s 
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RAM to ensure that no data is lost, but if too many writes are performed such 
that the card is kept locked for four minutes or more, data may discarded. Note 
that Windows 98 is particularly bad at keeping the card locked when there is no 
need for it. Windows 2000 or Windows XP is thus the operating system of 
choice when using this feature. 

• You should never attempt to use Windows to format a CompactFlash card that 
you have mounted via the G3, whether it be via Explorer or from the command 
prompt. Windows does not correctly lock the card during format operations, and 
the format may thus be unreliable and lead to subsequent data loss. See below 
for details of how to format a card in a reliable manner. 

FORMATTING THE COMPACTFLASH 

The preferred method of formatting a card is via the Format Flash command on the Link 
menu. Selecting this command will explain that the formatting process will destroy all the 
data stored on the CompactFlash card and offer you a chance to cancel the operation. If you 
elect to continue, the operator panel will be instructed to format the card. Note that this 
process may take several minutes for a large card. Slow formats on panels that are performing 
data logging may therefore result in gaps in the recorded data. 

A less attractive method of formatting a card is via a dedicated CompactFlash drive connected 
to your PC. If you use this method, be sure to instruct Windows to format the card using 
FAT16. For very small or very large cards, Windows will most likely choose the wrong 
format by default. Worse still, some versions of Windows Explorer will not allow you to 
override the default format, forcing you to use the command line version FORMAT instead. 

SENDING THE TIME AND DATE 

The Link-Send Time command can be used to set the G3’s clock to match that of the PC on 
which MonicoView is executing. Obviously, make sure your clock is right before you do this! 

USING THE EMULATOR 

MonicoView.0 features an Emulator capable of reproducing some of the devices locally on a 
PC. This feature will only work on PCs with Windows® XP or 2000. The only supported 
devices are the graphical color G3 range of operator interfaces. The rest of the product line is 
not supported. 

The Emulator can be used to test not only the user interface portion of a database, but also the 
operation of the data logger and the web server. Note that data logger data is saved in the 
computer RAM memory and is therefore not available on the hard drive. This means the 
memory will be emptied every time the Emulator is stopped. The RAM will not behave like 
the G3 CompactFlash card and file functions will not work. 

Downloading to the Emulator will open a new window representing the G3 as shown. To 
download to the Emulator, the link has to be configured by checking “Send to the Emulator” 
in the Link Options or by activating that link via the tool bar button. 
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Emulator Toolbar button  

The database can be downloaded in the Emulator using either the Link-Send or Link-Update 
commands. 

 

UPDATING VIA COMPACTFLASH 

If you need to update the database within a unit that is already installed at a customer’s site, 
MonicoView allows you to save a copy of the database to a CompactFlash card, ship that card 
to your customer, and have the G3 load the database from that card. The process is performed 
via the Save Image command on the File menu. 

 

The Save Image command will create a MonicoView database image file with a CDI 
extension. It will also save a copy of the current G3 firmware to a file with a BIN extension. 
The image file must be given the name DBASE.CDI, and both it and the BIN file must be 
placed in the root directory of a CompactFlash card. To update a G3 panel, power down the 
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unit, insert the CompactFlash card bearing the two files, and reapply power to the unit. The 
G3’s boot loader will first check whether it needs to upgrade the unit’s firmware, and once 
this process has been completed, the MonicoView runtime application will load the database 
stored on the card. The CompactFlash card can then be removed or left in place as required. 

GURU MEDITATION CODES 

If a problem with the MonicoView runtime application within the G3 operator panel results in 
the panel being reset, the condition that caused the fault will be logged. When the panel 
restarts, this information will be displayed in the form of a Guru Meditation Code. A typical 
code will have the format… 

 03-2004-1BE4-205 

The message can be accepted by pressing the F1 key, at which point the terminal will resume 
normal operation. Note that communications, data logging and the web server are still active 
when the GMC is displayed—only the user interface is interrupted. This means that system 
disruption is minimized, and functions such as protocol conversion continue to operate. 

Before accepting the message, you may wish to write down the code. You may then email it 
to Monico technical support, so that one of our technical gurus can meditate on this 
information in order to track-down the cause of the problem. You may also want to email a 
copy of the terminal’s database, and describe what you were doing when the terminal crashed. 
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CONFIGURING COMMUNICATIONS 
The first stage of creating a MonicoView database is to configure the communications ports 
of the G3 panel to indicate which protocols you want to use, and which remote devices you 
want to access. These operations are performed from the Communications window, which is 
opened by selecting the first icon of the MonicoView main screen. 

 

As can be seen, the Communications window lists the unit’s available ports in the form of a 
tree structure. G3 panels have three primary serial ports, with the option to add a further two 
ports in the form of an expansion card. They also provide a single Ethernet port that is 
capable of running four communications protocols simultaneously. 

SERIAL PORT USAGE 

When deciding which of the G3’s serial ports to use for communications, note that… 

• The G303 multiplexes a single serial communications controller between its 
RS-232 and RS-485 comms ports. This means that if either port is used for a 
slave protocol, the other port is unavailable. It also means that if a token-passing 
protocol such as Allen-Bradley DH-485 is employed, the other port is similarly 
disabled. Other G3 panels impose no such restrictions. 

• The unit’s programming port may be used as an additional communications port, 
but it will obviously not be available for download if it is so employed. This is 
not an issue if the USB port is used for such purposes, and it is highly 
recommended that you use this method of download if you want to connect 
serial devices via the programming port. 
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SELECTING A PROTOCOL 

To select a protocol for a particular port, click on that port’s icon in the left-hand pane of the 
Communications window, and press the Edit button next to the Driver field in the right-hand 
pane. The following dialog box will appear… 

 

Select the appropriate manufacturer and driver, and press the OK button to close the dialog 
box. The port will then be configured to use the appropriate protocol, and a single device icon 
will be created in the left-hand pane. If you are configuring a serial port, the various Port 
Settings fields (Baud Rate, Data Bits, Stop Bits and Parity) will be set to values appropriate to 
the protocol in question. You should obviously check these settings to make sure that they 
correspond to the settings for the device to be addressed. 

PROTOCOL OPTIONS 

Some protocols require additional configuration of parameters specific to that protocol. These 
appear in the right-hand pane of the Communications window when the corresponding port 
icon is selected. The example below shows the additional parameters for the Allen-Bradley 
DH-485 driver, which appear under the Driver Settings section of the window. 
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WORKING WITH DEVICES 

As mentioned above, when a communications protocol is selected, a single device is created 
under the corresponding port icon. In the case of a master protocol, this represents the initial 
remote device to be addressed via the protocol. If the protocol supports access to more than 
one device, you can use the Add Additional Device button included with the port icon’s 
properties to add further target devices. Each device is represented via an icon in the left-hand 
pane of the Communications window, and, depending on the protocol in question, may have a 
number of properties to be configured… 

 

In the example above, the Modbus Universal Master protocol has been selected, and two 
additional devices have been created, indicating that a total of three remote devices are to be 
accessed. The right-hand pane of the window shows the properties of a single device. The 
Enable Device property is present for devices for all protocols, while the balance of the fields 
are specific to the protocol that has been selected. Note that the devices are given default 
names by MonicoView when they are created. These names may be changed by selecting the 
appropriate icon in the left-hand pane, and simply typing the new device name. 

ETHERNET CONFIGURATION 

The G3’s Ethernet port is configured via the Ethernet icon in the left-hand pane of the 
Communications window. When this icon is selected, the following settings are displayed… 
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IP PARAMETERS 

The Port Mode field controls whether or not the port is enabled, and the method by which the 
port is to obtain its IP configuration. If DHCP mode is selected, the G3 will attempt to obtain 
an IP address and associated parameters from a DHCP server on the local network. If the unit 
is configured to use slave protocols or to serve web pages, this option will only make sense if 
the DHCP server is configured to allocate a well-known IP address to the MAC address 
associated with the unit, as otherwise, users will not be sure how to address the panel! 

If the more common Manual Configuration mode is selected, the IP Address, Network Mask 
and Gateway fields must be filled out with the appropriate information. The default values 
provided for these fields will almost never be suitable for your application! Be sure to consult 
your network administrator when selecting appropriate values, and be sure to enter and 
download these values before connecting the G3 to your network. If you do not follow this 
advice, it is possible—although unlikely—that you will cause problems on your network. 

IP ROUTING 

The IP Routing option can be used to enable or disable the routing of IP packets between the 
Ethernet port and any PPP connections made to or by the panel. You should not enable this 
option unless you understand the implications of allowing such routing. Please refer to the 
Advanced Communications chapter for more information. 

PHYSICAL LAYER 

The Physical Layer options control the type of connection that the G3 will attempt to 
negotiate with the hub to which it is connected. Generally, these options can be left in their 
default states, but if you have trouble establishing a reliable connection, especially when 
connecting directly to a PC without an intervening hub or switch, consider turning off both 
Full Duplex and High Speed operation to see if this solves the problem. 

REMOTE UPDATE 

The Remote Update option is used to enable or disable firmware and configuration download 
via TCP/IP. As noted in an earlier section, remote firmware updates over TCP/IP require the 
units to be fitted with a CompactFlash card. Since downloads will more than likely involve a 
firmware update at some point, such a card is highly recommended when using this feature. 

PROTOCOL SELECTION 

Once the Ethernet port has been configured, you can select the protocols that you wish to use 
for communications. Up to four protocols may be used at once, and many of these protocols 
will support multiple remote devices. This means that you have several options when 
deciding how to mix protocols and devices to achieve the results you want. 
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For example, suppose you want to connect to two remote slave devices using Modbus over 
TCP/IP. Your first option is to use two of the Ethernet port’s protocols, and configure both as 
Modbus TCP/IP Masters, with a single device attached to each protocol... 

 

For most protocols, this will produce higher performance, as it will allow simultaneous 
communications with the two devices. It will, however, consume two of the four protocols, 
limiting your ability to connect via additional protocols in complex applications. Your second 
option is therefore to use a single protocol configured as a Modbus TCP/IP Master, but to add 
a further device so that both slaves are accessed via the same driver… 

 

This will typically produce slightly reduced performance, as MonicoView will poll each 
device in turn, rather than talking to both devices at the same time. It will, however, conserve 
Ethernet protocols, allowing more complex applications without running out of resources. 

SLAVE PROTOCOLS 

For master protocols (ie. those where the G3 initiates communication) there is no further 
configuration required under the Communications icon. For slave protocols (ie. those where 
the G3 receives and responds to remote requests), however, the process is slightly more 
complex, as you must also indicate what data you wish to expose for remote access. 
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SELECTING THE PROTOCOL 

As with master protocols, the first stage is to select the protocol for the communications port 
that you wish to use. The example below shows the G3’s RS-232 port configured for 
operation with the Modbus ASCII Slave protocol… 

 

Note that a single device has been automatically created for the protocol. In the case of master 
protocols, this represents the remote device that the G3 will access. In this case, though, the 
device represents the Modbus slave that the G3 will itself embody. This means that only a 
single device is required, and that things such as the station number to which the G3 will 
respond are normally configured via the port settings rather than those of the device. 

ADDING GATEWAY BLOCKS 

Having configured the protocol, you must now decide what range of addresses you want the 
slave protocol to expose. In this example, we want to use Modbus registers 40001 through 
40008 to allow read and write access to certain data items in our database. We begin by 
selecting the device icon in the left-hand pane of the Communications window, and clicking 
the Add Gateway Block button in the right-hand pane. An icon to represent Block 1 will 
appear, and selecting it will show the following settings… 

 

In the example above, we have configured the Start Address to 40001 to indicate that this is 
where we want the block to begin. We have also configured the Block Size to eight so as to 
allocate one Modbus register for each tag we want to expose. Finally, we have configured the 
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Direction as Device to G3, to indicate that we want remote devices to be able to read and 
write data items exposed via this block. 

ADDING ITEMS TO A BLOCK 

Once the block has been created and its size defined, entries appear in the left-hand pane of 
the window to represent each of the registers that the block exposes to remote access. When 
one of these entries is selected, the right-hand pane shows a list of available data items, 
comprising both tags from within your database, and data registers from any master 
communications devices that you have configured… 

 

To indicate that you want a particular register within your gateway block to correspond to a 
particular data item, simply drag that item from the right-hand pane to the left-hand pane, 
dropping it on the appropriate gateway block entry. The example above shows how the first 
four registers in the block have been mapped to tags called Tank1 through Tank4, indicating 
that accesses to 40001 through 40004 should be mapped to the respective variables. 

ACCESSING INDIVIDUAL BITS 

 

If your application requires it, you can expand individual elements within a Gateway Block to 
their constituent bits, and map a different data item to each bit. To do this, right-click on the 
element in question, and select Expand from the resulting pop-up menu. The right-hand pane 
will be updated to show the individual bits that make up the register, and these can be mapped 
using the drag-and-drop process described above. 
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PROTOCOL CONVERSION 

In addition to exposing internal data tags via slave protocols, Gateway Blocks can also be 
used to expose data that is obtained from other remote devices, or to move data between two 
such master devices. This unique protocol conversion feature allows much tighter integration 
between elements of your control system, even when using simple, low-cost devices. 

MASTER AND SLAVE 

 

Exposing data from other devices over a slave protocol is simply an extension of the mapping 
process described above, except this time, instead of dragging a tag from the right-hand pane, 
you should expand the appropriate master device, and drag across the icon that represents the 
registers that you want to expose. You will then be asked for a start address in the master 
device, and the number of registers to map, and the mappings will be created as shown. 

In this example, registers N7:0 through N7:7 in an Allen-Bradley controller have been 
exposed for access via Modbus TCP/IP as registers 40001 through 40008. MonicoView will 
automatically ensure that these data items are read from the Allen-Bradley PLC so as to fulfill 
Modbus requests, and will automatically convert writes to the Modbus registers into writes to 
the PLC. This mechanism allows even simple PLCs to be connected on an Ethernet network. 

MASTER AND MASTER 

 

To move data between two master devices, simply select one of the devices, and create a 
Gateway Block for that device. You can then add references to the other device’s registers 
just as you would when exposing data on a slave protocol. Again, C2 will automatically read 



CONFIGURING COMMUNICATIONS DATA TRANSFORMATION 

REVISION 12 PAGE 31 

or write the data as required, transparently moving data between the devices. The example 
above shows how to move data from a Mitsubishi FX into an SLC-500. 

WHICH WAY AROUND? 

One question that may occur to you is whether you should create the Gateway Block within 
the Allen-Bradley device, as in this example, or within the Mitsubishi device. The first thing 
to note is that there is no need to create more than a single block to perform transfers in a 
single direction. If you create a block in AB to read from MITFX, and a block in MITFX to 
write to AB, you’ll simply perform the transfer twice and slow everything down! The second 
observation is that the decision as to which device should “own” the Gateway Block is 
essentially arbitrary. In general, you should create your blocks so as to minimize the number 
of blocks in the database. This means that if the registers in the Allen-Bradley lay within a 
single range, but the registers in the Mitsubishi are scattered all over the PLC, the Gateway 
Block should be created within the Allen-Bradley device so as to remove the need to create 
multiple blocks to access the different ranges of the Mitsubishi device. 

DATA TRANSFORMATION 

You may also use Gateway Blocks to perform math operations that your PLC might not 
otherwise be able to handle. For example, you may want to read a register from the PLC, 
scale it, take the square root, and write it back to another PLC register. To accomplish this, 
refer to the section on Data Tags, and create a mapped variable to represent the input value 
that will be read from the device. Then, create a formula to represent the output value, setting 
the expression so as to perform the required math. You can then create a Gateway Block 
targeted at the required output register, and drag the formula across to instruct MonicoView 
to write the derived value back to the PLC. 

NOTES FOR EDICT USERS 

Users of Monico’s Edict-97 operator interface configuration software will by this point no 
doubt be wondering what happened to the Communications Blocks that they know and love 
so well. The answer is simple: MonicoView manages communications blocks automatically, 
and only reads and writes the data that is needed to satisfy the requirements of the system at 
that time. This means that if a register is only accessed on a given page, it will only be read 
when that page is selected. The communications process is thus automatically optimized. 

Other communications differences between Edict-97 and MonicoView are… 

• Slave protocols are no longer handled via Communications Blocks, but by 
mapping data items into Gateway Blocks. This means that the same data item 
can be exposed via multiple slave protocols without any further configuration. 

• Writes in MonicoView are transaction-based rather than value-based. This 
means that if you write a register to 1 and then to 0, you are guaranteed that two 
writes will be performed. This avoids the need for Pulse Blocks and other 
horribleness. 
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• Rather than using the comms update complete event to move values from one 
device to another, or to transform values and write them back to the source 
device, MonicoView uses Gateway Blocks as described above. 

• MonicoView’s communications architecture operates at much higher 
performance levels than that of Edict-97. It uses multiple tasks and much greater 
amounts of buffering to ensure that communications updates are kept to a 
minimum. 
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ADVANCED COMMUNICATIONS 
This chapter explains how to use some of the more advanced communications features that 
are supported by MonicoView. Simple applications may not require these features, and you 
may thus choose to skip this chapter and return to it later. 

USING EXPANSION CARDS 

Each G3 panel is capable of hosting an expansion card to provide additional communications 
facilities. Currently available cards offer additional serial ports and CANOpen support. More 
cards will be made available as the G3 range is expanded. Hardware installation instructions 
are provided with each card, so please refer to the supplied data sheet for information on how 
to fit the card to the panel. Once the card is installed, configuration is performed by selecting 
the G3 icon in the left-hand pane of the Communications window, and clicking on the Edit 
button next to the Option Card property… 

 

Selecting the appropriate card will add an icon to tree shown in the left-hand pane of the 
window. This icon will in turn contain icons for the additional port or ports that are made 
available by the card. The example below shows a G3 with a serial expansion card installed… 

 

The additional ports can be configured by following the instructions supplied in the previous 
chapter. Note that the drivers available for a port will depend on the connection type it 
supports. For example, the CANOpen expansion card shows a port that will only support 
drivers designed for the CAN communication standard. 
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SHARING SERIAL PORTS 

All G3 operator panels provide a so-called “port sharing” facility that allows either physical 
or virtual serial connections to be made to any device connected to the HMI. For example, 
you may be using the HMI with a small programmable controller, but since the PLC has only 
a single serial port, you may find yourself continually swapping cables when modifying the 
PLC’s ladder program. By sharing the operator panel’s communications port, you can send 
data directly to the PLC, either from another serial port on the HMI or by means of a virtual 
serial connection made over an Ethernet link. 

ENABLING TCP/IP 

The first configuration step when using port sharing is to enable the panels Ethernet port as 
described in the previous chapter. While you may not choose to use the virtual serial port 
facility, even the local sharing of ports is based upon the TCP/IP protocol, which will not be 
available unless Ethernet is enabled. To enable Ethernet, select the Ethernet icon in the 
Communications window, and select the required configuration mode. For installations where 
Ethernet is not actually being used, you can select Manual Configuration and leave the rest of 
the options at their defaults. 

SHARING THE REQUIRED PORT 

The next step is to share the required port, which is done by selecting Yes in the Share Port 
property and by optionally entering a suitable TCP/IP port number. This number represents 
the virtual port that will be used to expose the serial port for access via TCP/IP. 

  

If you leave the port setting at zero, a number of 4000 plus the logical index of the port will 
be used. (To obtain the logical index of the port, count the port’s position in the list, noting 
that the programming port is always logical port 1.) You may use any number that is not 
already used by another TCP/IP protocol. If you are stuck for ideas, we recommend numbers 
between 4000 and 4099. 

CONNECTING VIA ANOTHER PORT 

If you want to use another port on the HMI to route data to the shared port, you must select 
the Generic Program Thru driver for that port, and configure this driver with the TCP/IP port 
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number of the serial port that you have shared. In the example below, we are routing data 
from the programming port to a PLC that is connected via the RS-232 comms port… 

  

Note that the Baud rate and other port settings do not have to be the same as those for the port 
which we are sharing, unless the unit being programmed is a PAX meter. In that case, the 
PAX and the G3 port MUST be set for 9600 8 N 1. In the configuration shown above, data to 
and from the programming software is sent at a higher Baud rate than the data to and from the 
PLC, with the G3 doing the appropriate buffering and conversion. 

In this example, to make use of the shared port you would connect a spare serial port on your 
PC to the programming port of the G3, and configure the PLC programming software to talk 
to this COM port. As soon as the PC begins to talk to the PLC, communications between the 
G3 and the PLC will be suspended, and the G3’s two ports will be “connected” in software, 
such that the PC will appear to be talking directly to the PLC. If no data is transferred for 
more than a minute, communications between the G3 and the PLC will be resumed. 

CONNECTING VIA ETHERNET 

Rather than using an additional serial port on your PC and on the HMI, it is possible to use a 
third-party utility to create what are known as virtual serial ports on your computer. These 
appear to applications to be physical COM ports, but in fact, they send and receive data to a 
remote device over TCP/IP. By installing one of these utilities and configuring it to address 
the G3 HMI, you can have serial access to any devices connected to the HMI without any 
additional cabling. Indeed, there is no need to have any physical serial ports available on the 
PC at all—something that is very valuable when working with modern laptops, where a COM 
port is often an expensive option. 

Several third-party virtual serial port utilities are available. On the freeware side, a company 
called HW Group (http://www.hw-group.com) provides a utility called HW Virtual Serial 
Port. There are also a number of other freeware port drivers available, most of which seem to 
be derived from the same source base. On the commercial side, a company called Tactical 
Software (http://www.tacticalsoftware.com) offers Serial/IP for about $100 a port. 

While the various freeware drivers no doubt have many contented users, we have found that 
these drivers have occasional stability problems on certain PCs. Tactical Software’s Serial/IP 

http://www.tacticalsoftware.com/�
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is thus the only package that we are able to support, and the following information assumes 
that you are using this package. 

To create a virtual serial port, open Serial/IP’s configuration screen, and select the name of 
the COM port you wish to define. This will typically be the first free COM port after those 
allocated to the physical ports and modems installed in your PC. Next, enter the IP address of 
the G3, and enter the TCP/IP port number that you allocated when sharing the port. The 
example below is configured as required by the previous samples in this document. Finally, 
ensure Raw TCP Connection is selected, and close the Serial/IP dialog. 

 

You will now be able to configure any Windows-based software to use the newly-created 
COM port for download. When the software opens the connection, the G3 will suspend 
communications on the shared port, and then data will be exchanged between the PC software 
and the remote PLC—just as if they were connected directly! When the port is closed, or if no 
data is transferred for a minute, communications will be resumed. 

Note that assuming you’ve purchased the appropriate number of licenses for Serial/IP, you 
will be able to create as many virtual ports as you need. This means that you can be connected 
to multiple devices from the same PC, downloading to each via its respective programming 
package—all without plugging or unplugging a single cable. This feature is extremely 
valuable when you have many devices in a complex system. 

PURE VIRTUAL PORTS 

In some circumstances, you may want to use a spare serial port on a G3 to provide access to a 
remote device that is not otherwise connected to the HMI. Or you might want to use such a 
port to connect to a dedicated programming port on a device, even though the G3 is using 
another port to perform communications with that device. For example, if you have a Monico 
Modular Controller connected to a G3, you will typically communicate using Ethernet or via 
the Modular Controller’s RS-232 port. If you wish to use port sharing to remotely reconfigure 
the Modular Controller, you may wish to connect the device’s programming port to a spare 
RS-232 port on the G3 so that you may then share this port via TCP/IP. To do this, configure 
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the port in the usual way, selecting the Virtual Serial Port driver for that port. Then, share the 
port as described above. This Virtual Serial Port driver performs no communications activity 
of its own, but still allows the device to be shared for remote access. 

LIMITATIONS 

Note that some PLC programming packages may not work with virtually or physically shared 
ports. Issues to watch out for are tight timeouts that do not allow the G3 time to relay the data 
to the PLC; a reliance on sending break signals or on the manipulation of hardware 
handshaking lines; or DOS-style port access such that the package cannot “see” the virtual 
serial ports. Luckily, these issues are rare, and most packages will happily communicate as if 
they were directly connected to the PLC in question. [TBA] 

USING ELECTRONIC MAIL 

MonicoView can be configured to send email messages when alarm conditions are present, or 
when notifications needs to be provided of other events within the system. The methods to be 
used to deliver email are configured via the Mail icon in the Communications window… 

 

The properties on a General tab are used to enable or disable mail manager, and to provide a 
name for the operator panel. This name will be used within email messages to identify the 
originator of the message. Applications will typically use the name of the machine to which 
the G3 is attached, or the name of the site that it is monitoring. 

CONFIGURING SMTP 

The SMTP tab is used to configure the Simple Mail Transport Protocol. This is the standard 
protocol used to send email over the Internet or over other TCP/IP networks. SMTP addresses 
follow the familiar name@domain standard. 
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The configuration options for the SMTP transport are shown below… 

 

• The Transport Mode property is used to enable or disable the transport. Note that 
the mail manager must be enabled via the General tab before the SMTP transport 
can be enabled. Note also that either SMTP or SMS must be enabled if the mail 
manager is to be able to deliver messages. 

• The Server Selection property is used to define how the transport will locate an 
SMTP server. If Manual Selection is used, the Server IP Address property should 
be used to manual designate a server. If Configured via DHCP is selected, the 
unit’s Ethernet port must be configured to use DHCP, and the network’s DHCP 
server must be configured to designate an SMTP server via option 69. 

• The Server IP Address property is used to designate an SMTP server when 
manual server selection is enabled. The server must be configured to accept mail 
from the panel, and to relay messages if required by the application. 

• The Server Port Number property is used to define the TCP port number that 
will be used for SMTP sessions. The default value is 25. This value will be 
suitable for most applications, and will only need to be adjusted if the SMTP 
server has been reconfigured to use another port. 

• The Domain Name property is used to specify the domain name that will be 
passed to the SMTP server in the HELO command. The vast majority of SMTP 
servers ignore this string. In the unlikely event that your SMTP server attempts 
to do a DNS lookup to confirm the identity of its client, you may need to enter 
something appropriate to your DNS configuration. 

• The Reverse Path property is used to specify the email address that will be 
supplied as the originator of the messages sent by the operator panel. The 
property comprises a display name, and an email address. Since the panel is not 
capable of receiving messages, the email address will often be set to something 
that will return an “undeliverable” message if a reply is sent. 
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• The Record Log File property can be enabled to keep a log of all SMTP 
interactions in the root directory of the CompactFlash card. This file can be 
useful when debugging SMTP operations, but it will tend to degrade 
performance slightly. 

• The Initial Timeout property is used to specify how long the mail client will wait 
for the SMTP server to sent its welcome banner. Some Microsoft servers attempt 
to negotiate Microsoft-specific authentication with mail clients, thereby delaying 
the point at which the banner appears. You may want to extend this time period 
to 2 minutes or more when working with such servers. 

CONFIGURING SMS 

The SMS tab is used to configure the Short Messaging Service. This transport is used to send 
text messages to cell phones via a GSM modem. Email addresses for SMS comprise an 
international format telephone number, minus the introductory plus-sign. An example address 
in the United States would be 17175551234, while an example in the UK would be 
441246555555. In each case, the address comprises the country code, followed by the area 
code and the subscriber number. 

The configuration options for SMS are shown below… 

 

• The Transport Mode property is used to enable or disable the transport. Note that 
the mail manager must be enabled via the General tab before the SMS transport 
can be enabled. Note also that either SMTP or SMS must be enabled if the mail 
manager is to be able to deliver messages. 

• The Message Relay property is used to enable or disable the panel’s SMS relay 
feature. If this feature is enabled, a user who receives an SMS message that has 
been sent to several recipients can reply to that message, and have the operator 
panel relay the message to the other recipients. This provides a simple 
conferencing facility between message recipients. 
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Note that for the SMS transport to operate, a GSM modem must have been installed on one of 
the unit’s serial ports. Refer to later sections of this chapter for details on how to configure 
such a modem, and on multiple modems will interact. 

THE ADDRESS BOOK 

The Addresses tab is used to define email recipients… 

 

An unlimited number of address book entries can be added, edited or deleted using the 
buttons in the right-hand pane. Each entry can refer to one or more email recipients from any 
of the transports enabled by the database. Recipients for multiple transports can be included 
in the same entry. The dialog used to define the properties of each recipient is shown below… 

 

• The Display Name property is used to define the human-readable name of the 
address book entry. This is the name that will be used for the display name of the 
SMTP recipients, and choosing an address book entry within MonicoView. 

• The Email Address property is used to define one or more recipients for this 
address book entry. Multiple recipients should be separated by semicolons. The 
format of each recipient will depend on the transport that is expected to deliver 
the message. In the example above, the address book entry refers to one SMTP 
recipient and one SMS recipient. The address can be mapped to a string tag so it 
could be changed from the display. 

WORKING WITH MODEMS 

This section explains how to configure your G3 panel to work either with modems, or with 
direct serial connections to computers running the Windows operating system. Note that 
MonicoView’s modem support is fundamentally different from that provided by earlier 
Monico operator panels, in that it is entirely based upon the Point-To-Point Protocol, 
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otherwise known as PPP. While protocols such a Modbus allow a single conversation to 
occur between any two devices, PPP is more akin to an Ethernet connection in that it allows 
an unlimited number of logical connections to exist on a single physical link. A single PPP 
connection can thus allow simultaneous access to the panel’s TCP/IP download facility, its 
web server, its shared serial ports, and to any TCP/IP protocols that have been selected via the 
Communications window. 

SOME TYPICAL APPLICATIONS 

The sections below list some typical applications of modem technology… 

• You want an operator panel in a remote location to send an email to a service 
engineer to inform him of a fault condition. By configuring an on-demand 
connection to an Internet Service Provider, the panel is instructed to 
automatically connect when an email is to be sent, and then to hang-up when the 
message has been transferred. 

• You want an operator panel in a remote location to send messages directly to the 
cell phones of a group of service engineers to inform them of a fault condition. 
By configuring a GSM modem with SMS support, the panel is instructed to 
notify the engineers of the fault by means of short text messages. Further, when a 
given engineer replies to the message to indicate that he will deal with the 
problem, the G3 can optionally forward the reply to all the other engineers, 
letting them know that someone has taken ownership of the issue. 

• An operator panel in a remote location is configured to accept incoming 
connections from a PC based at a central office. Once the connection is made, 
the panel’s database can be remotely upgraded by instructing the MonicoView 
configuration to download via the TCP/IP link. If so configured, the panel’s web 
server can be accessed so as to provide remote control facilities. Best of all, by 
installing virtual serial port software on the PC and by enabling port sharing on 
the G3, a PLC programming package can be used to download to the 
programmable controller connected to the operator panel—with the software 
‘thinking’ it is talking over a standard COM port! 

• An operator panel in a remote location is configured to accept incoming 
connections from a SCADA system located in a central office. The SCADA 
package can use Modbus TCP/IP to access gateway blocks within the panel, 
thereby reading and writing data collected from devices connected to the G3’s 
serial ports. The SCADA package can also make direct contact with devices 
connected to the panel by means of the G3’s IP routing capability. 

There are obviously many other applications beyond these few examples. 

ADDING A DIAL-IN CONNECTION 

To add a dial-in connection to your database, open the Communications window and select 
the serial port to which the connection will be made. Click on the Edit button of Driver field 
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in the right-hand pane, and select the PPP and Modem Server driver from the System section 
of the selection dialog… 

 

The right-hand pane will now show the modem configuration… 

 

The modem has the following configuration options… 

• The Connect Using property is used to select the physical device to be used to 
make the connection. The devices supported at this time are direct serial 
connections to computers running the Microsoft Windows operating system, 
generic landline modems which implement the Hayes command set, and the 
Telit GM-862 GSM mode. For dial-in connections, the Telit device must be 
configured in Circuit Switched Data mode. 

• The Activity Timeout property is used to define how long a period must pass 
without the G3 sending a packet over the PPP link in order for the connection to 
be terminated. For dial-in connections, it is assumed that the connecting device is 
friendly, so no effort will be made to filter out optional packets that might result 
in the link staying active for long periods. Note that even if you want a 
permanent connection, you must enter a suitable timeout so as to allow the 
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detection of dead links. This implies that so-called permanent connections may 
still drop on occasions, but since the client will immediately reestablish the link, 
this is not an issue. 

• The Additional Init string is used with non-direct links, and provides a series of 
AT commands to be used to initialize the modem. The initial AT prefix is not 
required. Several commands may be combined by simply placing one after the 
other. The exact string that will be required for your modem is dependent upon 
its internal software, so if you contact Technical Support for assistance, be sure 
to have exact make and model information available. 

• The SMS Support property is used to enable Short Message Service messaging 
when using a GSM modem. In order for SMS messaging to operate properly, 
you will also have to enable the SMS Transport using the Mail icon in the 
Communications window as described above. 

• The Logon Username and Logon Password properties are used to define the 
credentials that the remote client must provide in order to be allowed to connect 
to this device. The username is not case sensitive, while the password is. 
MonicoView’s PPP implementation will ask its peer to use CHAP authentication 
to avoid transmitting or receiving plaintext password, but will fallback to using 
PAP if the remote client does not support CHAP. 

• The Local Address property is used to define the IP address to be allocated to the 
local end of the connection. This will thus be the IP address of the G3 for this 
link. Please note that this must not be the same as the IP address of the G3’s 
Ethernet port, as every physical IP interface must have a distinct IP address. The 
default value will work in most situations, unless your network design demands 
that you use a different setting. 

• The Remote Address property is used to define the IP address to be allocated to 
the remote end of the connection. It is used together with the Remote Mask 
property to determine what packets will be routed to this connection. For most 
applications, a mask of 255.255.255.255 will be used, thereby instructing 
MonicoView to send via this interface only those packets directly bound for the 
remote client. A mask of 0.0.0.0, by contrast, will allow all packets that do not 
specifically match another interface to be forwarded to the remote client, 
presumably for further forwarding to the intended host. Intermediate masks may 
be used to control exactly which packets are sent. 
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ADDING A DIAL-OUT CONNECTION 

Dial-out connections are added exactly as above, except that the PPP and Modem Client 
driver should be selected for the required port. The configuration options for this modem are 
shown below… 

 

The modem has the following properties that are distinct from those for dial-in connections… 

• The Connect Using property is as for dial-in connections, with the addition of 
support for GPRS connections via a GSM modem. These connections differ 
from CSD connections in that they achieve much higher speeds, and are 
typically charged on the basis of how much data is transferred rather than how 
long the connection is maintained. GPRS connections may thus be configured 
for permanent connection, unless there is a need to provide downtime to allow 
SMS messages to be transferred. 

• The No Firewall property is used to turn off the firewall protection that is 
otherwise provided for dial-out connections. This protection prevents incoming 
connections from being made to this interface, and prevents the G3 from sending 
certain diagnostic packets that might either provide a hacker with information 
about the system, or might be used by an attacker to keep a connection active in 
the absence of actual data transfer. If you are connecting directly to the Internet 
by means of this connection, you should not normally turn off the firewall. The 
firewall should be disabled only for connections to corporate networks or to 
other controlled environments. 

• The Connection Type property is used to indicate whether you want this 
connection to be permanently maintained, or whether you want it to be 
established automatically when an attempt is made to transfer data to hosts that 
are reachable via this interface. If you select an on-demand connection, you must 
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specify the timeout after which the link will be terminated if no packets have 
been transmitted by the G3. 

• The Logon Username and Logon Password properties are used to define the 
credentials that will be passed to the remote server when attempting to initialize 
this connection. The username is not case sensitive, while the password is. 
MonicoView’s PPP implementation will ask its peer to use CHAP authentication 
to avoid transmitting or receiving plaintext password, but will fallback to using 
PAP if the remote server does not support CHAP. 

• The Route Type property is used to define the data that will be transferred via 
this interface. For on-demand connections, this effectively defines when the 
connection will be activated. If Default Gateway is selected, any packets that do 
not match the address and netmask of the Ethernet connection will be sent to this 
interface. Note that in this mode, the Ethernet port must have a gateway setting 
of 0.0.0.0, or it will take all the packets and leave none to activate the modem! If 
Specific Network is selected, you must provide the address and netmask that 
defines the network to which packets will be routed. 

ADDING AN SMS CONNECTION 

SMS connections are used when text messaging functionality is required, but where neither 
dial-in nor dial-out PPP connections will be established. They are configured as described 
above, except that the SMS via GSM Modem device should be selected for the required port. 
The configuration options for this modem are shown below… 

 

The device properties are a subset of those provided for dial-in connections. SMS support is 
always enabled with this driver, but once again, note that in order for SMS messaging to 
operate properly, you will also have to enable the SMS Transport using the Mail icon in the 
Communications window. 
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SMS MESSAGE PROCESSING 

When SMS messaging is enabled, the G3 will instruct the GSM modem to check for new 
incoming or outgoing messages every five seconds. Incoming messages are forwarded to the 
mail manager, which will optionally forward them to other users according to its 
configuration. Note that it is not possible to check for messages while the modem is 
connected to a CSD or GPRS session, so you will want to avoid using permanent connections 
when working with SMS. Note also that if more than one GSM modem is configured, all will 
be able to receive messages, but only the second modem will be used for sending. 

USING MULTIPLE INTERFACES 

Each G3 panel can support up to two modem independent connections. When combined with 
the Ethernet port, this gives a total of up to three distinct IP interfaces, all of which will 
operate according to the configuration parameters defined for each connection. This section 
describes how these multiple interfaces will interact, and how the G3 will decide where to 
send each packet of data. 

INTERFACE SELECTION 

Each interface has an IP address and a network mask, which are used to decide whether to 
forward packets to that interface. For example, if the Ethernet interface is configured with an 
IP address of 192.168.1.0 and a network mask of 255.255.255.0, any packets for IP addresses 
starting with 192.168.1 will be sent to this interface. Likewise, if an on-demand modem 
connection has a remote IP address of 192.168.2.2 and a netmask of 255.255.255.255, 
sending a packet to address 192.168.2.2 will result in the connection being established. 

DEFAULT ROUTE 

In addition, one single interface may also define a default route, which will be used to handle 
packets that do not specifically match any other interface. The method used to configure the 
route varies according to the interface type, as shown in the table below… 

INTERFACE TO DEFINE DEFAULT ROUTE 

Ethernet Enter a non-zero value for the Gateway property. 

Dial-In Enter 0.0.0.0 for the Remote Mask. 

Dial-Out Select Default Gateway for the Route Type property 
 

Note again that only a single interface may define a default route. For example, a G3 panel 
may be connected to a number of Ethernet devices using an IP address of 192.168.1.0 and a 
netmask of 255.255.255.0, with no gateway defined. An on-demand modem connection may 
be configured to access an Internet Service Provider so as to send alarm emails. Its Route 
Type is set to Default Gateway, making it the route for any packets for IP addresses that do 
not match the network defined for the Ethernet port. The SMTP server is configured as 
24.104.0.39, resulting in a dial-out connection when an attempt is made to send a message. 
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IP ROUTING 

The Ethernet icon in the Communications window contains a property called IP Routing. If 
this facility is enabled, incoming packets from non-firewalled modem interfaces will be 
compared against the IP address and netmask for the Ethernet interface, and will be 
forwarded to that interface should a match occur. This facility is most often used with dial-in 
connections, and allows IP access to all devices connected to the Ethernet port, provided a 
suitable route is defined by the client. 

CHECKING THE MODEM STATUS 

In order to help debug modem connections, MonicoView provides the GetInterfaceStatus 
function. This function takes a single argument, which is the numeric index of the required 
interface. Interface zero is always the panel’s loopback interface. Next comes the Ethernet 
interface, if it is enabled, such that the first PPP interface is numbered 1 when Ethernet is 
disabled and 2 when it is enabled. 

The function returns a string, which can be interpreted according to the following table… 

STATUS MEANING 

CLOSED The interface has not yet been initialized. This state will 
only occur for a short time during system start-up. 

INIT The modem is being initialized. If the connection 
remains in this state, there are probably errors in the init 
strings being sent to the modem. 

IDLE The link is idle. GSM modems will return a number at 
the end of the string to indicate signal strength. The next 
table explains how to interpret these values. 

SMS The modem is sending SMS messages, or polling the 
modem to see if new SMS message are available. If SMS 
messaging is enabled for a modem, you will see this state 
appear for a short period every five seconds. 

CONNECTING The modem is establishing a connection. This state 
typically appears only for client connections, and 
indicates that a call is being placed. 

LISTENING The modem is waiting for a call. This state appears only 
for server connections. Note that GSM modems will also 
return an IDLE state while waiting for a call in order to 
show signal strength. 

ANSWER The modem is answering a call and trying to negotiate 
the Baud rate for the connection. This state appears only 
for server connections. If the connection is established, 
the modem will enter the CONNECTED state. 
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STATUS MEANING 

CONNECTED The modem has established a connection. This state will 
persist for only a short time, as the LCP negotiation 
process will begin after a small delay. 

NEG LCP The connection is negotiating LCP options. This process 
decides on a set of link protocol settings that are 
acceptable to both the client and the server. 

AUTH The connection is performing the authentication process 
to ensure that the appropriate user credentials are used. 

NEG IPCP The connection is negotiating IPCP options. This process 
decides on a set of network protocol settings that are 
acceptable to both the client and the server. 

UP The connection is active and IP data can be exchanged. 

HANGING UP The modem is disconnecting. This state will exist for 
only a short time before the modem returns to IDLE. 

 

The signal strength values returned by GSM modems have the following meaning… 

VALUE SIGNAL STRENGTH 

0 –113dBm or less. 

1 –111dBm. 

2-30 –109dBm to –52dBm in 2dBm steps. 

31 –51dBm or greater. 

99 Signal strength cannot be determined. 
 

Cell phones typically interpret these values as follows when displaying signal strength… 

VALUE STRENGTH NUMBER OF BARS 

5 or less. –103dBm or less. One 

6 thru 9. –101dBm thru –95dBm Two 

10 thru 14. –93dBm thru –85dBm Three 

15 or greater. –83dBm or greater. Four 
 

MODEM INITIALIZATION SEQUENCE 

The interface needs the following settings configured in the modem: 

• No echo 

• Verbal result codes 

• Normal carrier detect operation 

• DTR override 
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• No Flow Control 

• Modem must ignore RTS 

• DSR override, always on 

• Auto answer disabled 

• Escape character set to 43 decimal 

• 500 millisecond guard time for the escape code sequence (+++) 

The following sequence shows the init strings send to modems: 

AT COMMAND STRING DESCRIPTION 

AT&FE0 &F - set factory defaults (same as &F0) 

E0 - disable echo 

ATH0Q0V1 

 

H0 - Hang Up 

Q0 - Displays result codes 

V1 - Verbal codes 

ATL1M1X3 

 

L1 - Low speaker volume 

M1 - Speaker on until connect 

X3 - Sets result codes 

AT&C1&D0&H0&I0&R1&S0 &C1 - Normal CD operations 

&D0 - DTR override 

&H0 - Flow control disabled 

&I0 - software flow control disabled 

&R1 - Modem ignores RTS 

&S0 - DSR override; always on 

This string can be modified within C2 

ATS0=0S2=43S12=25 S0=0 - auto-answer disabled 

S2=43 - set Escape Character to 43 decimal 

S12=25 - Sets the duration, in fiftieths of a second, of 
the guard time for the escape code sequence (+++) 

 

TROUBLESHOOTING MODEM COMMUNICATION 

The PPP and Modem Client and PPP and Modem Server protocols provide a Log File 
property to log communication exchange with the modem to a file on the CompactFlash card. 
This file is used for debugging purpose during initial modem setup. Be sure to disable this 
feature once the correct modem configuration sequence has been established. 
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The codes in the table below are modem replies recorded in the file. 

CODE IN LOG FILE DESCRIPTION 

codeOK 0 

codeConnect     1 

codeRing          2 

codeNoCarrier     3 

codeError         4 

codeNoDialTone    6 

codeBusy          7 

codeNoAnswer      8 

codeClient        12 

codeServer 13 

codeExtended 14 

codePrompt 15 

codeEcho 16 

codeNone          99 

 

OPC COMMUNICATION 

MonicoView’s OPC support provides two different features. First, with the combination of 
Monico’s software OPCWorx, OPC becomes a standard and user-friendly communication 
tool to exchange data with SCADA packages. Second, OPC can be used as a data exchange 
protocol between Monico Controls products such as G3s, Modular Controllers and Data 
Station Plus series. The protocol is tag based, allowing units to exchange tag values 
seamlessly, thus avoiding complex programming. 

Note: OPC communication can only be used other Ethernet. Please make sure the Ethernet 
port is active. 

OPC SERVER SETTINGS 

Once the OPC Server is enabled, clients are able to access the unit’s tags. The connection to 
the server is done via the TCP port setup. TCP port 790 is suitable for most applications. The 
Session Limit indicates the maximum number of clients connecting simultaneously on this 
server. The maximum possible is four. 
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The Security properties are used to restrict OPC server access to hosts whose IP address 
matches the mask and data indicated. All access may be restricted, or the filter may be used to 
restrict only attempts to write data in the server. The filter works in the following way: 

Permitted IP Data: 192.168.100.1 

Permitted IP Mask: 255.255.255.0 

Range of IP authorized = Permitted IP Data & Permitted IP Mask 

Range of IP authorized = 192.168.100.X. 

This means any PC with IP addresses starting with 192.168.100 is allowed to access the 
server or write data. 

IP filter may be defeated by certain advanced hacking techniques, and is not warranted by 
Monico Controls. 

OPC AND SCADA 

SCADA packages can access OPC data available in the operator interface using Monico 
Controls software OPCWorx. This software is the OPC Server identified by the SCADA 
package permitting access to the operator interface data tags. It can run either locally on the 
SCADA PC, or, in multi-SCADA architecture, on a network server accessed by multiple PCs. 

For information on OPCWorx configuration and functionality, please see OPCWorx manual 
available upon request. 

OPC LINK (MONICO PRODUCTS DATA EXCHANGE) 

Some Monico Controls’ products have the ability to exchange data using OPC. This facility 
provides direct tag addressing, avoiding cumbersome mapping, and thus being a major 
advantage over other traditional protocols such as Modbus TCP.  

The communication architecture is client/server based. One server can share the data to 
multiple clients (Maximum 4). The client can request and if authorized, change data in the 
server. 
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PROGRAMMING A SERVER 

The server interface is programmed as described in OPC server settings previously. The OPC 
server just has to be activated so data can be shared. Any tags present in the server database 
will be available for clients except Arrays and String tags. 

PROGRAMMING A CLIENT 

Access to the server tags is achieved via the OPC Master protocol available on the Ethernet 
protocols in Communication. Once the driver is selected, a new device HMI1 is created. 

 

The properties available on HMI1 are the server’s OPC and Ethernet settings. The IP Address 
and TCP Port should match the server’s. The Browse button provides access to a dialog box 
where the server database should be identified. Using this method, MonicoView knows the 
tags available in the server unit. The tag list is pulled from the server database so it can be 
available when mapping new tags in the client. 

 

 

When creating data tags, the server tags will be accessible via the mapping button. A client 
tag can be linked to one of the server’s tags. Once used in the database, reading or writing this 
tag will access the server with the appropriate command and action with no further 
programming necessary. If the server tag is related to a PLC, changing the client tag will 
impact on the server, which in turn will reflect the change in the PLC. 
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Note: The server tag list provided in the client database is updated every time the client 
MonicoView database is opened. Therefore, if the server database is modified and new tags 
are created, reopening the client database will update the server tag list and the newly created 
tags will be available for mapping in the client. 

USING TIME MANAGEMENT 

MonicoView contains facilities to allow you to synchronize the time and date within the G3 
to a variety of sources. The time manager is also capable of maintaining information about the 
G3’s current time-zone, and whether daylight saving time is currently enabled. In fact, having 
accurate time-zone information available is a vital to proper synchronization, as the various 
synchronization methods are all designed to work with Universal Coordinated Time, also 
known as UTC or Greenwich Mean Time. This protocol works over Ethernet. The operator 
interface can then either act as a client, requesting the time, and/or a server, providing the 
time. Note that the server implementation does not currently support third party clients. 

CONFIGURING THE TIME MANAGER 

The various properties associated with configuring the time management facilities are 
accessed via the Time Manager icon in the Communications window… 
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The properties are detailed below… 

• The Enable Time Manager property is used to control access to the other 
facilities. If it is not checked, MonicoView will operate in local time and will 
have no knowledge of time-zones or other time management information. 

TIME SERVER 

MonicoView.0 can act as an SNTP server by selecting yes in the Time Server Enable SNTP 
drop down selection box. This will allow other Monico products to synchronize their own 
clocks to the clock of this unit. The IP address of the server when programming the client is 
the Ethernet port IP address programmed in MonicoView.0. Note that MonicoView’s 
implementation of SNTP is not fully RFC compliant, and is not supported as a source of 
synchronization for non-Monico clients. 

TIME CLIENT 

MonicoView.0 can act as an SNTP client by selecting yes in the Time Client Enable SNTP 
drop down selection box. The operator interface will then attempt to synchronize its clock 
with another Monico product, or to another SNTP time source such as a server on the 
network. For example, Windows XP Pro is an SNTP server. 

• The Linked DST property is used to instruct the SNTP client to attempt to read 
the current Daylight Savings Time setting from the SNTP server. As this facility 
is not a standard part of the SNTP protocol, it will only operate if another Master 
or G3 operator panel is specified as the server. The facility is useful, in that it 
allows the Daylight Savings Time adjustment to be made via a single device on 
the factory network, with the other devices then following the central setting. 

• The SNTP Mode and SNTP Server properties are used to configure the IP 
address of the Simple Network Time Service server. If Configured via DHCP is 
selected, the unit’s Ethernet port must be configured to use DHCP, and the 
network’s DHCP server must be configured to designate a server via option 42. 

• The Enable GPS property is used to instruct the time client to use a GPS unit 
connected via NMEA-0183 as an alternative method of obtaining the current 
time. The unit may be connected to any serial port using the appropriate driver. 

• The Frequency property is used to specify how often the G3 should attempt to 
synchronize its time by the methods enabled above. The G3 will always attempt 
to sync twenty seconds after power-up, and will then sync as specified by this 
property. If a given attempt to sync fails, the unit will retry every 30 seconds 
until it is successful. If both GPS and SNTP synchronization are enabled, the 
SNTP will only be used if a GPS is not available. 

LOG FILE 

• The Time-Stamp Using UTC property is used to instruct MonicoView to base its 
event and data logging on UTC rather than on local time. This produces log files 
which are more easily portable across time-zones, and which do not suffer from 
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discontinuities when switching in and out of Daylight Savings Time. The setting 
is global, and will effect all log files within the system. 

SELECTING AN SNTP SERVER 

When configuring the SNTP client, you have several options when selecting a server. 

If you have a Windows- or Unix-based time server as part of your network infrastructure, you 
should ultimately synchronize to this source to ensure enterprise-wide synchronization. If you 
have several G3s on the same network, though, you will find it better to nominate one of 
these as the master device for the purpose of setting Daylight Savings Time, and then have 
that G3 alone synchronize to the enterprise time source. You can then configure the other 
devices to synchronize to the master device, and enable the Linked DST facility to propagate 
the Daylight Savings Time setting around your factory. 

If you have no enterprise time source available, you may choose to nominate a single G3 as 
the point where an operator will set the time, and then have other G3s synchronize to that 
source. Alternatively, if your installation provides TCP/IP access to the Internet via either 
Ethernet or a modem connection, you may configure the SNTP client to synchronize to a 
public time server. An example of this would be 192.6.15.28, which is the current IP address 
of a public time server provided by NIST. A list of other servers can be found at… 

http://support.microsoft.com/kb/262680 

Note that since MonicoView uses an IP address and not a host name to reference the SNTP 
server, it will lose connection with any server that is relocated to a new network address. 
While such relocations are very rare, they are beyond your control and that of Monico. The 
use of an enterprise time source which accesses its own source via DNS is thus considered 
preferable! 

TIME-ZONE CONFIGURATION 

As mentioned above, the G3 operator interface must have knowledge of the current time-zone 
if it is to use advanced time management. This information can be given to the G3 in two 
ways: The simplest method is to use Send Time command on the Link menu of the 
MonicoView configuration software. In addition to setting the G3’s clock, this command also 
sends the PC’s current time zone and the status of Daylight Savings Time. The G3 will store 
this data in non-volatile memory, and use it from that point forward. Obviously, you should 
be sure that the PC contains valid time and date information before sending it to the unit! 

• The alternative method is to use the system variables TimeZone and UseDST. 
The former holds the number of hours by which the local time zone differs from 
UTC, and may be either negative or positive. For example, a setting of –5 
corresponds to Eastern Standard Time in the United States. The latter contains 
either 0 or 1, depending on whether Daylight Savings Time is active. Editing 
either of these variables via the user interface will result in the unit’s clock 
changing to take account of the new settings. For example, enabling Daylight 
Savings Time will move the clock forward one hour, while disabling it will 
move it back. A typical database will only need to expose UseDST for editing by 
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the user, and even this may not be necessary if the Linked DST facility described 
above is in use. 

CONFIGURING THE SYNCHRONIZATION MANAGER (FTP) 

MonicoView’s synchronization manager can be used to exchange files between the G3 and a 
server. Therefore, log files can be synchronized on a server computer, either automatically or 
on-demand. The synchronization manager is configured in the Sync Manager icon under 
Services in the Communications window. 

The communication standard used for the exchange is FTP. FTP stands for File Transfer 
Protocol. It is used on TCP/IP networks to exchange files between devices. An exchange is 
always made in a client/server way, i.e. a client connects to a server to access information by 
uploading (transfer to the server) or downloading (transfer from the server) files.  

The G3 FTP support is a client and therefore has to connect to a server for the function to 
work. Numerous FTP servers are available on the market, some free, others at a charge. 
Windows IIS is an example of an FTP server embedded in the OS. 

SYNCHRONIZATION MANAGER SETTINGS 

Enabling the Sync Manager activates the FTP support. The different settings necessary to 
connect to an FTP server are then available. 

 

• The Server IP address indicates the IP address of the FTP server. In most 
applications, this address will be a computer/server IP address. 

• The Port Number represents the TCP port to which the G3 FTP client service 
connects. This port number is setup in the FTP server. The default value is 
suitable for most applications. 

• The Logon Username and Logon Password are credentials required by the server 
for a client to connect. It has to match a user set up in the Server. Both are case 
sensitive. For anonymous login, enter “anonymous” in Username and leave the 
password blank. 
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• The Data Connection provides a choice between standard and PASV mode. You 
can enable the PASV mode to have the FTP client initiate all data connections 
rather than waiting for incoming connections from the server. This mode is 
sometimes required when working behind non-FTP aware firewalls or when 
using certain forms of network address translation. It is also used when working 
over a GPRS modem connection. 

• The Keep Alive time is the period for which the FTP connection should be kept 
alive in case further transfers are required. A value of zero will close the 
connection as soon as the current transfer has been completed. Non-zero values 
make for more efficient operation when transferring multiple files. 

• Enable the Record Log File to keep a log of all FTP interactions in the root 
directory of the CompactFlash card. This file can be useful when debugging FTP 
operations, but it will tend to degrade performance slightly. 

AUTOMATIC LOG SYNCHRONIZATION 

The automatic log synchronization feature will enable the G3 to synchronize all log files 
present on the CompactFlash card with the FTP server on a time base. The user does not have 
to download the log files via the web server anymore, but can access them directly on the 
server or computer the G3 synchronized with. 

To enable Automatic log synchronization, check Enable Log File Sync. 

 

The Log synchronization becomes available and the following settings can be entered. 

• The Base Directory defines the directory on the server where the log files will be 
synchronized. This directory is relative to the folder settings given in the FTP 
server. For example, if the FTP server is programmed to save any FTP 
connection under C:\inetpub\ftproot and the Base Directory in MonicoView.0 is 
\MyFolder, then all log files will be saved under C:\inetpub\ftproot\MyFolder. 
The G3 will duplicate the folder tree present on the CompactFlash card in the 
Base Directory so data remains in the same order. 
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• The Sync Period is the frequency at which the terminal will synchronize file 
transfers. 

• The Sync Delay is the offset in minutes past the hour between file transfers. Use 
this property to allow multiple terminals’ file transfers to be offset to avoid 
collisions. 

ADVANCED FTP EXCHANGE FUNCTIONS 

Please refer to Appendix A later in this manual for details on the FtpPutFile() and 
FtpGetFile() functions. The second function is useful when you plan to load a file from the 
server to the CompactFlash card. Automatic logging only transfers from the CompactFlash 
card to the server. 

CONFIGURING THE FTP SERVER 

MonicoView’s FTP Server provides a mean to exchange files between a G3 and an FTP 
client application. The G3 will act as a server, waiting for client applications to connect and 
download or upload files.  

For example, a user can connect to a G3 using an FTP client software and download log files 
from the CompactFlash card to the PC hard drive. On the other hand, he could upload new 
recipe files or updated HTML files for the custom web site from the PC hard drive to the G3 
CompactFlash card. 

Numerous FTP clients are available on the market, some free, others at a charge. Windows 
Explorer is an example of FTP client embedded in the OS. The FTP Server configuration is 
available in the Communication module. 

FTP SERVER SETTINGS 

Check the Enable FTP Server check box to activate the FTP Server support. The following 
settings are then available. 

 

• The Anonymous Access defines the rights for a user accessing the server with 
anonymous username and password. If Disabled, no anonymous users can access 
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the server. In Read-Only mode, the anonymous user can only download files 
from the CompactFlash card. In Read-Write, the user will have full access on the 
CompactFlash card. For security reasons, Disabled is recommended. 

• Enable the Record Log File to keep a log of all FTP interactions in the root 
directory of the CompactFlash card. This file can be useful when debugging FTP 
operations, but it will tend to degrade performance slightly. 

FTP SECURITY 

Since the FTP Server can provide full remote access to the CompactFlash card, for security 
reasons, it has to be protected with password access. The Security Manager provides all the 
flexibility by creating independent users. Each user are assigned specific rights. Two are 
available for FTP Server access. 

• Check FTP Server Read Access to authorize a user to download files from the 
G3 CompactFlash card. 

• Check FTP Server Write Access to authorize a user to upload files to the G3 
CompactFlash card. 

 

ACCESSING THE SERVER 

To access an FTP server from a web browser, type ftp://192.168.200.1 where 192.168.200.1 
has to be replaced with your unit IP address. 

 

ftp://192.168.200.1/�
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CONFIGURING DATA TAGS 
Once you have configured the communications options for your database, the next step is to 
define the data items that you want to display or otherwise manipulate. This is done by 
selecting the Data Tags icon from the main screen. 

Note that this chapter is written on the assumption that you are configuring an operator 
terminal with a color graphics display. If you are working with a G303, you will notice that 
tags do not have the Colors tab, and that certain other facilities might not be present. Features 
that are not supported on a G303 are marked with an asterisk. 

ALL ABOUT TAGS 

Data Tags are named entities that represent data items within the operator terminal. Tags may 
be “mapped” to registers in remote devices, in which case MonicoView will automatically 
read the corresponding register when the tag is referenced or displayed. Similarly, if you 
change a mapped tag, MonicoView will automatically write the new value to the remote 
device. 

TYPES OF TAGS 

When you first open the Data Tags window, you will see that the right-hand pane contains an 
apparently bewildering number of buttons that can be used to create different kinds of data 
tags. While all these buttons may seem a little intimidating at first, the fifteen different kinds 
of tag can be broken down into three families, each containing five members. 

 

TAG FAMILIES 

The three families of tags are listed below… 

• Variables represent a single data item within the terminal. Variables may be 
mapped to PLC registers, and may be configured as retentive, in which case their 
values will be kept in memory even when the operator panel is powered off. The 
defining characteristics of a variable are that they contain a single item, and that 
it is in theory possible to write to this item, even if in practice the variable is 
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configured as read-only. (If this seems confusing, read on, and you’ll see how 
this contrasts to a formula, which does not have this property.) 

• Formulae represent derived values. They are a combination of other data items, 
typically combined using one or more math operations. For example, a formula 
might represent the sum of two tank levels. While a formula can be set to be 
equal to the contents of a PLC register, it is not truly mapped to that register, in 
that it can never be written to and thus cannot be considered to be equivalent to 
that register. The need for this restriction is obvious if you consider a formula 
such a Tank1+Tank2. What would it mean to write to this expression? 

• Arrays represent a collection of data items within the terminal. These are 
typically used to store recipe data, or to build up collections of data for statistical 
analysis. They are not used in the majority of simple applications, but provide a 
powerful tool for more complex projects. 

TAG TYPES 

Each family contains five tag types, each of which holds a different kind of data… 

 

Flag tags represent a single true or false condition. When they are mapped to a 
register in a remote device, they will typically correspond to an internal coil or to 
a single digital I/O point. Flag formulae typically represent combinations of such 
items, or comparisons of numeric values. 

 

Integer tags represent 32-bit signed numbers. These tags can store values between 
–2,147,483,648 and +2,147,483,647. Even if a tag is mapped to a PLC register 
which contains only 16 bits of data, MonicoView performs its internal operations 
at the higher level of precision to ensure large intermediate values can be handled 
with ease. 

 

Multi tags represent numeric values that correspond to a number of distinct states. 
Thus, while an integer might represent a tank level, a multi tag will represent, 
say, one of three states of a machine, such as Stopped, Running or Paused. The 
distinction is obvious when you consider that a multi tag is displayed as one of a 
set of strings, while an integer is displayed as a number. 

 

Real tags represent 32-bit single precision floating-point numbers. These tags can 
store values between ±10-38 and ±10+38 with a precision of about 7 significant 
figures. While it is seldom necessary to use real tags to represent physical 
quantities—which typically have more tightly defined ranges—they are useful for 
performing statistical operations or other math functions. 

 

String tags represent an item of text made up of a number of characters. They are 
used to store such things as recipe names, or to process data received using Raw 
Port device drivers. Strings cannot be mapped to PLC registers, but can be used 
to store such data within the Master itself. 
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TAG COLORS 

The color of the tag depends of its family and mapping with a communication device. The 
table below shows the different colors by family and access for an integer tag. The same color 
scheme is used on all tag types; only the symbol is then different as shown above. 

 VARIABLE FORMULA ARRAY 

Internal  Blue  Olive  Purple 

Mapped as Read only  Green N/A  Green 

Mapped as Read/Write 
or Write Only 

 Red N/A  Red 
 

 TAGS? 

Given all these various options, you may wonder why you would want to use tags in the first 
place? After all, MonicoView allows you to directly place a PLC register on a display page, 
so you can in fact configure a simple database without ever opening the Data Tags icon. The 
basic answers are as follows… 

• Tags allow you to name data items, so you know which data item within the PLC 
you are referring to. Further, if the data in the PLC moves or if you decide to 
switch to an entirely different family of PLC, you can simply re-map the tags, 
and avoid having to make any other changes to your database. 

• Tags allow you to avoid re-entering the same information again and again. When 
you create a tag, you specify how the tag is to be displayed. In the case of an 
integer tag, this means you tell MonicoView how many decimal places are to be 
used, and what units, if any, are to be appended to the value. When you place a 
tag on a display page, MonicoView knows how to format it without you having 
to do anything further. Similarly, if you decide to change the formatting, and 
perhaps switch from one set of units to another, you can do this in one place, 
without having to edit each display page in turn. 

• On terminals with color displays, tags are used as the basis for color animation. 
The various colors that are defined for a tag can be used to specify the way in 
which other animation primitives will be displayed. Without tags, you will have 
no way of changing the color of anything other than text-based data fields. 

• Tags are the key to implementing slave protocols. MonicoView treats these 
protocols as mechanisms for exposing data items within the terminal. This 
allows the same data to be accessed via multiple ports, so that, for example, a 
machine setting could be changed by both a local SCADA package, and a similar 
package working over Ethernet from a remote site. Without tags, there would be 
nothing to expose, and this mechanism could not be implemented! 
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• Tags are used within MonicoView to implement many advanced features. If you 
want to use functionality such as alarms, triggers, data logging or the web server, 
you will have to use tags, period. The formatting data from the tag definition is 
typically required by all these features, so tags are mandatory for their operation. 

In other words, tags will automate many tasks during programming, saving you time. Even if 
you decide not to use tags, many of the subsequent chapters of this manual refer to concepts 
discussed in this chapter. You should thus read it thoroughly before proceeding.  

CREATING TAGS 

To create a tag, either click on one of the buttons displayed when the Tags icon is selected in 
the left-hand pane of the Data Tags window, or use the new tag buttons on the toolbar. Either 
way, a new tag will be added to the tag list. To edit the tag’s name, select the tag in the 
left-hand pane, and type in the new name. 

Tag names must conform to the following rules… 

• Tag names may not contain spaces or punctuation. 

• Tag names must start with a letter of the alphabet or an underscore. 

• Subsequent characters must be digits, letters or underscores. 

• Names must not exceed 24 characters in length. 

EDITING TAGS 

When a tag is selected in the left-hand pane, the right-hand pane will change to display a 
number of tabs, each of which shows certain properties of the tag. Depending on the family 
and type of the tag, different tabs may be present, and each tab may contain different fields. 

No matter what kind of tag is selected, the first tab in the right-hand pane is always the Data 
tab. This tab contains fields that indicate what data the tag is to represent, and how that data is 
to be stored—and perhaps transferred to or from a remote device. The exact contents of the 
tab will vary according to the family and type of the tag in question. 

The second tab is always the Format tab. This indicates how the data in the tag is to be 
formatted when shown on the operator panel’s display, or when presented to a user via any 
other mechanism, such as a web page. The Format tab will take the same form for all tags of 
the same type, such that all integer tags, for example, share the same set of properties. 

The balance of the tabs define alarms and triggers for the tag. These are not included for 
string tags or for arrays. Alarms are used to detect a condition that needs to be brought to the 
operator’s attention, or simply to log the fact that the condition has occurred. Triggers operate 
in a similar way, but instead of recording the condition, they are used to execute an action. 

EDITING PROPERTIES 

Most properties are edited in ways that are self-evident to anyone who has used a Windows 
operating system. For example, you may be required to enter a numeric value, or to select an 
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item from a drop-down list. Certain types of property, though, provide more complex editing 
options, and these are described below. 

EXPRESSION PROPERTIES 

Expression properties are capable of being set to… 

• A constant value. 

• The contents of a data tag. 

• The contents of a register in a remote communications device. 

• A combination of such items linked together using various math operators. 

In its default state, the arrowed button immediately after the label of the property shows that 
the field is in General mode, and the edit box to the right of the button shows a grayed-out 
string that indicates the default behavior of the property… 

 

If you are familiar with MonicoView’s expression syntax—a complete description of which 
can be found in the Writing Expressions section—you can edit the property by typing an 
expression directly into the edit box. Most users, though, will choose to press the arrowed 
button and select from the menu of options that is presented... 

• Selecting Tag will display a dialog box containing a list of data tags. You can 
select the tag that you want to be used to control this property. In some cases, 
you will also be given the chance to create a new tag and define its basic 
properties. This is not available when editing properties that belong directly to 
other data tags, as it is otherwise too easy to forget which tag you’re editing! 

• Selecting a device name will display a dialog box allowing you to choose a 
register within that remote communications device. The various communications 
devices are listed at the end of the menu in the order in which they were created. 

• Selecting Next will set the property to be equal to the register which follows the 
last selected register within the last selected device. For example, if you have 
used the device name option to set a previous property to N7:10 of PLC1, 
selecting Next will set the current property to N7:11 of the same device. 

TRANSLATABLE STRINGS 

MonicoView databases are designed to support multi-lingual operation, whereby any string 
that will be presented to the user of the operator panel is capable of being displayed in one of 
many different languages. To allow you to define these translations, properties that contain 
such strings have a button labeled Translate to their right-hand side. 
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To enter the translations, click the button and the following dialog box will appear… 

 

If you do not enter text for a particular language, and that language is subsequently selected 
by the operator, MonicoView will use the default language in its place. Note that 
MonicoView will re-configure Windows to use the appropriate Input Method Editor 
whenever a complex (ie. Unicode-based) language is being edited on a color terminal. For 
information on how to select the languages for the database, and on how to configure a key or 
a menu to select a different language, refer to the User Interface section of this manual. 

COLOR PROPERTIES*

Color properties within tag represent a foreground and a background color that will be used to 
display the tag’s state in textual form. Either of these colors can then be used to define the 
color of other animation primitives. The example below shows a color pair being edited… 

 

 

The drop-down list contains the following colors… 

• The sixteen standard VGA colors. 

• The sixteen custom colors defined by the user. 

• Fourteen shades of gray that fall between black and white. 

                                                        
* Not present on G303 and other monochrome devices. 
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The More option at the bottom of the list can be used to invoke the color selection dialog… 

 

This dialog offers several ways of defining a color. You can pick from the palette, pick from 
the “rainbow” window, or enter the explicit HSL or RGB parameters. The dialog also allows 
custom colors to be added to the palette. These will appear whenever the dialog is invoked, 
and will also appear in the drop-down list described above. Note that not every color that is 
displayed in the “rainbow” will be capable of being rendered on the panel’s 256-color 
display. MonicoView will choose the nearest color within the abilities of the device. 

EDITING FLAG TAGS 

You will recall that flag tags represent a true or false value. The following sections describe 
the various tabs that are displayed on the right-hand side of the Data Tags window when 
editing one of the various kinds of flag tags. 

THE DATA TAB (VARIABLES) 

The Data tab of a flag variable contains the following properties... 

 

• The Mapping property is used to specify if the variable is to be mapped to a 
register in a remote device, or if it exists only within the terminal. If you press 
the arrow button and select a device name from the resulting menu, you will be 
presented with a dialog box that will allow a PLC register to be selected. 
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• The Bit Number property is used when a flag variable is mapped to a PLC 
register which contains more than a single bit of information. The property is 
then used to indicate which bit within the register is to be accessed by the tag. 

• The Access property is used to specify what sort of data transfers should be 
performed for a mapped variable. You may indicate that data is to be both read 
and written, or just read or written as appropriate. Write-only tags can be used to 
avoid unnecessary read operations on data that can only be changed by the 
terminal. They will typically be set to retentive as their value cannot be obtained 
from the PLC, and must therefore be stored by the terminal. 

• The Storage property is used to indicate whether MonicoView should allocate 
FLASH memory within the panel in order to retain the value of the tag during 
power-down. Mapped tags that are not write-only cannot be set to retentive, as 
their values will in any case be read from the PLC, and it does not therefore 
make sense to waste local storage to retain data that will be overwritten. 

• The Simulation property is used to select the value that MonicoView will assign 
to this tag when displaying it within the display page editor. This facility can be 
useful for documenting databases, in that it allows a display page to be 
configured to represent a particular machine state, such that a screen capture can 
then be pasted into an operator manual or other documentation. 

• The Setpoint properties are used to indicate whether a setpoint will be specified 
for this tag, and what that setpoint will be. Setpoints are used by certain alarm 
modes, and allow the actual state of a tag to be compared to its intended state. 
For example, a tag that represents the state of an input from a speed switch for a 
motor might have the motor’s control output specified as a setpoint. This allows 
an alarm to be programmed to activate if the motor fails to start. 

• The On Write property is used to define an action that will be executed when a 
change is made to the tag. This action may be used to update dependent values, 
or to perform other actions specific to the database. Care should be taken not to 
perform actions that are too complex, or system performance may be reduced. 
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THE DATA TAB (FORMULAE) 

The Data tab of a flag formula contains the following properties... 

 

• The Tag Value property is used to specify the value that is to be represented by 
this tag. It is typically set to a logical combination of other tags or PLC registers, 
or to a comparison between numeric values. In the example shown above, the tag 
is configured to be true when a motor speed exceeds a certain value. 

• The Setpoint and Simulation properties are as described for flag variables. 

THE DATA TAB (ARRAYS) 

The Data tab of a flag array contains the following properties... 

 

• The Elements property is used to indicate how many data items the array should 
hold. Array elements are referred to using square brackets, such that Array[0] is 
the first element, and Array[n-1] is the last element, where n is equal to the 
value entered for this property. 

• The Access and Storage properties are as described for flag variables. 
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• The Simulation property is as described for flag variables. Note that the value to 
be simulated applies to all elements of the array. If you need to simulate on a per 
element basis, use a number of formulae to alias the array elements. 

• The Read Policy property is used to define how MonicoView will read the data 
for arrays that are mapped to remote data items. The table below lists the various 
policies that can be configured, and describes their operation… 

 

MODE DESCRIPTION 

Read Adaptively Any referenced array elements will be added to the 
communications scan. Data either side of a referenced 
element, as defined by the Read Ahead and Read Behind 
properties, will be read as well. Old data may be 
displayed momentarily when an element from an adaptive 
array is first displayed on the panel. 

Read Manually The array will be read if and only if the ReadData

Read Whole Array 

 
function is called. This mode is useful for items that are 
read only rarely, or which are known not to change in the 
remote device. 

The entire array will be added to the communications 
scan if any element in the array is referenced. This mode 
ensures that all data items are available before they are 
referenced, but can lower system performance. 

 

• The Read Ahead and Read Behind properties modify the behavior of the adaptive 
read policy by controlling how many adjoining registers will be read when a 
specific array element is referenced. The adjoining reads are used to maximize 
the chance of data being available when indirection is used to scroll up or down 
an array. The default values should be suitable for most applications. 

• The On Write property is as described for flag variables. 

THE FORMAT TAB 

The Format tab of a flag tag contains the following properties... 

 

• The Label Text property is used to specify the label that can be shown next to 
this tag when including the tag on a display page. The label differs from the tag 
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name, in that the former can be translated for international applications, while 
the latter remains unchanged and is never shown to the user of the panel. 

• The On State and Off State properties are used to specify the text to be displayed 
when the tag contains a non-zero and zero value, respectively. When you enter 
the text for the on state, MonicoView will attempt to generate corresponding text 
for the off state by referring both to previously-created flag tags, and to its 
internal list of common antonymic pairs. 

THE COLORS TAB*

The Colors tab of a flag tag contains the following properties… 

 

 

• The Tag On property is used to define the color pair to be used to display the tag 
when it is in the on state. 

• The Tag Off property is used to define the color pair to be used to display the tag 
when it is in the off state. 

                                                        
* Not present on G303 and other monochrome devices. 
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THE ALARMS TAB 

The Alarms tab of a flag variable or formula contains the following properties... 

 

• The Event Mode property is used to indicate the logic that will be used to decide 
whether the alarm should activate. The tables below list the available modes. 

 

MODE ALARM WILL ACTIVATE WHEN… 

Active On The tag is true. 

Active Off The tag is false. 
 

 The following modes are only available when a setpoint is defined… 
 

MODE ALARM WILL ACTIVATE WHEN… 

Not Equal to SP The tag does not equal its setpoint. 

Off When SP On The tag does not respond to an ON setpoint. 

On When SP Off The tag does not respond to an OFF setpoint. 

Equal to SP The tag equals its setpoint. 
 

• The Event Name property is used to define the name that will be displayed in the 
alarm viewer or in the event log as appropriate. MonicoView will suggest a 
default name based upon the tag’s label, and the event mode that has been 
selected. 

• The Trigger property is used to indicate whether the alarm should be edge or 
level triggered. In the former case, the alarm will trigger when the condition 
specified by the event mode first becomes true. In the latter case, the alarm will 
continue in the active state while the condition persists. This property can also be 
used to indicate that this alarm should be used as an event only. In this case, the 
alarm will be edge triggered, but will not result in an alarm condition. Rather, an 
event will be logged to the G3’s internal memory. 

• The Delay property is used to indicate how long the alarm condition must exist 
before the alarm will become active. In the case of an edge triggered alarm or 
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event, this property also specifies the amount of time for which the alarm 
condition must no longer exist before subsequent reactivations will result in a 
further alarm being signaled. As an example, if an alarm is set to activate when a 
speed switch indicates that a motor is not running even when the motor has been 
requested to start, this property can be used to provide the motor with time to 
run-up before the alarm is activated. 

• The Accept property is used to indicate whether the user will be required to 
explicitly accept an alarm before it will no longer be displayed. Edge triggered 
alarms must always be manually accepted. 

• The Priority property is used to control the order in which alarms are displayed 
by MonicoView’s alarm viewer. The lower the numerical value of the priority 
field, the nearer to the top the alarm will be displayed. 

• The Email property is used to specify the email address book entry to which a 
message should be sent when this alarm is activated. Refer to the Advanced 
Communications chapter for information on configuring email. 

• The Siren property is used to indicate whether or not the activation of this alarm 
should also activate the G3 panel’s internal sounder. While the sounder is active, 
the panel’s display will also flash to better draw attention to the alarm condition. 

THE TRIGGERS TAB 

The Triggers tab of a flag variable or formula contains the following properties... 

 

• The Trigger Mode property is as described for the Alarms tab. 

• The Delay property is as described for the Alarms tab. 

• The Action property is used to indicate what action should be performed when 
the trigger is activated. Refer to the Writing Actions section for a description of 
the syntax used to define the various actions that MonicoView supports. 
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EDITING INTEGER TAGS 

You will recall that integer tags represent a 32-bit signed value. The following sections 
describe the various tabs that are displayed on the right-hand side of the Data Tags window 
when editing one of the various kinds of integer tags. 

THE DATA TAB (VARIABLES) 

The Data tab of an integer variable contains the following properties... 

 

• The Mapping property is used to specify if the variable is to be mapped to a 
register in a remote device, or if it exists only within the terminal. If you press 
the arrow button and select a device name from the resulting menu, you will be 
presented with a dialog box that will allow a PLC register to be selected. 

• The Sign Mode property is used to override the default behavior of the comms 
driver when reading 16-bit values from a remote device. The driver will 
normally make a decision about whether to treat these values as signed or 
unsigned, based upon how the data is normally used within the device. If you 
want to override this decision, set this property as required. 

• The Access property is as described for flag variables. 

• The Storage property is as described for flag variables. 

• The Simulation property is as described for flag variables. 

• The Scaling and Transforms properties are used to modify the data value as it is 
read and written from the remote device. When the linear scaling mode is 
selected, the Store As range indicates the upper and lower bounds of the variable 
within the PLC, while the Display As range indicates the corresponding values as 
they will be presented to the operator. The Source Data property can also be 
used in this mode to force MonicoView to treat the underlying data as a floating-
point value before performing the scaling. The other modes are as follows… 
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MODE DESCRIPTION 

BCD to Binary The BCD value is converted to binary. 

Binary to BCD The binary value is converted to BCD. 

Swap Bytes in Word The lower two bytes of the value are swapped. 

Swap Bytes in Long All four bytes of the value are swapped. 

Swap Words The upper and lower words of the value are swapped. 

Reverse Bits in Byte Bits 0 through 7 of the value are reversed. 

Reverse Bits in Word Bits 0 through 15 of the value are reversed. 

Reverse Bits in Long Bits 0 through 31 of the value are reversed. 

Invert Bits in Byte Bits 0 through 7 of the value are inverted. 

Invert Bits in Word Bits 0 through 15 of the value are inverted. 

Invert Bits in Long Bits 0 through 31 of the value are inverted. 
 

• The Setpoint properties are used to indicate whether a setpoint will be specified 
for this tag, and what that setpoint will be. Setpoints are used by certain alarm 
modes, and allow the state of a tag to be compared to its intended state. For 
example, a tag which represents the temperature of a vessel might have a 
setpoint that indicates the required temperature. This will allow an alarm to 
activate if the vessel strays beyond a certain distance from its target. 

• The On Write property is as described for flag variables. 

THE DATA TAB (FORMULAE) 

The Data tab of an integer formula contains the following properties... 

 

• The Tag Value property is used to specify the value represented by this tag. It is 
typically set to a combination of other tags, linked together using math operators. 
In the example above, the tag is set to be equal to the sum of two tank levels, 
therefore indicating the total amount of feedstock available. 

• The Scaling and Transforms properties are as described for integer variables. 

• The Setpoint properties are as described for integer variables. 
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THE DATA TAB (ARRAYS) 

The Data tab of an integer array contains the following properties... 

 

• The Mapping property is used to specify if the variable is to be mapped to a 
register in a remote device, or if it exists only within the terminal. If you press 
the arrow button and select a device name from the resulting menu, you will be 
presented with a dialog box that will allow a PLC register to be selected. 

• The Elements property is used to indicate how many data items the array should 
hold. Array elements are referred to using square brackets, such that Array[0] is 
the first element, and Array[n-1] is the last element, where n is equal to the 
value entered for this property. 

• The Sign Mode property is used to override the default behavior of the comms 
driver when reading 16-bit values from a remote device. The driver will 
normally make a decision about whether to treat these values as signed or 
unsigned, based upon how the data is normally used within the device. If you 
want to override this decision, set this property as required. 

• The remainder of the properties are as described for the Data tab of flag tags. 

THE FORMAT TAB 

The Format tab of an integer tag contains the following properties... 
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• The Label Text property is used to specify the label that can be shown next to 
this tag when including the tag on a display page. The label differs from the tag 
name, in that the former can be translated for international applications, while 
the latter remains unchanged and is never shown to the user of the panel. 

• The Minimum Value and Maximum Value properties are used to define the limits 
used for data entry, and to provide similar limits for the various graphical 
primitives that need to know the bounds within which the tag may vary, such as 
when scaling a tag’s value for display as a bar-graph. 

• The Number Base property is used to indicate whether the tag should be 
displayed in decimal, hexadecimal, binary, octal, or passcode. Decimal values 
may be signed or unsigned, while all other number bases imply unsigned 
operation. Selecting passcode mode will display asterisks for values being 
entered and is intended for security purposes. 

• The Sign Mode property is used to indicate whether or not a sign should be 
prefixed to the tag’s value. If a hard sign is selected, either a positive or a 
negative sign will be prefixed as appropriate. If a soft sign is selected, a positive 
sign will not be shown, but a space will be prefixed instead. 

• The Digits Before DP property is used to indicate how many digits should be 
shown before the decimal place, or, if no digits are to be shown after the decimal 
place, to indicate how many digits should be shown in total. 

• The Digits After DP property is used to indicate how many digits should be 
shown after the decimal place. Somewhat obviously, decimal places are not 
supported if a number base other than decimal has been selected! 

• The Leading Zeroes property is used to indicate whether zeros at the beginning 
of a number should be shown, or replaced with spaces. 

• The Group Digits property is used to indicate whether decimal values should 
have the digits before the decimal place grouped in threes, and separated with 
commas. Similar separation is performed on other number bases, using 
groupings and separators appropriate to the selected radix. 

• The Prefix property is used to specify a translatable string that will be displayed 
in front of the numeric value. This is typically used to indicate units of measure. 

• The Suffix property is used to specify a translatable string that will be displayed 
after the numeric value. This is also typically used to indicate units of measure. 
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THE COLORS TAB*

The Colors tab of an integer tag contains the following properties… 

 

 

• The Default property is used to define the color pair that will be used to display 
the tag when its value is less than the Limit 1 property. 

• The remaining properties define limits, and color pairs, that will be used to 
display the tag when its value is greater than the corresponding limit, and less 
than the next limit. If the next limit is zero, the color pair will be used whenever 
the tag’s value exceeds the specified limit. 

THE ALARM TABS 

Each Alarm tab of an integer variable or formula contains the following properties... 

 

• The Event Mode property is used to indicate the logic that will be used to decide 
whether the alarm should activate. The tables below list the available modes. 

                                                        
* Not present on G303 and other monochrome devices. 



CONFIGURING DATA TAGS EDITING INTEGER TAGS 

REVISION 12 PAGE 79 

 

MODE ALARM WILL ACTIVATE WHEN… 

Data Match The value of the tag is equal to the alarm’s Value. 

Data Mismatch The value of tag is not equal to the alarm’s Value. 

Absolute High The value of the tag exceeds the alarm’s Value. 

Absolute Low The value of the tag falls below the alarm’s Value. 
 

 The following modes are only available when a setpoint is defined… 
 

MODE ALARM WILL ACTIVATE WHEN… 

Deviation High The value of the tag exceeds the tag’s Setpoint by an 
amount equal to or greater than the alarm’s Value. 

Deviation Low The value of the tag falls below the tag’s Setpoint by an 
amount equal to or greater than the alarm’s Value. 

Out of Band The tag moves outside a band equal in width to twice the 
alarm’s Value and centered on the tag’s Setpoint. 

In Band The tag moves inside a band equal in width to twice the 
alarm’s Value and centered on the tag’s Setpoint. 

 

• The Value property is used to define either the absolute value at which the alarm 
will be activated, or the deviation from the setpoint value. The exact 
interpretation depends on the event mode as described above. 

• The Hysteresis property is used to prevent an alarm from oscillating between the 
on and off states when the process is near the alarm condition. For example, for 
an absolute high alarm, the alarm will become active when the tag exceeds the 
alarm’s value, but will only deactivate when the tag falls below the value by an 
amount greater than or equal to the alarm’s hysteresis. Remember that the 
property always acts to maintain an alarm once the alarm is activated, and not to 
modify the point at which the activation occurs. 

• The remainder of the properties are as described for the Alarms tab of flag tags. 

THE TRIGGERS TAB 

The Triggers tab of an integer variable or formula contains the following properties... 
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• The Trigger Mode property is as described for the Alarm tabs. 

• The Delay property is as described for a flag tag’s Alarms tab. 

• The Action property is used to indicate what action should be performed when 
the trigger is activated. Refer to the Writing Actions section for a description of 
the syntax used to define the various actions that MonicoView supports. 

EDITING MULTI TAGS 

You will recall that multi tags represent a 32-bit signed value, but are used to select between 
one of a number of text strings. The following sections describe the various tabs that are 
displayed on the right-hand side of the Data Tags window when editing a multi tag. 

THE DATA TAB (VARIABLES) 

The Data tab of a multi variable contains the following properties... 

 

• The Mapping property is used to specify if the variable is to be mapped to a 
register in a remote device, or if it exists only within the terminal. If you press 
the arrow button and select a device name from the resulting menu, you will be 
presented with a dialog box that will allow a PLC register to be selected. 

• The remainder of the properties are as described for the Data tab of flag tags. 
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THE DATA TAB (FORMULAE) 

The Data tab of a multi formula contains the following properties... 

 

• The Tag Value property is used to specify the value represented by this tag. It is 
typically set to a combination of other tags, linked together using math operators. 
In the example above, the tag is set equal to a value of one, two or three, 
depending on the state of three different flags. For more information on the ?: 
operator used in this example, refer to the Writing Expressions section. 

• The Simulation property is a described for flag tags. 

THE DATA TAB (ARRAYS) 

The Data tab of a multi array contains the following properties... 

 

All of these properties are as described for flag arrays. 
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THE FORMAT TAB 

The Format tab of a multi tag contains the following properties... 

 

• The Label Text property is used to specify the label that can be shown next to 
this tag when including the tag on a display page. The label differs from the tag 
name, in that the former can be translated for international applications, while 
the latter remains unchanged and is never shown to the user of the panel. 

• The Item States properties are used to define up to eight values that represent 
different states of the tag. Each state has an integer value associated with it, and a 
text string to indicate what should be displayed when the tag holds that value. At 
least two states must be defined, but the balance may be left in their default 
condition if they are not needed. 

• The Default property is used to define the text to be displayed if the tag holds a 
value other than one of those listed in the item states. 

• The Navigation slider is used to step through the 512 states that can be defined 
for a particular tag. Moving the slider left and right will update the right-hand 
pane to show the selected states. 

The Export to File button can be used to export state names and values to a CSV file… 
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The CSV file will contain a line for each defined state, stating the state label, the state value, 
and the text assigned to that state. If multiple languages are in use, an additional column will 
be provided for each language. The file type drop-down can be used to select a Unicode 
format file if you are using languages that cannot be represented in standard ASCII. The file 
can be subsequently re-imported using the Import from File button. 

The Copy from Tag button will display the following dialog box… 

 

This dialog can be used to select another multi tag from which the format information is to be 
copied. This facility will save a lot of typing if the same format is to be used on several tags. 

THE COLORS TAB*

The Colors tab of a multi tag contains the following properties… 

 

 

• The various color pairs are used to specify how the tag should be displayed when 
it is each of the states specified on the Format tab. As with the Format tab, the 
Navigation slider can be used to up and down the list of color pairs when more 
than eight states have been defined. 

                                                        
* Not present on G303 and other monochrome devices. 
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THE ALARM TABS 

Each Alarm tab of a multi variable or formula contains the following properties... 

 

• The Event Mode property is used to indicate the logic that will be used to decide 
whether the alarm should activate. The table below lists the available modes. 

 

MODE ALARM WILL ACTIVATE WHEN… 

State Match The value of the tag is equal to the alarm’s Value. 

State Mismatch The value of tag is not equal to the alarm’s Value. 
 

• The Value property is used to define the comparison data for the alarm. 

• The remainder of the properties are as described for the Alarms tab of flag tags. 

THE TRIGGERS TAB 

The Triggers tab of a multi variable or formula contains the following properties... 

 

• The Trigger Mode property is as described for the Alarm tabs. 

• The Delay property is as described for a flag tag’s Alarms tab. 

• The Action property is used to indicate what action should be performed when 
the trigger is activated. Refer to the Writing Actions section for a description of 
the syntax used to define the various actions that MonicoView supports. 
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EDITING REAL TAGS 

You will recall that real tags represent a single-precision floating-point value. All the tabs 
displayed for real tags are exactly the same as those displayed for integer tags, with the 
exception that data entered for items such as the value and hysteresis properties of alarms and 
triggers may contain decimals. You are thus referred to the sections on integer tags. You will 
notice some selections for integer tags that are not applicable to real tags. 

EDITING STRING TAGS 

You will recall that string tags represent an item of text, this being made up of a number of 
individual characters. The following sections describe the various tabs that are displayed on 
the right-hand side of the Data Tags window when editing one of the various string tags. 

THE DATA TAB (VARIABLES) 

The Data tab of a string variable contains the following properties... 

 

• The Mapping property is used to specify if the variable is to be mapped to a 
register in a remote device, or if it exists only within the terminal. If you press 
the arrow button and select a device name from the resulting menu, you will be 
presented with a dialog box that will allow a PLC register to be selected. 

• The Encoding property is used to specify how text will be packed into mapped 
registers that contain more than 8 bits of data. Selecting unpacked will store one 
character per register no matter how large the register, leaving the high-order bits 
empty. Selecting low-to-high packed mode will store one character in each 8 bits 
of the target register, storing the first character in the lowest order bits. Selecting 
high-to-low packed mode will store one character in each 8 bits of the target 
register, storing the first character in the highest order bits. 

• The Length property is used to indicate how many characters of storage should 
be allocated for this string. A value need only be entered if you have configured 
the variable for retentive storage. Strings that are kept in the terminal’s RAM and 
not committed to FLASH have no practical limit on their length. 
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• The remainder of the properties are as described for flag variables. 

THE DATA TAB (FORMULAE) 

The Data tab of a string formula contains the following properties... 

 

• The Tag Value property is used to specify the value represented by this tag. It is 
typically set to a combination of other tags, linked together using math operators 
or functions. In the example above, the tag is set equal to the combination of two 
strings variables, separated by a space. For more information on the operators 
and functions that can be used with strings, refer to the Writing Expressions 
section and the Function Reference at the end of this document. 

• The Simulation property is as described for flag variables. 

THE DATA TAB (ARRAYS) 

The Data tab of a string array contains the following properties... 

 

• The Length and Encoding properties are as described for string variables. 

• The remainder of the properties are as described for flag arrays. 
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THE FORMAT TAB 

The Format tab of a string tag contains the following properties... 

 

• The Label Text property is used to specify the label that can be shown next to 
this tag when including the tag on a display page. The label differs from the tag 
name, in that the former can be translated for international applications, while 
the latter remains unchanged and is never shown to the user of the panel. 

• The Template property is used to provide a “picture” of the string, thereby 
indicating what kind of characters can occur in each position. If a template is 
specified, data entry will be limited such that only the correct kind of character 
can be selected for each character in the string. The table below shows the 
meaning of the various special characters that can be included in a template… 

 

Character Permitted Characters 
In Template A-Z a-z 0-9 Space Misc 

A Yes - - - - 

a Yes Yes - - - 

S Yes - - Yes - 

s Yes Yes - Yes - 

N Yes - Yes - - 

n Yes Yes Yes - - 

M Yes - Yes Yes - 

m Yes Yes Yes Yes - 

0 - - Yes - - 

X Yes Yes Yes Yes Yes 
 

The additional characters referred to by the “Misc” column are… 

,.:;+-=!?%/$ 

Characters not included in the table are copied verbatim to the display. 

For example, to allow entry of a US telephone number, use a template of… 

(000) 000-0000 
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The parentheses, the space and the dash will all be included when the field is 
displayed, but only the 10 digits indicated by the ‘0’ characters will be stored in the 
string. Similarly, if data entry is enabled for a field using this template, the cursor 
will skip the various non-numeric positions when moving left or right, and will only 
allow numeric characters to be entered for those positions that can be selected. 

• The Length property is used in lieu of the template to indicate how many 
characters should be reserved on a page when displaying this string. If a string 
variable is marked as retentive, it makes sense for this property to be equal to the 
length entered on the Data tab, but this is not obligatory, as you may want to 
allocate more or less space on the display for layout purposes. 

• The Justification property is used when a template is not specified, and indicates 
how strings shorter than the Length property should be positioned within the 
storage allocated for the string. It is distinct from the Justification property of the 
display format, in that it impacts the data that is actually stored. 

THE COLORS TAB*

The Colors tab of a string tag contains the following properties… 

 

 

The tab is used to specify the default colors to be used to display this tag. 

MORE THAN TWO ALARMS 

If your application requires more than two alarms (or indeed triggers) for a tag, define a 
formula to be equal in value to the primary tag, and set the extra alarms on the alias. For 
example, if you have a variable called Level which is mapped to N7:100 in a PLC, and you 
need to create a third alarm for that tag, create a variable called, say, LevelAlias and set its 
value property to Level. You can then set additional alarms on this alias tag. 

                                                        
* Not present on G303 and other monochrome devices. 
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VALIDATING TAGS 

Selecting the Tags icon in the left-hand pane of the Tags window will allow access to the 
Validate All Tags button. Pressing this button will recompile all expressions in your database, 
fixing any broken communications references and updating tag reference counts. You should 
not need to push this button unless you have removed and then replaced tags, and wish to 
repair the expression that will have been broken when the tags were deleted. 

EXPORTING TAG MAPPINGS 

Selecting the Tags icon in the left-hand pane of the Tags window will also allow access to the 
tag import and export facilities. The Export to File button can be used to export the tag names 
and mappings to a CSV file for subsequent editing in Microsoft Excel or some other suitable 
tool. The Import from File button can then be used to re-import the file, changing the tag 
mappings in line with the changes made to the file. These facilities are useful when porting an 
application from one PLC to another, as it allows all the mappings to be changed in a single 
operation. The import facility can also be used to create tags to correspond to data mappings 
that have been exported into a CSV file from a Monico Modular Controller. 

LOGGING EVENT MESSAGES*

When the Tags icon is selected in the left-hand pane, the right-hand pane of the Tags window 
contains options to control the logging of the messages generated by the alarms and events 
attached to each tag… 

 

 

• The Send to Raw Port property is used to indicate which communications port 
events should be printed to. The port in question must have a raw port driver 
bound to it as described in the Using Raw Ports chapter. Note that a serial driver 
or a TCP/IP driver may be used as required by the application. 

• The Save to CompactFlash property is used to enable the writing of events to 
CSV files on the card fitted to the panel. Events are stored using techniques 
similar to those for data logging. The New File Every and Retain at Most 
properties control how files are allocated. Refer to the Configuring Data Logging 
chapter for information on how the data is written and how files are named. 

NOTES FOR EDICT USERS 

Users of Monico’s Edict-97 software should note… 

• MonicoView’s Data Tags window is used to perform all of the various functions 
that were previously implemented using the Named Data window, the Alarm 
Scanner, and the Trigger Table. 

                                                        
* Not present on G303 and other monochrome devices. 
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• MonicoView does not have the concept of constants as a separate tag family. 
Edict used constants to help it perform certain optimizations that MonicoView is 
now able to perform automatically. Constants can thus be implemented using 
formulae. 

• MonicoView associates alarms and triggers with tags, rather than allowing them 
to be defined on the basis of arbitrary expressions. If you need to have an alarm 
or trigger monitor a general expression, define a formula to be equal to that 
expression, and set the alarm and/or trigger on that tag instead. 
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CONFIGURING THE G303 USER INTERFACE 
Now that you have configured your communications options, and created data tags for the 
various items that you wish to display, you can create display pages to allow the user to view 
or edit these data items. These pages are manipulated by selecting the User Interface icon 
from the main screen. Please note that this chapter refers specifically to monochrome operator 
panels such as the G303. If you are using an operator panel with a color display, please refer 
to the next chapter for configuration details. 

CONTROLLING THE VIEW 

By default, the User Interface window shows the entire front panel of the G303, including the 
display and all the available keys. If you want to allocate more of your PC’s screen to show 
the G303’s display, you can use the four different zoom levels as shown below… 

    

    

As you can see, at each level, fewer keys are shown, and more of the window is allocated to 
the display itself. The zoom level can be controlled from the View menu, by using the 
magnifying glass icon, or by pressing the Alt key together with the digits 1 through 4. 

OTHER VIEW OPTIONS 

As well as controlling the zoom, the View menu contains the following options… 

• The Page List command can be used to show or hide the left-hand pane of the 
User Interface window. If the page list is disabled, even more space is made 
available for editing the display. The F4 key toggles the page list on and off. 

• The Hold Aspect command can be used to control whether or not MonicoView 
attempts to maintain the aspect ratio of the display. If aspect holding is enabled, 
a figure that would appear as, say, a circle on the G303 will appear as a perfect 
circle on your PC. If this mode is not selected, MonicoView can expand the 



USING THE PAGE LIST CRIMSON USER MANUAL 

PAGE 92 www.monicoinc.com/support 

display page to use more of the PC’s screen, but at the expense of some 
distortion. 

Other options are available during page editing, and are described below. 

USING THE PAGE LIST 

To create, rename or delete display pages, click on the left-hand pane of the User Interface 
window. The various commands on the Page menu can then be used to make the desired 
changes. Alternatively, right-click on the required display page, and select from the menu. 

To select a page, either click on the page in the page list, or use the up and down arrows in the 
toolbar. Alternatively, you can use the Alt+Left and Alt+Right key combinations to move 
up and down the list as required. These keys will work no matter which pane is selected. 

DISPLAY EDITOR TOOLBOXES 

To edit the contents of a display page, first select the page as described above. Then, click on 
the green rectangle that represents the G3’s display. A white rectangle will appear around the 
display to indicate that it has been selected, and a number of toolboxes will appear. 

THE DRAWING TOOLBOX 

The drawing toolbox is used to add various elements, known as primitives, 
to the display page. The first two icons control the insertion mode, while 
the balance of the icons represent individual primitives. The primitives 
shown in yellow are basic geometric and animation items, while the ones 
shown in green are rich primitives that use formatting and other 
information from a data tag to control their operation. The primitives 
shown in red are system items, such as the active alarm viewer. All of the 

commands contained in the toolbox can also be accessed via the Insert menu. 

THE FILL FORMAT TOOLBOX 

The fill format toolbox is used to control the pattern that will be used to fill a 
display primitive. If one or more primitives is selected, clicking on a fill 
pattern will change all the selected items to use that pattern. If nothing is 
currently selected, clicking on a pattern will set the default pattern for 

newly-created primitives. The various options can also be accessed via the Format menu, or 
via the paint-can icon on the toolbar. 

THE LINE FORMAT TOOLBOX 

The line format toolbox is used to control the color that will be used to draw an 
outline around a display primitive. If one or more primitives is selected, clicking 
on a line color will change all the selected items to use that color. If nothing is 

currently selected, clicking on a color will set the default outline color for newly-created 
primitives. The various options can also be accessed via the Format menu, or via the 
paintbrush icon on the toolbar. 
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THE TEXT FORMAT TOOLBOX 

The text format toolbox is used to control the horizontal and vertical alignment of 
primitives that contain text elements. If one or more such primitives is selected, 
clicking on an icon will change all the selected items to use the selected 

justification. If nothing is currently selected, clicking on an icon will set the default format for 
newly-created primitives. The various options can also be accessed via the Format menu. 

THE FOREGROUND TOOLBOX 

The foreground toolbox is used to control the foreground color for primitives that 
contain text elements. If one or more such primitives is selected, clicking on an 
icon will change all the selected items to use the selected color. If nothing is 

currently selected, clicking on an icon will set the default color for all newly-created 
primitives. The various options can also be accessed via the Format menu. 

THE BACKGROUND TOOLBOX 

 The background toolbox is used to control the background color for primitives 
that contain text elements. If one or more such primitives is selected, clicking on 
an icon will change all the selected items to use the selected color. If nothing is 

currently selected, clicking on an icon will set the default color for all newly-created 
primitives. The various options can also be accessed via the Format menu. 

ADDING DISPLAY PRIMITIVES 

To add a display primitive to a page, click on the required icon in the drawing toolbox, or 
select the required option from the Insert menu. The mouse cursor will change to an arrow 
with a crosshair at its base, and you will then be able to drag-out the required position of the 
primitive within the display window… 

 

SMART ALIGNMENT 

If you have the Smart Align features of the View menu enabled, MonicoView will provide 
you with guidelines to help align a new primitive with existing primitives, or with the center 
of the display. In the example shown above, the horizontal dotted line indicates that the center 
of the tank primitive is vertically aligned with the center of the display. With a little practice, 
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this feature can make it very easy to align primitives as they are created, without the need to 
go back and “tweak” your display pages to get the various figures into alignment. 

In the Smart Align example shown below, a newly-created ellipse is being aligned with two 
existing rectangles. Guidelines are present at both the edges of the figures, and at the center, 
showing that both the edges and the centers are aligned. The red rectangle is highlighting the 
newly-created primitive, while the blue rectangles are highlighting the primitives to which the 
guidelines have been drawn. 

 

Smart Align is also enabled when primitives are moved or re-sized. 

KEYBOARD OPTIONS 

While creating a display primitive, the following keyboard options are available… 

• Holding down the Shift key while dragging-out the primitive will cause the 
primitive to be drawn such that it is centered on the initial mouse position, with 
one of its corners defined by the current mouse position. (If this doesn’t make 
sense, go ahead and try it—it’s a lot easier to see than it is to explain!) This is 
useful for drawing symmetrical figures centered on an initial point. 

• Holding down the Ctrl key while dragging-out the primitive will keep its 
horizontal and vertical sizes the same. This is useful when you want to be sure 
that you draw an exact circle or square using the ellipse or rectangle primitives. 

These options are also active when primitives are re-sized. 

LOCK INSERT MODE 

The padlock icon on the drawing toolbox can be used to add a number of primitives of the 
same basic type without having to click the toolbox icon for each item in turn. To cancel lock 
mode, click the padlock icon again, or press the Escape key. The same operation can be 
performed by using the Lock Mode command on the Insert menu. 

SELECTING PRIMITIVES 

To select a display primitive, simply move your mouse pointer over the primitive in question, 
and perform a left-click. You will notice that while your pointer is hovering over a primitive, 
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a bounding rectangle is drawn in blue to help show what will be selected. When the actual 
selection is performed, the rectangle will change to red, and handles will appear, so as to 
allow you to re-size the primitive as required. If you find that the primitive you want to select 
is hidden below another primitive, press the Alt key to allow the selection to be made. 

To select several primitives, either drag-out a selection rectangle around the primitives you 
want to select, or select each primitive in turn, holding down the Shift key to indicate that 
you want each primitive to be added to the selection. If multiple primitives are selected, the 
red rectangle will surround all of the primitives, and the handles can then be used to resize the 
primitives as a group. The relative size and position of the primitives will be maintained, as 
long as MonicoView can do so without violating minimum size requirements. 

MOVING AND RESIZING 

Primitives can be moved by first selecting them, and then by dragging them to the required 
position on the display page. If Smart Align is turned on, guidelines will appear to help you 
align the primitives with other items on the page. Holding down Ctrl while moving a 
primitive will leave a copy of the primitive in its original position, thereby allowing 
duplicates to be created. You can also use the cursor keys to “nudge” the current selection a 
single pixel in the required direction. Holding down Ctrl while nudging will increase the 
movement of the primitives by a factor of eight. 

Primitives can be resized by selecting them, and then by dragging the appropriate handle to 
the required position. Once again, if Smart Align is turned on, guidelines will appear to help 
you align the primitives with other items on the page. The Shift and Ctrl keys can be used 
to modify the resize behavior as described in the Adding Display Primitives section. Note that 
MonicoView will always constrain resizing operations so as to ensure that primitives stay on 
the screen, and to make sure that items do not exceed their maximum permitted size, or shrink 
below the minimum size appropriate to their format. 

REORDERING PRIMITIVES 

Primitives on a display page are stored in what is known as a z-order. This defines the 
sequence in which the primitives are drawn, and therefore whether or not a given primitive 
appears to be in front of or behind another primitive. In the first example below, the hatched 
square is shown behind the solid squares ie. at the bottom of the z-order. In the second 
example, it has been moved to the front of the order, and appears in front of the other figures. 

    

To move items in the z-order, select the items, and then use the various commands on the 
Arrange menu. The Move Forward and Move Backward commands move the selection one 
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step in the indicated direction, while the Move To Front and Move To Back commands move 
the selection to the indicated end of the z-order. Alternatively, if you have a mouse that is 
equipped with a wheel, the wheel can be used to move the selection. Scrolling up moves the 
selection to the back of the z-order; scrolling down moves the selection to the front. 

EDITING PRIMITIVES 

In addition to the above, primitives can be edited in various ways… 

• The various clipboard commands on the Edit menu (eg. Cut, Copy and Paste), or 
the corresponding toolbar icons, can be used to duplicate items or move them 
around on a page or between pages. The Duplicate command can be used to 
perform a Copy operation, immediately followed by a Paste operation. Note that 
when a Paste is performed, MonicoView will offset the newly-pasted item if it 
will exactly overlay an item of the same type. 

• The various formatting properties (eg. fill pattern, outline color, text justification 
and so on) can be changed by selecting a primitive, and then either clicking the 
various buttons in the appropriate toolboxes or by using the associated 
commands on the Format menu. If multiple primitives have been selected, 
MonicoView will apply the changes to all selected primitives. 

• The more detailed properties of a primitive can be edited by double-clicking the 
primitive, or by using the Properties command on the Edit menu. A dialog box 
will be displayed, allowing all of the primitives to be accessed. The properties 
associated with each primitive will be described below. 

PRIMITIVE DESCRIPTIONS 

The sections below describe each primitive found in the drawing toolbox. 

THE LINE PRIMITIVE 

 

The Line primitive is a line drawn between two points. Its only property is the 
style of line to be used. In addition to the solid colors shown on the line toolbox, a 
number of dotted styles can also be accessed via the properties dialog box. 

 

THE SIMPLE GEOMETRIC PRIMITIVES 

 

The Rectangle primitive is a rectangle with a defined outline and fill pattern. The 
fill pattern may be set to No Fill to draw the outline alone, or the outline may be 
set to None to draw a figure without a border. 

 

The Round Rectangle primitive is similar to the rectangle, but has rounded 
corners. When the primitive is selected, an additional handle appears, allowing 
the radius of the corners to be edited by dragging the handle from side to side. 

 

The Shadow primitive is similar to the rectangle, but with a drop-shadow located 
to the bottom right of the figure. The primitive is often drawn with no fill pattern, 
so as to allow it to act as a frame around text primitives. 
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The Wedge primitive is a right-angled triangle located within one quadrant of a 
bounding rectangle. In addition to the outline and fill properties, the wedge has a 
property to indicate which quadrant it should occupy. 

 

The Ellipse primitive is an ellipse with a defined outline and fill pattern. The fill 
pattern may be set to No Fill to draw the outline alone, or the outline may be set 
to None to draw a figure without a border. 

 

The Ellipse Quadrant primitive is one quadrant of an ellipse. In addition to the 
outline and fill properties, the ellipse quadrant has a property to indicate which 
quadrant it should occupy. 

 

The Ellipse Half primitive is one half of an ellipse. In addition to the outline and 
fill properties, the ellipse half has a property to indicate which of the four 
possible halves (think about it!) will be drawn. 

 

The properties for these primitives need little further explanation, other than to point out that 
the quadrant or half rendered by the Wedge, Ellipse Quadrant or Ellipse Half primitives can 
also be edited via the command found on the Transform menu. 

THE TANK PRIMITIVES 

 

The Conical Tank primitive is a conical tank with a defined outline and fill 
pattern. When the primitive is selected, additional handles appear, allowing the 
exact shape of the tank to be modified by dragging the handles as required. 

 

The Round Bottomed Tank primitive is a tank with a defined outline and fill 
pattern. When the primitive is selected, an additional handle appears, allowing the 
exact shape of the tank to be modified by dragging the handle as required. 

 

The properties for these primitives need little further explanation. 

THE SIMPLE BAR-GRAPH PRIMITIVES 

 

The Simple Vertical Bar primitive allows an expression to be drawn as a vertical 
bar-graph between specified minimum and maximum values. An additional 
property allows the primitive’s border to be displayed or hidden. 

 

The Simple Horizontal Bar primitive allows an expression to be drawn as a 
horizontal bar-graph between specified minimum and maximum values. An 
additional property allows the primitive’s border to be displayed or hidden. 
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The properties are accessed by double-clicking the primitive… 

 

• The Value property is used to specify the value to be displayed. In the example 
given above, the primitive is configured to display the level of a tank. 

• The Minimum and Maximum properties are used to specify the range of values to 
be shown. In the example above, a range of 0 to 1000 is specified. 

• The Show Border property is used to display or hide the primitive’s border. 

THE FIXED TEXT PRIMITIVE 

 

The Fixed Text primitive is used to add unchanging text to a page. The text is 
displayed in a specified font and color, and with a specified justification. The text 
can also be translated for international applications. 

 

When the text is created, a cursor will appear, allowing the text to be entered… 
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Only the US English text can be edited directly. The international versions of the text must be 
edited via the properties dialog box, which is accessed by selecting the primitive and pressing 
Alt+Enter, or by selecting the Properties command from the Edit menu… 

 

• The Text property is used to specify the text to be displayed. As mentioned 
above, the US English version of the text can also be edited directly on the 
display page when the primitive is created, or by clicking an existing primitive. 

• The Font property is used to specify the font to be used. This property can also 
be edited by using the font button on the toolbar, or by using the Format menu. 

• The Foreground and Background properties are used to specify the colors to be 
used to draw the text. Obviously, having the same color for both settings will 
render the text unreadable. Selecting None for the background will create 
transparent text, allowing underlying primitives to be seen through the letters. 

• The Horizontal and Vertical justification properties are used to indicate where 
the text should be placed within the bounding rectangle of the primitive. These 
properties can also be edited via the associated toolbox, or via the Format menu. 

THE AUTO TAG PRIMITIVE 

 

The Auto Tag primitive allows you to select a tag, and then automatically place 
the appropriate text primitive on the display. For example, selecting an integer tag 
will allow insertion of an appropriately-configured integer text primitive. 

 

This is the icon you will use most often for adding tags to a page. It first displays the dialog 
box shown below to allow tag selection, and then creates one of the five tag text primitives 
described in the next section. The new primitive will be configured so as to display the tag in 
question using its label and its formatting properties, as defined when the tag was created. 



PRIMITIVE DESCRIPTIONS CRIMSON USER MANUAL 

PAGE 100 www.monicoinc.com/support 

 

THE TAG TEXT PRIMITIVES 

The tag text primitives are used to display or edit an expression in textual form. Primarily, 
they are used to display tags, in which case the default format is taken from the Format tab 
associated with that tag in the Data Tags window. If a non-tag expression is entered—or if 
you want the formatting to differ from the default values for a tag—the format data can be 
overridden as required. There is one type of tag text for each tag family… 

 

The Flag Text primitive is used to display a true or false condition. 

 

The Integer Text primitive is used to display an integer expression. 

 

The Real Text primitive is used to display a floating-point expression. 

 

The Multi Text primitive is used to display a multi-state condition. 

 

The String Text primitive is used to display a string expression. 

 

The properties of a tag text primitive are displayed using two tabbed pages. 
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The first page is more-or-less the same for all five primitive types… 

 

• The Value property is used to indicate from where the data for this primitive 
should be obtained. You may select a tag, a register in a communications device, 
or an expression that combines a number of such items. The data type of the item 
must be appropriate to the primitive in question eg. the Value property for an 
integer text primitive cannot be set equal to a string expression. 

• The Data Entry property is used to indicate whether or not you want the user of 
the operator interface panel to be able to change the underlying value via this 
primitive. For data entry to be enabled, the expression entered for the value 
property must be capable of being changed. For example, if a formula is entered, 
data entry will not be permitted. 

• The Show Label property is used to indicate whether or not you want the 
primitive to include a label to identify the data being displayed. If this property is 
set to yes, the label will be left-justified within the primitive’s bounding 
rectangle, while the data itself will be right-justified. If this property is set to no, 
the Horizontal Justification property will be used to locate the data within the 
field. Note that this property can be edited via the Field Label commands on the 
Format menu. When no primitive is selected, these commands can also be used 
to set the default value for newly-created primitives. 

• The Get Label property is used to indicate from where the label text should be 
obtained. The options presented depend on what was entered for the value 
property. If a tag has been selected, you will be given the option of using the 
tag’s default label, or entering a new label on the Format tab of the dialog box. If 
something else has been selected, you will only have the second option. 

• The Get Format property is used to indicate from where the formatting 
information for this primitive should be obtained. The options presented depend 
on what was entered for the value property. If a tag of the correct data type has 
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been selected, you will be given the option of using the tag’s default formatting, 
or entering modified information on the Format tab of the dialog box. If 
something else has been selected, you will only have the second option. 

• The Flash on Alarm property is used to indicate whether or not you want the text 
on the G3’s display to flash if the tag entered in the value property is currently in 
an alarm state. This property is not available for string text primitives, or for 
those primitives that have a non-tag value defined for the value property. 

• The balance of the properties control the font, colors and justification to be used 
when drawing the primitive. These properties require no further explanation. 

The second page varies according to the primitive in question, and displays the same 
information as the Format tab of the associated tag type. Different sections of the page will be 
enabled according to the settings provided for the Get Label and Get Format properties. The 
example below shows the Format tab for an integer text primitive… 

 

As can be seen, the properties shown are indeed identical to those shown on the Format tab of 
an integer tag. As mentioned above, the properties for the other types of primitive are 
similarly identical to those of the corresponding tag. You are thus referred to the earlier 
section of the manual regarding Data Tags for more information on each property. 

EDITING THE UNDERLYING TAG 

If you want to edit a tag text primitive’s properties, either double-click on the primitive, or 
right-click and select the Properties command from the resulting menu. If, however, you want 
to edit the properties of the tag that is being used to control the primitive, right-click and 
select the Tag Details command instead. The resulting dialog box will show the Data and 
Format tab from the Data Tags window, and allow you to change the various properties. Note 
that a change made via this mechanism will change all the primitives controlled by that tag if 
those primitives have the Get Label or Get Format properties set to From Tag Properties. 
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THE TIME AND DATE PRIMITIVE 

 

The Time and Date primitive is used to display the current time and date, or to 
display the contents of a time and date expression. It can also be used to edit such 
an expression, or to set the operator panel’s real time clock. 

 

The properties of a time and date primitive are displayed using two tabbed pages. 

The first page is shown below… 

 

• The Value property is used to indicate the time and date value to be displayed. If 
no value is entered, the current time and date is shown. If an expression is 
entered, it is taken to represent the number of seconds that have elapsed since 1st 
January 1997. Such values are typically obtained using the various time and date 
functions described in the Function Reference. 

• The Data Entry property is used to indicate whether or not you want the user of 
the operator interface panel to be able to change the underlying value via this 
primitive. If no value property has been defined, this amounts to changing the 
current time or date. If a value property has been entered, the expression entered 
must be capable of being changed. For example, if a formula is entered, data 
entry will not be permitted. 

• The balance of the properties are as described for tag text primitives. (While it 
may look odd to have Get Label and Flash On Alarm properties, remember that 
the value property may be a tag, and so MonicoView does have access to the tag 
label and to the tag’s alarm state, should you decide to use them.) 
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The second tab is shown below… 

 

• The Label Text property is used to define an optional label for the primitive. 

• The Field Type property is used to indicate whether the field should display the 
time, the date or both. In the last case, this property also indicates in which order 
the two elements should be shown. 

• The Time Format property is used to indicate whether 12-hour (civil) or 24-hour 
(military) time format should be used. As with other properties, leaving this set 
to Locale Default will allow MonicoView to pick a suitable format according to 
the language selected within the operator panel. 

• The AM Suffix and PM Suffix properties are used with 12-hour mode to indicate 
the text to be appended to the time field in the morning and afternoon as 
appropriate. If you leave the property undefined, MonicoView will use a default. 

• The Show Seconds property is used to indicate whether the time field should 
include the seconds, or whether it should just comprise hours and minutes. 

• The Date Format property is used to indicate the order in which the various date 
elements (ie. date, month and year) should be displayed. 

• The Show Month property is used to indicate whether the month should be 
displayed as digits (ie. 01 through 12) or as its short name (ie. Jan though Dec). 

• The Show Year property is used to indicate whether the date field should include 
the year, and if so, how many digits should be shown for that element. 

THE RICH BAR-GRAPH PRIMITIVES 

 

The Rich Vertical Bar primitive allows you to display a more complex bar-graph 
which includes a label, a numeric version of the data being displayed, and tick 
markers to indicate any associated setpoint. 
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The Rich Horizontal Bar primitive allows you to display a more complex bar-
graph which includes a label, a numeric version of the data being displayed, and 
tick markers to indicate any associated setpoint. 

 

The operation of these rich primitives is analogous to that of the various tag text primitives, in 
that they are capable of deriving much of the required formatting information from the tag 
used as their controlling value. Just as with tag text primitives, two tabbed pages are used to 
edit the primitives’ properties. The first of these pages is shown below… 

 

• The Value property is used to define the value to be displayed. 

• The Show Label property is used to indicate whether a label should be included 
with the bar-graph. For vertical graphs, the label is included at the bottom; for 
horizontal graphs, it is included at the left-hand side. If a tag is used for the value 
property, the label may be obtained from that tag. Otherwise, it must be entered 
on the Format tab of the dialog box. 

• The Show Value property is used to indicate whether the value of the data should 
be displayed within the graph itself. If a tag of the appropriate data type is used 
for the value property, the format may be obtained from the tag. Otherwise, as 
with the label, it must be entered on the Format tab. 

• The Show Setpoint property is used to indicate whether tick marks should be 
added either side of the bar to indicate the setpoint for the controlling value. This 
option is only available if a tag has been entered for the value field. 

• The Get Label and Get Format properties are as defined for the various tag text 
primitives. The format is not required if the show value property is set to No. 

• The Fill property is used to indicate the pattern to be used for the active portion 
of the bar. If you find that your bar-graph does not appear to work, make sure 
you have not left this property set to None! 
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• The Font property is used to indicate the font to be used to display the value 
embedded in the graph, if such a value is enabled via the Show Value property. 

The second page contains the label and formatting information for the field... 

 

The properties shown are as described for an integer tag, and you are thus referred to the 
earlier section of the manual that refers to Data Tags for more information. Note that the 
existence of this primitive explains why one must enter minimum and maximum values for 
formulae, when such tags can never be the subject of data entry. If such limits were not 
defined, how would MonicoView know how to scale the bar? 

THE SYSTEM PRIMITIVES 

 

The Alarm Viewer primitive is used to provide the operator with a method to 
view and accept active alarms. It will always take up the whole of the display 
width, but can be restricted to less than the full height if required. 

 

The Alarm Ticker primitive scrolls through the active alarms in the system. It 
takes up a single line, and the whole of the display width. It does not allow the 
operator to accept the alarms. 

 

The Event Viewer primitive is used to provide the operator with a method to view 
the events recorded in the system’s event log. It will always take up the whole of 
the display width, but can be restricted to less than the full height if required. 

 

If you use manual-accept alarms in your system, you should provide a page that contains an 
alarm viewer to make sure the operator can accept these alarms. You may also wish to add the 
alarm ticker to other pages to make the operator aware of alarms while they are viewing other 
pages. Similarly, if you use events, you should provide a page that contains an event viewer 
to allow the operator to see what events have occurred. 
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DEFINING PAGE PROPERTIES 

Each page has a number of properties that can be accessed via the Page menu… 

 

• The On Select and On Remove properties are used to define actions to be 
performed when the page is first selected for display, or when the page is 
removed from the display. Refer to the Writing Actions section and the Function 
Reference for a list of supported actions. Refer to the Data Availability section in 
this chapter for details of a timeout than can occur when using these properties. 

• The On Tick property is used to define an action that will run every second 
during the period for which this page is displayed. Refer to the Writing Actions 
section and the Function Reference for a list of supported actions. If a lack of 
data availability results in this action being unable to execute, it will be skipped 
and retried one second later. 

• The Period is the time in seconds to wait before performing the action specified. 

• On Timeout is the action to be performed when the period of time has expired. 

• The Parent Page property is used to indicate the page to be displayed when the 
panel’s Exit key is pressed while this page is active. Selection of this page can 
be overridden using the techniques below. 

• The Next Page property is used to indicate the page to be displayed when the 
panel’s Next key is pressed while this page is active, and when the cursor is on 
the last data entry field on the page. This selection can also be overridden. 

• The Previous Page property is used to indicate the page to be displayed when the 
panel’s Prev key is pressed while this page is active, and when the cursor is on 
the first data entry field on the page. This selection can also be overridden. 

If you have too many data entry fields to fit on a single page, the Next Page and Previous 
Page properties can be used to link together a series of pages to allow the operator to edit the 
fields in sequence. MonicoView will automatically position the cursor appropriately, such 
that if the Prev key is pressed on the first field of a page, the previous page will be activated 
with the cursor on the last field of that page. 

• The Entry Order property is used to define how the cursor on the operator panel 
will move between data entry fields. The settings determine whether fields 
organized in a grid will be entered in row or column order. 
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• The Update Rate property is used to define how frequently items on the display 
are updated. As update rates increase in frequency, overall performance of the 
operator interface panel may decrease. This selection should be left at the default 
setting when possible. 

DEFINING SYSTEM ACTIONS 

In addition to the various actions that can be defined via page properties, MonicoView gives 
you the ability to define an action to be run when the system first starts, and an action to be 
run once a second, no matter which page is displayed. These actions can be accessed by 
selecting the Pages icon in the left-hand pane of the User Interface window. 

DEFINING KEY BEHAVIOR 

The previous sections have provided a detailed description of how to use the G3’s display to 
get information to the operator. All that remains to complete the User Interface configuration 
is to define how the operator is to use the G3’s keyboard to interact with the system. 

To define the actions to be performed by a key, select a zoom level that allows you to see the 
key in question. For example, if you want to configure one of the function keys, select zoom 
level one or two as appropriate. Then, double-click the key to display the following… 

 

You will note that this dialog box has two tabbed pages. The first page is used to define what 
will happen when the key in question is pressed when the current page is selected. The second 
page is used to define what will happen if the key is pressed when any page is selected. The 
first type of action is called a local action, while the second type is called a global action. The 
color used to display the key will change according to which actions are defined… 

 
If the key is displayed in PURPLE, a local action is defined for this PAGE. 

 
If the key is displayed in GREEN, a GLOBAL action is defined. 
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If the key is displayed in BLUE, local and global actions are BOTH defined. 

 

Once you have defined an action, you can right-click on the key and use the resulting menu to 
select either Make Global or Make Local to change the action type. These options will not be 
available if both types of action have already been defined. 

ENABLING ACTIONS 

If you want to make a particular action dependent on some condition being true, enter an 
expression for that condition in the Enable field for the action in question. This expression 
may reference a flag tag directly, or may use any of the comparison or logical operators 
defined in the Writing Expressions section. If you need more complex logic such that one of 
several actions is performed based on more complex decision-making, configure the key in 
user defined mode and use it to invoke a program that implements the required logic. 

ACTION DESCRIPTIONS 

The sections below describe each available type of action. When each type is selected, the 
Action Details portion of the action dialog box will change to show the available options. 

THE GOTO PAGE ACTION 

This action is used to instruct the G3 to show a new page. The options are shown below… 

 

• The Target Page property is used to indicate which page should be displayed. 
You can either choose a specific one to be displayed, or choose Previous Page to 
return to what was displayed before the current page was called. 

• The Show As Popup selection causes the target page to be displayed as a popup 
on top of the current page. While the popup is displayed, the panel keys will 
assume the definitions established for that page, with the exception of the exit 
key. The exit key is used to remove the popup from the display. 
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THE PUSH BUTTON ACTION 

This action is used to emulate a pushbutton. The options are shown below… 

 

• The Button Type property is used to define the key’s behavior. 
 

BUTTON TYPE THE BUTTON WILL… 

Toggle Change the data state when the key is pressed. 

Momentary Set the data to 1 when the key is pressed. 
Set the data to 0 when the key is released. 

Turn On Set the data to 1 when the key is pressed. 

Turn Off Set the data to 0 when the key is pressed. 
 

• The Button Data property is used to define the data to be changed by the key. 

In the example above, the key will toggle the value of the Output tag. 

THE CHANGE INTEGER VALUE ACTION 

This action is used to write an integer value to a data item. The options are shown below… 
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• The Write To property is used to define the data item to be changed. 

• The Data property is used to define the data to be written. 

In the example above, the key will set the MotorSpeed tag to 100. 

THE RAMP INTEGER VALUE ACTION 

This action is used to increase or decrease a data item. The options are shown below… 

 

• The Write To property is used to define the data item to be changed. 

• The Data property is used to define the step by which to raise or lower the item. 

• The Limit property is used to define the minimum or maximum data value. 

• The Ramp Mode property is used to define whether to raise or lower the item. 

In the example above, holding the key will raise MotorSpeed by 1 until it reaches 100. 

THE PLAY TUNE ACTION 

This action plays a selected tune using the G3’s internal sounder. 
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• Tune Name selects the tune to be played. 

Customized tunes may be played using the PlayRTTTL() function. 

THE USER DEFINED ACTION 

This action is used to do anything else you desire! The options are shown below… 

 

• The On Pressed property is used to define the action to be performed when the 
key is pressed. This action may invoke any of the functions from the Function 
Reference or the data modification operators described in the Writing Actions 
section, or it may run a program. 

• The On Auto-Repeat property is used to define the action to be performed when 
the key is pressed and then held down. The action occurs both on the initial 
depression and on subsequent auto-repeats, so there is no need to define both this 
property and On Pressed. This action may invoke any of the functions from the 
Function Reference or the data modification operators described in the Writing 
Actions section, or it may run a program. 

• The On Released property is used to define the action to be performed when the 
key is released. This action may invoke any of the functions from the Function 
Reference or the data modification operators described in the Writing Actions 
section, or it may run a program. 

In the example above, a user defined action is used to implement a momentary pushbutton. 

BLOCK DEFAULT ACTION 

This action does not actually do anything, but can be used as a place-holder to prevent further 
processing. As an example, suppose you have configured F1 to perform a global action, but 
want to prevent this action from being invoked on a particular page. By configuring F1 on 
that page as Block Default Action, the global action will not occur. 
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CHANGING THE LANGUAGE 

To configure a key to change the language displayed by the operator panel, select User 
Defined mode and enter SetLanguage(n) as the On Pressed property, where n is a number 
between 1 and 8, according to the language to be displayed. The display page will be redrawn 
in the selected language, with any text for which translations have been entered—including 
fixed text, tag labels and tag formatting information—adjusted as appropriate. Pages that are 
subsequently displayed will also be drawn in the selected language. 

ADVANCED TOPICS 

The following sections deal with more advanced issues relating to keyboard actions. 

ACTION PROCESSING 

When a key is pressed or released, MonicoView goes through a defined sequence when 
deciding what to do with the event. If any stage results in some action being performed, the 
sequence is stopped, and the later stages do not get a chance to process the key. 

The sequence is as follows… 

1. If a display primitive is selected for user interaction, it is given a chance to 
process the key. Active data entry fields will consume the Raise, Lower, Exit 
and Enter

2. If a display primitive is selected for user interaction and the Next or Prev keys 
are pressed, MonicoView will attempt to find the next or previous display 
primitive that also desires user interaction. If any such field exists, the key will 
be consumed, and that primitive will be activated. 

 keys, plus whatever other keys are appropriate to the operation being 
performed. For example, integer entry fields will also consume the numeric keys. 

3. If a local action is defined, the action is performed and the key consumed. 

4. If a global action is defined, the action is performed and the key consumed. 

5. If the key remains unconsumed, the default actions are implemented… 
 

EVENT ACTION 

Next Displays the page’s Next Page, if one is defined.  Key Pressed 

Prev Displays the page’s Previous Page, if one is defined.  Key Pressed 

Exit Displays the page’s Parent Page, if one is defined.  Key Pressed 

Menu Displays the fist page in the page list.  Key Pressed 

Mute Silences the G3’s internal alarm sounder.  Key Pressed 
 

As mentioned above, configuring a key for any global or local action—even one that does 
nothing, such as Block Default Action—prevents this sequence from proceeding. It should be 
obvious, then, why such an action is useful, even though at first sight it serves no purpose! 
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DATA AVAILABILITY 

MonicoView’s communications infrastructure reads only those data items that are required 
for the current page. This means that when a page is first selected, certain data items may not 
be available. For a display primitive, this is no problem, as the primitive simply displays an 
undefined state (typically a number of dashes) until the data becomes available. For actions, 
though, things can get more complex. 

For example, suppose a local action increases the speed of a motor by 50 rpm. If the motor 
speed is not referenced on the previously displayed page, then, when the page is first 
displayed, MonicoView will not know the current speed, and will thus be unable to write the 
new value. To handle this, if the operator attempts to perform an action for which the required 
data is not available, the G3 panel will display a “NOT READY” message until the key in 
question is released. The operator must then wait a short while, and try the operation again. In 
practice, communications updates normally take place quickly enough that even the most 
nimble-fingered operator will be hard pressed to get the message to appear, but since it may 
on occasions be seen, it is worth explaining. 

A slightly more complex issue comes about if the action defined by a page’s On Select 
property is unable to proceed because it also finds that required data is not available. Here, 
MonicoView will wait up to thirty seconds for the data to arrive. If it does not, the action will 
not be performed, and a “TIMEOUT” message will be displayed for the operator. This 
timeout mechanism is required to avoid problems should a communications link become 
severed. 

NOTES FOR EDICT USERS 

Users of Monico’s Edict-97 software should note… 

• Pages no longer have text and graphic layers, as all primitives are graphical in 
nature. This means that the concept of a page format is similarly redundant. 

• Page categories have been replaced with system primitives. Where Edict would 
use an entire page for its alarm viewer, for example, the corresponding system 
primitive can be used to allocate as little or as much of the display as is required. 

• The actions defined by double-clicking a key replace the global and local event 
maps. If your application used more than one row per event, you will most likely 
need to use a program to implement the required logic. 

• Events such as comms update complete and one second tick have been removed, 
as most of the actions performed by such events can now be handled via other 
mechanisms. For example, comms update complete was often used to move data 
between devices. This can now be performed using the protocol conversion 
functionality of the Communications window. Also, these events were often 
misused and lead to the creation of overly complex databases. 

• While Edict would typically manage something between two and five display 
updates per second, MonicoView is designed to redraw the display every 
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100msec, thus providing, for example, smoother operator feedback during data 
entry. 
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CONFIGURING A COLOR USER INTERFACE 
Now that you have configured your communications options, and created data tags for the 
various items that you wish to display, you can create display pages to allow the user to view 
or edit these data items. These pages are manipulated by selecting the User Interface icon 
from the main screen. Please note that this chapter refers specifically to color operator panels 
such as the G306. If you are using a G303 operator panel with a monochrome display, please 
refer to the previous chapter for configuration details. 

CONTROLLING THE VIEW 

By default, the User Interface window attempts to show the entire front panel of the operator 
panel, including the display and all the available keys. In many cases, this will not allocate 
enough screen space for the display to be edited, so you will probably want to use one of the 
other zoom levels as shown below… 

      

      

As you can see, at each level, fewer keys are shown, and more of the window is allocated to 
the display itself. The panel view level can be controlled from the View > Panel menu, or by 
using the panel icon , or by pressing the Alt key together with the digits 1 through 4. 

ZOOM FUNCTION 

In addition to the panel views, a zoom is available to help graphic designs. Zooming in and 
out can be achieved from the View > Zoom menu, or by using the magnifying glass icon , 
or by rolling your mouse wheel up or down. 

The Zoom will center on the mouse cursor so you can control which area of the screen you 
are zooming to. There are four levels of zoom. The highest level would give the following 
screen for the above database. 
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Due to screen resolution and panel size, it might not be possible to visualize the entire screen 
design even when zoomed out. It is possible however to get this view using the View > Panel 
> Show All Screen menu. This menu is only available when the Panel is NOT in display only 
mode. Edition of the screen however will not be available in this mode since the screen 
resolution is too small for accurate drawings. 

  

OTHER VIEW OPTIONS 

As well as controlling the zoom, the View menu contains the following options… 

• The Page List command can be used to show or hide the left-hand pane of the 
User Interface window. If the page list is disabled, even more space is made 
available for editing the display. The F4 key toggles the page list on and off. 

• The Hold Aspect command can be used to control whether or not MonicoView 
attempts to maintain the aspect ratio of the display. If aspect holding is enabled, 
a figure that would appear as, say, a circle on the G303 will appear as a perfect 
circle on your PC. If this mode is not selected, MonicoView can expand the 
display page to use more of the PC’s screen, but at the expense of some 
distortion. 

Other options are available during page editing, and are described below. 

USING THE PAGE LIST 

To create, rename or delete display pages, click on the left-hand pane of the User Interface 
window. The various commands on the Page menu can then be used to make the desired 
changes. Alternatively, right-click on the required display page, and select from the menu. 
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To select a page, either click on the page in the page list, or use the up and down arrows in the 
toolbar. Alternatively, you can use the Alt+Left and Alt+Right key combinations to move 
up and down the list as required. These keys will work no matter which pane is selected. 

WORKING WITH THE GRID 

The Show Grid command on the View menu can be used to show or hide an eight-pixel grid 
that is useful for aligning objects. Every eighth column of the grid is shown in a brighter 
color, as is every sixth row. Various drawing operations may be configured so as to “snap” to 
the grid points whether or not the grid is shown,. The three separate actions of creating 
objects, moving objects and sizing objects may be controlled individually, or the Snap for All 
or Snap for None commands may be used to control all three actions at once. 

THE DRAWING TOOLBOX 

To edit the contents of a display page, first select the page as described 
above. Then, click on the rectangle that represents the G3’s display. A 
white rectangle will appear around the display to indicate that it has 
been selected, and the drawing toolbox will appear. 

This toolbox is used to add various elements, known as primitives, to 
the display page. The first two icons control the insertion mode, while 
the balance of the icons represent individual primitives. The primitives 
shown in yellow are basic geometric and animation items, while the 
ones shown in green are rich primitives that use formatting and other 
information from a data tag to control their operation. The primitives 
shown in red are system items, such as the active alarm viewer. 
Primitives shown in blue are typically enhanced versions of other 
primitives that were added to the software more recently. 

All of the commands contained in the toolbox can also be accessed via the Insert menu. 
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ADDING DISPLAY PRIMITIVES 

To add a display primitive to a page, click on the required icon in the drawing toolbox, or 
select the required option from the Insert menu. The mouse cursor will change to an arrow 
with a crosshair at its base, and you will then be able to drag-out the required position of the 
primitive within the display window… 

 

SMART ALIGNMENT 

If you have the Smart Align features of the View menu enabled, MonicoView will provide 
you with guidelines to help align a new primitive with existing primitives, or with the center 
of the display. In the example shown above, the horizontal dotted line indicates that the center 
of the tank primitive is vertically aligned with the center of the display. With a little practice, 
this feature can make it very easy to align primitives as they are created, without the need to 
go back and “tweak” your display pages to get the various figures into alignment. 

In the example shown below, a newly-created ellipse is being aligned with two rectangles… 

 

Guidelines are present at both the edges of the figures, and at the center, showing that both 
the edges and the centers are aligned. The red rectangle is highlighting the newly-created 
primitive, while the blue rectangles are highlighting the primitives to which the guidelines 
have been drawn. Smart Align is also enabled when primitives are moved or re-sized. 
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KEYBOARD OPTIONS 

While creating a display primitive, the following keyboard options are available… 

• Holding down the Shift key while dragging-out the primitive will cause the 
primitive to be drawn such that it is centered on the initial mouse position, with 
one of its corners defined by the current mouse position. (If this doesn’t make 
sense, go ahead and try it—it’s a lot easier to see than it is to explain!) This is 
useful for drawing symmetrical figures centered on an initial point. 

• Holding down the Ctrl key while dragging-out the primitive will keep its 
horizontal and vertical sizes the same. This is useful when you want to be sure 
that you draw an exact circle or square using the ellipse or rectangle primitives. 

These options are also active when primitives are re-sized. 

LOCK INSERT MODE 

The padlock icon on the drawing toolbox can be used to add a number of primitives of the 
same basic type without having to click the toolbox icon for each item in turn. To cancel lock 
mode, click the padlock icon again, or press the Escape key. The same operation can be 
performed by using the Lock Mode command on the Insert menu. 

USING THE IMAGE LIBRARY 

To add an image from MonicoView’s extensive image library, click on the “book” icon in the 
toolbar, or select the Picture / Image command from the Insert menu. The image library will 
open at the last-accessed page, allowing an image to be selected… 

 

Double-click on an image to select, and then drag-out the required size of the image as you 
would when inserting any other kind of primitive. The software will automatically create a 
Picture primitive containing the selected image. You should refer to the later sections of this 
manual for details on how this primitive might be further manipulated. 
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SELECTING PRIMITIVES 

To select a display primitive, simply move your mouse pointer over the primitive in question, 
and perform a left-click. You will notice that while your pointer is hovering over a primitive, 
a bounding rectangle is drawn in blue to help show what will be selected. When the actual 
selection is performed, the rectangle will change to red, and handles will appear, so as to 
allow you to re-size the primitive as required. If you find that the primitive you want to select 
is hidden below another primitive, press the Alt key to allow the selection to be made. 

To select several primitives, either drag-out a selection rectangle around the primitives you 
want to select, or select each primitive in turn, holding down the Shift key to indicate that 
you want each primitive to be added to the selection. If multiple primitives are selected, the 
red rectangle will surround all of the primitives, and the handles can then be used to resize the 
primitives as a group. The relative size and position of the primitives will be maintained, as 
long as MonicoView can do so without violating minimum size requirements. 

MOVING AND RESIZING 

Primitives can be moved by first selecting them, and then by dragging them to the required 
position on the display page. If Smart Align is turned on, guidelines will appear to help you 
align the primitives with other items on the page. Holding down Ctrl while moving a 
primitive will leave a copy of the primitive in its original position, thereby allowing 
duplicates to be created. You can also use the cursor keys to “nudge” the current selection a 
single pixel in the required direction. Holding down Ctrl while nudging will increase the 
movement of the primitives by a factor of eight. 

Primitives can be resized by selecting them, and then by dragging the appropriate handle to 
the required position. Once again, if Smart Align is turned on, guidelines will appear to help 
you align the primitives with other items on the page. The Shift and Ctrl keys can be used 
to modify the resize behavior as described in the Adding Display Primitives section. Note that 
MonicoView will always constrain resizing operations so as to ensure that primitives stay on 
the screen, and to make sure that items do not exceed their maximum permitted size, or shrink 
below the minimum size appropriate to their format. 
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ALIGNING PRIMITIVES 

While the Smart Alignment options discussed above allow many alignment operations to be 
performed by hand, there are times that you will want the software to perform the alignment 
for you. This can be done by selecting a number of primitives, starting with the primitive that 
you wish to use as the reference point for the alignment operation. Note that the reference 
primitive is always shown with a double-square at its center. Once you have made your 
selection, use the Align command on the Arrange menu to display the following dialog box… 

 

The Horizontal and Vertical settings can be used to indicate what type of alignment is to be 
performed, while the Operation setting indicates whether the primitives should be resized or 
moved to achieve the desired result. 

As an example, in Move mode, selecting Left for Horizontal will align the left-hand edges of 
all the primitives with the left-hand edge of the reference primitive. Similarly, selecting 
Middle for vertical will align the primitives so that the horizontal line through the center of 
each are aligned with the same line through the center of the reference primitive. 

In Size mode, the edge-alignment operations work by growing the non-reference primitives in 
order to achieve the desired results, while the center-alignment operations work by changing 
the height or width of the primitives to make them match the reference primitive. You may 
want to experiment with Size mode to get a better idea of its operation. 

SPACING PRIMITIVES 

If you have a number of primitives that you wish to space equally on the page, you may use 
the Space Equally Vertical or Space Equally Horizontal commands on the Arrange menu. The 
commands work on the currently selected primitives, and attempt to reallocate the free space 
between the items to achieve equal spacing. The two outer primitives will be left in their 
current positions. Note that the command may fail if an inappropriate set of primitives are 
selected, and may not achieve perfect spacing if the available space is too limited. 

REORDERING PRIMITIVES 

Primitives on a display page are stored in what is known as a z-order. This defines the 
sequence in which the primitives are drawn, and therefore whether or not a given primitive 
appears to be in front of or behind another primitive. In the first example below, the blue 
square is shown behind the red squares ie. at the bottom of the z-order. In the second 
example, it has been moved to the front of the order, and appears in front of the other figures. 
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To move items in the z-order, select the items, and then use the various commands on the 
Arrange menu. The Move Forward and Move Backward commands move the selection one 
step in the indicated direction, while the Move To Front and Move To Back commands move 
the selection to the indicated end of the z-order. Alternatively, if you have a mouse that is 
equipped with a wheel, the wheel can be used to move the selection. Scrolling up moves the 
selection to the back of the z-order; scrolling down moves the selection to the front. 

GROUPING PRIMITIVES 

If you have several primitives that you wish to treat as a single object, you may select them as 
described above and then use the Group command on the Arrange menu. You can perform the 
same operation by pressing the Ctrl+G key combination. Once a group has been created, it 
can be moved, sized and copied just like a single object. A group can be broken into its 
component primitives by selecting it and using the Ungroup command, or the Ctrl+U key 
combination. Note that groups can comprise both primitives and other groups, and that groups 
can be nested indefinitely. You should typically avoid excessive levels of grouping, however, 
as it can make it difficult to edit the most deeply nested primitives.  

EDITING PRIMITIVES 

In addition to the above, primitives can be edited in various ways… 

• The various clipboard commands on the Edit menu (eg. Cut, Copy and Paste), or 
the corresponding toolbar icons, can be used to duplicate items or move them 
around on a page or between pages. The Duplicate command can be used to 
perform a Copy operation, immediately followed by a Paste operation. Note that 
when a Paste is performed, MonicoView will offset the newly-pasted item if it 
will exactly overlay an item of the same type. 

• The more detailed properties of a primitive can be edited by double-clicking the 
primitive, or by using the Properties command on the Edit menu. A dialog box 
will be displayed, allowing all of the primitives to be accessed. The properties 
associated with each primitive will be described below. 

DEFINING COLORS 

Many properties of primitives relate to the colors in which the primitive is to be drawn. The 
example below shows one of the fill colors from a Rectangle primitive… 
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You will note that the color property is presented by means of a drop-down menu button, a 
drop-down list and the Pick button. The drop-down menu is used to select the color mode, 
which can be any one of the following… 

• In Fixed mode, the color does not change, and is selected from the drop-down 
list, or by invoking the color selection dialog by pressing the Pick button. 

• In Tag Text mode, the color is animated to match the foreground color defined 
by a particular tag. The specific tag can be selected by pressing the Pick button. 

• In Tag Back mode, the color is animated to match the background color defined 
by a particular tag. The specific tag can be selected by pressing the Pick button. 

The drop-down list contains the fixed following colors… 

• The sixteen standard VGA colors. 

• The sixteen custom colors defined by the user. 

• Fourteen shades of gray that fall between black and white. 

The color selection dialog referenced above is shown below… 

 

This dialog offers several ways of defining a color. You can pick from the palette, pick from 
the “rainbow” window, or enter the explicit HSL or RGB parameters. The dialog also allows 
custom colors to be added to the palette. These will appear whenever the dialog is invoked, 
and will also appear in the drop-down list described above. Note that not every color that is 
displayed in the “rainbow” will be capable of being rendered on the panel’s 256-color 
display. MonicoView will choose the nearest color within the abilities of the device. 

DEFINING FILL PATTERNS 

A fill pattern is defined as shown below… 

 

The Fill Style property is used to select the hatch or dotted pattern to be used, while the two 
color properties are used to define the colors to be used to form the pattern. Each color is 
defined as explained above. The second color is not required when a solid fill is selected. 
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DEFINING ACTIONS 

Many primitives can be made touch-sensitive such that certain actions will occur when they 
are pressed, held-down or released. To define the actions to be performed by a primitive, 
display the properties of that primitive and select the Action tab… 

 

The drop-down list is used to select the action mode, each of which is described below. 

ENABLING ACTIONS 

If you want to make a particular action dependent on some condition being true, enter an 
expression for that condition in the Enable field for the action in question. This expression 
may reference a flag tag directly, or may use any of the comparison or logical operators 
defined in the Writing Expressions section. If you need more complex logic, such that one of 
several actions is performed based on more complex decision-making, configure the primitive 
in user-defined mode and use it to invoke a program that implements the required logic. In 
addition, the Remote property can be used to enable or disable this action via the web server’s 
virtual panel facility: In order for remote access to be allowed, the Enable expression must 
evaluate to a non-zero value, and the Remote property must be set to Enabled. 

ACTION DESCRIPTIONS 

The sections below describe each available type of action. When each type is selected, the 
Action Details portion of the action dialog box will change to show the available options. 
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THE GOTO PAGE ACTION 

This action is used to instruct the G3 to show a new page. The options are shown below… 

 

• The Target Page property is used to indicate which page should be displayed. 
You can either choose a specific one to be displayed, or choose Previous Page to 
return to what was displayed before the current page was called. 

• The Show As property is used to define how the page should be displayed. Aside 
from displaying it as a normal page, it can be shown as a popup page or as a 
popup menu. Both types of popup are shown on top of the existing page, and 
while they are displayed, the panel keys and touch-screen will assume the 
functions for the new page. Popup menus are displayed aligned to the left of the 
display so as to match up with the soft keys, while popup pages are displayed in 
the position indicated by the page properties. Note that a primitive or key on the 
new page must be assigned the HidePopup() action to remove the popup. 

Note: Popups are submitted to maximum size due to graphical memory limitation. They are 
created by wrapping around all the objects on the page called as a popup. If the external 
square around all the objects does not follow the rules below, the popup will be truncated  

Popup Window: 

• QVGA Display: 305 x 224 pixels max. 

• VGA Displays: The popup cannot be larger than 296 pixels and higher than 224 
pixels at the same time. One of the dimensions has to stay below the respective 
value. This means the maximum dimensions horizontally are 624 x 224 and 
vertically 296 x 464. 

Popup Menu: 

• QVGA Display: No limits 

• VGA Display: 296 pixels wide max. 
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THE PUSH BUTTON ACTION 

This action is used to emulate a pushbutton. The options are shown below… 

 

• The Button Type property is used to define the primitive’s behavior. 
 

BUTTON TYPE THE BUTTON WILL… 

Toggle Change the data state when the primitive is pressed. 

Momentary Set the data to 1 when the primitive is pressed. 
Set the data to 0 when the primitive is released. 

Turn On Set the data to 1 when the primitive is pressed. 

Turn Off Set the data to 0 when the primitive is pressed. 
 

• The Button Data property is used to define the data to be changed. 

In the example above, the primitive will toggle the value of the Output tag. 
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THE CHANGE INTEGER VALUE ACTION 

This action is used to write an integer value to a data item. The options are shown below… 

 

• The Write To property is used to define the data item to be changed. 

• The Data property is used to define the data to be written. 

In the example above, the primitive will set the MotorSpeed tag to 100. 

THE RAMP INTEGER VALUE ACTION 

This action is used to increase or decrease a data item. The options are shown below… 

 

• The Write To property is used to define the data item to be changed. 

• The Data property is used to define the step by which to raise or lower the item. 

• The Limit property is used to define the minimum or maximum data value. 

• The Ramp Mode property is used to define whether to raise or lower the item. 
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In the example above, holding the primitive will raise MotorSpeed by 1 until it reaches 100. 

THE PLAY TUNE ACTION 

This action plays a selected tune using the G3’s internal sounder. 

 

• Tune Name selects the tune to be played. 

Customized tunes may be played using the PlayRTTTL() function. 

THE USER DEFINED ACTION 

This action is used to do anything else you desire! The options are shown below… 

 

• The On Pressed property is used to define the action to be performed when the 
primitive is pressed. This action may invoke any of the functions from the 
Function Reference or the data modification operators described in the Writing 
Actions section, or it may run a program. 
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• The On Auto-Repeat property is used to define the action to be performed when 
the primitive is pressed and then held down. The action occurs both on the initial 
depression and on subsequent auto-repeats, so there is no need to define both this 
property and On Pressed. This action may invoke any of the functions from the 
Function Reference or the data modification operators described in the Writing 
Actions section, or it may run a program. 

• The On Released property is used to define the action to be performed when the 
primitive is released. This action may invoke any of the functions from the 
Function Reference or the data modification operators described in the Writing 
Actions section, or it may run a program. 

In the example above, a user-defined action is used to implement a momentary pushbutton. 

USING DEFAULT SETTINGS 

The dialog box used to edit the properties of each type of primitive has a button in its bottom 
right-hand corner labeled Set As Defaults. This button can be used to save the current settings 
of certain properties of the primitive as the default settings to be used when creating a new 
primitive. The same function can be performed by selecting the Save As Defaults command 
from the Edit menu, or by pressing the Ctrl+E key combination. Note that not all properties 
are included in the default settings—only those that refer to formatting, as opposed to the 
underlying data presented by the primitive, are saved. The default settings can be applied to 
the currently selected primitive or primitives by using the Apply Defaults command from the 
Edit menu, or by pressing the Ctrl+L key combination. 

PRIMITIVE DESCRIPTIONS 

The sections below describe each primitive found in the drawing toolbox. 

THE LINE PRIMITIVE 

 

The Line primitive is a line drawn between two points. Its only properties are the 
style of line to be used. In addition to the solid colors shown on the line toolbox, a 
number of dotted styles can also be accessed via the properties dialog box. 

 

THE SIMPLE GEOMETRIC PRIMITIVES 

 

The Rectangle primitive is a rectangle with a defined outline and fill pattern. The 
fill pattern may be set to No Fill to draw the outline alone, or the outline may be 
set to None to draw a figure without a border. 

 

The Round Rectangle primitive is similar to the rectangle, but has rounded 
corners. When the primitive is selected, an additional handle appears, allowing 
the radius of the corners to be edited by dragging the handle from side to side. 

 

The Shadow primitive is similar to the rectangle, but with either a drop-shadow, 
or with a shaded 3D effect. The primitive is often drawn so as to allow it to act as 
a frame around text primitives or other groups of elements. 
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The Wedge primitive is a right-angled triangle located within one quadrant of a 
bounding rectangle. In addition to the outline and fill properties, the wedge has a 
property to indicate which quadrant it should occupy. 

 

The Ellipse primitive is an ellipse with a defined outline and fill pattern. The fill 
pattern may be set to No Fill to draw the outline alone, or the outline may be set 
to None to draw a figure without a border. 

 

The Ellipse Quadrant primitive is one quadrant of an ellipse. In addition to the 
outline and fill properties, the ellipse quadrant has a property to indicate which 
quadrant it should occupy. 

 

The Ellipse Half primitive is one half of an ellipse. In addition to the outline and 
fill properties, the ellipse half has a property to indicate which of the four 
possible halves (think about it!) will be drawn. 

 

The properties for these primitives need little further explanation, other than to point out that 
the quadrant or half rendered by the Wedge, Ellipse Quadrant or Ellipse Half primitives can 
also be edited via the command found on the Transform menu. 

THE TANK PRIMITIVES 

 

The Conical Tank primitive is a conical tank with a defined outline and fill 
pattern. When the primitive is selected, additional handles appear, allowing the 
exact shape of the tank to be modified by dragging the handles as required. 

 

The Round Bottomed Tank primitive is a tank with a defined outline and fill 
pattern. When the primitive is selected, an additional handle appears, allowing the 
exact shape of the tank to be modified by dragging the handle as required. 

 

The properties for these primitives need little further explanation. 

THE SIMPLE BAR PRIMITIVES 

 

The Simple Vertical Bar primitive allows an expression to be drawn as a vertical 
bar-graph between specified limits. Additional properties allow the primitive’s 
fill color and border style be defined. 

 

The Simple Horizontal Bar primitive allows an expression to be drawn as a 
horizontal bar-graph between specified limits. Additional properties allow the 
primitive’s fill color and border style be defined. 
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The properties are accessed by double-clicking the primitive… 

 

• The Value property is used to specify the value to be displayed. In the example 
given above, the primitive is configured to display the level of a tank. 

• The Minimum and Maximum properties are used to specify the range of values to 
be shown. In the example above, a range of 0 to 100 is specified. 

• The Fill Format properties are used to define the fill color for the primitive. The 
filled area of the bar is drawn in the pattern and colors indicated, while the 
unfilled area is drawn with solid Fill Color 2. 

• The Line Format properties are used to define the border for the primitive. 

THE BAR-GRAPH PRIMITIVES 

 

The Vertical Bar Graph primitive displays a set of values from an array as a 
number of vertical bars. Each value is scaled according to the same minimum and 
maximum values. Between 2 and 400 values can be shown. 

 

The Horizontal Bar Graph primitive displays a set of values from an array as a 
number of horizontal bars. Each value is scaled according to the same minimum 
and maximum values. Between 2 and 400 values can be shown. 
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The properties are accessed by double-clicking the primitive… 

 

• The Value property is used to specify the first array element to be shown. 

• The Count property is used to specify the number of values to be shown. 

• The Minimum and Maximum properties are used to specify the scaling. 

• The Fill Format properties are used to define the fill color for the primitive. The 
filled areas of the bars are drawn in the pattern and colors indicated, while the 
unfilled areas are drawn with solid Fill Color 2. 

• The Line Format properties are used to define the border for the primitive. 

THE SCATTER GRAPH PRIMITIVE 

 

The Scatter Graph Primitive displays up to four sets of data values. Each set is 
composed of two data arrays plotted against each other, with optional data point 
markers and regression line. 
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The properties are split over five tabbed pages, one general, and one for each set/graph, and 
are accessed by double-clicking the primitive. The Properties tab defines the common 
features for all the graphs such as the background and outline color or if the primitive should 
be displayed or not using the Show Item field. 

 

Each graph is composed of the same proprietary set of properties. Data sources and scaling 
are defined directly on the graph tab. The format and style are accessible via the Edit button. 

 

• The X Values property is used to define the array element that contains the first x 
coordinate to be plotted, while the Y Values property is used to define the array 
element that contains associated y coordinate. 

• The Count property is used to specify the number of values to be shown. 
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• The X Axis Minimum and X Axis Maximum properties are used to specify the 
scaling for the horizontal axis, while the Y Axis Minimum and Y Axis Maximum 
properties are used to specify the scaling for the vertical axis. 

The Edit Graph Properties window accessed via the Edit button defines various formatting 
options. 

 

• The Graph Style property is used to select between a line graph, a line graph 
with data markers, or a set of data markers without a line. The various other 
formatting options on the Color page will be enabled or disabled as required. 

• The Regression Line property is used to show or hide the regression line for the 
data sets. If the line is enabled, the software will calculate a best-fit line based 
upon the least-squares method, and draw it on top of the data sets. 

• The remaining properties are used to define the background color of the 
primitive, and whether or not an outline should be drawn around its outer edge. 

The Colors tab defines the colors of the various chart elements for this graph… 
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• The Data Points properties are used to define the pattern and colors used to 
create the data point markers. These properties will only be accessible if the 
chart has these data point markers enabled. 

• The Data Line properties are used to define the format and color of the line 
drawn between the data points. These properties will only be accessible if the 
chart has this line enabled. 

• The Regression Line properties are used to define the format and color of the line 
drawn as a best-fit to the data points. These properties will only be accessible if 
the chart has this line enabled. 

THE SCALE PRIMITIVES 

 

The Horizontal Scale primitive displays a scale with a specified number of minor 
and major divisions. It is often used to label other primitives, such as bar graphs. 

 

The Vertical Scale primitive displays a scale with a specified number of minor 
and major divisions. It is often used to label other primitives, such as bar graphs. 

 

The scale primitives can either be fix or adaptive, the latest providing a new set of division if 
the maximum or minimum is changed. The properties are accessed by double-clicking the 
primitive… 

 

• The Style property defines if the scale should be fixed or adaptive. If the second 
is selected, the minimum and maximum are made available for tag mapping so 
the scale follows tags values. 

• The Orientation property is used to indicate the direction in which the tick-marks 
should point. Vertical scales support selections of left and right, while horizontal 
scales support selections of up or down. 

• The Major Divisions property is used to indicate into how many major divisions 
the scale should be divided. Large tick-marks are drawn at each division. The 
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lowest number of major divisions is one, in which case large tick-mark will be 
drawn at the ends of the scale, but not along its length. This property is only 
available when the scale is fixed. 

• The Minor Divisions property is used to indicate into how many minor divisions 
each major division should be divided. Smaller tick-marks are drawn at each 
division. Selecting a value of one for this property will disable minor divisions. 

• The minimum and maximum are tags or expressions the scale will follow to 
define the number of major division required. The Counts per Major Division is 
the number of unit between each major division. For example, if the counts is 10, 
the maximum 100 and the minimum 20. The full scale is 80 (100-20), therefore 
there will be 8 major divisions. 

• The Show Item property defines if the primitive should be displayed or not 
depending of the expression. 

The Color page defines the fill pattern and line style of the scale. 

THE FIXED TEXT PRIMITIVE 

 

The Fixed Text primitive is used to add unchanging text to a page. The text is 
displayed in a specified font and color, and with a specified justification. The text 
can also be translated for international applications. 

 

When the text is created, a cursor will appear, allowing the text to be entered… 

 

The text editor supports cutting, pasting and all the other options normally found within a 
Windows editor. The editor will also configure the keyboard to use the appropriate Input 
Method Editor for the currently selected default language. 

Note that only the default language text can be edited directly. Other versions of the text must 
be edited via the properties dialog box, which is accessed by selecting the primitive and 
pressing Alt+Enter, or by selecting the Properties command from the Edit menu… 
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• The Text property is used to specify the text to be displayed. As mentioned 
above, the default language version of the text can also be edited directly on the 
display page when the primitive is created, or by clicking an existing primitive. 

• The Font property is used to specify the font to be used. The font list comprises 
the eight resident fonts found in all terminals, plus any custom fonts already 
created in this database. The Pick button can be used to invoke the font selection 
dialog, allowing any font that is installed on your system to be rendered in a 
form that can be used by the target device. Note that it is your responsibility to 
ensure that your license in respect of the font allows this kind of usage. 

• The Text Type property is used to indicate whether the text should be drawn with 
a solid or transparent background. Transparent text can be used to overlay 
multiple primitives while still allowing those primitives to be seen. 

• Foreground and Background properties are used to specify the colors to be used 
to draw the text. Obviously, having the same color for both settings will render 
the text invisible—a fact that can be exploited to show or hide text as required. 

• The Horizontal and Vertical justification properties are used to indicate where 
the text should be placed within the bounding rectangle of the primitive. 

THE AUTO TAG PRIMITIVE 

 

The Auto Tag primitive allows you to select a tag, and then automatically place 
the appropriate text primitive on the display. For example, selecting an integer tag 
will allow insertion of an appropriately-configured integer text primitive. 

 

This is the icon you will use most often for adding tags to a page. It first displays the dialog 
box shown below to allow tag selection, and then creates one of the five tag text primitives 
described in the next section. The new primitive will be configured so as to display the tag in 
question using its label and its formatting properties, as defined when the tag was created. 
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THE TAG TEXT PRIMITIVES 

The tag text primitives are used to display or edit an expression in textual form. Primarily, 
they are used to display tags, in which case the default format is taken from the Format tab 
associated with that tag in the Data Tags window. If a non-tag expression is entered—or if 
you want the formatting to differ from the default values for a tag—the format data can be 
overridden as required. There is one type of tag text for each tag family… 

 

The Flag Text primitive is used to display a true or false condition. 

 

The Integer Text primitive is used to display an integer expression. 

 

The Real Text primitive is used to display a floating-point expression. 

 

The Multi Text primitive is used to display a multi-state condition. 

 

The String Text primitive is used to display a string expression. 

 

The properties of a tag text primitive are displayed using three tabbed pages. 
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The first page is more-or-less the same for all five primitive types… 

 

• The Value property is used to indicate from where the data for this primitive 
should be obtained. You may select a tag, a register in a communications device, 
or an expression that combines a number of such items. The data type of the item 
must be appropriate to the primitive in question eg. the Value property for an 
integer text primitive cannot be set equal to a string expression. 

• The Data Entry property is used to indicate whether or not you want the user of 
the operator interface panel to be able to change the underlying value via this 
primitive. Selecting Local will enable data entry, but prevent access via the 
virtual panel facility of the web server. For data entry to be enabled, the 
expression entered for the value property must be capable of being changed. For 
example, if a formula is entered, data entry will not be permitted. 

• The Show Label property is used to indicate whether or not you want the 
primitive to include a label to identify the data being displayed. If this property is 
set to yes, the label will be left-justified within the primitive’s bounding 
rectangle, while the data itself will be right-justified. If this property is set to no, 
the Horizontal Justification property will be used to locate the data in the field. 

• The Show Data property is used to indicate whether or not the primitive should 
include the data value, or whether it should just show the label. Since the 
primitive might be capable of reflecting the state of the underlying data item by 
means of color alone, the actual value may sometimes be omitted. 

• The Get From Tag properties are used to indicate from where the label text, the 
field format and the text colors should be obtained. The options presented 
depend on what was entered for the Value property. In each case, you may 
manually enter the data in the appropriate properties, or, assuming a suitable 
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expression has been defined, you may instruct the primitive to get the required 
information from the underlying data tag. 

• The Flash on Alarm property is used to indicate whether or not you want the text 
on the G3’s display to flash if the tag entered in the value property is currently in 
an alarm state. This property is not available for string text primitives, or for 
those primitives that have a non-tag value defined for the value property. 

• The balance of the properties control the font, colors and justification to be used 
when drawing the primitive. These properties require no further explanation. 

The second page is only used for fields that are selected for data entry… 

 

• The Enable property is used to define an expression that must be true in order for 
data entry to be permitted. This property may thus be used to implement a 
security system, or to restrict entry to certain machine states. 

• The Validate property is used to define an expression that will be used to 
validate any entered values, e.g. DATA %25 == 0 will only allow multiples of 25 
to be entered into the variable Amount. The special system variable Data will 
hold the newly-entered value, but only during the execution of this expression. 
The code should evaluate to non-zero to allow entry, or zero to block it. 

• The On Selected and On Deselected properties are used respectively to define 
actions to be executed when the user selects the field for entry, or when the user 
deselected the field by selecting another. The actions may invoke any of the 
various functions from the Function Reference or the data modification operators 
described in the Writing Actions section, or may run a program. 

• The On Entry Complete and On Entry Error properties are used respectively to 
define actions to be executed when data entry is completed successfully, or when 
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an invalid value is entered. The actions may invoke any of the functions from the 
Function Reference or the data modification operators described in the Writing 
Actions section, or may run a program. 

• The Keypad Type property is used to select the type of keypad to be displayed 
when the value is edited. By default, a full keypad with raise and lower keys will 
be shown. The options available will vary according to the primitive type. 

• The Keypad Style property is used to override the default color scheme 
associated with the popup keypad, and to substitute a high-contrast version in its 
place. This is used in low-visibility applications such as direct sunlight. 

The third page varies according to the primitive in question, and displays the same 
information as the Format tab of the associated tag type. Different sections of the page will be 
enabled according to the settings provided for the Get Label and Get Format properties. The 
example below shows the Format tab for an integer text primitive… 

 

As can be seen, the properties shown are indeed identical to those shown on the Format tab of 
an integer tag. As mentioned above, the properties for the other types of primitive are 
similarly identical to those of the corresponding tag. You are thus referred to the earlier 
section of the manual regarding Data Tags for more information on each property. 

EDITING THE UNDERLYING TAG 

If you want to edit a tag text primitive’s properties, either double-click on the primitive, or 
right-click and select the Properties command from the resulting menu. If, however, you want 
to edit the properties of the tag that is being used to control the primitive, right-click and 
select the Tag Details command instead. The resulting dialog box will show the Data, Format 
and Colors tabs from the Tags window, and allow you to change the various properties. Note 
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that a change made via this mechanism will change all the primitives controlled by that tag if 
those primitives are configured to obtain their configuration from that source. 

THE MULTI-LINE TEXT PRIMITIVES 

 

The Multi-Line Status Text primitive is used to display an on-off value, but split 
over several lines. This allows larger amounts of text to be shown, perhaps to 
provide prompts or help information to the operator. 

 

The Multi-Line Multi Text primitive is used to display one of a series of text 
values, but split over several lines. This allows larger amounts of text to be 
shown, perhaps to provide prompts or help information to the operator. 

 

Each of these primitives is as the associated single-line primitive, except that they do not 
support data entry. The text string to be displayed is broken into lines by the inclusion of 
vertical bar (“|”) characters wherever a line-break is required. 

THE TIME AND DATE PRIMITIVE 

 

The Time and Date primitive is used to display the current time and date, or to 
display the contents of a time and date expression. It can also be used to edit such 
an expression, or to set the operator panel’s real time clock. 

 

The properties of a time and date primitive are displayed using three tabbed pages. 

The first page is shown below… 

 

• The Value property is used to indicate the time and date value to be displayed. If 
no value is entered, the current time and date is shown. If an expression is 
entered, it is taken to represent the number of seconds that have elapsed since 1st 
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January 1997. Such values are typically obtained using the various time and date 
functions described in the Function Reference. 

• The Data Entry property is used to indicate whether or not you want the user of 
the operator interface panel to be able to change the underlying value via this 
primitive. Selecting Local will enable data entry, but prevent access via the 
virtual panel facility of the web server. If no value property has been defined, 
this amounts to changing the current time or date. If a value property has been 
entered, the expression entered must be capable of being changed. For example, 
if a formula is entered, data entry will not be permitted. 

• The balance of the properties are as described for tag text primitives. (While it 
may look odd to have Get From Tag and Flash On Alarm properties, remember 
that the value property may be a tag, and so MonicoView does have access to the 
tag label and to the tag’s alarm state, should you decide to use them.) 

The second page contains data entry properties. These are as described for text tag primitives. 

The third page is shown below… 

 

• The Label Text property is used to define an optional label for the primitive. 

• The Field Type property is used to indicate whether the field should display the 
time, the date or both. In the last case, this property also indicates in which order 
the two elements should be shown. 

• The Time Format property is used to indicate whether 12-hour (civil) or 24-hour 
(military) time format should be used. As with other properties, leaving this set 
to Locale Default will allow MonicoView to pick a suitable format according to 
the language selected within the operator panel. 
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• The AM Suffix and PM Suffix properties are used with 12-hour mode to indicate 
the text to be appended to the time field in the morning and afternoon as 
appropriate. If you leave the property undefined, MonicoView will use a default. 

• The Show Seconds property is used to indicate whether the time field should 
include the seconds, or whether it should just comprise hours and minutes. 

• The Date Format property is used to indicate the order in which the various date 
elements (ie. date, month and year) should be displayed. 

• The Show Month property is used to indicate whether the month should be 
displayed as digits (ie. 01 through 12) or as its short name (ie. Jan though Dec). 

• The Show Year property is used to indicate whether the date field should include 
the year, and if so, how many digits should be shown for that element. 

THE RICH BAR PRIMITIVES 

 

The Rich Vertical Bar primitive allows you to display a more complex bar-graph 
which includes a label, a numeric version of the data being displayed, and tick 
markers to indicate any associated setpoint. 

 

The Rich Horizontal Bar primitive allows you to display a more complex bar-
graph which includes a label, a numeric version of the data being displayed, and 
tick markers to indicate any associated setpoint. 

 

The operation of these rich primitives is analogous to that of the various tag text primitives, in 
that they are capable of deriving much of the required formatting information from the tag 
used as their controlling value. Just as with tag text primitives, multiple tabbed pages are used 
to edit the primitives’ properties. The first of these pages is shown below… 

 

• The Value property is used to define the value to be displayed. 
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• The Show Label property is used to indicate whether a label should be included 
with the bar-graph. For vertical graphs, the label is included at the bottom; for 
horizontal graphs, it is included at the left-hand side. If a tag is used for the value 
property, the label may be obtained from that tag. Otherwise, it must be entered 
on the Format tab of the dialog box. 

• The Show Value property is used to indicate whether the value of the data should 
be displayed within the graph itself. If a tag of the appropriate data type is used 
for the value property, the format may be obtained from the tag. Otherwise, as 
with the label, it must be entered on the Format tab. 

• The Show Setpoint property is used to indicate whether tick marks should be 
added either side of the bar to indicate the setpoint for the controlling value. This 
option is only available if a tag has been entered for the value field. 

• The Flash on Alarm property is used to indicate whether or not you want the text 
on the G3’s display to flash if the tag entered in the value property is currently in 
an alarm state. This property is not available for those primitives that have a non-
tag value defined for the value property. 

• The Value Background property is used to indicate whether the value should be 
drawn with a solid or transparent background. The choice of format will 
typically depend upon the visibility of the value against the bar itself. 

• The Get From Tag properties are used to indicate from where the label text, the 
field format and the text colors should be obtained. The options presented 
depend on what was entered for the Value property. In each case, you may 
manually enter the data in the appropriate properties, or, assuming a suitable 
expression has been defined, you may instruct the primitive to get the required 
information from the underlying data tag. 

The second page contains additional formatting information for the field… 
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• The Text Format properties are used to define the font and the colors to be used 
to draw the value and the field label, assuming these elements are enabled. 

• The Fill Format properties are used to define the fill color for the primitive. The 
filled areas of the bars are drawn in the pattern and colors indicated, while the 
unfilled areas are drawn with solid Fill Color 2. 

• The Line Format properties are used to define the style of the primitive’s outline. 

The third page contains the label and formatting information for the field... 

 

The properties shown are as described for an integer tag, and you are thus referred to the 
earlier section of the manual that refers to Data Tags for more information. Note that the 
existence of this primitive explains why one must enter minimum and maximum values for 
formulae, when such tags can never be the subject of data entry. If such limits were not 
defined, how would MonicoView know how to scale the bar? 

THE RICH SLIDER PRIMITIVES 

 

The Vertical Slider primitive displays a value, typically from an integer tag, as a 
slider that can either display a value, or allow it to be manipulated by touching a 
specific location on the primitive, or by pressing buttons at either end.  

 

The Horizontal Slider primitive displays a value, typically from an integer tag, as 
a slider that can either display a value, or allow it to be manipulated by touching a 
specific location on the primitive, or by pressing buttons at either end. 

 

Just as with other rich primitives, the slider primitives are capable of deriving much of the 
required formatting information from the tag used as their controlling value. Just as with tag 
text primitives, multiple tabbed pages are used to edit the primitives’ properties. 
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The first of these pages is shown below… 

 

• The Value property is used to indicate from where the data for this primitive 
should be obtained. You may select a tag, a register in a communications device, 
or an expression that combines a number of such items. 

• The Data Entry property is used to indicate whether or not you want the user of 
the operator interface panel to be able to change the underlying value via this 
primitive. Selecting Local will enable data entry, but prevent access via the 
virtual panel facility of the web server. For data entry to be enabled, the 
expression entered for the value property must be capable of being changed. For 
example, if a formula is entered, data entry will not be permitted. 

• The Type property is used to indicate the type of slider to be displayed. The three 
types of sliders allow data entry via buttons, via direct manipulation, or via both 
methods. You should note that direct manipulation can be somewhat risky, in 
that accidental touches may result in large changes to process values. 

• The Get From Tag property is used to indicate whether the data format should be 
obtained from the controlling value, or from the Format page. Note that most of 
the format values are unused, save the minimum and maximum values. 

• The Line Format properties are used to define the style of the primitive’s outline. 

• The Fill Format properties are used to define the color and style of the 
primitive’s background and of the slider itself. The background is drawn in Fill 
Color 2, while the slider is drawn in either Fill Color 1, or the combination of the 
two colors that is specified by the Fill Style. 

The second page is used to control data entry, and functions are as for tag text primitives. You 
are thus referred to the earlier section for more information. The third page is used to define 
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the optional label, and the minimum and maximum values, possibly by means of a complete 
data format. This page functions as was previously discussed for integer data tags, and you 
are referred to that section for further details. 

THE ALARM VIEWER PRIMITIVE 

 

The Alarm Viewer primitive is used to provide the operator with a method to 
view and accept active alarms. Differing color pairs are used to show the various 
alarm states. Additional data about the alarms may be displayed if required. 

 

If you use manual-accept alarms in your system, you should provide a page that contains an 
alarm viewer to make sure the operator can accept these alarms. You may wish to consider 
creating a popup page and using it to display the alarm viewer, although the size restrictions 
on popups may cause you to reject this idea. The properties of the alarm viewer are displayed 
on four tabbed pages, the first of which is shown below… 

 

• The Font property is used to select the font to be used to draw the primitive. A 
fixed-pitch font should ideally be used to ensure that the various data fields 
remain in the correct alignment. 

• The List Colors properties are used to define the foreground and background 
colors used to display each alarm state. The default values should be acceptable 
for most applications. The selection “Active Alarm – Use Priority Colors” can be 
set to YES, in which case the “Active Alarm” color selection below it will be 
disabled, and color selection based on the tag priority will be enabled on the 
Priority Colors page. 

• The Show End Markers property is used to indicate whether to display a column 
that contains markers showing the beginning and end of the alarm list. If this 
column is omitted, the primitive will take less space, but it will be harder for the 
operator to determine the limits of the list. 
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• The Show Alarm Time property is used to indicate whether or not the time at 
which the alarm occurred should be included in the primitive. If the time is 
displayed, the second tab is used to define the format to be used. 

• The No Active Alarms Text property is used to override the default text that is 
displayed when no alarms are present, or to enter localized versions of this text 
on systems that support multiple languages. 

The second tab of the properties is used to define the format of the alarm time… 

 

The properties are as defined for the time and date primitive. 
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The third tab of the properties is used to control how the primitive’s buttons are labeled… 

 

• The Font property is used to select the required font. 

• The Enable Help property activates a Help button to be displayed on the 
primitive. This Help button can be used to provide the operator with information 
on specific alarms as explained in Using the Help button below. 

• The Button Labels properties are used to override the default label that is shown 
on each of the four buttons, or to enter localized versions of this text on systems 
that support multiple languages. Setting all four of the text items to a single * 
will disable the buttons, and blank that area on the display. 

The fourth tab of the properties is used to select the colors of the alarm text when “Active 
Alarm – Use Priority Colors” is set to YES on the Properties page... 



CONFIGURING A COLOR USER INTERFACE PRIMITIVE DESCRIPTIONS 

REVISION 12 PAGE 153 

 

Up to eight pairs of colors may be assigned to tags with priorities 1 through 8. A priority 
value greater than 8 will use the setting for priority 8. 

USING THE HELP BUTTON 

The Alarm Viewer includes a Help button to provide context help on alarms. For example, 
when multiple alarms are active in the viewer, the operator can select one of the alarms and 
push the Help button to get more information or eventual solution for this alarm. 

To use this functionality, the help button has to be activated in the Alarm Viewer as shown 
below. 

 

The actions in the OnHelp field will be launched when the Help button is pressed on the 
alarm viewer. Any actions can be entered in the OnHelp field, however, to use contextual 
help, the following design as to be followed. 

 

 

 

 

 

 

 

 

Get alarm 
selected by user 

Run a program 
passing the 

alarm number 

Display proper 
information 
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The first step is achieved using the system variable Data. This system variable is only 
available for the OnHelp field and contains information on the alarm selected. Data is a Long 
(Double word) and contains the following information: 

• Low word: the tag index this alarm is related to. 

• High word: the alarm number for this tag. (Remember, there are two alarms per 
tag. 

The second step is thus achieved by running a program with Data as argument. A program 
has to be created first and set up to accept an integer argument as show in the image below. 

 

Now the OnHelp field is ready to accept the following code. This tells the viewer to run 
Program1 with the information provided in Data when the Help button is pressed. 

Program1(Data) 
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The last step is then to write the program so the proper information is displayed depending on 
the alarm selected. The code sample below illustrates an example with 2 tags and different 
alarm numbers. 

// When the program is called, Data is transferred in Arg1 
 
int Alarm = Arg1 >> 16;   // Local integer assigned 
     // with alarm number 
 
int Tag = Arg1 & 0xFFFF;   // Local integer assigned 
     // with tag index number 

switch( Tag )    // Look a the tag index 
{ 
 case 0:    // Tag index is 0 
    if( Alarm == 1 ) // Alarm number is 1 
  { 
   GotoPage(Help1); 
  } 
  break; 
  
 case 9:   // Tag index is 9 
  if( Alarm == 2 ) // Alarm number is 2 
  { 
   GotoPage(Help2); 
  } 
  break; 
 
 default:    // Tag index not found 
  GotoPage(NoHelp); 
} 

In this sample, if alarm 1 of the tag with index 0 is selected in the alarm viewer and the 
operator presses the Help button, the display will go to the page with name Help1. If alarm 2 
of the tag with index 9 is selected in the alarm viewer and the operator presses the Help 
button, the display will go to the page with name Help2. 

In the event another alarm is selected and the Help button is pressed, the display will go to the 
page with name NoHelp. 

Note: GotoPage() functions can be replaced by ShowPopup() functions to display a popup 
window instead of a page. 

Note: The index number of a tag can be found in the status bar in the Data Tags when a tag is 
selected. 

THE ALARM TICKER PRIMITIVE 

 

The Alarm Ticker primitive scrolls through the active alarms in the system. It 
takes up a single line, and is typically placed at the bottom of the display, perhaps 
on every page. It does not allow the operator to accept the alarms. 
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The properties of the alarm ticker are displayed on three tabbed pages. 

The first of these pages is shown below… 

 

• The Font property is used to select the font to be used to draw the primitive. A 
fixed-pitch font should ideally be used to ensure that the various data fields 
remain in the correct alignment. 

• The Ticker Colors properties are used to define the foreground and background 
colors used to display each alarm state. The default values should be acceptable 
for most applications. The selection “Active Alarm – Use Priority Colors” can be 
set to YES, in which case the “Active Alarm” color selection below it will be 
disabled, and color selection based on the tag priority will be enabled on the 
Priority Colors page. 

• The No Active Alarms property is used to indicate whether a message should be 
displayed when no alarms are present, or whether the bar should be left blank in 
these circumstances. 

• The Show Alarm Count property is used to indicate whether the number of 
currently active alarms should be displayed in the primitive. Unless display 
space is restricted, showing this field typically improves operator readability. 

• The Show Alarm Time property is used to indicate whether or not the time at 
which the alarm occurred should be included in the primitive. If the time is 
displayed, the second tab is used to define the format to be used. 

The second tab is the time format, and is as described for the time and date primitive for the 
alarm viewer. 

The third tab is the priority colors selection, and is as described in the alarm viewer. 
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THE EVENT VIEWER PRIMITIVE 

 

The Event Viewer primitive is used to provide the operator with a method to view 
the events recorded in the system’s event log. As with the alarm viewer, it is 
sometimes placed on a popup page. 

 

The properties of this primitive are essentially the same as those for the alarm viewer. You 
are thus referred to the earlier section for more details. The only additional property is Show 
Event Type, which is used to indicate whether or not each row should be labeled with the kind 
of event that resulted in the log entry. The possible event types are alarm activations, alarm 
acceptances, alarm deactivations and event activations. 

THE FILE VIEWER PRIMITIVE 

 

The File Viewer Primitive is used to display the content of a file saved on the 
CompactFlash card.  

 

The primitive can display different files residing under the same folder but only one at a time. 
This is particularly handy to visualize Data Log files allowing the user to move from one file 
to another for the desired log. Only files with CSV, TXT and LOG extensions are supported. 
The properties are accessed by double-clicking the primitive. 

  

• The Font property is used to select the font to be used to draw the primitive. A 
fixed-pitch font should ideally be used to ensure that the various data fields 
remain in the correct alignment. 

• The Line Numbers property defines if the line number should be shown or not in 
front of each file line. 

• The Sort Order property is used to choose whether files residing under the folder 
should be displayed or not and if the order is from the newest or the oldest file. 
The selection New File First will display the files from the newest to the oldest 
when moving through the folder with the primitive. The selection Old Files First 
will do the contrary. 
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•  The Button Font property is used to select the required font for the navigation 
buttons of the primitive. 

• The Root Directory defines the root folder on the CompactFlash card where files 
to be open reside. The viewer can only open files present under the indicated 
folder and cannot navigate to other folders. 

The picture below shows functionalities available on the file viewer once downloaded in an 
operator interface. Here, the viewer is displaying the content of a CSV file available from the 
CompactFlash Card. The file is accessed when the page with the primitive is displayed. The 
Rescan button provides a way to reload the file content so the user has access to the latest 
data. The Prev and Next button are used to navigate from one file to another. They are 
available only if more than one file is present in the folder. 

 

 

THE REMOTE DISPLAY PRIMITIVE 

 

The Remote Display Primitive is used to send part of the operator interface 
display to an external large display such as the BFD (Big Flexible display) or 
LFD (Large Flexible display). 

 

This primitive sends the graphical information within its area to the slave large display. It is 
used in combination with the Monico Big Flexible Display serial port driver. This driver is 
selected in Communication.  

Each pixel on the graphic area represents an LED on the remote display matrix. Remote 
displays being monochrome, in the case of a color unit controlling the display, any colors will 
be a lit LED, only black will be an off LED. 

Name of the file displayed 
File number in the folder 

Total number of files in the folder 
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More than one remote display is programmable on a single screen as each can have a single 
unit address. The properties of the remote display are available when double clicking the 
primitive. 

 

• The Model defines the type of slave display the graphical area will be sent to. 
The big flexible display will cover an area of 128 x 64 pixels on the screen 
where the Little Flexible Display will cover 128 x 16 pixels. 

• The Port points to the serial communication port number where the large display 
for this primitive will be connected. Port numbers starts at one with the 
communication port. 

• The address is the large display node address this primitive will send the 
information to. Please refer to the large display documentation to find the 
address required. 

THE CAMERA PRIMITIVE 

 
The Camera Primitive is used to display the incoming image from a Banner 
PresencePlus series camera. 

 

This primitive is used in combination with the Banner PresencePlus Camera Ethernet port 
driver. This driver is selected in Communication. More than one camera can be connected to 
the operator interface. Properties are accessed by double clicking the primitive. 
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• The Camera property is used to select the camera the primitive will display the 
image from. 

• The Scale property defines the ratio the source image should be scaled before 
being displayed on the operator interface. 

• The Fill format properties are used to define the background of the primitive. 

• The Line Format properties are used to specify the format of the optional border 
around the primitive. 

• The Show Item property defines if the primitive should be displayed or not 
depending of the expression. 

THE TRENDING PRIMITIVES 

 

The Data Logger primitive provides a fixed view of the data contained within a 
data logger. The number of data points to be displayed may be defined, and 
channels may be shown or hidden using a bit-mask. 

 

The Trend Viewer primitive provides a more advanced interactive view of a data 
logger, allowing the operator to zoom in, zoom out, and to scroll backwards and 
forwards through historical data that is saved in the logger’s history buffer. 

 

The data logger primitive is configured via two property pages, shown below is the general 
properties page. 

 

• The Data Log property is used to select the data log to be displayed. 

• The Sizing Mode property is used to indicate whether you wish to specify the 
number of data points to be displayed, or whether you want the software to 
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display one data point for each horizontal pixel of the primitive. The Points to 
Show property is used to specify the number of points to be displayed when the 
Sizing Mode is so configured. 

• The Show Channels property is used to specify an optional integer value that 
controls which channels are displayed. If an expression is entered, channel n will 
be shown if and only if the nth bit of the value is set. The nth bit is defined as the 
bit having the weight of 2n, such that the lowest-order bit is bit 0. Bit 0 represents 
the first tag in the list displayed in the Pens tab. Bit 1 would be the second tag in 
the list. 

• The Fill Format properties are used to define the background of the primitive. 

• The Line Format properties are used to specify the format of the optional border 
around the primitive. Note that these properties do no change the pens used to 
draw the actual channel data: the colors of these lines are defined by the system. 

• The Show Item property defines if the primitive should be displayed or not 
depending of the expression. 

The Pens page provides a way to change the color of the trace for each tag present in the data 
log. Select the tag to get the corresponding color. The color is changed via the drop down 
window. More colors are available at the end of the list. 
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The trend viewer primitive is similar, but includes more pages. The first page of the 
properties is shown below… 

 

• The Data Log property is used to select the data log to be displayed. If you want 
the operator to be able to scroll backwards through historical data, be sure to 
enable the log’s history buffer. Refer to the Data Logging chapter for details. 

• The Viewer Width property is used to define the default amount of data to be 
shown when the primitive is first displayed. Note that the operator can zoom in 
or out as required, and may thus choose to show more or less data. 

• The Show Channels and Show Item properties are as defined for the data logger 
primitive. 

• The Show Data property indicates whether or not tag values from visible traces 
should be displayed at the bottom of the viewer. The value will be the latest 
sample value in live mode or the value at the crossing point of the trace and the 
cursor when the cursor is used. 

• The Label Font property is used to define the font used to draw the various 
labels that adorn the primitive. The default font will typically be too large for 
applications where the primitive does not take up the entire screen. 

• The Fill Format properties define the background of the primitive. Please make 
sure that the background color is not identical to a pen color, otherwise the trace 
will not appear. 

The time page is used to specify the time and date format that will be used to indicate the 
extremities of the displayed data. 
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The gridline page defines the horizontal and vertical divisions to be shown on the trend 
viewer. 

 

• The Major Data Gridlines property is used to indicate into how many major 
divisions the vertical axis of the viewer should be divided. A thick line will be 
drawn across the viewer for each division. Selecting a value of one for this 
property disables it. Note that each tag displayed is scaled according to its own 
format properties, and that different tags may thus have different scaling. You 
ideally should define gridlines that make sense for all tags that are to be shown, 
and ensure that you label the display page to let the operator know what scaling 
you have selected. 

• The Minor Data Gridlines property is used to indicate into how may minor 
divisions each major division should be divided. A thin line will be drawn across 
the viewer at each division. Selecting a value of one for this property disables it. 

• The Show Divisions property is used to indicate whether gridlines should be 
drawn for the time axis. The major and minor divisions to be used are chosen by 
the system according to the current zoom level. 

The Cursor page is used to activate the history cursor and define its color. The cursor is useful 
in combination with the Show Data property to view the value of a trace at a specific time. 
When displayed on the viewer, the cursor indicates its time position for reference. 
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THE GENERAL BUTTON PRIMITIVE 

 

The General Button primitive displays an animated button that can respond to 
user input. Several different button styles are provided, including one that uses 
custom images from the software’s image library. 

 

The properties of the general button are defined using four tabs. 

The first of these tabs is shown below… 

 

• The Label property is used to define the text to be shown on the button. 

• The Style property is used to define the style of button to be displayed… 
 

STYLE DESCRIPTION 

Round A round button comprising two concentric circles. 

Flat Rectangle A rectangular button comprising two nested rectangles. 

3D Rectangle A rectangular button drawn using 3D coloring effects. 

3D Rectangle with Bevel A rectangular button with more pronounced 3D effects. 

Custom Images A button based upon two custom images. 
 

• The Layout property is used to indicate where, if anywhere, the label should be 
placed when using custom images to define the button’s appearance. 

• The Text Format properties are used to define the label font and coloring. 
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The second page is used to define additional formatting information… 

 

• The Fill Format properties are used to define the color and pattern to be used to 
fill the interior of the button. For 3D buttons, this color is used to draw the button 
face, while the system uses various shades of grey to draw the border so as to get 
the 3D effect. For buttons based on custom images, the fill format defines the 
background that is to be drawn underneath the images. 

• The Line Format properties are used to define the style and color of the lines that 
make up the outlines of the Round and Flat Rectangle styles. The properties are 
not used when other styles are selected. 

The third tab is used for buttons of the Custom Image style to define the images to be shown 
when the button is in the release and pressed states. Image selection is described in detail 
under the picture primitive, and you are thus referred to those sections. The fourth tab is used 
to define the action to be performed by the button. You are referred to the earlier section of 
this chapter for more details. 

THE RICH BUTTON PRIMITIVE 

 

The Rich Button primitive displays an animated button that is used to control the 
state of a flag tag. While the same functionality can be achieved using a general 
button, the rich version automatically obtains data from the underlying tag. 

 

The properties of the rich button are defined using five tabs. 
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The first of these tabs is shown below… 

 

• The Value property is used to indicate from where the data for this primitive 
should be obtained. You may select a tag, a register in a communications device, 
or an expression that combines a number of such items. The data type of the item 
must be an integer or a flag. 

• The Data Entry property is used to indicate whether or not you want the user of 
the operator interface panel to be able to change the underlying value via this 
primitive. Selecting Local will enable data entry, but prevent access via the 
virtual panel facility of the web server. For data entry to be enabled, the 
expression entered for the value property must be capable of being changed. For 
example, if a formula is entered, data entry will not be permitted. Most buttons 
will have data entry enabled. 

• The Type defines the action to be taken when the button is pressed and released... 
 

BUTTON TYPE THE BUTTON WILL… 

Toggle Change the data state when the primitive is pressed. 

Momentary Set the data to 1 when the primitive is pressed. 
Set the data to 0 when the primitive is released. 

Turn On Set the data to 1 when the primitive is pressed. 

Turn Off Set the data to 0 when the primitive is pressed. 
 

• The Style property is as defined for general buttons. 

• The Layout property is used to define where the optional label and data values 
are to be placed relative to the button itself when custom images are used. The 
text fields are always placed within the button for the other button styles. 

• The Show Label property is used to indicate whether or not you want the 
primitive to include a label to identify the data being displayed and controlled.  
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• The Show Data property is used to indicate whether or not the primitive should 
include the associated data value. For buttons configured with a type of toggle or 
momentary, the displayed data value is the value of the underlying tag. For other 
buttons, the displayed value is the value to which the tag will be set. 

• The Get From Tag properties are used to indicate from where the label text, the 
field format and the text colors should be obtained. The options presented 
depend on what was entered for the Value property. In each case, you may 
manually enter the data in the appropriate properties, or, assuming a suitable 
expression has been defined, you may instruct the primitive to get the required 
information from the underlying data tag. 

The second page defines additional formatting information, and is as described for the general 
button primitive. The third page is used to define the custom images to be used to reflect the 
button states, and is as described for the general button, except that different images can be 
specified depending on whether the underlying tag is on or off. You should again refer to the 
picture primitive for information on selecting images. The fourth page defines a number of 
properties specific to data entry. These are as defined for the flag tag text primitive, and you 
should refer to that section for details. The fifth and final page defines the label and format to 
be used for the primitive, and is as defined for flag tags. 

THE SELECTOR PRIMITIVES 

 

The Rich 2-State Selector primitive displays a rotary-style switch that can be used 
to turn-on and turn-off a flag tag. As with all rich primitives, most of the 
configuration data can be obtained from the underlying tag. 

 

The Rich Multi-State Selector primitive displays a rotary-style switch that can be 
used to turn on and turn off a multi tag. As with all rich primitives, most of the 
configuration data can be obtained from the underlying tag. 

 

Each of these primitives displays a circular selector switch within the area used to define the 
primitive. If the primitive is tall enough that the circular switch has sufficient space above it, 
labels can be added to the primitive to allow the various states to be identified. 
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Both primitives are configured using four tabbed pages, the first of which is shown below… 

 

• The Value property is used to indicate from where the data for this primitive 
should be obtained. You may select a tag, a register in a communications device, 
or an expression that combines a number of such items. The data type of the item 
must be appropriate to the primitive in question eg. the Value property for a 
multi-state selector primitive cannot be set equal to a string expression. 

• The Data Entry property is used to indicate whether or not you want the user of 
the operator interface panel to be able to change the underlying value via this 
primitive. Selecting Local will enable data entry, but prevent access via the 
virtual panel facility of the web server. For data entry to be enabled, the 
expression entered for the value property must be capable of being changed. For 
example, if a formula is entered, data entry will not be permitted. 

• The Show States property is used to indicate whether or not you want the 
primitive to attempt to label each of the possible states of the tag. The states will 
only be shown if sufficient space exists at the top of the primitive. It is also 
important to select a small enough font to avoid overlapping text. 

• The Get From Tag properties are used to indicate from where the data format 
and the associated text colors should be obtained. The options presented depend 
on what was entered for the Value property. In each case, you may manually 
enter the data in the appropriate properties, or, assuming a suitable expression 
has been defined, you may instruct the primitive to get the required information 
from the underlying data tag. 

• The Text Format properties are used to select the font and text colors for the 
state labels. If the primitive is configured to obtain its text colors from the 
underlying tag, the color fields will be disabled. 
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The second tab contains additional formatting information… 

 

• The Fill Color 1 property is used to define the color of the rectangular portion of 
the selector that moves in order to indicate the tag state. The Fill Color 2 
property is used to define the color of the rest of the primitive. 

• The Line Format property is used to define the color of the various lines that are 
used to draw the primitive. These include the circle around the selector, and the 
four lines that define the rectangle within the primitive. 

The fourth page defines a number of properties specific to data entry. These are as defined for 
the tag text primitives, and you should refer to that section for details. The fourth page defines 
the label and format to be used for the primitive, and is as defined for flag tags or multi-state 
tags, depending on which type of selector is being configured. You are once again referred to 
the chapter of Tags for information on the various formatting options. 

THE PICTURE PRIMITIVE 

 

The Picture primitive is used to display one of a number of images, based upon 
an optional data value. The images may be manipulated in various ways, and may 
be moved within the primitive according to internal or external data values. 

 

The primitive provides exhaustive facilities for displaying bitmaps, JPEG picture, or metafiles 
images from MonicoView’s extensive image library or from third-party clipart providers. 
Five separate tabbed pages control the various options. 
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The first tab is used to select the images to be displayed… 

 

• The Image Count property is used to indicate how many different images should 
be displayed by this primitive. Up to ten different images can be shown. 

• The Image Selection property is a numeric value used to select between the 
various images if an Image Count of greater than one has been configured. A 
value of zero will display Image 0 and so on. 

• The Image Visible property is a true-or-false value used to hide or show the 
selected image. If you want the image to be hidden, you must not select No Fill 
for the Background when defining the background format. 

• The Image properties define each particular image. The Pick button next to each 
image can be used to launch the image library to allow an image to be selected; 
the Browse button can be used to open a file containing a bitmap, a JPEG or a 
Windows metafile; the Clear button can be used to remove the image; and the 
Adjust button can be used to edit the image as discussed below. 
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If you use one of the Adjust buttons to manipulate an image, you will first be warned about 
the problems you will encounter if you then try to download a database containing 
manipulated images using earlier versions of the Windows operating systems. Assuming you 
are happy to rule-out the use of such earlier releases, the following dialog box will appear… 

 

The various sliders can be used to pan, zoom and spin the image, while the checkboxes can be 
used to mirror it horizontally or vertically. The Show Center checkbox shows or hides the 
blue lines that mark the center of the image, while the Reset button can be used to restore the 
image to its original state. The various manipulation options are typically used to modify an 
image in order to create various different states for use in animation. 

The second tab of the Picture primitive’s properties contains any additional images that could 
not be displayed on the first page. It is only required when the Image Count is set to a value 
greater than four. The third tab controls movement of the image within the primitive. To 
enable this facility, drag either or both of the shaded rectangular handles in the top-left corner 
of the primitive so as to define a sub-region in which the image should reside… 
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The now-reduced image can be moved within the whole primitive by defining values to 
control its horizontal and vertical position. These values are defined together with minimum 
and maximum limits that specify the values corresponding to the extremes of the image’s 
movement within the primitive’s bounding rectangle… 

 

In this example, setting XPos to 0 will place the image at the left of the primitive, while 
setting it to 100 will place it at the far right. Similar behavior in respect of the up and down 
limits of the primitive can be obtained via the value stored in YPos. 

The fourth tab of the primitive’s properties is used to control basic formatting… 
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• The Fill Format properties are used to define the background pattern for the 
primitive. Note that if you want to animate the primitive in any way, you should 
specify some sort of background color so that the system can erase old images. 

• The Line Format properties are used to define the primitive’s outline style. 

The final tab of the primitive’s properties is used to define an optional action that can be 
triggered when the operator touches the image. You are referred to the earlier section on 
assigning actions to primitives for more details of how to configure this functionality. 

THE CF IMAGE PRIMITIVE 

The CF Image primitive is only available via Insert > Picture > CF Image menu. This 
primitive is used to display images saved on the CompactFlash card thus saving internal 
memory on large databases.  

Images have to be converted before their transfer on the CompactFlash card using the 
makepic utility, the primitive is not made to display BMP or other image formats straight 
from the card. Please refer to Converting Images for the CompactFlash below for more 
information on the makepic utility. Moreover, converted images HAVE TO be saved under 
the \PICS folder on the CompactFlash card to be available to the primitive. 

The properties of the CF Image primitive are displayed on two tabbed pages, the first of 
which is shown below… 

 

• The Image Selection property is used to select the image to display from the 
CompactFlash card. This setting is an integer number given by the MakePic 
utility when converting from  BMP only to the format required on the 
CompactFlash card.  

• The Show Image property is a true-or-false value used to hide or show the image. 
If you want the image to be hidden, you must not select No Fill for the 
background when defining the background format. 
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• The Show Item property is a true-or-false value used to hide or show the 
primitive. A value of zero will hide the primitive. 

• The Fill Format properties are used to define the background of the primitive. 

• The Line Format  properties are used to specify the format of the optional border 
around the primitive. 

The second tab of the primitive’s properties is used to define optional actions that can be 
triggered when the operator touches the image. You are referred to the earlier section on 
assigning actions to the primitives for more details of how to configure this functionality. 

CONVERTING IMAGES FOR THE COMPACTFLASH 

In order to prepare images for the CF Image primitive, the “makepic” utility is used. This 
utility can be found under MonicoView.0 installation folder and is a command line based 
utility. 

Makepic can only convert BMP images and it is strongly recommended to resize the image to 
its final appearance on the panel before the conversion. 

The syntax for makepic is as follow: 

makepic {switches} <input-file> <picture-number> 

… where <input-file> is the path and file name of the image you whish to convert and 
<picture-number> the number assigned to the converted picture, number that will be used 
by the primitive in the Image Selection property to identify the image. 

The switches field may contain one or more of the following options… 

• -nocomp can be used so the Bitmap result is not compressed. 

• -wide can be used to use 16 bit colors instead of 256. 

As an example, the following command line… 

 makepic C:\MyImages\picture.bmp 1 

… will convert the image picture.bmp and create a file pic001.g3p under the makepic 
installation folder. This file can then be copied over to the CompactFlash card under the 
\PICS folder. This image will be available for the CF Image primitive when image selection is 
equal to 1. 

THE DIAL GAUGE PRIMITIVES 

 

The Full Dial Gauge primitive displays an integer value as a pointer with a 270º 
swing within a full circle. The primitive can optionally display the data value, and 
the associated data label. The number of scale divisions can also be defined. 

 

The Half Dial Gauge primitive functions as does the full dial gauge, but displays 
a pointer with a 180º swing within a half-circle. All the other formatting and 
display options remain the same. 
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The Quarter Dial Gauge primitive functions as does the full dial gauge, but 
displays a pointer with a 90º swing within a quarter-circle. All the other 
formatting and display options remain the same. 

 

Just as with other rich primitives, the dial gauge primitives are capable of deriving much of 
the required formatting information from the tag used as their controlling value. Just as with 
tag text primitives, multiple tabbed pages are used to edit the primitives’ properties. 

The first of these pages is shown below… 

 

• The Value property is used to define the value to be displayed. 

• The Show Label property is used to indicate whether a label should be included 
with the gauge. The label is displayed in the center of the primitive, above the 
optional value. If a tag is used for the value property, the label may be obtained 
from that tag. Otherwise, it must be entered on the Format tab of the dialog box. 

• The Show Value property is used to indicate whether the value of the data should 
be displayed within the gauge. If a tag of the appropriate data type is used for the 
value property, the format may be obtained from the tag. Otherwise, as with the 
label, it must be entered on the Format tab. 

• The Get From Tag properties are used to indicate from where the label text, the 
field format and the text colors should be obtained. The options presented 
depend on what was entered for the Value property. In each case, you may 
manually enter the data in the appropriate properties, or, assuming a suitable 
expression has been defined, you may instruct the primitive to get the required 
information from the underlying data tag. 

• The Orientation property is used to indicate the direction in which the scale’s 
minor tick-marks should point. The major tick-marks always point inwards. 



SYSTEM PRIMITIVES CRIMSON USER MANUAL 

PAGE 176 www.monicoinc.com/support 

• The Major Divisions property is used to indicate into how many major divisions 
the scale should be divided. Large tick-marks are drawn at each division. The 
lowest number of major divisions is one, in which case large tick-marks will be 
drawn at the extremes of the scale, but not along its arc. 

• The Minor Divisions property is used to indicate into how many minor divisions 
each major division should be divided. Smaller tick-marks are drawn at each 
division. Selecting a value of one for this property will disable minor divisions. 

The second page defines various formatting options… 

 

• The Text Format properties are used to define the font to be used to display the 
optional data value and data label, and the colors to be used for the text. In 
addition, a property is provided to define whether the font should be opaque, or 
whether the pointer should be visible through the text. 

• The Fill Format properties are used to define the background color of the dial, 
and the color to be used to draw the interior of the pointer and the scale 
tick-marks. Fill Color 1 defines the background; Fill Color 2 the other items. 

• The Line Format property is used to define the color of the lines used to demark 
the pointer, the scale tick-marks and the outline of the dial gauge itself. 

The third page is used to define the optional label, and the minimum and maximum values, 
and the data format for the optional data value. This page functions as was previously 
described for integer data tags, and you are referred to that section for further details. 

SYSTEM PRIMITIVES 

The sections below describe each system primitive. These primitives are used to troubleshoot 
the interface. To insert one of the primitives, click Insert and select System as shown below. 
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THE TOUCH TEST PRIMITIVE 

This primitive is used to test the operator interface’s touch screen. Once the primitive is 
inserted on the display, touching the primitive draws a square dot at the position the touch 
screen was pressed. This provides control of the touch screen precision, as the dot should 
appear under the finger. If this is not the case, please proceed with the touch calibration 
primitive. 

Double clicking the primitive accesses the format properties to define colors and line format. 

THE TOUCH CALIBRATION PRIMITIVE 

This primitive is used to calibrate the operator interface’s touch screen. Once the primitive is 
inserted on the display and downloaded in the terminal, the page with the Touch Calib will 
display a set of instructions to calibrate the screen. It is required that you touch each of the 
squares shown on the display. The primitive will then inform you as to the success or failure 
of the calibration.  

Double clicking the primitive will access the format properties to define colors and line 
format. Actions can also be inserted upon success or failure of the test. 
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DEFINING PAGE PROPERTIES 

Each page has a number of properties that can be accessed via the Page menu… 

 

• The Entry Order property is used to define how the cursor on the operator panel 
will move between data entry fields. The setting determines whether fields 
organized in a grid will be entered in row or column order. 

• The Popup Location property is used to define the location of popup windows or 
the popup keypad when this display page is visible. You may wish to adjust this 
property to keep the popups away from important data items. 

• The Update Rate property is used to define how frequently items on the display 
are updated. As update rates increase in frequency, overall communications 
performance of the operator interface panel may decrease. This selection should 
be left at the default setting when possible. 

• The Background property is used to define the background color of the display 
page. Note that the background cannot be animated, as a change in the color 
would force the whole page to redraw, thereby impairing performance. 

• The On Select and On Remove properties are used to define actions to be 
performed when the page is first selected for display, or when the page is 
removed from the display. Refer to the Writing Actions section and the Function 
Reference for a list of supported actions. Refer to the Data Availability section in 
this chapter for details of a timeout than can occur when using these properties. 

• The On Tick property is used to define an action that will run every second while 
this page is displayed. Refer to the Writing Actions section and the Function 
Reference for a list of supported actions. If a lack of data availability results in 
this action being unable to execute, it will be skipped and retried one second 
later. 

• The On Update property is use to define an action that will be run each time the 
page is redrawn. Refer to the Writing Actions section and the Function 
Reference for a list of supported actions. If a lack of data availability results in 
this action being unable to execute, it will be skipped and retried on the next 
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update. You should note that you can severely reduce system performance by 
performing complex actions on every display update. You should also note that 
in many cases, actions that you may think need to be run on each update can be 
performed using triggers, or by using mapping blocks. 

• The Parent Page property is used to indicate the page to be displayed when the 
panel’s Exit key is pressed while this page is active. Selection of this page can 
be overridden using the techniques below. 

• The Next Page property is used to indicate the page to be displayed when the 
panel’s Next key is pressed while this page is active, and when the cursor is on 
the last data entry field on the page. This selection can also be overridden. 

• The Previous Page property is used to indicate the page to be displayed when the 
panel’s Prev key is pressed while this page is active, and when the cursor is on 
the first data entry field on the page. This selection can also be overridden. 

• The Period property is used to define the time in seconds to wait without any 
user interaction occurring before performing the action specified in the On 
Timeout property. These properties are typically used to remove a popup or to 
return to some sort of menu screen after several seconds of inactivity. 

If you have too many data entry fields to fit on a single page, the Next Page and Previous 
Page properties can be used to link together a series of pages to allow the operator to edit the 
fields in sequence. MonicoView will automatically position the cursor appropriately, such 
that if the Prev key is pressed on the first field of a page, the previous page will be activated 
with the cursor on the last field of that page. 

DEFINING SYSTEM ACTIONS 

In addition to the various actions that can be defined via page properties, MonicoView gives 
you the ability to define an action(s) to be run before the system starts, when the system first 
starts, and an action(s) to be run once a second or on page updates, no matter which page is 
displayed. These actions can be accessed by selecting the Pages icon in the left-hand pane of 
the User Interface window. You should refer to previous warnings regarding the use of the On 
Update property. 

ADDITIONAL SYSTEM PROPERTIES 

In addition to the system actions described above, there are two property pages accessed by 
selecting the Pages icon that gives you access to a number of other system-wide parameters. 
The Basic tab covers the following parameters… 
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• The Backlight Off After property is used to configure the system so as to disable 
the display backlight after the specified number of seconds of inactivity. This 
facility can be used to extend the life of the backlight components. The operator 
can reactivate the backlight by pressing a key, or touching an active area of the 
touch-screen. The key-press or touch is ignored until the backlight is lit. 

• The Activate Beeper property is used to control if the beeper should sound when 
the HMI touch screen or soft key buttons are pressed. This property will not 
deactivate the beeper for other events such as alarms or beep() functions. 

• The One Touch Data Entry property defines whether or not the keypad should 
pop up after one touch or two touches on a data entry field. Selecting No requires 
two touches to allow data entry. 

• The Keypad Next/Prev Keys property defines whether or not the system keypad 
popups for data entry should include the Next and Prev keys. Next and Prev keys 
are used to jump from one data entry field to another so as to avoid hiding the 
keypad between each data entry. 

• The Select Languages button is described in Selecting Languages below. 

The Advanced tab provides more evolved parameters explained below. 
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• The Error Recovery properties are used to define the behavior of the system 
when it encounters a software problem, or when the display fails to update for a 
long period of time as a result of a coding error. By default, the system will reset 
and display a so-called Guru Meditation Code to help the development engineers 
in tracking-down the problem. You may disable the display of this code to allow 
the system to recover more quickly and without user intervention. 

• The Include Image Files property is used to indicate that MonicoView should 
save within the database file a copy of any disk-based images that have been 
imported into the project. By default, the filename alone of the image is stored, 
thereby requiring you to have the images available on disk whenever you are 
working on the project. If you wish to create a single file that contains all the 
required data for the project, enable this option. Note that databases that contain 
image files will typically be very large, and may prevent upload support from 
working. 

• The Store Relative paths property indicates whether or not image paths should be 
stored relative to the Image Directory. Enabling this setting allows images to be 
stored in different directories on different PCs, without the need to browse for 
each individual image when moving between machines. 

• The Image Directory specifies the root directory to be used when loading images 
if relative paths have been enabled. Note that this is a per-machine setting, not a 
property of each individual database file. You should thus select a directory 
below which the images for all databases will be stored. 

• The Maintenance buttons can be used to remove unused fonts or images from 
the database, thereby reducing file size and lowering memory usage. You should 
typically use these options before releasing a database for use in the field, as they 
will remove most of the debris that accumulates during development. 

SELECTING LANGUAGES 

To select the various languages to be supported within your database, select the Pages icon 
within the User Interface window, and press the Select Languages button to display the 
following dialog box… 
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Up to eight different languages can be defined, each of which can be chosen from a 
drop-down list. MonicoView will re-configure Windows to use the appropriate Input Method 
Editor whenever a complex (ie. Unicode-based) language is being edited. In order to use this 
facility, you should ensure that you have the required language support installed by referring 
to the appropriate Windows documentation. If you wish to use a Unicode-based language that 
is not included in the drop-down list, select Generic Unicode mode instead. You will then be 
able to enter any Unicode characters, although you will have to manually select the 
appropriate keyboard mode or Input Method Editor. 

CHANGING THE LANGUAGE 

To configure a key or primitive to change the language displayed by the operator panel, select 
User Defined mode and enter SetLanguage(n) as the On Pressed property, where n is a 
number between 1 and 8, according to the language to be displayed. The display page will be 
redrawn in the selected language, with any text for which translations have been entered—
including fixed text, tag labels and tag formatting information—adjusted as appropriate. 
Pages that are subsequently displayed will also be drawn in the selected language. 

SIMULATING LANGUAGES IN MONICOVIEW 

Simulating languages provides a way to simulate how translated text will be shown in 
different languages. Therefore, required space for text fields or primitives containing text can 
be adjusted for all languages directly in MonicoView. To select the language to display, click 
View and Simulate Language... Languages set up earlier via the Select Language buttons are 
displayed. Just pick the language and click OK, MonicoView will switch all the text 
displayed in pages to the selected translation field. 
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DEFINING KEY BEHAVIOR 

In addition to defining actions that occur when primitives are touched, you may define actions 
to be executed when keys are pressed. To do this, first change the zoom level so that the 
required key can be seen. Then, double-click the key to produce the following dialog box… 

 

You will note that this dialog box is similar to that shown earlier in respect of primitives, but 
that it has two tabbed pages. The first page is used to define what will happen when the key in 
question is pressed when the current page is selected. The second page is used to define what 
will happen if the key is pressed when any page is selected. The first type of action is called a 
local action, while the second type is called a global action. 

The color used to display the key will change according to which actions are defined… 

 
If the key is displayed in PURPLE, a local action is defined for this PAGE. 

 
If the key is displayed in GREEN, a GLOBAL action is defined. 

 
If the key is displayed in BLUE, local and global actions are BOTH defined. 

 

Once you have defined an action, you can right-click on the key and use the resulting menu to 
select either Make Global or Make Local to change the action type. These options will not be 
available if both types of action have already been defined. 

BLOCKING DEFAULT ACTIONS 

When defining key actions, you may use the Block Default Action selection as a place-holder 
to prevent further processing. As an example, suppose you have configured F1 to perform a 
global action, but want to prevent this action from being invoked on a particular page. By 
configuring F1 on that page as Block Default Action, the global action will not occur. 
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DATA AVAILABILITY 

MonicoView’s communications infrastructure reads only those data items that are required 
for the current page. This means that when a page is first selected, certain data items may not 
be available. For a display primitive, this is no problem, as the primitive simply displays an 
undefined state (typically a number of dashes) until the data becomes available. For actions, 
though, things can get more complex. 

For example, suppose a local action increases the speed of a motor by 50 rpm. If the motor 
speed is not referenced on the previously displayed page, then, when the page is first 
displayed, MonicoView will not know the current speed, and will thus be unable to write the 
new value. To handle this, if the operator attempts to perform an action for which the required 
data is not available, the G3 panel will display a “NOT READY” message until the key in 
question is released. The operator must then wait a short while, and try the operation again. In 
practice, communications updates normally take place quickly enough that even the most 
nimble-fingered operator will be hard pressed to get the message to appear, but since it may 
on occasions be seen, it is worth explaining. 

A slightly more complex issue comes about if the action defined by a page’s On Select 
property is unable to proceed because it also finds that required data is not available. Here, 
MonicoView will wait up to thirty seconds for the data to arrive. If it does not, the action will 
not be performed, and a “TIMEOUT” message will be displayed for the operator. This 
timeout mechanism is required to avoid problems should a communications link become 
severed. 

NOTES FOR EDICT USERS 

Users of Monico’s Edict-97 software should note… 

• Pages no longer have text and graphic layers, as all primitives are graphical in 
nature. This means that the concept of a page format is similarly redundant. 

• Page categories have been replaced with system primitives. Where Edict would 
use an entire page for its alarm viewer, for example, the corresponding system 
primitive can be used to allocate as little or as much of the display as is required. 

• The actions defined by double-clicking a key replace the global and local event 
maps. If your application used more than one row per event, you will most likely 
need to use a program to implement the required logic. 

• Events such as comms update complete and one-second tick have been removed, 
as most of the actions performed by such events can now be handled via other 
mechanisms. For example, comms update complete was often used to move data 
between devices. This can now be performed using the protocol conversion 
functionality of the Communications window. In addition, these events were 
often misused and led to the creation of overly complex databases. 

• While Edict would typically manage something between two and five display 
updates per second, MonicoView is designed to redraw the display every 
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100msec, thus providing, for example, smoother operator feedback during data 
entry. 

CONFIGURING PROGRAMS 
The previous sections of this manual describe how you can use actions to perform all manner 
of operations in response to key presses or changes in data tags. If you need to perform an 
action that is too complex to fit on a single line, or that demands more complex decision-
making logic, you can use the Programming icon from the main screen to create and 
manipulate programs. You should note that many applications will not need programs. You 
may thus choose to skip this chapter if desired. 

 

USING THE PROGRAM LIST 

To create, rename or delete programs, click on the left-hand pane of the User Interface 
window. The various commands on the Program menu can then be used to make the desired 
changes. Alternatively, right-click on the required program, and select from the menu. 

To select a program, either click on the name in the list, or use the up and down arrows in the 
toolbar. Alternatively, you can use the Alt+Left and Alt+Right key combinations to move 
up and down the list as required. These keys will work no matter which pane is selected. 

EDITING PROGRAMS 

To edit a program, simply edit the program text using the large area in the right-hand pane of 
the Programming window. When you have finished, press the Ctrl+T key combination or 
select the Translate command from the Program menu. This will read the program and check 
it for errors. If an error is found, a dialog box will be displayed, and the cursor will be moved 
to the approximate position of the error. If no errors exist, a dialog box will be displayed to 
confirm this fact, and the program will be translated into MonicoView’s internal format for 
subsequent execution by the operator panel. 
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PROGRAM PROPERTIES 

The various fields at the bottom of the right-hand pane are used to edit program properties… 

• The Return Type property is used to indicate whether this program should simply 
perform a series of actions, or whether it will perform a calculation and return 
the value of that calculation to the user. Programs that return values are 
described in more detail below. 

• The Run In Background property is used to indicate whether MonicoView 
should wait for the program to complete execution before continuing with 
processing whatever task invoked the program. For example, if this property is 
set to No, running a program in response to a key being pressed will result in a 
pause in display updates until the program completes. (Since most programs take 
very little time to execute, this may not even be noticeable.) If this property is set 
to Yes, display updates will continue immediately, and the program will execute 
at a lower priority in the background. Only one background program will run at 
once, so subsequent requests are queued for later execution. Note also that 
programs that return values cannot be run in the background, as their return 
value would then not be available for the caller to use! 

• The External Data and Timeout properties are used to control how the program 
interacts with MonicoView’s communication infrastructure with respect to 
external data items to which the program makes reference. You will recall that 
MonicoView only reads data items when they are used. This property is used to 
control the exact interpretation of this rule with respect to programs… 

 

MODE BEHAVIOR 

Read When Referenced External data used by the program will be added to the 
comms scan whenever the program is referenced. If the 
program is referenced by a display page, the data will be 
read when that page is displayed; if the program is 
referenced by a global action or a trigger, the data will be 
read at all times. This is the default mode, and is 
acceptable for all programs, except those that use very 
large amounts of external data. 

Read Always External data used by the program will be read at all 
times, whether or not the program is referenced. This 
means that the program will always be ready to run, and 
that the operator will not see the “NOT READY” message 
that might otherwise occur when the program is first 
referenced. The downside of this mode is that comms 
performance may be reduced if large amounts of data are 
referenced by the program. 

Read When Executed External data used within the program will be read only 
when the program is invoked. The program will wait for 
the period defined in the timeout property for such data to 
be available. If the data cannot be read—perhaps because 
a device is offline—the program will not execute. This 
mode is typically used with globally-referenced programs 
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MODE BEHAVIOR 

that consume large amounts of data that would otherwise 
slow down the communications scan. 

Read But Run Anyway External data will be treated as described for Read Always 
mode, but the program will execute whether or not the 
data has been read successfully. The operator will 
therefore never see the “NOT READY” message, but if a 
device is offline, there is no guarantee that the program’s 
data items contain valid data. 

 

• The Arguments property is used to specify up to five arguments that can be 
passed into the program. Each argument has a name and a data type, as specified 
by the dialog box that is displayed when the Edit button is pressed... 

 

• Passing arguments to programs is described in more detail below. 

ADDING COMMENTS 

You can add comments to your programs in two ways. Firstly, you can use the // sequence to 
introduce a comment which will continue for the rest of the current line. Secondly, you can 
use the /* sequence to introduce a single- or multi-line comment. This comment will continue 
until the */ sequence appears. The sample below shows both commenting styles… 

// This is a single-line comment 
 
/* This is line 1 of the comment 
   This is line 2 of the comment 
   This is line 3 of the comment */ 

A single-line comment may also be placed at the end of a line that contains code. 
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RETURNING VALUES 

As mentioned above, programs can return values. Such programs can be invoked by other 
programs or by expressions anywhere in the database. For example, if you want to perform a 
particularly complex decode on a number of conditions relating to a motor and return a value 
to indicate the current state, you could create a program that returns an integer like this… 

if( MotorRunning ) 
 return 1; 
else { 
 if( MotorTooHot ) 
  return 2; 
 if( MotorTooCold ) 
  return 3; 
 return 0; 
 } 

You could then configure a multi-state formula to invoke this program, and use that tag’s 
format tab to define the names of the various states. The invocation would be performed by 
setting the tag’s Value property to Name(), where Name is the name of the program in 
question. The parentheses are used to indicate a function call, and cannot be omitted. 

HERE BE DRAGONS! 

Note that you have to exercise a degree of caution when using programs to return values. In 
particular, you should avoid looping for long periods of time, or performing actions that make 
no sense in the context in which the function will be invoked. For example, if the code 
fragment above called the GotoPage function to change the page, the display would change 
every time the program was invoked. Imagine what would happen if you, say, tried to log 
data from the associated tag, and you’ll realize that this would not be a good thing! Therefore, 
keep programs that return values simple, and always consider the context in which they will 
be run. If in doubt, avoid doing anything other than simple math and if statements. 

PASSING ARGUMENTS 

As also mentioned above, program can accept arguments. As an example, suppose you want 
to write a program called FindMean to take the average of two values. The program could be 
configured to accept two integer arguments, a and b, as shown in the example given when 
defining the purpose of the Arguments property. The program would also be configured so as 
to return a integer value. The code within the program would then be defined as… 

return (a+b)/2; 

Once this program has been created and translated, you will be able to enter an expression 
such as FindMean(Tag1, Tag2) to invoke it with the appropriate arguments. In this case, the 
expression will be equal to the average of Tag1 and Tag2. 
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PROGRAMMING TIPS 

The sections below provide an overview of the programming constructions supported by 
MonicoView. The basic syntax used is that of the C programming language. Note that the aim 
is not to try and teach you to become a programmer, or to master the subtleties of the C 
language. Such topics are beyond the scope of this manual. Rather, the aim is to provide a 
quick overview of the facilities available, so that the interested user might experiment further. 

MULTIPLE ACTIONS 

The simplest type of program comprises a list of actions, with each action taking up a single 
line, and being followed by a semicolon. All of the various actions defined in the Writing 
Actions section are available for use. Simple programs like this are typically used where 
combining the actions in a single action definition would otherwise prove unreadable. 

The sample shown below sets several variables, and then changes the display page… 

Motor1 := 0; 
Motor2 := 1; 
Motor3 := 0; 

GotoPage(Page1); 

The actions will be executed in order, and the program will then return to the caller. 

IF STATEMENTS 

This type of statement is used within a program to make a decision. The construct consists of 
an if statement with a condition in parentheses, followed by an action (or actions) to be 
executed if the condition is true. If more than one action is specified, each should be placed 
on a separate line, and curly-brackets should be used to group the statements together. An 
optional else clause can be used to provide for code to be run if the condition is false. 

The architecture of the if statement is as follow… 

if( condition ){ 
 action1; 
 } 
else{ 
 action2; 
 } 

The example below shows an if statement with a single action… 

if( TankFull ) 
 StartPump := 1; 
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The example below shows an if statement with two actions… 

if( TankEmpty ) { 
 StartPump := 0; 
 OpenValue := 1; 
 } 

The example below shows an if statement with an else clause… 

if( MotorHot ) 
 StartFan := 1; 
else 
 StartFan := 0; 

Note that it is very important to remember to place the curly-brackets around groups of 
actions to be executed in the if or else portion of the statement. If you omit the brackets, 
MonicoView will most likely misunderstand exactly which actions you want to be dependent 
upon the if condition. Although line breaks are recommend between actions, they are not 
used to figure out what is and is not included within the conditional statement. 

SWITCH STATEMENTS 

A switch statement is used to compare an integer value against a number of possible 
constants, and to perform an action based upon which value is matched. The exact syntax 
supports a number of options beyond those shown in the example below, but for the vast 
majority of applications, this simple form will be acceptable. 

The architecture of the switch statement is as follow… 

switch ( int var) { 
 case 1: 
  action1; 
  break; 
 case 2: 
  action2; 
  … 
 default: 
  action3; 
  break; 
 } 
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This example below will start a motor selected by the value in the MotorIndex tag... 

switch( MotorIndex ) { 
 
 case 1: 
  MotorA := 1; 
  break;  
 case 2: 
 case 3: 
  MotorB := 1; 
  break;  
 case 4: 
  MotorC := 1; 
  break; 
 default: 
  MotorD := 1; 
  break; 
 } 

A value of 1 will start motor A, a value of 2 or 3 will start motor B, and a value of 4 will start 
motor C. Any value which is not explicitly listed will start motor D. Things to note about the 
syntax are the use of curly-brackets around the case statements, the use of break to end each 
conditional block, the use of two sequential case statements to match more than one value, 
and the use of the optional default statement to indicate an action to perform if none of the 
specified values is matched by the value in the controlling expression. (If this syntax looks 
too intimidating, a series of if statements can be used instead to produce the same results, but 
with marginally lower performance, and somewhat less readability.) 

LOCAL VARIABLES 

Some programs use variables to store intermediate results, or to control one of the various 
loop constructs described below. Rather than defining a tag to hold these values, you can 
declare what are known as local variables using the syntax shown below… 

int     a;  // Declare local integer ‘a’ 
float   b;  // Declare local real    ‘b’ 
cstring c;  // Declare local string  ‘c’ 

Local variables may optionally be initialized when they are declared by following the variable 
name with := and the value to be assigned. Variables that are not initialized in this manner 
are set to zero, or an empty string, as appropriate. 

Note that local variables are truly local in both scope and lifetime. This means that they 
cannot be referenced outside the program, and they do not retain their values between 
function invocations. If a function is called recursively, each invocation has its own variables. 

LOOP CONSTRUCTS 

The three different loop constructs can be used to perform a given section of code while a 
certain condition is true. The while loop tests its condition before the code is executed, while 
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the do loop tests the condition afterwards. The for loop is a quicker way of defining a while 
loop, allowing you to combine three common elements into one statement. 

You should note that some care is required when using loops within your programs, as you 
may make a programming error which results in a loop that never terminates. Depending on 
the situation in which the program is invoked, this may seriously disrupt the terminal’s user 
interface activity, or its communications. Loops which iterate too many times may also cause 
performance issues for the subsystem that invokes them. 

THE WHILE LOOP 

This type of loop repeats the action that follows it while the condition in the while statement 
remains true. If the condition is never true, the action will never be executed, and the loop 
will perform no operation beyond evaluating the controlling condition. If you want more than 
one action to be included in the loop, be sure to surround the multiple statements in curly-
brackets, as with the if statement. The example below initializes a pair of local variables, and 
then uses the first to loop through the contents of an array, totaling the first ten elements, and 
returning the total value to the caller… 

The architecture of the while loop statement is as follow… 

 

while ( condition ){ 
 Action; 
 } 

int i:=0, t:=0; 
 
while( i < 10 ) { 
 t := t + Data[i]; 
 i := i + 1; 
 } 
 
return t; 

The example below shows the same program, but rewritten in a compressed form. Since the 
loop statement now controls only a single action, the curly-brackets have been omitted… 

int i:=0, t:=0; 
 
while( i < 10 ) 
 t += Data[i++]; 
 
return t; 
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THE FOR LOOP 

You will notice that the while loop shown above has four elements… 

1. The initialization of the loop control variable. 

2. The evaluation of a test to see if the loop should continue. 

3. The execution of the action to be performed by the loop. 

4. The making of a change to the control variable. 

The for loop allows elements 1, 2 and 4 to be combined within a single statement, such that 
the action following the statement need only implement element 3. This syntax results in 
something similar to the FOR-NEXT loop found in BASIC and other such languages.  

The architecture of the for loop statement is as follow… 

for ( initialization; condition; control ){ 
 action1; 
 } 

Using this statement, the example given above can be rewritten as… 

int i, t; 
 
for( i:=t:=0; i<10; i++ ) 
 t += Data[i]; 
 
return t; 

You will notice that the for statement contains three distinct elements, each separated by 
semicolons. The first element is the initialization step, which is performed once when the loop 
first begins; the next is the condition, which is tested at the start of each loop iteration to see if 
the loop should continue; the final element is the induction step, which is used to make a 
change to the control variable to move the loop on to its next iteration. Again, remember that 
if you want more than one action to be included in the loop, include them in curly-brackets! 

THE DO LOOP 

This type of loop is similar to the while loop, except that the condition is tested at the end of 
the loop. This means that the loop will always execute at least once.  

The architecture of the do loop statement is as follow… 

do { 
 action1; 
 } while ( condition ); 
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The example below shows the example from above, rewritten to use a do loop… 

int i:=0, t:=0; 
 
do { 
 t += Data[i]; 
 } while( ++i < 10 ); 
 
return t; 

LOOP CONTROL 

Two additional statements can be used within loops. The break statement can be used to 
terminate the loop early, while the continue statement can be used to skip the balance of the 
loop body and begin another iteration without executing any further code. To make any sense, 
these statements must be used with if statements to make their execution conditional. The 
example below shows a loop that terminates early if another program returns true… 

for( i:=0; i<10; i++ ) { 
 if( LoopAbort() ) 
  break; 
 LoopBody(); 
 } 

NOTES FOR EDICT USERS 

Users of Monico’s Edict-97 software should note… 

• MonicoView supports local variables by means of C-style declarations within 
the program body, rather than via the local variable table. Unlike Edict’s local 
variables, MonicoView’s variables are held on the stack, and can thus be used if 
a program is called recursively. This also means that MonicoView’s local 
variables do not hold their values between program invocations. 

• MonicoView supports passing arguments into functions, so there is no need to 
use global variables to improvise such functionality. As with local variables, 
arguments are stored on the stack, and can thus be used recursively. 

• MonicoView does not support the Dispatch function. The decision as to 
whether to run a program in the foreground or the background is based upon the 
program’s properties, and not on the method used for its invocation. 

• MonicoView invokes programs using a C-style syntax, and—while the older 
syntax is still supported—does not need the Run function to be used. Programs 
that return values must be invoked using the newer syntax, though, as the Edict 
family functions such as RunInteger are not provided. 

• Programs within MonicoView run much more quickly than they did within 
Edict! 
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CONFIGURING DATA LOGGING 
Now that you have configured the core of your application, you may decide to make use of 
MonicoView’s data logger to record certain tag values to CompactFlash. Data recorded in this 
way is stored in industry-standard comma-separated variable (CSV) files, and can easily be 
imported into applications such as Excel using a variety of methods. To configure data 
logging, select the Data Logger icon from the main screen… 

 

The right hand pane presents options for Data logging.  

• Batch logging is explained below.  

• The Trend Viewer Support property is used to activate the trend history buffer 
for the trend viewer primitive. If the historical data facility is not used, this 
setting should be disabled so the minimum history buffer memory allocation is 
freed, thus reducing memory usage. 

BATCH LOGGING 

Batch Logging is a utility to create production oriented logging. For normal data logging 
operation, the data logger will save the log files under a folder named as the log. On the other 
hand, batch-logging operation follows a start and end event, meaning the data will be 
recorded only between the start and end event. In this case, log files included in batch logging 
are not only saved under the log folder but also the batch folder. The batch folder will take an 
operator given name upon the start event. Logs are included with the Include In Batch option 
present in different places in MonicoView such as each data log, Data Tags for event logging 
and the Security Manager. 
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The figure above shows the result on the CompactFlash card for normal logging and batch 
logging. 

In this example, two batches were created, one called WATERA and one WATERB. Each 
folder contains a LOG1 folder which in turn contains log files with data only recorded while 
each respective batch was running. The data logger created continuous log files under 
LOGS\LOG1. Note that LOG2 was not included in batch, as it does not appear under the 
batch folders. 

CONTROLLING A BATCH 

In order to control batch logging, some functions are available. NewBatch(cstring Name) 
will create a batch folder called Name on the CompactFlash card and start batch logging. Files 
recorded after this command will be saved under that folder. EndBatch() will stop the 
current running Batch. GetBatch() will return the name of the current running batch. For 
more information, please refer to the functions reference of this manual. 

CREATING DATA LOGS 

You may use the Create Data Log button to create as many data logs as you need. Since each 
log can record an unlimited number of data tags, most applications will only use a single log. 
However, since each log has a fixed set of properties in terms of its sample rate, you may 
decide to use multiple logs if you wish to sample different data at different rates. 

USING THE LOG LIST 

To rename or delete data logs, click on the left-hand pane of the Data Logger window. The 
commands on the Log menu can then be used to make the desired changes. Alternatively, you 
may right-click on the required data log, and select from the menu. 

(Note that the name of a data log must be eight characters or less in length. This is because 
the name will be used to define the directory under which the log files are stored, and the G3 
panel is not able to handle names that do not conform to FAT-style 8.3 naming.) 

To select a data log, either click on the name in the list, or use the up and down arrows in the 
toolbar. Alternatively, you can use the Alt+Left and Alt+Right key combinations to move 
up and down the list as required. These keys will work no matter which pane is selected. 



CONFIGURING DATA LOGGING DATA LOG PROPERTIES 

REVISION 12 PAGE 199 

DATA LOG PROPERTIES 

Each data log has the following properties… 

 

• The Update Type property defines if this data log will record data continuously 
or on a trigger edge. Continuous Sample data logging saves tags values at regular 
time intervals, as define by the Update Rate property. Triggered Snapshot saves 
tags values when the expression in the Log Trigger property goes from false to 
true. Since the log trigger is looking at the change in the expression, only one set 
of data will be recorded at the time of change, the expression has to return to 
false and back to true again to save another set. Each set is a line of data in a 
CSV file. 

• The Update Rate property is used to indicate how often MonicoView will take a 
sample of the data items to be logged. The fastest sample rate is one second, but 
note that using such a high rate will produce very large amounts of data! All of 
the tags in the log will be sampled at the same rate. 

• The Each File Holds property is used to indicate how many samples will be 
included in each log file. When this many samples have been recorded, a new 
log file will be created using a different name. Typically, this value is set such 
that each log file contains a sensible amount of data. For example, the log shown 
above is configured to use a new log file each day. 

• The Retain At Most property is used to indicate how many log files will be kept 
on CompactFlash before the oldest file is deleted. This property should be set so 
as to allow whatever is consuming the logged information to extract the data 
from the G3 panel before the information is deleted. The log shown above is 
configured to retain a week’s worth of data. 

• The Log Enable property is used to allow or inhibit logging. If the entered 
expression is true, logging will be enabled. If the expression is false, logging will 
be disabled. If no expression is entered, logging will be enabled by default. 

• The Log Trigger property is used to log a single set of data when the expression 
changes from false to true. 
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• The History Buffer property is used to indicate how much RAM should be 
allocated for the history buffer for this data logger. The history buffer is used to 
support the historical trending user interface primitive, and allows the user to 
scroll backwards to view older data than would otherwise be available. No more 
than a total of 256K should be allocated to all data logs. This property is ignored 
on G303s and other panels that lack the historical trending primitives. 

• The Contents property is used to indicate which tag should be logged. The first 
list shows the selected tags, while the second shows those that are available 
within the database. Tags can be added to the log by double-clicking them in the 
right-hand list; they can be removed by double-clicking them in the left-hand 
list, or by pressing the Del key while the tag is selected. The Up and Down 
buttons can be used to move tags within the list. One day, someone may even get 
around to implementing drag-and-drop to allow easier manipulation of this list! 

LOG FILE STORAGE 

As mentioned above, a data log stores its data in a series of files on the Master’s 
CompactFlash card. These files are placed in a subdirectory named after the data log, with 
this directory being stored under a root directory entry called LOGS.  

FILENAME FOR CONTINUOUS DATA LOGGING 

The files are named after the time and date at which the log is scheduled to begin. If each file 
contains an hour or more of information, the files will be named YYMMDDhh.CSV, where YY 
represents the year of the file, MM represents the month, DD represents the date, and hh 
represents the hour. If each file contains less than one hour of information, the files will 
instead be named MMDDhhmm.CSV, with the initial six characters as described above, and the 
trailing mm representing the minute at which the log began. These rules ensure that each log 
file has a unique name. 

The length of each file depends on the Update Rate and Each File Holds properties. For 
example, with an update rate of 5 seconds and a number of samples of 360, each file will hold 
(5 x 360) / 60 = 30 minutes of data, therefore following the MMDDhhmm.CSV filename 
format. A new file will therefore be created every 30 minutes. 

FILENAME FOR TRIGGERED SNAPSHOT DATA LOGGING 

Since triggered data logging does not follow an update rate, you might think a file is created 
every time the number of samples specified is reached. However, this is not the case, the 
same rules apply for triggered data logging filenames as for continuous data logging. This 
means the Update Rate still has an influence on file creation. 

As soon as a rising edge is detected by the log trigger, a set of data is recorded and a new file 
is created if none exists. Every time the log is triggered, a new data set will be added to the 
file until it reaches the maximum time specified by the Update Rate x Number of samples. 
For example, with an update rate of 60 seconds and a number of samples of 1440, a new file 
will be created every (1440 x 60) / 3600 = 24 hours. The number of samples per file will 
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most likely be different, however, each file will represent a fix length of time regardless of the 
number of samples. 

THE LOGGING PROCESS 

MonicoView’s data logger operates using two separate processes. The first samples each data 
point at the rate specified in its properties, and places the logged data into a buffer within the 
RAM of the G3 panel. The second process executes every two minutes, and writes the data 
from RAM to the CompactFlash card. This structure has several advantages… 

• Writes to the CompactFlash card are guaranteed to begin only on a two-minute 
boundary—that is, at exactly 2, 4 or 6 minutes past the hour, and so on. This 
means that if your G3 panel supports hot-swapping of CF cards, you can wait for 
the next burst of writes to start, and, when the CompactFlash activity LED on the 
front of the panel ceases to flicker, you are guaranteed to have until the start of 
the next two-minute interval before further writes will be attempted. This means 
that you can remove the card without fear of data corruptions. As long as you 
insert a new card before four minutes have elapsed, no data will be lost. 

• Writes to the CompactFlash achieve a much higher level of performance, by 
avoiding the need to continually update the card’s file system data structures for 
every single sample. For logs configured to sample at very high data rates, the 
bandwidth of a typical CompactFlash card would not allow data to be written 
reliably in the absence of such a buffering process. 

Note that because data is not committed to CompactFlash for up to two minutes, up to this 
amount of log data may be lost when the terminal is powered-down. Further, if the terminal is 
powered-down while a write is in progress, the CompactFlash card may be corrupted. To 
ensure that such corruption is not permanent, the G3 panel uses a journaling system that 
caches writes to additional non-volatile memory within the terminal. If the panel detects that a 
write was interrupted during power-down, the write will be repeated when power is reapplied, 
thereby reversing any corruption, and repairing the CompactFlash card. 

This means that if you want to remove a CompactFlash card from a panel performing data 
logging, you must observe the procedure described above with respect to the activity LED, 
and only remove power when the activity has ceased. If you are not sure if the terminal was 
powered-down correctly, reapply power, allow a CompactFlash write sequence to complete, 
and power down according to the correct procedure. The card can then be removed safely. 

Since the gyrations required to remove a CompactFlash card are somewhat complex, 
MonicoView provides two other mechanisms for accessing log files, thereby eliminating the 
need for such removals. These methods are described below. 

ACCESSING LOG FILES 

There are three additional methods of accessing log files… 

• The less preferable method is to mount the card as a drive on a PC via the 
process described at the start of this manual, so that the logs can be copied using 
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Windows Explorer. Note that Windows 2000 or above is recommended when 
using this method, as earlier versions of Windows may otherwise lock the 
CompactFlash card and disrupt data logging. 

• The preferred method is to use the web server as described in the next chapter. 
With the web server enabled, log files can be accessed over the panel’s Ethernet 
port, using either a web browser, such as Microsoft Internet Explorer, or by 
using the automated process implemented by the WebSync utility that is 
provided with the MonicoView configuration software. 

• Another preferred method, especially over networks, is to use the 
Synchronization Manager. This advanced feature uses the File Transfer Protocol 
(FTP) to synchronize the G3 CompactFlash card with an FTP server. The G3 in 
this case will be an FTP client, thus allowing the G3 to initiate the file transfer, 
as opposed to the PC initiating the transfer via WebSync. Please refer to the 
section “Advanced Communication – Configuring the Synchronization Manager” 
of this manual for details on this feature. 

USING WEBSYNC 

The WebSync utility—which will be stored in the directory specified when the software was 
installed—can be executed to synchronize a directory on a PC with the contents of an 
operator panel’s data logs. You may decide to configure an application, such as the Windows 
Scheduler (or perhaps a cron daemon), to run this utility on a regular basis, or you may use a 
command line switch to instruct WebSync to perform the polling automatically. You may 
also decide to host WebSync on a central server so that the log files can be made available to 
selected users on your corporate network. 

WEBSYNC SYNTAX 

WebSync is invoked from the command line using the following syntax… 

websync {switches} <hostname> 

…where <hostname> is replaced with the IP address of the panel to be polled. 

OPTIONAL SWITCHES 

The switches field may contain one or more of the following options… 

• –terse can be used to suppress progress information. 

• –poll <n> can be used to poll the terminal every n minutes. 

• –path <dir> can be used to specify dir as the directory to hold the log files. 

• -ras <name> can be used to invoke a dial-out connection to access the unit. 

• -user <name> can be used to specify the username for the connection. 

• -pass <pass> can be used to specify the password for the connection. 
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• -num <num> can be used to override the phone number for the connection. 

EXAMPLE USAGE 

As an example, the following command line… 

websync –poll 10 –path C:\Logs 192.9.200.52 

…will read the log files for all data logs on the terminal with the IP address of 192.9.200.52, 
and will store these logs under subdirectories of the C:\Logs directory. WebSync will 
continue to execute, and will repeat the polling process every ten minutes. The polling 
interval must obviously be set such that it is much less than the sampling rate times the 
number of samples in a file times the number of log files to be retained. If this constraint is 
met, the directory on the PC will accumulate copies of all the log files from the terminal. 

NOTES FOR EDICT USERS 

Users of Monico’s Edict-97 software should note… 

• Logs within MonicoView record the time and date of each sample, and do not 
need to store the “empty” values used by Edict to mark power-down periods. 
When a G3 panel is powered-down, this will show simply as a gap in the log 
files. 
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CONFIGURING THE WEB SERVER 
MonicoView’s web server can be used to expose various data via the G3 panel’s Ethernet 
port, allowing remote access to diagnostic information, or to the values recorded by the Data 
Logger. The web server is configured by selecting the Web Server icon from the main screen. 

WEB SERVER PROPERTIES 

The web server has the following properties… 

Under the Main tab: 

  

• The Server State property is used to enable or disable the web server. If the 
server is enabled, the panel will monitor port 80 for incoming requests, and will 
fulfill the requests as required. If the server is disabled, connections to this port 
will be refused. Remember that in order for the server to operate, the panel’s 
Ethernet port must have been enabled via the Communications window. 

• The Listen on Port property indicates the TCP port number the web server will 
listen on. Port 80 is the standard http port for web browsing and will most likely 
suit your application. 

• The Title property is used to provide the title to be shown on the web server 
menu. This title can be used to differentiate between several terminals on a 
network, thereby ensuring that the correct terminal is being accessed. 

• The Data Log Access property is used to enable or disable web access to the files 
created by the Data Logger. Obviously, this facility must be enabled if the 
WebSync utility is to be used to copy the log files to a PC. 

• The Remote Viewing property is used to enable or disable a facility by which a 
web browser can be used to view the current contents of a G303’s display. This 
facility is very useful when remotely diagnosing problems that an operator may 
be having with the operator panel or the machine it controls. 
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• The Remote Control property is used to enable or disable an option by which the 
remote viewing facility is extended to allow a web browser to be used to 
simulate the pressing of keys on the operator panel, thereby allowing remote 
control of the panel or the machine it controls. While this feature is extremely 
useful, care must be taken to use the various security parameters to avoid 
unauthorized tampering with a machine. The use of an external firewall is also 
strongly recommended if the panel is reachable from the Internet. 

• The Custom Site property is used to enable or disable a facility by which files 
stored in the WEB directory of the CompactFlash card are exposed via the web 
server. This facility is described in more detail below. 

• The Remote Refresh property represents the frequency at which the web browser 
connected to the G3 Web Server will refresh the remote view web page. A value 
of zero will refresh as quick as possible. For slower connections such as 
modems, a higher value is recommended. The maximum is 60 seconds.  

Under the Security tab: 

 

• The Security properties are used to restrict web server access to hosts whose IP 
address matches the mask and data indicated. All access may be restricted, or the 
filter may be used to restrict only attempts to use the remote control facility. The 
filter works in the following way: 

Permitted IP Data: 192.168.100.1 

Permitted IP Mask: 255.255.255.0 

Range of IP authorized = Permitted IP Data & Permitted IP Mask 

Range of IP authorized = 192.168.100.X. 

This means, any PC with IP addresses starting with 192.168.100 are allowed to 
access the restriction selected. It is your responsibility to use an external firewall to 
prevent unauthorized access if the remote control facility is enabled, as the IP filter 
may be defeated by certain advanced hacking techniques, and is not warranted by 
Monico Controls. 
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• The Authentication properties are used to restrict access to any user connecting 
onto the web server when Authenticated Users is selected. Upon connection, the 
user will be required to enter the Username and Password defined under Logon 
Username (Max 31 characters) and Logon Password (Max 15 characters). Both 
are case sensitive. It is your responsibility to use an external firewall to prevent 
unauthorized access if the remote control facility is enabled, as the login control 
may be defeated by certain advanced hacking techniques, and is not warranted 
by Monico Controls. 

ADDING WEB PAGES 

In addition to the facilities described above, the web server supports the display of generic 
web pages, each of which contains a predefined list of tag values. These pages are created by 
pressing the Create Web Page button below the web server properties, and are stored in a list 
similar to that used for display pages, data logs and so on. 

 

Each web page has the following properties… 

• The Title property is used to identify the web page in the menu presented to the 
user via their web browser. Although the title is translatable, current versions of 
MonicoView use only the US version of the text. 

• The Refresh property is used to indicate whether or not the web browser should 
be instructed to refresh the page contents automatically. Update rates between 1 
and 8 seconds are supported. Note that the amount of flicker exhibited by the 
web browser will vary according to the exact package used and the performance 
of the machine being employed. The update is not intended to be flicker-free. 

• The Use Colors property (not available in the G303) is used to indicate if the 
tags colors should be displayed for this page in the web browser. The color 
displayed in the web browser will follow the one defined for each tag and will 
therefore change depending on the tag status. The tag colors are defined on each 
tag in the Data Tags module. Please refer to the Configuring Data Tags section 
of the manual for more details. 

• The Contents property is used to indicate which tags should be included on the 
page. The first list shows the selected tags, while the second shows those that are 



USING A CUSTOM WEB SITE CRIMSON USER MANUAL 

PAGE 208 www.monicoinc.com/support 

available within the database. Tags can be added to the page by double-clicking 
them in the right-hand list; they can be removed by double-clicking them in the 
left-hand list, or by pressing the Del key while the tag is selected. The Up and 
Down buttons can be used to move tags within the list. Drag-and-drop operation 
may one day be implemented to allow easier manipulation of this list! 

USING A CUSTOM WEB SITE 

While the standard web pages provide quick-and-easy access to the data within the terminal, 
you may find that your inability to edit their precise formatting leaves your artistic 
capabilities somewhat frustrated. You may thus use the terminal’s custom site facility to 
create a completely custom web site using your favorite third-party HTML editor, and—by 
inserting certain special sequences and storing the resulting files on the panel’s CompactFlash 
card—expose this site using the panel’s web server. 

CREATING THE SITE 

The web site may use any HTML facilities supported by your browser, but must not use ASP, 
CGI or other server-side tricks. The filenames used for the HTML files and associated 
graphics must also comply with the old-style 8.3 naming convention. This means that file 
extensions will be—for example—HTM instead of HTML, and JPG instead of JPEG. This also 
means that the body of the filename must be eight characters or less, and that you must not 
rely on the difference between upper- and lower-case to differentiate between pages. You 
may use any directory structure, as long as you once again ensure that your directories 
observe the 8.3 naming convention and do not rely on case differences. 

EMBEDDING DATA 

To embed tag data within a web page, insert the sequence [[N]], replacing N with the index 
number of the tag in question. This index number is displayed on the status bar when a tag is 
selected within the Data Tag window, and more-or-less corresponds to the order in which the 
tags were created. When the web page containing this sequence is served, the sequence will 
be replaced by the current value of the tag, formatted according to the tag’s properties. 

DEPLOYING THE SITE 

To deploy your custom web site, copy it into the \WEB directory on the CompactFlash card to 
be installed in the terminal. To copy the files, either mount the card as a drive on your PC as 
described at the start of this manual, or use a suitable card writer connected to your PC. Make 
sure that the Enable Custom Site property is set, and the custom site will appear on the web 
server menu. When the site is selected, a file called DEFAULT.HTM within the \WEB directory 
will be displayed. Beyond that point, navigation is according to the links within the site. 

COMPACTFLASH ACCESS 

Note that in order to serve custom web pages—or to provide access to the panel’s data 
logger—the web server needs to be able to access the unit’s CompactFlash card. If you have 
mounted the card as a drive on your PC and performed write operations, you may have to 
wait a minute or so for the PC to unlock the card and allow the terminal to get access. If you 
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are using an operating system earlier than Windows 2000 to perform such an operation, you 
may find that your PC locks the card when the drive is first mounted, whether or not a write is 
performed. Again, this lock will be released within a minute or so. 

ACCESSING THE WEB SERVER 

The web server can be accessed by multiple means depending on your application.  

USING ETHERNET 

The principal and easiest way to access the web server is via Ethernet. If your G3 is 
connected to the Local Area Network (LAN) and has a valid IP address, start your Web 
Browser and type the G3 Ethernet IP address to connect to the G3 web server. The browser 
will then display the menu page or require login if authentication is activated.  

In case the TCP port defined in the Web Server module is different from 80, the IP address 
entered in the web browser has to be followed by a colon (:) and the port required. For 
example: http://192.168.1.10:81 

USING MODEMS 

The second way to access the web server is via a modem connection. The G3 supports 
multiple types of modems such as Landline, GSM and GPRS. The G3 Ethernet port does 
NOT have to be activated if you only plan to access the web server via modem. Please refer 
to the Advanced Communication – Working With Modems section for more details about 
modem configuration. 

For a PPP and modem server configuration, once the PC and the modem are connected, the IP 
address required in the browser is NOT the G3 Ethernet port IP address, but the Local 
Address defined on the Comm. Port where the PPP modem protocol is selected. The remote 
address is the one obtained by the PC upon its connection with the modem. 

 

For a PPP and modem client configuration, the G3 will most likely connect to the Internet 
using an Internet access provider. The IP address to enter in your web browser is therefore the 
one provided by this service. For this reason, you will most likely require a fixed IP address 
to be able to access the G3 web server. 

http://192.168.1.10:81/�


WEB SERVER SAMPLES CRIMSON USER MANUAL 

PAGE 210 www.monicoinc.com/support 

In case the TCP port defined in the Web Server module is different from 80, the IP address 
entered in the web browser has to be followed by a colon (:) and the port required. For 
example: http://192.168.100.0:81. 

WEB SERVER SAMPLES 

The picture below shows the main menu displayed by the web server… 

 

The picture below shows a list of standard web pages… 

 

The picture below shows a standard web page containing three tags… 

 

http://192.168.100.0:81/�
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The picture below shows the data log menu… 

 

The picture below shows the contents of a given data log… 

 

The picture below shows the contents of a given log file… 
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The picture below shows a custom page containing three tags… 

 

The picture below shows the custom page being created within FrontPage… 
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The picture below shows the remote viewing and/or control display for the G303… 
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USING THE SECURITY SYSTEM 
MonicoView contains powerful features to allow you to define which operators have access 
to which display pages, and limit those operators who are able to make changes to sensitive 
data. The software also contains a security logging facility that can be used to record changes 
to data values indicating when the change occurred, and by whom it was performed. 

SECURITY BASICS 

The follow sections details some of the basic concepts used by the security system. 

OBJECT-BASED SECURITY 

MonicoView’s security system is object-based. This means that security characteristics are 
applied to a display page or to a tag, and not to the user interface element that accesses the 
page or makes a change to the tag. The alternative subject-based approach typically means 
that you have to be careful to apply security settings to every single user interface element 
that might change restricted data. MonicoView’s approach avoids this duplication and ensures 
that once you have decided to protect a tag, it will remain protected throughout your database. 

NAMED USERS 

MonicoView supports the ability to create any number of users, each of whom will have a 
username, a real name and a password. The username is a case-insensitive string with no 
embedded spaces that is used to identify the user when logging on, while the real name is 
typically a longer string that is used within logon files to record the human-readable identity 
of the user making a change. Note that you are free to use these fields in other ways if it suits 
your application: You may, for example, create users that represent groups of individuals or 
perhaps roles, such as Operators, Supervisors and Managers. You may also decide to use the 
real name to hold an item such as a clock number to tie user identities into your MRP system. 

 

USER RIGHTS 

Each user is granted zero or more access rights. A user with no rights can access those objects 
that merely require the identity of the user to be recorded, whereas users with more rights can 
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access those objects that demand those rights to be present. Rights are divided into System 
Rights and User Rights, with the former controlling access to facilities within the 
MonicoView software, and the latter being available for general use. For example, User Right 
1 might be used within your database to control access to production targets; only users 
whom you want to be able to vary such things would then be assigned this right. 

ACCESS CONTROL 

Objects that are subject to security have an associated access control setting… 

 

This setting allows you to specify whether the item can be accessed by anyone, by any 
operator whose identity is known, or by users with specific user rights. The access control 
setting also allows you to specify whether a tag can be changed by a program running as a 
result of something other than user action. This facility allows you to guarantee that no 
background changes occur to sensitive data, even if a programming error attempts to make 
such a change. 

WRITE LOGGING 

Tags also have a write logging property... 

 

This indicates whether changes made to a tag by users or by programs should be logged. This 
facility allows you to create an audit trail of changes to your system, thereby simplifying fault 
finding and providing quality-control information as to process configuration. Note that care 
should be taken when logging changes made by programs, as certain database may log 
unmanageable amounts of data in such circumstances. 

DEFAULT ACCESS 

To speed the configuration process, MonicoView also provides the ability to specify default 
access and write logging parameters for mapped tags, internal tags and display pages. The 
differentiation between mapped and unmapped tags is important in systems where all changes 
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to external data must be recorded, but where data internal to MonicoView can be manipulated 
without the need for such an audit trail. 

ON-DEMAND LOGON 

MonicoView’s security system supports both conventional and on-demand logon. A 
conventional logon can occur when a user interface element such as a pushbutton is used to 
activate the Log On User action or to call the UserLogOn() function. On-demand logon 
occurs if the operator attempts an action without sufficient access rights, and if a failed logon 
attempt has not occurred within the same action. For example, a user may press a button that 
runs a program to reset a number of values. As soon as the program attempts to change a 
value that requires security access, the system will prompt for logon credentials. This method 
reduces operator interaction, and produces a more responsive system. 

MAINTENANCE ACCESS 

The system also provides a facility called Maintenance Mode to allow the user inactivity 
timeout to be overridden during system commissioning. This mode is activated if a display 
page is marked as being accessible with the Maintenance Access right, and if the current user 
has gained access to the page as a result of that right. Use of this mode avoids the need to 
logon repeatedly when testing the system. 

SECURITY SETTINGS 

The security system settings are accessed via the Security Manager icon… 

 

The available properties are as follows… 

• The Inactivity Timeout property is used to indicate how much time must pass 
without user input before the current user is automatically logged off. Too high a 
value for this setting will produce an insecure system, while too low a value will 
produce a system that is awkward for operators. 

• The Clear Logon Name property is used to indicate whether or not the username 
should be cleared before asking the operator to logon. If this setting is disabled, 
the previous username will be displayed, and only the password will need to be 
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re-entered. Enabling this feature produces higher security, and may be required 
to comply with security standards in certain industries. 

• The Default Access properties are used to indicate the access to be provided to 
various objects should no specific access be defined for that item. The settings 
are as described in the Access Control section above.  

• The Default Logging properties are used to indicate whether changes to mapped 
and unmapped tags should be logged should no specific logging criteria be 
defined for a tag. It is not possible to log programmatic access by default, as 
such logging should be carefully considered to avoid excessive log activity. 

• The Logging Control properties are used to define whether and how the security 
logs should be created. Refer to the Configuring Data Logging chapter for 
information on how the data is written and how files are named. 

CREATING USERS 

You may use the Create User button to create as many users as you need. The users may be 
renamed or deleted using the left-hand pane. To select a user, either click on the name in the 
list, or use the up and down arrows in the toolbar. Alternatively, you can use the Alt+Left 
and Alt+Right key combinations to move up and down the list as required. These keys will 
work no matter which pane is selected. 

 

Each user has the following properties… 

• The Real Name property is used to record the user’s identity in security logs, and 
in the Security Manager primitive that is used to change passwords from the 
operator terminal. If maximum security is required, the user name should not be 
easily derived from the real name. 

• The Password property is used to specify an initial password for this user. The 
password is case-sensitive and comprises alphanumeric characters. Note that if 
the Override Existing box is checked, any changes made to this password from 
the operator panel itself will be overridden when this database is downloaded to 
the panel. 
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• The System Rights properties are used to grant a user the ability to perform 
certain system actions. The properties relating to password changes are self-
explanatory, while the user of Maintenance Mode is described above. 

• The Custom Rights properties are used to grant a user certain rights which may 
then be used within the database to allow access to groups of tags or display 
pages. The exact usage of these rights is up to the system designer. 

SPECIFYING TAG SECURITY 

Each writable tag has a tab called Security which is used to define the access control and 
write logging settings for that tag. If you do not define specific settings, the system will use 
the appropriate default settings, depending on whether it is mapped to external data. 

SPECIFYING PAGE SECURITY 

The access control settings for a display page are defined via the Properties dialog… 

 

Once again, if no setting is defined, default settings will be used. 

THE SECURITY MANAGER PRIMITIVE 

 

The Security Manager Primitive is used to display the names of users present on 
the system. It can be used to change a user’s password, depending on the rights 
allocated to the active user. 

 

The only editable properties of this primitive define the fonts to be used, and whether or not 
the primitive should be displayed. Refer to other primitives for descriptions of these settings. 

SECURITY RELATED FUNCTIONS 

Please refer to Appendix A later in this manual for details on the UserLogOn(), 
UserLogOff() and TestAccess() functions. This third function is useful when changing 
many values from within a program, as it allows you to force an access check early in the 
code to avoid making changes only to have later operations fail due to insufficient user rights. 
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WRITING EXPRESSIONS 
You will recall from the earlier sections of this manual that many fields within MonicoView 
are configured as what are called expression properties. You will further recall that these 
fields are configured by means of a user interface element similar to that shown below… 

 

In many situations, you will be configuring these properties to be equal to the value of a tag, 
or to the contents of a register in a remote communications device, in which case your 
selection will be made simply by clicking the appropriate option on the drop-down menu, and 
then selecting the required item from the resulting dialog box. 

There will be situations, though, when you want to make a property dependent on a more 
complex combination of data items, perhaps using some math to combine or compare their 
values. Such eventualities are handled via what are known as expressions, which can be 
entered in the property’s edit box whenever General mode is selected via the drop-down. 

DATA VALUES 

All expressions contain at least one data value. The simplest expressions are thus references 
to single constants, single tags or single PLC registers. If you enter either of the last two 
options, MonicoView will simplify the editing process by automatically changing the 
property mode as appropriate. For example, if you enter a tag name in General mode, 
MonicoView will switch to Tag mode, and show the tag name in the selection field. 

CONSTANTS 

Constants represent—not surprisingly—constant numbers or strings. 

INTEGER CONSTANTS 

Integer constants represent a single 32-bit signed number. They may be entered in decimal, 
binary, octal or hexadecimal as required. The examples below show the same number entered 
in the four different number bases… 
 

BASE EXAMPLE 

Decimal 

Binary 

123 

Octal 

0b1111011 

Hexadecimal 

0173 

 

0x7B 

The ‘U’ and ‘L’ suffixes supported by earlier versions of software are not used. 
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CHARACTER CONSTANTS 

Character constants represent a single ASCII character, encoded in the lower 8 bits of a 32-bit 
signed number. A character constant comprises a single character enclosed in single quotation 
marks, such that 'A' can be used to represent a value of 65. Certain otherwise unprintable or 
unrepresentable characters can be encoded using what are called escape sequences, each of 
which is introduced with a single backslash… 
 

SEQUENCE VALUE ASCII 

Hex 0x07, Decimal 7 \a BEL 

Hex 0x09, Decimal 9 \t TAB 

Hex 0x0A, Decimal 10 \n LF 

Hex 0x0C, Decimal 12 \f FF 

Hex 0x0D, Decimal 13 \r CR 

Hex 0x1B, Decimal 27 \e ESC 

The hex value represented by \xnn nn - . 

The octal value represented by \nnn nnn - . 

A single backslash character. \\ - 

A single quotation mark character. \' - 

A double quotation mark character. \" - 
 

LOGICAL CONSTANTS 

Logical constants represent a 1 or 0 value that is used to indicate the truth or otherwise of a 
yes-or-no expression. An example of something that can be assigned to be equal to a logical 
constant is a tag that represents a digital output in a PLC. Logical constants can either be 
entered simply as 1 or 0, or by use of the keywords true or false. 

FLOATING-POINT CONSTANTS 

Floating-point constants represent a 32-bit single-precision floating-point value. They are 
represented as you might expect—by the integer portion, followed by a single decimal point, 
followed by the fractional portion. Exponential notation is not supported. 

STRING CONSTANTS 

String constants represent sequences of characters. They comprise the characters to be 
represented, enclosed in double quotation marks. For example, the string "ABCD" represents a 
four-character string, comprising the values 65, 66, 67 and 68. (Actually, five bytes are used 
to store the string, with a null value being appended to indicate the end of the string.) The 
various escape sequences discussed above may also be used within strings. 

TAG VALUES 

The value of a tag is represented in an expression by the tag name. Upper-case and lower-case 
characters are considered equivalent when finding the required tag. Also, once an expression 
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has been entered, any changes to the name of the tag will modify all of the expressions that 
make reference to it, so there is no need to re-edit the expressions to “fix” the name. 

COMMUNICATIONS REFERENCES 

References to registers in master communications devices can be entered into an expression 
by means of a syntax comprising an opening square bracket, the register name, and a closing 
square bracket. An optional device name may be prefixed to the register name and separated 
by a period. The device name need not be specified for registers in the first (or only) device 
within the database. Examples of this syntax are shown below… 
   

EXAMPLE MEANING 

Register [D100] D100 in first device. 

Register [AB.N7:0] N7:0 in device AB. 

Register [FX.D100] D100 in device FX
 

. 

SIMPLE MATH 

As mentioned above, expressions often contain more than one data value, with their values 
being combined mathematically. The simplest of these expressions may add a pair of values, 
while a more complex expression might obtain the average of three values. These operations 
are performed using the familiar syntax you will have seen in applications such as Excel. The 
examples below show the basic operations that can be performed… 
   

OPERATOR PRIORITY EXAMPLE 

Addition Group 4 

Subtraction 

Tag1 + Tag2 

Group 4 

Multiplication 

Tag1 - Tag2 

Group 3 

Division 

Tag1 * Tag2 

Group 3 

Remainder 

Tag1 / Tag2 

Group 3 
 

Tag1 % Tag2 

Although the examples show spaces surrounding the operators, these are not required. 

OPERATOR PRIORITY 

You will have noticed the Priority column in the above table. As you no doubt recall from 
your algebra classes, when several operators are used together, they are evaluated in a defined 
order. For example, multiplication is always evaluated before addition. MonicoView 
implements this ordering by means of what are known as operator priorities, with each 
operator being put in a group, and with operators being applied in order from the lowest 
numbered group to the highest. (Except where noted otherwise in the text, operators within a 
group are evaluated left-to-right.) The default order of evaluation can be overridden by using 
parentheses. 
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TYPE CONVERSION 

Normally, MonicoView will automatically decide when to switch from evaluating an 
expression in integer math to evaluating it using floating-point. For example, if you divide an 
integer value by a floating-point value, the integer will be converted to floating-point before 
the division is carried out. However, there will be some situations where you want to force a 
conversion to take place. 

For example, suppose you are adding together three integers that represent the levels in three 
tanks, and then dividing the total by the tank count to obtain the average level. If you use an 
expression such as (Tank1+Tank2+Tank3)/3 then your result may not be as accurate as you 
demand, as the division will take place using integer math, and the average will not contain 
any decimal places. To force MonicoView to evaluate the result using floating-point math, 
the simplest technique is to change the 3 to 3.0, thereby forcing MonicoView to convert the 
sum to floating-point before the division is performed. A slightly more complex technique is 
to use syntax such as float(Tank1+Tank2+Tank3)/3. This invokes what is known as a 
“type cast” on the term in parentheses, manually converting it to floating-point. 

Type casts may also be used to convert a floating-point value to an integer value, perhaps 
deliberately giving-up some precision from an intermediate value before storing it in a PLC 
register. For example, the expression int(cos(Theta)*100) will calculate the cosine of an 
angle, multiply this value by 100 using floating-point math, and then convert it to an integer, 
dropping any digits after the decimal place. 

COMPARING VALUES 

You will quite often find that you wish to compare the value of one data with another, and 
make a decision based on the result. For example, you may wish to define a flag formula to 
show when a tank exceeds a particular value, or you may wish to use an if statement in a 
program to execute some code when a motor reaches its desired speed. The following 
comparison operators are provided… 
 

OPERATOR PRIORITY EXAMPLE 

Equal To Group 7 

Not Equal To 

Data == 100 

Group 7 

Greater Than 

Data != 100 

Group 6 

Greater Than or Equal To 

Data >  100 

Group 6 

Less Than 

Data >= 100 

Group 6 

Less Than or Equal To 

Data <  100 

Group 6 
 

Data <= 100 

Each operator produces a value of 0 or 1, depending on the condition it tests. The operators 
can be used on integers, floating-point values, or text strings. If strings are compared, the 
comparison is case-insensitive ie. “abc” is considered equal to “ABC”. 



TESTING BITS CRIMSON USER MANUAL 

PAGE 224 www.monicoinc.com/support 

TESTING BITS 

MonicoView allows you to test the value of a bit within a data value by using the bit selection 
operator, which is represented by a single period. The left-hand side of the operator should be 
the value in which the bit is to be tested, and the right-hand side should be an expression 
indicating the bit number to test. This right-hand value should be between 0 and 31. The 
result of the operator is equal to 0 or 1 depending on the value of the bit in question. 
   

OPERATOR PRIORITY EXAMPLE 

Bit Selection Group 1 
 

Input.2 

The example shown tests bit 2 (ie. the bit with a value of 4) within the indicated tag. 

If you want to test for a bit being equal to zero, you can use the logical NOT operator… 
   

OPERATOR PRIORITY EXAMPLE 

Logical NOT Group 2 
 

!Input.2 

This example is equal to 1 if bit 2 of the indicated tag is equal to 0, and vice versa. 

MULTIPLE CONDITIONS 

If you want to define an expression that is true if a number of conditions are all true, you can 
use the logical AND operator. Similarly, if you want to define an expression that is true if any 
of a number of conditions are true, you can use the logical OR operator. The examples below 
show each operator in use… 
 

OPERATOR PRIORITY EXAMPLE 

Logical AND Group 11 

Logical OR 

A>10 && B>10 

Group 12 
 

A>10 || B>10 

The logical AND operator produces a value of 1 if and only if the expressions on the 
left-hand and right-hand sides are true, while the logical OR operator produces a value of 1 if 
either expression is true. Note that—unlike the bitwise operators referred to elsewhere in this 
section—the logical operators stop evaluating once they know what the answer will be. This 
means that in the above example for logical AND, the right-hand side of the operator will 
only be evaluated if A is greater than 10, as, if this were not true, the result of the AND 
operator must already be zero. While this property makes little difference in the examples 
given above, if the left-hand or right-hand expressions call a program or make a change to a 
data value, this behavior must be taken into account. 
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CHOOSING VALUES 

You may find situations where you want to select between two values—be they integers, 
floating-point values or strings—depending on the value of some condition. For example, you 
may wish to set a motor’s speed equal to 500 rpm or 2000 rpm based on a flag tag. This 
operation can be performed using the ?: operator, which is unique in that it takes three 
arguments, as shown in the example below… 
 

OPERATOR PRIORITY EXAMPLE 

Selection Group 13 
 

Fast ? 2000 : 500 

This example will evaluate to 2000 if Fast is true, and 500 otherwise. The operator can be 
thought to be equivalent to the IF function found in applications such as Microsoft Excel. 

MANIPULATING BITS 

MonicoView also provides operators to perform operations that do not treat integers as 
numeric values, but instead as sequences of bits. These operators are known as bitwise 
operators. 

AND, OR AND XOR 

These three bitwise operators each produce a result in which each bit is defined to be equal to 
the corresponding bits in the values on the operator’s left-hand and right-hand sides, 
combined using a specific truth-table… 
  

OPERATOR PRIORITY EXAMPLE 

Bitwise AND Group 8 

Bitwise OR 

Data & Mask 

Group 9 

Bitwise XOR 

Data | Mask 

Group 10 
 

Data ^ Mask 

The table below shows the associated truth tables… 
 

A B A & B A | B A ^ B 

0 0 0 0 0 

0 1 0 1 1 

1 0 0 1 1 

1 1 1 1 
 

0 

SHIFT OPERATORS 

MonicoView also provides operators to shift an integer n bits to the left or right… 
 

OPERATOR PRIORITY EXAMPLE 

Shift Left Group 5 

Shift Right 

Data << 2 

Group 5 
 

Data >> 2 
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Each example shifts Data two bits in the specified direction. 

BITWISE NOT 

Finally, MonicoView provides a bitwise NOT operator to invert the sense of the bits in a 
value… 
 

OPERATOR PRIORITY EXAMPLE 

Bitwise NOT Group 2 
 

~Mask 

This example produces a value where every bit is equal to the opposite of its value in Mask. 

INDEXING ARRAYS 

Elements within an array tag can be selected by following the array name with square 
brackets that contain an indexing expression. This expression must range from 0 to one less 
than the number of elements in the array. If you create a 10-element array, for example, the 
first element will be Name[0] and the last will be Name[9]. 

INDEXING STRINGS 

Square brackets can also be used to select characters within a string. For example, if you have 
a tag called Text that contains the string “ABCD”, then the expression Text[0] will return a 
value of 65, this being equal to the ASCII value of the first character. Index values beyond the 
end of the string will always return zero. 

ADDING STRINGS 

As well as adding numbers, the addition operator can be used to concatenate strings. Thus, the 
expression "AB"+"CD" evaluates to "ABCD”. You may also use the addition operator to add 
an integer to a string, in which case a single character equal to the ASCII code represented by 
the integer is appended to the data in the string. 

CALLING PROGRAMS 

Programs that return values may be invoked within expressions by following the program 
name with a pair of parentheses. For example, Program1()*10 will invoke the associated 
program, and multiply the return value by 10. Obviously, the return type for Program1 must 
be set to integer or floating-point for this to make sense. 

USING FUNCTIONS 

MonicoView provides a number of predefined functions that can be used to access system 
information, or to perform common math operations. These functions are defined in detail in 
the Function Reference. They are invoked using a syntax similar to that for programs, with 
any arguments to the function being enclosed within the parentheses. For example, cos(0) 
will invoke the cosine function with an argument of 0, returning a value of +1.0. 
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PRIORITY SUMMARY 

The table below shows the priority of all the operators defined in this section… 
 

GROUP OPERATORS 

Group 1 

Group 2 

. 

Group 3 

! ~ 

Group 4 

* / % 

Group 5 

+ - 

Group 6 

<< >> 

Group 7 

< > <= >= 

Group 8 

== != 

Group 9 

& 

Group 10 

| 

Group 11 

^ 

Group 12 

&& 

Group 13 

|| 

 

?: 

Operators in the lower-numbered groups are applied first. 

NOTES FOR EDICT USERS 

Users of Monico’s Edict-97 software should note… 

• The && and || operators stop evaluation once the result is known. 

• The only available data types are string, integer and floating-point. 

• The ?: ternary operator is now supported. 
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WRITING ACTIONS 
While expressions are used to define values, actions are used to define what you want to 
happen when a trigger or other event occurs. Since the vast majority of the actions in a 
database will relate to key-presses, and since MonicoView provides a simple method of 
defining commonly-used actions via the dialog box discussed in the User Interface section, 
you will often be able to avoid writing actions “by hand”. Actions are needed, though, if you 
want to use triggers, write programs, or use a key in User Defined mode. 

CHANGING PAGE 

To create an action that changes the page shown on the panel’s display, use the syntax 
GotoPage(Name), where Name is the name of the display page in question. The current page 
will be removed, and the new page will be displayed in its place. 

CHANGING NUMERIC VALUES 

MonicoView provides several ways of changing data values. 

SIMPLE ASSIGNMENT 

To create an action that assigns a new value to a tag or to a register in a communications 
device, use the syntax Data:=Value, where Data is the data item to be changed, and Value 
is the value to be assigned. Note that Value need not just be a constant value, but can be any 
valid expression of the correct type. Refer to the previous section for details of how to write 
expressions. For example, code such as [N7:0]:=Tank1+Tank2 can be used to add two tank 
levels and store the total quantity directly in a PLC register. 

COMPOUND ASSIGNMENT 

To create an action that sets a data value equal to its current value combined with another 
value by means of any of the operators defined in the previous section, use the syntax 
Dataop=Value, where Data is the tag to be changed, Value is the value to be used by the 
operator, and op is any of the available operators. For example, the code Tag+=10 will 
increase Tag by a value of 10, while Tag*=10 will multiply the current value by 10. 

INCREMENT AND DECREMENT 

To create an action that increases a data value by one, use the syntax Data++. To create an 
action that decreases a tag by one, use the syntax Data--. Note that the ++ or -- operators 
may be placed before or after the data value in question. In the former case, the value of the 
expression represented by ++Data is equal to the value of Data after it has been incremented. 
In the latter case, the expression is equal to the value before it has changed. 

CHANGING BIT VALUES 

To change a bit within a tag, use the syntax Data.Bit:=1 or Data.Bit:=0 to set or clear the 
bit as required, where Data is the tag in question and Bit is the zero-based bit number. Note 
again that the value on the right-hand side of the := operator can be an expression if desired, 
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such that an example such as Data.1:=(Level>10) can be used to set or clear a bit 
depending on whether or not a tank level exceeds a preset value. 

RUNNING PROGRAMS 

Programs may be invoked within actions by following the program name with a pair of 
parentheses. For example, Program1() will invoke the associated program. The program will 
execute in the foreground or background as defined by the program’s properties. 

USING FUNCTIONS 

MonicoView provides a number of predefined functions that can be used to perform various 
operations. These functions are defined in detail in the Function Reference. They are invoked 
using a syntax similar to that for programs, with any arguments to the function being enclosed 
within the parentheses. For example, SetLanguage(1) will set the terminal language to 1. 

OPERATOR PRIORITY 

All assignment operators fall into Group 14. In other words, they will be evaluated after all 
other operators in an action. They are also unique in that they group right-to-left. This means 
that code such as Tag1:=Tag2:=Tag3:=0 can be used to clear all three tags at once. 

NOTES FOR EDICT USERS 

Users of Monico’s Edict-97 software should note… 

• The = operator can now be used instead of the := operator. 
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USING RAW PORTS 
In order to allow customers to implement simple ASCII protocols without having to ask 
Monico to develop custom drivers, MonicoView provides a new facility whereby the 
software’s programming language can be used to directly control either serial ports or TCP/IP 
network sockets. This functionality—known as raw port access—replaces the driver and 
functions used to support the Roll-Your-Own Protocol facility within Edict-97. It also 
replaces the General ASCII Frame protocol by providing a function to perform the parsing 
operations that the driver previously implemented. Note that if you are not using custom 
ASCII protocols, but are instead using the standard drivers provided with MonicoView, you 
can skip this section. 

CONFIGURING A SERIAL PORT 

To use a serial port in raw mode, select the Raw Serial Port driver as shown… 

 

The port’s Baud rate and other byte format parameters should be configured to indicate the 
required communications settings, and the On Update property should be set to specify the 
program that will be performing the communication. This program will be called continually 
by the port’s communications task. 

CONFIGURING A TCP/IP SOCKET 

To use a TCP/IP socket in raw mode, select the Raw TCP/IP Passive driver as shown… 
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The On Update property is configured as described above, while the Port property should be 
configured to indicate which TCP port you want the driver to monitor. The driver will accept 
connections on this port, and then call the On Update program to handle communications. 

READING CHARACTERS 

To read data from a raw port a character at a time, use the PortRead function, as documented 
in the Function Reference section of this manual. As with all raw port functions, the port 
argument for this function is calculated by counting down the list of ports in the left-hand 
pane of the Communications window, with the programming port being port 1. 

The example below shows to use PortRead to accept characters… 

int Data; 
 
for(;;) { 
 
 if( (Data := PortRead(2, 100)) >= 0 ) { 
 
  /* Add code to process data */ 
  } 
 } 

Note that by passing a non-zero value for the period argument, the need to call the Sleep 
function is removed. If you use a zero value for this argument, you must make sure that you 
suspend the communications task at some point, or you will disrupt system operation. 

READING ENTIRE FRAMES 

To read an entire frame from a raw port, use the PortInput function, as documented in the 
Function Reference section of this manual. This function allows you to specify frame 
delimiters, the required frame length and a frame timeout, thereby removing the need to write 
your own receive state machine. As sample program is shown below… 

cstring input; 
int     value; 
 
for(;;) { 
 
 input := PortInput(5, 42, 13, 3, 0); 
  
 if( value := TextToInt(input, 10) ) { 
 
  Speed := value; 
 
  PortPrint(5, "Value is "); 
  PortPrint(5, IntToText(value,10,5)); 
  PortPrint(5, "\r\n"); 
  } 
 } 
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The example above listens on a TCP/IP socket for a frame that starts with an asterisk and 
ends with a carriage return. It then converts the frame to a decimal value, stores this in an 
integer tag, and echoes the value back to the client. 

SENDING DATA 

To send data on a raw port, use the PortWrite or PortPrint functions, as documented in 
the Function Reference section of this manual. The first function sends a single byte, while 
the second function sends an entire string. To send numeric values, use the IntToText 
function to convert them into strings. 

NOTES FOR EDICT USERS 

Users of Monico’s Edict-97 software should note… 

• The raw serial port device driver controls the port’s handshaking lines, so there 
is no need to call SetRTS, HoldTx or any of the various other port management 
functions. These functions are thus not provided by MonicoView. 

• When sending data, MonicoView automatically handles buffer overflow events, 
and ensures that no data is lost. The PortWrite and PortPrint thus neither 
provide a return value, nor is such a value required. 

• To directly emulate GAF, use a program similar to the example shown above, 
but store the received string in a string tag, and increment an integer tag. Such 
direct emulation is not recommended, as you will nearly always then have a 
trigger to respond to the change in the sequence number, in which case you 
might as well handle this logic within the communications program. 

• MonicoView’s enhanced programming support allows much higher performance 
levels when using raw port drivers. Performance typically exceeds that of the 
equivalent Edict configuration by an order of magnitude or more. 
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SYSTEM VARIABLE REFERENCE 
The following pages describe the various system variables that exist within MonicoView. 
These system variables can be invoked within actions or expressions as described in the 
previous two chapters. 

HOW ARE SYSTEM VARIABLES USED 

System variables are used either to reflect the state of the system, or to modify the behavior of 
the system in some way. The former type of variable will be read-only, while the latter type 
can have a value assigned to it. 

 



ACTIVEALARMS CRIMSON USER MANUAL 

PAGE 236 www.monicoinc.com/support 

ACTIVEALARMS 

DESCRIPTION 

Returns a count of the currently active alarms. 

VARIABLE TYPE 

integer. 

ACCESS TYPE 

Read-Only. 
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COMMSERROR 

DESCRIPTION 

Returns a bit-mask indicating whether or not each communications device is offline. A value 
of 1 in a given bit position indicates that the corresponding device is experiencing comms 
errors. Bit 0 (ie. the bit with a value of 1) corresponds to the first communication device. 

VARIABLE TYPE 

integer. 

ACCESS TYPE 

Read-Only. 
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DISPBRIGHTNESS 

DESCRIPTION 

Returns a number indicating the brightness of the display from 0 to 100, with zero being off. 

VARIABLE TYPE 

integer. 

ACCESS TYPE 

Read / Write. 
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DISPCONTRAST 

DESCRIPTION 

Returns a number indicating the amount of display contrast from 0 to 100. 

VARIABLE TYPE 

integer. 

ACCESS TYPE 

Read / Write. 
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DISPCOUNT 

DESCRIPTION 

Returns a number indicating the number of display updates since last reset. 

VARIABLE TYPE 

integer. 

ACCESS TYPE 

Read-Only. 
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DISPUPDATES 

DESCRIPTION 

Returns a number indicating how fast the display updates. 

VARIABLE TYPE 

integer. 

ACCESS TYPE 

Read-Only. 
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ISSIRENON 

DESCRIPTION 

Returns true if the panel’s sounder is on or false otherwise. 

VARIABLE TYPE 

integer. 

ACCESS TYPE 

Read-Only. 
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PI 

DESCRIPTION 

Returns pi as a floating-point number. 

VARIABLE TYPE 

Floating point. 

ACCESS TYPE 

Read-Only. 
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TIMEZONE 

DESCRIPTION 

Returns the Time Zone in hours from –12 to +12. Using the Link Send Time command in 
MonicoView will set the unit time and time zone to the computer’s values. Changing the 
Time Zone afterwards will increment or decrement the unit time. Note: TimeZone can only 
be viewed or changed if the Time Manager is enabled. 

VARIABLE TYPE 

integer. 

ACCESS TYPE 

Read / Write. 
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TIMEZONEMINS 

DESCRIPTION 

Returns the Time Zone in minutes from –720 to +720. Using the Link Send Time command 
in MonicoView will set the unit time and time zone to the computer’s values. Changing the 
Time Zone afterwards will increment or decrement the unit time. Note: TimeZoneMins can 
only be viewed or changed if the Time Manager is enabled. 

VARIABLE TYPE 

integer. 

ACCESS TYPE 

Read / Write. 
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USEDST 

DESCRIPTION 

Returns the unit daylight saving time state. This variable will add an hour to the unit time if 
set to true. Note: UseDST can only be viewed or changed if the Time Manager is enabled. 

VARIABLE TYPE 

flag. 

ACCESS TYPE 

Read / Write. 
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PROGRAMMING REFERENCE 
This section is a summary of all the commands used for programming. 

EXPRESSION OPERATORS 

For more information on the following operators, refer to the Writing Expression Section of 
this manual. 

LOGICAL CONSTANTS 

VALUE EXAMPLE 

0 False 

1 True 

INTEGER CONSTANTS 

BASE EXAMPLE 

Decimal 123 

Binary 0b1111011 

Octal 0173 

Hexadecimal 0x7B 

CHARACTER CONSTANTS 

SEQUENCE VALUE ASCII 

\a Hex 0x07, Decimal 7 BEL 

\t Hex 0x09, Decimal 9 TAB 

\n Hex 0x0A, Decimal 10 LF 

\f Hex 0x0C, Decimal 12 FF 

\r Hex 0x0D, Decimal 13 CR 

\e Hex 0x1B, Decimal 27 ESC 

\xnnn The hex value represented by nnn. - 

\nnn The octal value represented by 
nnn. 

- 

\\ A single backslash character. - 

\' A single quotation mark character. - 

\" A double quotation mark character. - 

LOGIC OPERATORS 

OPERATOR PRIORITY EXAMPLE 

Equal To Group 7 Data == 100 

Not Equal To Group 7 Data != 100 

Greater Than Group 6 Data >  100 

Greater Than or Equal To Group 6 Data >= 100 
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OPERATOR PRIORITY EXAMPLE 

Less Than Group 6 Data <  100 

Less Than or Equal To Group 6 Data <= 100 

Logical AND Group 11 A>10 && B>10 

Logical OR Group 12 A>10 || B>10 

Logical NOT Group 2 !Flag1 

Selection Group 13 Fast ? 2000 : 500 

OTHER OPERATORS 

OPERATOR PRIORITY EXAMPLE 

Grouping Operator Group 1 2*(Tag1+Tag2) 

Array Access Group 1 Array[4] 

Bit Selection Group 1 Input.2 

 

ACTION OPERATORS 

SIMPLE MATH 

OPERATOR PRIORITY EXAMPLE 

Assignment Not applicable Tag1 = Tag2 

Addition Group 4 Tag1 + Tag2 

Subtraction Group 4 Tag1 - Tag2 

Multiplication Group 3 Tag1 * Tag2 

Division Group 3 Tag1 / Tag2 

Remainder Group 3 Tag1 % Tag2 

Post-Increment Group 4 Tag1++ 

Pre-Increment Group 4 ++Tag1 

Post-Decrement Group 4 Tag1-- 

Pre-Decrement Group 4 --Tag1 

Increment and Assign Group 4 Tag1 += 4 

Decrement and Assign Group 4 Tag1 -= 3 

Multiply and Assign Group 4 Tag1 *= 5 

Divide and Assign Group 4 Tag1 /= 2 

Bit Shift Left and Assign Group 4 Tag1 <<= 8 

Bit Shift Right and Assign Group 4 Tag1 >>= 16 

Exclusive OR and Assign Group 4 Tag1 ^= 1 

Bitwise AND and Assign Group 4 Tag1 &= tag2 

Modulo and Assign Group 4 Tag1 %= tag2 

Normal Or and Assign Group 4 Tag1 |= tag2 
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MANIPULATING BIT 

OPERATOR PRIORITY EXAMPLE 

Bitwise AND Group 8 Data & Mask 

Bitwise OR Group 9 Data | Mask 

Bitwise XOR Group 10 Data ^ Mask 

Shift Left Group 5 Data << 2 

Shift Right Group 5 Data >> 2 

Bitwise NOT Group 2 ~Mask 

 

PROGRAMMING STATEMENTS 

LOCAL VARIABLES IN PROGRAMS 

int     a;  // Declare local integer ‘a’ 
float   b;  // Declare local real    ‘b’ 
cstring c;  // Declare local string  ‘c’ 

 

IF STATEMENT 

if( condition ){ 
 action1; 
 } 
else{ 
 action2; 
 } 

SWITCH STATEMENT 

switch ( int var) { 
 case 1: 
  action1; 
  break; 
 case 2: 
  action2; 
  break 
  … 
 default: 
  action3; 
  break; 
 } 
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WHILE LOOP 

FOR LOOP 

while ( condition ){ 
 Action; 
 } 

for ( initialization; condition; control ){ 
 action1; 
 } 

DO LOOP 

do { 
 action1; 
 } while ( condition ); 

LOOP CONTROL 

COMMAND DESCRIPTION 

Break; Will cause a loop to break if called. 

 

PRIORITY SUMMARY 

GROUP OPERATORS 

Group 1 . 

Group 2 ! ~ 

Group 3 * / % 

Group 4 + - 

Group 5 << >> 

Group 6 < > <= >= 

Group 7 == != 

Group 8 & 

Group 9 | 

Group 10 ^ 

Group 11 && 

Group 12 || 

Group 13 ?: 
 

Operators in the lower-numbered groups are applied first. 
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FUNCTION REFERENCE 
The following pages describe the various standard functions that provided by MonicoView. 
These functions can be invoked within programs, actions or expressions as described in the 
previous chapters. Functions that are marked as active may not be used in expressions that are 
not allowed to change values eg. in the controlling expression of a display primitive. 
Functions that are marked as passive may be used in any context. 

NOTES FOR EDICT USERS 

Users of Monico’s Edict-97 software should note… 

• The various Port functions replace the Serial RYOP functions. 
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ABS(VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

value int / The value to be processed. float 
 

DESCRIPTION 

Returns the absolute value of the argument. In other words, if value is a positive value, that 
value will be returned; if value is a negative value, a value of the same magnitude but with 
the opposite sign will be returned. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int or float, depending on the type of the value argument. 

EXAMPLE 

Error := abs(PV – SP) 
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ACOS(VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

value The value to be processed. float 
 

DESCRIPTION 

Returns the angle theta in radians such that cos(theta) is equal to value. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

theta := acos(1.0) 
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ALARMACCEPTALL() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Accepts all active alarms.  

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

AlarmAcceptAll() 
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ASIN(VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

value The value to be processed. float 
 

DESCRIPTION 

Returns the angle theta in radians such that sin(theta) is equal to value. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

theta := asin(1.0) 

 



ATAN(VALUE) CRIMSON USER MANUAL 

PAGE 256 www.monicoinc.com/support 

ATAN(VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

value The value to be processed. float 
 

DESCRIPTION 

Returns the angle theta in radians such that tan(theta) is equal to value. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

theta := atan(1.0) 
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ATAN2(A, B) 
 

ARGUMENT TYPE DESCRIPTION 

a The value of the side that is opposite the angle theta. float 

b The value of the side that is adjacent to the angle theta float 
 

DESCRIPTION 

This function is equivalent to atan(a/b), except that it also considers the sign of a and b, 
and thereby ensures that the return value is in the appropriate quadrant. It is also capable of 
handling a zero value for b, thereby avoiding the infinity that would result if the single-
argument form of tan were used instead. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

theta := atan2(1,1) 
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BEEP(FREQ, PERIOD) 
 

ARGUMENT TYPE DESCRIPTION 

freq The required frequency in semitones. int 

period The required period in milliseconds. int 
 

DESCRIPTION 

Sounds the terminal’s beeper for the indicated period at the indicated pitch. Passing a value of 
zero for period will turn off the beeper. Beep requests are not queued, so calling the function 
will immediately override any previous calls. For those of you with a musical bent, the freq  
argument is calibrated in semitones. On a more serious “note”, the Beep function can be a 
useful debugging aid, as it provides an asynchronous method of signaling the handling of an 
event, or the execution of a program step. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

Beep(60, 100) 
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CLEAREVENTS() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Clears the list of events displayed in the event log. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

ClearEvents() 
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CLOSEFILE(FILE) 
 

ARGUMENT TYPE DESCRIPTION 

file File handle as returned by int OpenFile
 

. 

DESCRIPTION 

Closes a file previously opened in a call to FileOpen(). 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

CloseFile(hFile) 
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COMMITANDRESET() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

This function will force all retentive tags to be written on the internal flash memory and then 
will reset the unit. 

NOTE: THIS FUNCTION SHOULD IN NO CASE BE CALLED ON A REGULAR 
BASIS, AS FREQUENT WRITING TO THE FLASH MEMORY WILL END UP IN 
A FAILURE. THIS FUNCTION IS TO BE USED IN COMBINATION WITH 
SetPortConfig() AND SetNetConfig() SO NEW PARAMETERS ARE SAVED AND 
SHOULD ONLY BE CALLED ONCE. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

CommitAndReset() 
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COMPACTFLASHEJECT() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Ceases all access of the CompactFlash card, allowing safe removal of the card. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

CompactFlashEject() 
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COMPACTFLASHSTATUS() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Returns the current status of the CompactFlash slot as an integer. 
 

VALUE STATE DESCRIPTION 

0 Empty Either no card is installed or the card has been ejected via a call to the 
CompactFlashEject

1 

 function. 

Invalid The card is damaged, incorrectly formatted or not formatted at all. 
Remember only FAT16 is supported. 

2 Checking The G3 is checking the status of the card. This state occurs when a 
card is first inserted into the G3. 

3 Formatting The G3 is formatting the card. This state occurs when a format 
operation is requested by the programming PC. 

4 Locked The operator interface is either writing to the card, or the card is 
mounted and Windows is accessing the card. 

5 Mounted A valid card is installed, but it is not locked by either the operator 
interface or Windows. 

 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

d := CompactFlashStatus() 
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CONTROLDEVICE(DEVICE, ENABLE) 
 

ARGUMENT TYPE DESCRIPTION 

device Device to be enabled or disabled. int 

enable Determines if device is enabled or disabled. int 
 

DESCRIPTION 

Allows the database to disable or enable a specified communications device. The number to 
be placed in the device argument to identify the device can be viewed in the status bar of the 
Communications category when the device name is highlighted. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

ControlDevice(1, true) 
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COPY(DEST, SRC, COUNT) 
 

ARGUMENT TYPE DESCRIPTION 

dest int / The first array element to be copied to. float 

src int / The first array element to be copied from. float 

count The number of elements to be processed. int 
 

DESCRIPTION 

Copies count array elements from src onwards to dest onwards. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

Copy(Save[0], Work[0], 100) 
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COS(THETA) 
 

ARGUMENT TYPE DESCRIPTION 

theta The angle, in radians, to be processed. float 
 

DESCRIPTION 

Returns the cosine of the angle theta. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

xp := radius*cos(theta) 
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CREATEDIRECTORY(NAME) 
 

ARGUMENT TYPE DESCRIPTION 

name The directory to be created. cstring 
 

DESCRIPTION 

Creates a new directory on the CompactFlash card. Note that the filing system used on the 
card does not support long filenames, and that if backslashes are included in the pathname to 
separate path elements, they must be doubled-up per MonicoView’s rules for string constants 
as described in the chapter on Writing Expressions. To avoid this complication, forward 
slashes can be used in place of backslashes without the need for such doubling. The function 
returns a value of one if it succeeds, and a value of zero if it fails. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

Result := CreateDirectory(“/LOGS/LOG1”) 
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CREATEFILE(NAME) 
 

ARGUMENT TYPE DESCRIPTION 

name The file to be created. cstring 
 

DESCRIPTION 

Creates an empty file on CompactFlash. Note that the filing system used on the card does not 
support long filenames, and that if backslashes are included in the pathname to separate path 
elements, they must be doubled-up per MonicoView’s rules for string constants as described 
in the chapter on Writing Expressions. To avoid this complication, forward slashes can be 
used in place of backslashes without the need for such doubling. The function returns a value 
of one if it succeeds, and a value of zero if it fails. Note that the file is not opened after it is 
created—a subsequent call to OpenFile() must be made to read or write data. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

Success := CreateFile(“/logs/custom/myfile.txt”) 
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DATATOTEXT(DATA, LIMIT) 
 

ARGUMENT TYPE DESCRIPTION 

data The first element in an array. int 

limit The number of characters to process. int 
 

DESCRIPTION 

Forms a string from an array (4 characters per array elelment) until either the limit is reached, 
or a null character is detected. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

cstring. 

EXAMPLE 

string := DataToText(Data[0], 8) 
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DATE(Y, M, D) 
 

ARGUMENT TYPE DESCRIPTION 

y The year to be encoded, in four-digit form. int 

m The month to be encoded, from 1 to 12. int 

d The date to be encoded, from 1 upwards. int 
 

DESCRIPTION 

Returns a value representing the indicated date as the number of seconds elapsed since the 
datum point of 1st January 1997. This value can then be used with other time/date functions. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

t := Date(2000,12,31) 
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DECTOTEXT(DATA, SIGNED, BEFORE, AFTER, LEADING, GROUP) 
 

ARGUMENT TYPE DESCRIPTION 

data Numeric data to be formatted. int/float 

signed 0 – unsigned, 1 – soft sign, 2 – hard sign. int 

before Number of digits to the left of the decimal point. int 

after Number of digits to the right of the decimal point. int 

leading 0 – no leading zeros, 1 – leading zeros. int 

group 0 – no grouping, 1– group digits in threes. int 
 

DESCRIPTION 

Formats the value in data as a decimal value according to the rest of the parameters. The 
function is typically used to generate advanced formatting option via programs, or to prepare 
strings to be sent via a raw port driver. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

cstring. 

EXAMPLE 

Text := DecToText(var1, 2, 5, 2, 0, 1) 
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DEG2RAD(THETA) 
 

ARGUMENT TYPE DESCRIPTION 

theta The angle to be processed. float 
 

DESCRIPTION 

Returns theta converted from degrees to radians. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

Load := Weight * cos(Deg2Rad(Angle)) 
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DELETEDIRECTORY(NAME) 
 

ARGUMENT TYPE DESCRIPTION 

name The directory to be deleted. cstring 
 

DESCRIPTION 

Remove a directory, its subdirectories and contents from the CompactFlash. Note that the 
filing system used on the card does not support long filenames, and that if backslashes are 
included in the pathname to separate path elements, they must be doubled-up per 
MonicoView’s rules for string constants as described in the chapter on Writing Expressions. 
To avoid this complication, forward slashes can be used in place of backslashes without the 
need for such doubling. The function returns a value of one if it succeeds, and a value of zero 
if it fails. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

Success := DeleteDirectory(“/logs/custom”) 
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DELETEFILE(FILE) 
 

ARGUMENT TYPE DESCRIPTION 

file File handle as returned by OpenFile. int 
 

DESCRIPTION 

Closes and then deletes a file located on the CompactFlash card. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

Result := DeleteFile(hFile) 
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DEVCTRL(DEVICE, FUNCTION, DATA) 
 

ARGUMENT TYPE DESCRIPTION 

device The index of the device to be controlled. int 

function The required function to be executed. int 

data Any parameter for the function. cstring 
 

DESCRIPTION 

This function is used to perform a special operation on a communications device. The number 
to be placed in the device argument to identify the device can be viewed in the status bar of 
the Communications category when the device name is highlighted. The specific action to be 
performed is indicated by the function parameter, the values of which will depend upon the 
type of device being addresses. The data parameter may be used to pass addition information 
to the driver. Most drives do not support this function. Where supported, the operations are 
driver-specific, and are documented separately. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

Refer to comms driver application notes for specific examples. 
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DISABLEDEVICE(DEVICE) 
 

ARGUMENT TYPE DESCRIPTION 

device The device to be disabled. int 
 

DESCRIPTION 

Disables communications for the specified device. The number to be placed in the device 
argument to identify the device can be viewed in the status bar of the Communications 
category when the device name is highlighted. 

FUNCTION TYPE 

The function is passive. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

DisableDevice(1) 



FUNCTION REFERENCE DISPOFF()  

REVISION 12 PAGE 277 

DISPOFF() 
 

ARGUMENT TYPE DESCRIPTION 

none Turns backlight to display off. float 
 

DESCRIPTION 

Turns backlight to display off. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

DispOff() 
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DISPON() 
 

ARGUMENT TYPE DESCRIPTION 

 none Turns backlight to display on.. 
 

DESCRIPTION 

Turns backlight to display on. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

DispOn() 
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DRVCTRL(PORT, FUNCTION, DATA OR VALUE???) 
 

ARGUMENT TYPE DESCRIPTION 

port The index of the driver to be controlled. int 

function The required function to be executed. int 

data Any parameter for the function. cstring 
 

DESCRIPTION 

This function is used to perform a special operation on a communications driver. The number 
to be placed in the port argument to identify the driver is the port number to which the driver 
is bound. The specific action to be performed is indicated by the function parameter, the 
values of which will depend upon the driver itself. The data parameter may be used to pass 
addition information to the driver. Most drivers do not support this function. Where 
supported, the operations are driver-specific, and are documented separately. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

Refer to comms driver application notes for specific examples. 

 

 



EMPTYWRITEQUEUE (DEV) CRIMSON USER MANUAL 

PAGE 280 www.monicoinc.com/support 

EMPTYWRITEQUEUE (DEV) 
 

ARGUMENT TYPE DESCRIPTION 

dev The device number int 
 

DESCRIPTION 

Empties the writing queue for the device identified with the argument dev. This will remove 
any pendant writes to the device from the queue, therefore the removed information will not 
be transferred to the device. 

Note: The device number can be identified in MonicoView’s status bar when a device is 
selected in Communication. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

EmptyWriteQueue(1) 
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ENABLEDEVICE(DEVICE) 
 

ARGUMENT TYPE DESCRIPTION 

device The device to be enabled. int 
 

DESCRIPTION 

Enables communications for the specified device. The number to be placed in the device 
argument to identify the device can be viewed in the status bar of the Communications 
category when the device name is highlighted. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

EnableDevice(1) 
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ENDBATCH() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Stops the current batch. 

Note: Starting a new batch within less than 10 seconds of ending or starting the last one will 
produce undefined behavior. To go straight from one batch to another, call NewBatch() 
without an intervening call to EndBatch(). 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

Result := EndBatch() 



FUNCTION REFERENCE EXP(VALUE)  
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EXP(VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

value The value to be processed. float 
 

DESCRIPTION 

Returns e (2.7183) raised to the power of value. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

Variable2 := exp(1.609) 
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EXP10(VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

value The value to be processed. float 
 

DESCRIPTION 

Returns 10 raised to the power of value. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

Variable4 := exp10(0.699) 
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FILL(ELEMENT, DATA, COUNT) 
 

ARGUMENT TYPE DESCRIPTION 

element int / The first array element to be processed. float 

data int / The data value to be written. float 

count The number of elements to be processed. int 
 

DESCRIPTION 

Sets count array elements from element onwards to be equal to data. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

Fill(List[0], 0, 100) 
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FIND(STRING,CHAR,SKIP) 
 

ARGUMENT TYPE DESCRIPTION 

string The string to be processed. cstring 

char The character to be found. int 

skip The number of times the character is skipped. int 
 

DESCRIPTION 

Returns the position of char in string, taking into account the number of skip occurrences 
specified. The first position counted is 0. Returns -1 if char is not found. In the example 
below, the position of “:”, skipping the first occurrence is 7. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

Position := Find("one:two:three",':',1) 
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FINDFILEFIRST(DIR) 
 

ARGUMENT TYPE DESCRIPTION 

dir Directory to be used in search. cstring 
 

DESCRIPTION 

Returns the filename of name of the first file or directory located in the dir directory on the 
CompactFlash card. Returns an empty string if no files exist or if no card is present. This 
function can be used with the FindFileNext function to scan all files in a given directory. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

cstring. 

EXAMPLE 

Name := FindFileFirst(“/LOGS/LOG1”) 
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FINDFILENEXT() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Returns the filename of the next file or directory in the directory specified in a previous call 
to the FindFileFirst function. Returns and empty string if no more files exist. This 
function can be used with the FindFileFirst function to scan all files in a given directory. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

cstring. 

EXAMPLE 

Name := FindFileNext() 
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FINDTAGINDEX(LABEL) 
 

ARGUMENT TYPE DESCRIPTION 

label Tag label (not tag name or mnemonic) cstring 
 

DESCRIPTION 

Returns the index number of the tag specified by label.  

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

Index = FindTagIndex(“Power”) 

Returns the index number for the tag with label Power. 
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FORCE(TAG, VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

Tag Tag which will be forced int/float 

Value Value to be written to the Tag int/float 
 

DESCRIPTION 

Sets tag to value, removing any existing entries for tag from the write queue and performing 
the write whether or not the operation results in a change to the value of tag.  This operation 
can be useful when making changes to a block of contiguous registers within a remote device, 
as it will allow the comms subsystem to write all the changes in a single operation, assuming 
the driver is capable of same.  Using the usual assignment operator may result in “holes” in 
the written data where changes are not being made, forcing the comms subsystem to perform 
multiple writes. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

Force(Var1,10); 
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FORCECOPY(DEST, SRC, COUNT) 
 

ARGUMENT TYPE DESCRIPTION 

dest The first array element to be copied to int/float 

src The first array element to be copied from int/float 

count The number of element to be processed int 
 

DESCRIPTION 

Copies count elements from array element src to array element dest. See Force(tag, value) for 
a description of forced assignment, and why it can be useful. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

ForceCopy(Save[0], Work[0], 100) 
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FORMATCOMPACTFLASH() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Formats the CompactFlash card in the terminal, thereby deleting all data on the card. You 
should thus ensure that the user is given appropriate warnings before this function is invoked. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

FormatCompactFlash()  
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FTPGETFILE(SERVER, LOC, REM, DELETE) 
 

ARGUMENT TYPE DESCRIPTION 

server FTP connection number, always 0 int 

loc Local file name on the CompactFlash card cstring 

rem Remote file name on the FTP server cstring 

delete If true, the source will be deleted after the transfer, 
otherwise, it will remain on the source disk. 

int 

 

DESCRIPTION 

This function will transfer the defined file from the FTP server to the operator interface 
CompactFlash card. It will return true if the transfer is successful, false otherwise. The source 
and destination file name can be different. The remote path is relative to the FTP server 
setting root path (See Synchronization Manager for details). 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

Success = FtpGetFile(0, “/Recipes.csv”, “/Recipes/Rec001.csv”, 0); 

In this example, the file Recipes.csv will be transferred from the FTP server to the 
CompactFlash Card. The original file will not be deleted from the PC server. 
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FTPPUTFILE(SERVER, LOC, REM, DELETE) 
 

ARGUMENT TYPE DESCRIPTION 

server FTP connection number, always 0 int 

loc Local file name on the CompactFlash card cstring 

rem Remote file name on the FTP server cstring 

delete If true, the source will be deleted after the transfer, 
otherwise, it will remain on the source disk. 

int 

 

DESCRIPTION 

This function will transfer the defined file from the operator interface CompactFlash card to 
the FTP server. It will return true if the transfer is successful, false otherwise. The source and 
destination file name can be different. The remote path is relative to the FTP server setting 
root path (See Synchronization Manager for details). 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

Success = FtpPutFile(0, “/LOGS/Report.txt”, “/Reports/Report.txt”, 1) 

In this example, the file Report.txt will be sent to the FTP server and deleted from the 
CompactFlash Card upon success of the transfer. 
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GETALARMTAG(INDEX) 
 

ARGUMENT TYPE DESCRIPTION 

index Tag index number int 
 

DESCRIPTION 

This function returns a bit mask integer representing the tag alarms state for the tag identified 
with index. Bit 0 (ie. the bit with a value of 0x01) represents the Alarm 1 state and bit 1 (ie. 
the bit with a value of 0x02) the Alarm 2. 

Note: The tag index can be found from the tag name using the FindTagIndex() function 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

AlarmsInTag = GetAlarmTag(12) 

In this example, the function returns the states of Alarm 1 and 2 for the tag with index 12. 
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GETBATCH() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Returns the name of the current batch. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

cstring. 

EXAMPLE 

CurrentBatch := GetBatch() 
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GETCAMERADATA(PORT, CAMERA, PARAM) 
 

ARGUMENT TYPE DESCRIPTION 

port The port number where the camera is connected int 

camera The camera number on the port int 

param The camera parameter to be read int 
 

DESCRIPTION 

This function returns the value of the parameter number param for a Banner camera 
connected on the operator interface. The argument camera is the device number showing in 
MonicoView.0 status bar when the camera is selected. More than one camera can be 
connected under the driver. The number to be placed in the port argument is the port number 
to which the driver is bound. Please see Banner documentation for parameter numbers and 
details. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

Value = GetCameraData(4, 0, 1) 

Returns parameter 1 on camera device number 0 connected on port 4 (Ethernet Protocol 1). 
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GETDATE (TIME) AND FAMILY 
 

ARGUMENT TYPE DESCRIPTION 

time The time value to be decoded. int 
 

DESCRIPTION 

Each member of this family of functions returns some component of a time/date value, as 
previously created by GetNow, Time or Date. The available functions are as follows… 
 

FUNCTION DESCRIPTION 

Returns the day-of-month portion of GetDate time. 

Returns the day-of-week portion of GetDay time. 

Returns the number of days in GetDays time. 

Returns the hours portion of GetHour time. 

Returns the minutes portion of GetMin time. 

Returns the month portion of GetMonth time. 

Returns the seconds portion of GetSec time. 

Returns the week-of-year portion of GetWeek time. 

Returns the number of weeks in GetWeeks time. 

Returns the week year when using week numbers. GetWeekYear 

Returns the year portion of GetYear time
 

. 

Note that GetDays and GetWeeks are typically used with the difference between two time 
values to calculate how long has elapsed in terms of days or weeks. Note also that the year 
returned by GetWeekYear is not always the same as that returned by GetYear, as the former 
may return a smaller value if the last week of a year extends beyond year-end. 

FUNCTION TYPE 

These functions are passive. 

RETURN TYPE 

int. 

EXAMPLE 

d := GetDate(GetNow() – 12*60*60) 
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GETDISKFREEBYTES(DRIVE) 
 

ARGUMENT TYPE DESCRIPTION 

drive The drive number, always 0. int 
 

DESCRIPTION 

Returns the number of free memory bytes on the CompactFlash Card. 

Note: This function requires time to calculate free memory space, as a long CompactFlash 
access is necessary. Do NOT call this function permanently with on tick, on update or in a 
formula. Call it upon an event such as OnSelect on the page you want to display the 
resulting value. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

FreeMemory = GetDiskFreeBytes(0) 
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GETDISKFREEPERCENT(DRIVE) 
 

ARGUMENT TYPE DESCRIPTION 

drive The drive number, always 0. int 
 

DESCRIPTION 

Returns the percentage of free memory space on the CompactFlash Card. 

Note: This function requires time to calculate free memory space, as a long CompactFlash 
access is necessary. Do NOT call this function permanently with on tick, on update or in a 
formula. Call it upon an event such as OnSelect on the page you want to display the 
resulting value. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

FreeMemory = GetDiskFreePercent(0) 

 



FUNCTION REFERENCE GETDISKSIZEBYTES(DRIVE)  

REVISION 12 PAGE 301 

GETDISKSIZEBYTES(DRIVE) 
 

ARGUMENT TYPE DESCRIPTION 

drive The drive number, always 0. int 
 

DESCRIPTION 

Returns the size in bytes of the CompactFlash Card. 

Note: This function requires time to calculate free memory space, as a long CompactFlash 
access is necessary. Do NOT call this function permanently with on tick, on update or in a 
formula. Call it upon an event such as OnSelect on the page you want to display the 
resulting value. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

CFSize = GetDiskSizeBytes(0) 
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GETFORMATTEDTAG(INDEX) 
 

ARGUMENT TYPE DESCRIPTION 

index Tag index number int 
 

DESCRIPTION 

Returns a string representing the formatted value of the tag specified by index. The string 
returned follows the format programmed on the targeted tag. For example, a flag will show 
On or Off, a multi variable will show the text corresponding to the value. The index can be 
found from the tag label using the function FindTagIndex().This function works with any 
type of tags.  

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

cstring. 

EXAMPLE 

Value = GetFormattedTag(10) 

Returns the value of the tag with index 10 in a string. 

Value = GetFormattedTag(FindTagIndex(“Power”)) 

Returns the value from the tag with label Power in a string. 
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GETINTERFACESTATUS(PORT) 
 

ARGUMENT TYPE DESCRIPTION 

interface The interface to be queried. int 
 

DESCRIPTION 

Returns a string indicating the status of the specified TCP/IP interface. Refer to the earlier 
chapter on Advanced Communications for details of how to calculate the value to be placed 
in the interface parameter, and of how to interpret the returned value. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

cstring. 

EXAMPLE 

EthernentStatus := GetInterfaceStatus(1) 
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GETINTTAG(INDEX) 
 

ARGUMENT TYPE DESCRIPTION 

index Tag index number int 
 

DESCRIPTION 

Returns the value of the integer tag specified by index. The index can be found from the tag 
label using the function FindTagIndex(). This function will only work if the targeted tag is 
an integer. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

Value = GetIntTag(10) 

Returns the value of the tag with index 10. 

Value = GetIntTag(FindTagIndex(“Power”)) 

Returns the value from the tag with label Power. 

 



FUNCTION REFERENCE GETMAXTAGINT(INDEX)  

REVISION 12 PAGE 305 

GETMAXTAGINT(INDEX) 
 

ARGUMENT TYPE DESCRIPTION 

index Tag index number int 
 

DESCRIPTION 

This function returns the maximum value from the data limits.  The index can be found from 
the tag label using the function FindTagIndex().  This function will only work if the target tag 
is an integer. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

Data := GetMaxTagInt(1); 
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GETMAXTAGREAL(INDEX) 
 

ARGUMENT TYPE DESCRIPTION 

index Tag index number int 
 

DESCRIPTION 

This function returns the maximum value from the data limits.  The index can be found from 
the tag label using the function FindTagIndex().  This function will only work if the target tag 
is an real (floating point). 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

Data := GetMaxTagReal(1); 
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GETMINTAGINT(INDEX) 
 

ARGUMENT TYPE DESCRIPTION 

index Tag index number int 
 

DESCRIPTION 

This function returns the minimum value from the data limits.  The index can be found from 
the tag label using the function FindTagIndex().  This function will only work if the target tag 
is an integer. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

Data := GetMinTagInt(1); 
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GETMINTAGREAL(INDEX) 
 

ARGUMENT TYPE DESCRIPTION 

index Tag index number int 
 

DESCRIPTION 

This function returns the minimum value from the data limits.  The index can be found from 
the tag label using the function FindTagIndex().  This function will only work if the target tag 
is an real (floating point). 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

Data := GetMinTagReal(1); 
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GETMONTHDAYS(Y, M) 
 

ARGUMENT TYPE DESCRIPTION 

y The year to be processed, in four-digit form. int 

m The month to be processed, from 1 to 12. int 
 

DESCRIPTION 

Returns the number of days in the indicated month, accounting for leap years etc. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

Days := GetMonthDays(2000, 3) 
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GETNETGATE(PORT) 
 

ARGUMENT TYPE DESCRIPTION 

port The index of the Ethernet port. Must be zero. int 
 

DESCRIPTION 

Returns the IP address of the port’s default gateway as a dotted-decimal text string. 

FUNCTION TYPE 

The function is passive. 

RETURN TYPE 

cstring. 

EXAMPLE 

gate := GetNetGate(0) 
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GETNETID(PORT) 
 

ARGUMENT TYPE DESCRIPTION 

port The index of the Ethernet port. Must be zero. int 
 

DESCRIPTION 

Reports an Ethernet port’s MAC address as 17-character text string. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

cstring. 

EXAMPLE 

MAC := GetNetId(0) 
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GETNETIP(PORT) 
 

ARGUMENT TYPE DESCRIPTION 

port The index of the Ethernet port. Must be zero. int 
 

DESCRIPTION 

Reports an Ethernet port’s IP address as a dotted-decimal text string. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

cstring. 

EXAMPLE 

IP := GetNetIp(0) 
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GETNETMASK(PORT) 
 

ARGUMENT TYPE DESCRIPTION 

port The index of the Ethernet port. Must be zero. int 
 

DESCRIPTION 

Reports an Ethernet port’s IP address mask as a dotted-decimal text string. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

cstring. 

EXAMPLE 

mask := GetNetMask(0) 
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GETNOW() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Returns the current time and date as the number of seconds elapsed since the datum point of 
1st January 1997. This value can then be used with other time/date functions. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

t := GetNow() 
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GETNOWDATE() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Returns the number of seconds in the days that have passed since 1st of January 1997. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

D := GetNowDate() 
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GETNOWTIME() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Returns the time of day in terms of seconds. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

t := GetNowTime() 
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GETPORTCONFIG(PORT, PARAM) 
 

ARGUMENT TYPE DESCRIPTION 

port Number of the port to be set int 

param Port parameter to be set int 
 

DESCRIPTION 

Returns the value of a parameter on port. The port number starts from the programming port 
with value 1. The table below shows the parameter number and associated return values. 

PARAM NB DESCRIPTION POSSIBLE VALUES 

Baud Rate 1 The actual baud rate, e.g. 115200 

Data Bits 2 7, 8 or 9 

Stop Bits 3 1 or 2 

Parity 4 0 (none), 1 (odd) or 2 (even) 

Physical Mode 5 0 (RS232), 1 (422 Master), 2 (422 Slave), 3 (485) 

 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

Config = GetPortConfig(2, 4) 

In this example, Config will take the value of the current parity setting on the RS232 
communication port. 
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GETREALTAG(INDEX) 
 

ARGUMENT TYPE DESCRIPTION 

index Tag index number int 
 

DESCRIPTION 

Returns the value of the real tag specified by index. The index can be found from the tag 
label using the function FindTagIndex().This function will only work if the targeted tag is 
a real (floating point). 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

float. 

EXAMPLE 

Value = GetRealTag(10) 

Returns the floating-point value of the tag with index 10. 

Value = GetRealTag(FindTagIndex(“Power”)) 

Returns the floating-point value from the tag with label Power. 
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GETSTRINGTAG(INDEX) 
 

ARGUMENT TYPE DESCRIPTION 

Index Tag index number int 
 

DESCRIPTION 

Returns the value of the string tag specified by index. The index can be found from the tag 
label using the function FindTagIndex().This function will only work if the targeted tag is 
a String. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

cstring. 

EXAMPLE 

Value = GetStringTag(10) 

Returns the string value of the tag with index 10. 

Value = GetStringTag(FindTagIndex(“Name”)) 

Returns the string value from the tag with label Name. 
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GETTAGLABEL(INDEX) 
 

ARGUMENT TYPE DESCRIPTION 

index Tag index number int 
 

DESCRIPTION 

Returns the label of the tag (not the mnemonic or tag name) specified by index. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

cstring. 

EXAMPLE 

Label = GetTagLabel(10) 

Returns the label of the tag with index 10. 
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GETUPDOWNDATA(DATA, LIMIT) 
 

ARGUMENT TYPE DESCRIPTION 

data A steadily increasing source value. int 

limit The number of values to generate. int 
 

DESCRIPTION 

This function takes a steadily increasing value and converts it to a value that oscillates 
between 0 and limit–1. It is typically used within a demonstration database to generate 
realistic looking animation, often by passing DispCount as the data parameter so that the 
resulting value changes on each display update. If the GetUpDownStep function is called with 
the same arguments, it will return a value indicating the direction of change of the data 
returned by GetUpDownData. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

Data := GetUpDownData(DispCount, 100) 
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GETUPDOWNSTEP(DATA, LIMIT) 
 

ARGUMENT TYPE DESCRIPTION 

data A steadily increasing source value. int 

limit The number of values to generate. int 
 

DESCRIPTION 

See GetUpDownData for a description of this function. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

Delta := GetUpDownStep(DispCount, 100) 
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GOTOPAGE(NAME) 
 

ARGUMENT TYPE DESCRIPTION 

Display Page name The page to be displayed. 
 

DESCRIPTION 

Selects page name to be shown on the terminal’s display. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

GotoPage(Page1) 
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GOTOPREVIOUS() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Causes the panel to return to the previous page shown on the terminal’s display. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

GotoPrevious() 
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HASACCESS (RIGHTS) 
 

ARGUMENT TYPE DESCRIPTION 

rights The required access rights. int 
 

DESCRIPTION 

Returns a value of true or false depending on whether the current user has access rights 
defined by the rights parameter. This parameter comprises a bit-mask representing the 
various user-defined rights, with bit 0 (ie. the bit with a value of 0x01) representing User 
Right 1, bit 1 (ie. the bit with a value of 0x02) representing User Right 2 and so on. The 
function is typically used in programs that perform a number of actions that might be subject 
to security, and that might otherwise not occur. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

if( HasAccess(1)) { 

 Data1 := 0; 

 Data2 := 0; 

 Data3 := 0; 

 } 

 



HIDEPOPUP() CRIMSON USER MANUAL 

PAGE 326 www.monicoinc.com/support 

HIDEPOPUP() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Hides the popup that was previously shown using ShowPopup. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

HidePopup()  
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INTTOTEXT(DATA, RADIX, COUNT) 
 

ARGUMENT TYPE DESCRIPTION 

data The value to be processed. int 

radix The number base to be used. int 

count The number of digits to generate. int 
 

DESCRIPTION 

Returns the string obtained by formatting data in base radix, generating count digits. The 
value is assumed to be unsigned, so if a signed value is required, use Sgn to decide whether to 
prefix a negative sign, and then use Abs to pass the absolute value to IntToText. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

cstring. 

EXAMPLE 

PortPrint(1, IntToText(Value, 10, 4)) 
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ISDEVICEONLINE(DEVICE) 
 

ARGUMENT TYPE DESCRIPTION 

device Reports if device is online. int 
 

DESCRIPTION 

Reports if device is online or not. As device is marked as offline if a repeated sequence of 
communications error have occurred. When a device is in the offline state, it will be polled 
periodically to see if has returned online. 

Note: The device number can be identified in MonicoView’s status bar when a device is 
selected in Communication. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

Okay := IsDeviceOnline(1) 
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ISPORTREMOTE(PORT) 
 

ARGUMENT TYPE DESCRIPTION 

port The port number to monitor. int 
 

DESCRIPTION 

The function will monitor the specified port to indicate if port sharing is active. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

IsPortRemote(1) 



ISWRITEQUEUEEMPTY(DEV) CRIMSON USER MANUAL 

PAGE 330 www.monicoinc.com/support 

ISWRITEQUEUEEMPTY(DEV) 
 

ARGUMENT TYPE DESCRIPTION 

dev The device number to get the queue state from int 
 

DESCRIPTION 

Returns the state of the writes queue for the device identified with the argument dev. The 
function will return true if the queue is empty, false otherwise. 

Note: The device number can be identified in MonicoView’s status bar when a device is 
selected in Communication. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

QueueEmpty = IsWriteQueueEmpty(1) 

In this example, the function returns the write queue stat for device1. 
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LEFT(STRING, COUNT) 
 

ARGUMENT TYPE DESCRIPTION 

string The string to be processed. cstring 

count The number of characters to return. int 
 

DESCRIPTION 

Returns the first count characters from string. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

cstring. 

EXAMPLE 

AreaCode := Left(Phone, 3) 
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LEN(STRING) 
 

ARGUMENT TYPE DESCRIPTION 

string The string to be processed. cstring 
 

DESCRIPTION 

Returns the number of characters in string. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

Size := Len(Input) 
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LOADCAMERASETUP(PORT, CAMERA, INDEX, FILE) 
 

ARGUMENT TYPE DESCRIPTION 

port The port number where the camera is connected int 

camera The camera device number int 

index Inspection file number in the camera int 

file Path and filename for the inspection file on the operator 
interface CompactFlash card 

cstring 

 

DESCRIPTION 

This function loads the inspection file from the operator interface CompactFlash card to the 
camera memory. The number to be placed in the port argument is the port number to which 
the driver is bound. The argument camera is the device number showing in MonicoView.0 
status bar when the camera is selected. More than one camera can be connected under a single 
driver. The index represents the inspection file number within the camera where the file will 
be loaded in. The file is the path and filename for the source inspection file on the 
CompactFlash card. This function will return true if the transfer is successful, false otherwise. 

*Note: This function should be called in a user program that runs in the background so the G3 
has enough time to access the CompactFlash card. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

Success = LoadCameraSetup(4, 0, 1, “\\in0.isp”) 

Loads the file named “in0.isp” in inspection file number 1 in camera device number 0 
connected on port 4 (Ethernet Protocol 1). 
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LOG(VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

value The value to be processed. float 
 

DESCRIPTION 

Returns the natural log of value. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

Variable1 := log(5.0) 



FUNCTION REFERENCE LOG10(VALUE)  
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LOG10(VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

value The value to be processed. float 
 

DESCRIPTION 

Returns the base-10 log of value. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

Variable3 := log10(5.0) 
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LOGSAVE() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Forces the data logger to save on the CompactFlash Card. 

Note: This function should NOT be called permanently or regularly. It is intended only for 
punctual use. An overuse of this function may result in CompactFlash card damage and loss 
of data. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

This function does not return a value 

EXAMPLE 

LogSave() 
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MAKEFLOAT(VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

value The value to be converted. int 
 

DESCRIPTION 

Reinterprets the integer argument as a floating-point value. This function does not perform a 
type conversion, but instead takes the bit pattern stored in the argument, and assumes that 
rather than representing an integer, it actually represents a floating-point value. It can be used 
to manipulate data from a remote device that might actually have a different data type from 
that expected by the communications driver. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

fp := MakeFloat(n); 
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MAKEINT(VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

value The value to be converted. float 
 

DESCRIPTION 

Reinterprets the floating-point argument as an integer. This function does not perform a type 
conversion, but instead takes the bit pattern stored in the argument, and assumes that rather 
than representing a floating-point value, it actually represents an integer. It can be used to 
manipulate data from a remote device that might actually have a different data type from that 
expected by the communications driver. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

n := MakeInt(fp); 
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MAX(A, B) 
 

ARGUMENT TYPE DESCRIPTION 

a The first value to be compared. int / float 
b The second value to be compared. int / float 

 

DESCRIPTION 

Returns the larger of the two arguments. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int or float, depending on the type of the arguments. 

EXAMPLE 

Larger := Max(Tank1, Tank2) 
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MEAN(ELEMENT, COUNT) 
 

ARGUMENT TYPE DESCRIPTION 

element int / The first array element to be processed. float 

count The number of elements to be processed. int 
 

DESCRIPTION 

Returns the mean of the count array elements from element onwards. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

Average := Mean(Data[0], 10) 
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MID(STRING, POS, COUNT) 
 

ARGUMENT TYPE DESCRIPTION 

string The string to be processed. cstring 

pos The position at which to start. int 

count The number of characters to return. int 
 

DESCRIPTION 

Returns count characters from position pos within string, where 0 is the first position. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

cstring. 

EXAMPLE 

Exchange := Mid(Phone, 3, 3) 
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MIN(A, B) 
 

ARGUMENT TYPE DESCRIPTION 

a The first value to be compared. int / float 
b The second value to be compared. int / float 

 

DESCRIPTION 

Returns the smaller of the two arguments. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int or float, depending on the type of the arguments. 

EXAMPLE 

Smaller := Min(Tank1, Tank2) 
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MULDIV(A, B, C) 
 

ARGUMENT TYPE DESCRIPTION 

a First value. int 

b Second value. int 

c Third value. int 
 

DESCRIPTION 

Returns a*b/c. The intermediate math is done with 64-bit integers to avoid overflows. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

d := MulDiv(a, b, c) 
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MUTESIREN() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Turns off the operator panel’s internal siren. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

MuteSiren() 
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NEWBATCH(NAME) 
 

ARGUMENT TYPE DESCRIPTION 

name Name of the batch. cstring 
 

DESCRIPTION 

Starts a batch called name. The name must be no more than 8 characters in length and made 
up of characters that are valid FAT16 filename. Restarting a batch already on the CF card will 
append the data. If a new batch exceeds the maximum number of batches to be kept, the 
oldest batch (i.e. The one last changed) will be deleted. If name is empty, the function is 
equivalent to EndBatch(). 

Note: Batch status is retained during a power cycle. Starting a new batch within less than 10 
seconds of ending or starting the last one will produce undefined behavior. To go straight 
from one batch to another, call NewBatch() without an intervening call to EndBatch(). 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

NewBatch(“ProdA”) 
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NOP() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

This function does nothing. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

Nop() 
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OPENFILE(NAME, MODE) 
 

ARGUMENT TYPE DESCRIPTION 

name The file to be opened. cstring 

mode The mode in which the file is to be opened… 
  0 = Read Only 
  1 = Read/Write at Start of File 
  2 = Read/Write at End of File 

int 

 

DESCRIPTION 

Returns a handle to the file name located on the CompactFlash card. This function is restricted 
to a maximum of four open files at any given time. The CompactFlash card cannot be 
unmounted while a file is open. Note that the filing system used on the card does not support 
long filenames, and that if backslashes are included in the pathname to separate path 
elements, they must be doubled-up per MonicoView’s rules for string constants as described 
in the chapter on Writing Expressions. To avoid this complication, forward slashes can be 
used in place of backslashes without the need for such doubling. Note also that this function 
will not create a file that does not exist. To do this, call CreateFile() before calling this 
function. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

hFile := OpenFile(“/LOGS/LOG1/01010101.csv”, 0) 
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PI() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Returns pi as a floating-point number. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

Scale = Pi()/180 
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PLAYRTTTL(TUNE) 
 

ARGUMENT TYPE DESCRIPTION 

tune The tune to be played in RTTTL representation. cstring 
 

DESCRIPTION 

Plays a tune using the terminal’s internal beeper. The tune argument should contain the tune 
to be played in RTTTL format—the format used by a number of cell phones for custom ring 
tones. Sample tunes can be obtained from many sites on the World Wide Web. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

PlayRTTTL("TooSexy:d=4,o=5,b=40:16f,16g,16f,16g,16f.,16f,16g,16f,16g,16g#

.,16g#,16g,16g#,16g,16f.,16f,16g,16f,16g,16f.,16f,16g,16f,16g,16f.,16f,16

g,16f,16g,16g#.,16g#,16g,16g#,16g,16f.,16f,16g,16f,16g,32f.") 
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POPDEV(ELEMENT, COUNT) 
 

ARGUMENT TYPE DESCRIPTION 

element int / The first array element to be processed. float 

count The number of elements to be processed. int 
 

DESCRIPTION 

Returns the standard deviation of the count array elements from element onwards, assuming 
the data points to represent the whole of the population under study. If you need to find the 
standard deviation of a sample, use the StdDev function instead. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

Dev := PopDev(Data[0], 10) 
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PORTCLOSE(PORT) 
 

ARGUMENT TYPE DESCRIPTION 

port Closes the specified port. int 
 

DESCRIPTION 

This function is used in conjunction with the active or passive TCP raw port drivers to close 
the selected port by gracefully closing the connection that is attached to the associated socket. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

PortClose(6) 
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PORTGETCTS(PORT) 
 

ARGUMENT TYPE DESCRIPTION 

port The raw port to get the CTS state from int 
 

DESCRIPTION 

Returns the CTS state of the specified port. The port must be one of the serial ports 
configured to use a raw driver. 

Note: The communication port number can be identified in MonicoView’s status bar when 
the port is selected. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

CtsState = PortGetCTS(2) 

In this example, the function returns the CTS state of the RS232 communication port in the 
variable CtsState. 
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PORTINPUT(PORT, START, END, TIMEOUT, LENGTH) 
 

ARGUMENT TYPE DESCRIPTION 

port The raw port to be read. int 

start The start character to match, if any. int 

end The end character to match, if any. int 

timeout The inter-character timeout in milliseconds, if any. int 

length The maximum number of characters to read, if any. int 
 

DESCRIPTION 

Reads a string of characters from the port indicated by port, using the various other 
parameters to control the input process. If start is non-zero, the process begins by waiting 
until the character indicated by this parameter is received. If start is zero, the receive 
process begins immediately. The process then continues until one of the following conditions 
has been met… 

• end is non-zero and a character matching end is received. 

• timeout is non-zero, and that period passes without a character being received. 

• length is non-zero, and that many characters have been received. 

The function then returns the characters received, not including the start or end byte. This 
function is used together with Raw Port drivers to implement custom protocols using 
MonicoView’s programming language. It replaces the RYOP functionality found in Edict. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

cstring. 

EXAMPLE 

Frame := PortInput(1, '*', 13, 100, 200) 
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PORTPRINT(PORT, STRING) 
 

ARGUMENT TYPE DESCRIPTION 

port The raw port to be written to. int 

string The text string to be transmitted. cstring 
 

DESCRIPTION 

Transmits the text contained in string to the port indicated by port. The port must be 
configured to use a raw driver, such as the raw serial port driver, or either of the raw TCP/IP 
drivers. The data will be transmitted, and the function will return. The port driver will handle 
handshaking and control of transmitter enable lines as required. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

PortPrint(1, "ABCD") 
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PORTREAD(PORT, PERIOD) 
 

ARGUMENT TYPE DESCRIPTION 

port The raw port to be read. int 

period The time to wait in milliseconds. int 
 

DESCRIPTION 

Attempts to read a character from the port indicated by port. The port must be configured to 
use a raw driver, such as the raw serial port driver, or either of the raw TCP/IP drivers. If no 
data is available within the indicated time period, a value of –1 will be returned. Setting 
period to zero will result in any queued data being returned, but will prevent MonicoView 
from waiting for data to arrive if none is available. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

Data := PortRead(1, 100) 
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PORTSETRTS(PORT, STATE) 
 

ARGUMENT TYPE DESCRIPTION 

port The raw port to control int 

state The state of the RTS, true (1) or false (0) int 
 

DESCRIPTION 

Sets the RTS.of the port indicated by port with the setting in state. The port must be 
configured to use a raw driver and be on of the serial ports. The state argument can take 
values 0 or 1 only. 

Note: The communication port number can be identified in MonicoView’s status bar when 
the port is selected. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

PortSetRTS(2, 1) 

In this example, the function sets the RTS of the RS232 communication port to true. 
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PORTWRITE(PORT, DATA) 
 

ARGUMENT TYPE DESCRIPTION 

port The raw port to be written to. int 

data The byte to be transmitted. int 
 

DESCRIPTION 

Transmits the byte indicated by data on the port indicated by port. The port must be 
configured to use a raw driver, such as the raw serial port driver, or either of the raw TCP/IP 
drivers. The character will be transmitted, and the function will return. The port driver will 
handle handshaking and control of transmitter enable lines as required. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

PortWrite(1, 'A') 
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POSTKEY(CODE, TRANSITION) 
 

ARGUMENT TYPE DESCRIPTION 

code Key code. int 

transition Transition code. int 
 

DESCRIPTION 

Adds a physical key operation to the queue. 
 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

void 

EXAMPLE 

PostKey(0x80 , 0) 

 

CODE KEY  CODE KEY 

Soft Key 1 0x80  Function Key 6 0x95 

Soft Key 2 0x81  Function Key 7 0x96 

Soft Key 3 0x82  Function Key 8 0x97 

Soft Key 4 0x83  ALARMS 0xA0 

Soft Key 5 0x84  MUTE 0xA1 

Soft Key 6 0x85  EXIT 0x1B 

Soft Key 7 0x86  MENU 0xA2 

Function Key 1 0x90  RAISE 0xA3 

Function Key 2 0x91  LOWER 0xA4 

Function Key 3 0x92  NEXT 0x09 

Function Key 4 0x93  PREV 0x08 

Function Key 5 0x94  ENTER  0x0D 

 

TRANSITION OPERATION 

0 Post key down, then key up 

Post key down only 1 

Post key up only 2 

Post key repeat only 3 
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POWER(VALUE, POWER) 
 

ARGUMENT TYPE DESCRIPTION 

value int / The value to be processed. float 

power int / The power to which float value
 

 is to be raised. 

DESCRIPTION 

Returns value raised to the power-th power. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int or float, depending on the type of the value argument. 

EXAMPLE 

Volume := Power(Length, 3) 
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RAD2DEG(THETA) 
 

ARGUMENT TYPE DESCRIPTION 

theta The angle to be processed. float 
 

DESCRIPTION 

Returns theta converted from radians to degrees. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

Right := Rad2Deg(Pi()/2) 
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RANDOM(RANGE) 
 

ARGUMENT TYPE DESCRIPTION 

range The range of random values to produce. int 
 

DESCRIPTION 

Returns a pseudo-random value between 0 and range-1. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

Noise := Random(100) 
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READDATA(DATA, COUNT) 
 

ARGUMENT TYPE DESCRIPTION 

data First array element to be read. any 

count Number of elements to be read. int 
 

DESCRIPTION 

Requests that count elements from array element data onwards to read on the next comms 
scan. This function is used with arrays that have been mapped to external data, and which 
have their read policy set to Read Manually. The function returns immediately, and does not 
wait for the data to be read. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

ReadData(array1[8], 10) 
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READFILE(FILE, CHARS) 
 

ARGUMENT TYPE DESCRIPTION 

file File handle as required by OpenFile. int 

chars Number of characters to be read. int 
 

DESCRIPTION 

Reads a string up to 512 characters in length from the specified file. This function does not 
look for a line feed and carriage return therefore allowing line read of more than 510 
characters (ReadFileLine() limit). 

If a file as multiple lines, the string returned by ReadFile() will be as many lines as required 
to reach the number of characters to be read. Line feed and carriage return will be part of the 
returned string. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

cstring. 

EXAMPLE 

Text := ReadFile(hFile, 80) 
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READFILELINE(FILE) 
 

ARGUMENT TYPE DESCRIPTION 

file File handle as returned by int OpenFile
 

. 

DESCRIPTION 

Returns a single line of text from file. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

cstring. 

EXAMPLE 

Text := ReadFileLine(hFile) 
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RENAMEFILE(HANDLE, NAME) 
 

ARGUMENT TYPE DESCRIPTION 

handle File handle. int 

name New file name. cstring 
 

DESCRIPTION 

Returns a non-zero value upon a successful rename file operation. The file handle is the 
returned value of the Openfile() function. After the rename operation, the file stays open 
and should be closed if no further operations are required. The file name is maximum 8 
characters long, excluding the extension, which is 3 characters long maximum. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

Result := RenameFile(File , “NewName.txt”) 
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RIGHT(STRING, COUNT) 
 

ARGUMENT TYPE DESCRIPTION 

string The string to be processed. cstring 

count The number of characters to return. int 
 

DESCRIPTION 

Returns the last count characters from string. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

cstring. 

EXAMPLE 

Local := Right(Phone, 7) 
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SAVECAMERASETUP(PORT, CAMERA, INDEX, FILE) 
 

ARGUMENT TYPE DESCRIPTION 

port The port number where the camera is connected int 

camera The camera device number int 

index Inspection file number in the camera int 

file Path and filename for the inspection file on the operator 
interface CompactFlash card 

cstring 

 

DESCRIPTION 

This function saves the inspection file uploaded from the camera on the operator interface 
CompactFlash card. The number to be placed in the port argument is the port number to 
which the driver is bound. The argument camera is the device number showing in 
MonicoView.0 status bar when the camera is selected. More than one camera can be 
connected under a single driver. The index represents the inspection file number within the 
camera. The file is the path and filename where the inspection file should be saved on 
CompactFlash card. This function will return true if the transfer is successful, false otherwise. 

*Note: This function should be called in a user program that runs in the background so the G3 
has enough time to access the CompactFlash card. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

Success = SaveCameraSetup(4, 0, 1, “\\in0.isp”) 

Saves the inspection file number 1 from camera device number 0 connected on port 4 
(Ethernet Protocol 1) under the name “in0.isp”. 
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SCALE(DATA, R1, R2, E1, E2) 
 

ARGUMENT TYPE DESCRIPTION 

data The value to be scaled. int 

r1 The minimum raw value stored in int data.. 

r2 The maximum raw value stored in int data.. 

e1 The engineering value corresponding to int r1. 

e2 The engineering value corresponding to int 
 

r2. 

DESCRIPTION 

This function linearly scales the data argument, assuming it to contain values between r1 
and r2, and producing a return value between e1 and e2. The internal math is implemented 
using 64-bit integers, thereby avoiding the overflows that might result if you attempted to 
scale very large values using MonicoView’s own math operators. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

Data := Scale([D100], 0, 4095, 0, 99999) 
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SENDFILE(RCPT, FILE) 
 

ARGUMENT TYPE DESCRIPTION 

rcpt The recipient’s index in the database’s address book. int 

file The path and file name to be sent. cstring 
 

DESCRIPTION 

Sends an email from the operator interface with the file specified attached. The function 
returns immediately, having first added the required email to the system’s mail queue. The 
message will be sent using the appropriate mail transport as configured in the database. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

SendFile(0, “/LOGS/LOG1/260706.csv”) 
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SENDMAIL(RCPT, SUBJECT, BODY) 
 

ARGUMENT TYPE DESCRIPTION 

rcpt The recipient’s index in the database’s address book. int 

subject The required subject line for the email. cstring 

body The required body text of the email. cstring 
 

DESCRIPTION 

Sends an email from the operator interface. The function returns immediately, having first 
added the required email to the system’s mail queue. The message will be sent using the 
appropriate mail transport as configured in the database. 

Note: The first recipient is 0. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

SendMail(1, “Test Subject Line”, “Test Body Text”) 
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SET(TAG, VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

tag The tag to be changed. int or real 

value The value to be assigned. int or real 
 

DESCRIPTION 

This function sets the specified tag to the specified value. It differs from the more normally 
used assignment operator in that it deletes any queued writes to this tag and replaces them 
with an immediate write of the specified value. It is thus used in situations where 
MonicoView’s normal write behavior is not required. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

Set(Tag1, 100) 
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SETINTTAG(INDEX, VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

index Tag index number int 

value The value to be assigned int 
 

DESCRIPTION 

This function sets the tag specified by index to the specified value. The index can be found 
from the tag label using the function FindTagIndex().This function will only work if the 
target tag is an integer. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

SetIntTag(5,1234) 

Set the tag of index 5 with value 1234. 
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SETLANGUAGE(CODE) 
 

ARGUMENT TYPE DESCRIPTION 

code The language to be selected. int 
 

DESCRIPTION 

Set the terminal’s current language to that indicated by code. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

SetLanguage(1) 

 



SETNETCONFIG(PORT, ADDR, MASK, GATE) CRIMSON USER MANUAL 

PAGE 374 www.monicoinc.com/support 

SETNETCONFIG(PORT, ADDR, MASK, GATE) 
 

ARGUMENT TYPE DESCRIPTION 

port The index of the Ethernet port. Must be zero. int 

addr The required IP address for the port. int 

mask The required netmask for the port. int 

gate The required default gateway for the port. int 
 

DESCRIPTION 

Overrides the database settings for the Ethernet port. The various IP parameters are 32-bit 
integers that can optionally be formed from strings using the TextToAddr() function. Note 
that setting all three of the IP values to zero will reset the port’s settings to the database 
defaults. Note also that the unit must be power-cycled before the new values will take effect. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

SetNetConfig(0,0,0,0) 
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SETNOW(TIME) 
 

ARGUMENT TYPE DESCRIPTION 

time The new time to be set. int 
 

DESCRIPTION 

Sets the current time via an integer that represents the number of seconds that have elapsed 
since 1st January 1997. The integer is typically generated via the other time/date functions. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

SetNow(252288000) 
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SETPORTCONFIG(PORT, PARAM, VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

port Number of the port to be set int 

param Port parameter to be set int 

value Value of the parameter int 
 

DESCRIPTION 

Sets the serial port parameter to value. The port number starts from the programming port 
with value 1. The table below shows the parameter number and associated possible values. 

PARAM NB DESCRIPTION POSSIBLE VALUES 

Baud Rate 1 The actual baud rate, e.g. 115200 

Data Bits 2 7, 8 or 9 

Stop Bits 3 1 or 2 

Parity 4 0 (none), 1 (odd) or 2 (even) 

Physical Mode 5 1 (RS232), 2 (422 Master), 3 (422 Slave), 4 (485) 

 

Note: This function will only work when called before the device startup. The OnLoad field 
provided in the User Interface on the pages tree root is used for this purpose. See example 
below for more details.  

 

Note: The function CommitAndReset() is used to force the device to cycle power in order 
for the SetPortConfig() function to set the new port parameters.  

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

cstring. 

EXAMPLE 

See next page. 



FUNCTION REFERENCE SETPORTCONFIG(PORT, PARAM, VALUE)  

REVISION 12 PAGE 377 

The following setup shows how to modify the RS232 port from the device display. 

• Create a tag for each parameter value, i.e. Baud, DataBits, StopBits, Parity 
and PhysicalMode. Make sure all tags are set to retentive.  

• Insert the tags on the User Interface for operator access. 

• Create a button, set its action to User Defined and enter the CommitAndReset() 
function in the OnPressed field. 

• Create a user program with the following code: 

Program1 

SetPortConfig(2, 1, Baud); 
SetPortConfig(2, 2, DataBits); 
SetPortConfig(2, 3, StopBits); 
SetPortConfig(2, 4, Parity); 
SetPortConfig(2, 5, PhysicalMode); 

• Call this program in the OnLoad field in the User Interface. 

The user can now enter the port settings on the display and will commit the changes when 
pressing the button. The device will cycle power to change the port settings. 

 



SETREALTAG(INDEX, VALUE) CRIMSON USER MANUAL 

PAGE 378 www.monicoinc.com/support 

SETREALTAG(INDEX, VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

index Tag index number int 

value The value to be assigned float 
 

DESCRIPTION 

This function sets the tag specified by index to the specified value. The index can be found 
from the tag label using the function FindTagIndex().This function will only work if the 
target tag is a real (floating point). 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

SetRealTag(5, 12.55) 

Set the real tag of index 5 with value 12.55. 
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SETSTRINGTAG(INDEX, VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

index Tag index number Int 

value The value to be assigned Int 
 

DESCRIPTION 

This function set the tag specified by index to the specified value.  The index can be found 
from the tag label using the function FindTagIndex().  This function will only work if the 
target tag is a string. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

SetStringTag(5,”Hello”) 

Set the tag of index 5 with value of Hello 
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SGN(VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

value The value to be processed. int / float 
 

DESCRIPTION 

Returns –1 if value is less than zero, +1 if it is greater than zero, or 0 if it is equal to zero. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int or float, depending on the type of the value argument. 

EXAMPLE 

State := Sgn(Level)+1 
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SHOWMENU(NAME) 
 

ARGUMENT TYPE DESCRIPTION 

Display Page name Display page to show as popup menu. 
 

DESCRIPTION 

Displays the page specified as a popup menu. This function is only available with on units 
fitted with touch-screens. Popup menus are shown on top of whatever is already on the 
screen, and are aligned with the left-hand side of the display. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

ShowMenu(Page2) 
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SHOWPOPUP(NAME) 
 

ARGUMENT TYPE DESCRIPTION 

name The page to be displayed as a popup. Display Page 
 

DESCRIPTION 

Shows page name as a popup on the terminal’s display. The popup will be centered on the 
display, and shown on top of the existing page. The popup can be removed by calling the 
HidePopup() function. It will also be removed from the display if a new page is selected by 
invoking the GotoPage() function, or by a suitably defined keyboard action. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

ShowPopup(Popup1)  
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SIN(THETA) 
 

ARGUMENT TYPE DESCRIPTION 

theta The angle, in radians, to be processed. float 
 

DESCRIPTION 

Returns the sine of the angle theta. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

yp := radius*sin(theta) 
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SIRENON() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Turns on the operator panel’s internal siren. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

SirenOn() 
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SLEEP(PERIOD) 
 

ARGUMENT TYPE DESCRIPTION 

period The period for which to sleep, in milliseconds. int 
 

DESCRIPTION 

Sleeps the current task for the indicated number of milliseconds. This function is normally 
used within programs that run in the background, or that implement custom communications 
using Raw Port drivers. Calling it in response to triggers or key presses is not recommended. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

Sleep(100) 
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SQRT(VALUE) 
 

ARGUMENT TYPE DESCRIPTION 

value int / The value to be processed. float 
 

DESCRIPTION 

Returns the square root of value. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int or float, depending on the type of the value argument. 

EXAMPLE 

Flow := Const * Sqrt(Input) 
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STDDEV(ELEMENT, COUNT) 
 

ARGUMENT TYPE DESCRIPTION 

element int / The first array element to be processed. float 

count The number of elements to be processed. int 
 

DESCRIPTION 

Returns the standard deviation of the count array elements from element onwards, assuming 
the data points to represent a sample of the population under study. If you need to find the 
standard deviation of the whole population, use the PopDev function instead. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

Dev := StdDev(Data[0], 10) 
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STOPSYSTEM() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Stops the operator interface to allow a user to update the database. This function is typically 
used when serial programming is required with respect to a unit whose programming port has 
been allocated for communications. Calling this function shuts down all communications, and 
thereby allows the port to function as a programming port once more. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

StopSystem() 
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STRIP(TEXT, TARGET) 
 

ARGUMENT TYPE DESCRIPTION 

text The string to be processed. cstring 

target The character to be removed. int 
 

DESCRIPTION 

Removes all occurrences of a given character from a text string. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

cstring. 

EXAMPLE 

Text := Strip(“Mississippi”, ’s’) 

Text now contains “Miiippi”. 
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SUM(ELEMENT, COUNT) 
 

ARGUMENT TYPE DESCRIPTION 

element int / The first array element to be processed. float 

count The number of elements to be processed. int 
 

DESCRIPTION 

Returns the sum of the count array elements from element onwards. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int or float, depending on the type of the value argument. 

EXAMPLE 

Total := Sum(Data[0], 10) 
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TAN(THETA) 
 

ARGUMENT TYPE DESCRIPTION 

theta The angle, in radians, to be processed. float 
 

DESCRIPTION 

Returns the tangent of the angle theta. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

yp := xp * tan(theta) 
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TESTACCESS(RIGHTS, PROMPT) 
 

ARGUMENT TYPE DESCRIPTION 

rights The required access rights. int 

prompt The prompt to be used in the log-on popup. cstring 
 

DESCRIPTION 

Returns a value of true or false depending on whether the current user has access rights 
defined by the rights parameter. This parameter comprises a bit-mask representing the 
various user-defined rights, with bit 0 (ie. the bit with a value of 0x01) representing User 
Right 1, bit 1 (ie. the bit with a value of 0x02) representing User Right 2 and so on. If no user 
is currently logged on, the system will display a popup to ask for user credentials, using the 
prompt argument to indicate why the popup is being displayed. The function is typically used 
in programs that perform a number of actions that might be subject to security, and that might 
otherwise be interrupted by a log-on popup. By executing this function before the actions are 
performed, you can provide a better indication to the user as to why a log-on is required, and 
you can avoid a security failure part way through a series of operations. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

if( TestAccess(1, “Clear all data?”) ) { 

 Data1 := 0; 

 Data2 := 0; 

 Data3 := 0; 

 } 
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TEXTTOADDR(ADDR) 
 

ARGUMENT TYPE DESCRIPTION 

addr The addressed in dotted-decimal form. cstring 
 

DESCRIPTION 

Converts a dotted-decimal string into a 32-bit IP address. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

ip := TextToAddr(“192.168.0.1”) 
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TEXTTOFLOAT(STRING) 
 

ARGUMENT TYPE DESCRIPTION 

string The string to be processed. cstring 
 

DESCRIPTION 

Returns the value of string, treating it as a floating-point number. This function is often 
used together with Mid to extract values from strings received from raw serial ports. It can 
also be used to convert other string values into floating-point numbers. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

float. 

EXAMPLE 

Data := TextToFloat("3.142")  
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TEXTTOINT(STRING, RADIX) 
 

ARGUMENT TYPE DESCRIPTION 

string The string to be processed. cstring 

radix The number base to be used. int 
 

DESCRIPTION 

Returns the value of string, treating it as a number of base radix. This function is often 
used together with Mid to extract values from strings received from raw serial ports. It can 
also be used to convert other string values into integers. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

Data := TextToInt("1234", 10) 
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TIME(H, M, S) 
 

ARGUMENT TYPE DESCRIPTION 

h The hour to be encoded, from 0 to 23. int 

m The minute to be encoded, from 0 to 59. int 

s The second to be encoded, from 0 to 59. int 
 

DESCRIPTION 

Returns a value representing the indicated time as the number of seconds elapsed since 
midnight. This value can then be used with other time/date functions. It can also be added to 
the value produced by Date to produce a value that references a particular time and date. 

FUNCTION TYPE 

This function is passive. 

RETURN TYPE 

int. 

EXAMPLE 

t := Date(2000,12,31) + Time(12,30,0) 
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USECAMERASETUP(PORT, CAMERA, INDEX) 
 

ARGUMENT TYPE DESCRIPTION 

port The port number where the camera is connected int 

camera The camera device number int 

index Inspection file number in the camera int 
 

DESCRIPTION 

This function selects the inspection file to be used by the camera. The number to be placed in 
the port argument is the port number to which the driver is bound. The argument camera is 
the device number showing in MonicoView.0 status bar when the camera is selected. More 
than one camera can be connected under a single driver. The index represents the inspection 
file number within the camera. This function will return true if the successful, false otherwise. 

*Note: This function should be called in a user program that runs in the background to let the 
camera enough time to change the file. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

Success = UseCameraSetup(4, 0, 1) 

Selects inspection file number 1 on camera device number 0 connected on port 4 (Ethernet 
Protocol 1). 
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USERLOGOFF() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Causes the current user to be logged-off the system. Any future actions that require security 
access rights will result in the display of the log-on popup to allow the entry of credentials. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

UserLogOff() 
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USERLOGON() 
 

ARGUMENT TYPE DESCRIPTION 

 none  
 

DESCRIPTION 

Forces the display of the log-on popup to allow the entry of user credentials. You do not 
normally have to use this function, as MonicoView will prompt for credentials when any 
action that requires security clearance is performed. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

This function does not return a value. 

EXAMPLE 

UserLogOn() 
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WAITDATA(DATA, COUNT, TIME) 
 

ARGUMENT TYPE DESCRIPTION 

data First array element to be read. any 

count Number of elements to be read. int 

time The timeout period in milliseconds. int 
 

DESCRIPTION 

Requests that count elements from array element data onwards to read on the next comms 
scan. This function is used with arrays that have been mapped to external data, and which 
have their read policy set to Read Manually. Unlike ReadData(), the function waits for up to 
the time specified by the time parameter in order to allow the data to be read. The return 
value is one if the read completed within that period, or zero otherwise. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

status := WaitData(array1[8], 10, 1000) 
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WRITEFILE(FILE, TEXT) 
 

ARGUMENT TYPE DESCRIPTION 

file File handle as required by OpenFile. int 

Text Text to be written to file. cstring 
 

DESCRIPTION 

Writes a string up to 512 characters in length to the specified file and returns the number of 
bytes successfully written. This function does not automatically include a Line feed and 
carriage return at the end. For easier programming, refer to WriteFileLine(). 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

count := WriteFile(hFile, “Writing text to file.”) 
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WRITEFILELINE(FILE, TEXT) 
 

ARGUMENT TYPE DESCRIPTION 

file File handle as required by OpenFile. int 

text Text to be written to file. cstring 
 

DESCRIPTION 

Writes a string to the specified file and returns the number of bytes successfully written, 
including the carriage return and linefeed characters that will be appended to each line. 

FUNCTION TYPE 

This function is active. 

RETURN TYPE 

int. 

EXAMPLE 

count := WriteFileLine(hFile, “Writing text to file.”) 
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TROUBLESHOOTING 
This section covers the most common problems encountered while setting up, programming 
or using the product. 

Do not forget to always download in the device after changing settings in MonicoView. 

GENERAL 

PROBLEM POSSIBLE CAUSES POSSIBLE SOLUTIONS 

Unit screen is blank.   

And PWR LED off. No power applied to the unit. Check power supply. Units require  
24 VDC, ± 10%. 

And PWR LED on. Contrast too low (G3 HMI only). Program one of the soft keys with the 
action as User Defined and the 
following code in the field On Pressed: 

No primitives on the display. 

dispcontrast++ 

Add objects to the User Interface in 
MonicoView. 

Backlight is off. Push one of the soft keys to turn it 
back on. 

Backlight tube is broken. Replace the backlight tube. 

Unit continually 
cycles on and off. 

Cross-references between tags, e.g., 
Var1 uses Var2 as maximum which in 
turn uses Var1 as minimum. 

Remove one of the references or use 
formula tags for indirect reference, 
e.g., Form1 is equal to Var1 and used 
in Var2 minimum instead of Var1. 

Database is corrupted. Create a new database or send to 
technical support for debugging. 

Unit cycles power 
after an operation. 

Most likely a program going in an 
endless loop. 

Check if the operation launches program 
containing loops with no exit point. 

Touchscreen not 
accurate 

The touchscreen is not calibrated 
correctly. 

Use the Touch Calibration primitive to 
recalibrate. Primitive available under 
Insert > System > Touch Calib. Insert the 
primitive so it covers the entire screen. 

CF LED flashing 
slowly. 

CF card corrupted or invalid. Format the card from MonicoView 
using the Link > Format Flash menu. 
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PROBLEM POSSIBLE CAUSES POSSIBLE SOLUTIONS 

Unit shows “Version 
Mismatch”. 

The database currently in the device does 
not match MonicoView’s firmware 
version. (Message occurs after a 
download with a new version of C2 
interrupted before the database was 
downloaded.) 

Download the database from 
MonicoView again. 

Unit shows “Invalid 
Database”. 

The database in the device is corrupted 
or there are no databases in the device. 

Download a database from 
MonicoView. 

Values show “ No communication with target device ----” See Serial Communication or Ethernet 
Communication. 

Value does not 
update. 

The tag on the screen is not linked 
correctly. 

Check the tag mapping making sure 
the target device (PLC, etc.) register is 
correct. 

Check the primitive Data Source in the 
user interface in case the word WAS is 
displayed. Re-link the tag in this case. 

Value shows +BIG or 
–BIG. 

Not enough digits before the decimal 
point to show the number. For 
example, data is 1000.5

Increase the number of digits before 
the decimal point in the tag format. 

 and format 
is three digits before the decimal point 
and one after. 

Value deviates by a 
factor of ten. 

The tag format is not correct. Change the decimal point position in 
the tag format. 

Value is invalid. Incorrect tag type. Check if the tag type corresponds to the 
data type. Is the data a floating point 
number and thus the tag a real (Pi 
symbol), and not an integer (X symbol)? 

Incorrect data mapping. Check if the tag is accessing the 
correct target device register. 

Incorrect primitive on the display. Check if the primitive corresponds to the 
tag type. For example, primitive is a Text 
Integer so the tag has to be an integer. 

Data received is not what’s expected. 
For example, bytes reversed in  
the word. 

Use the transform property on the tag 
to modify the data source. You might 
have to try multiple solutions to solve 
the issue. 
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PROBLEM POSSIBLE CAUSES POSSIBLE SOLUTIONS 

Symbol or image 
leaves a trace when 
animated. 

The background of the image is not 
refreshed. 

Change the primitive Fill Format to 
Solid color. 

 Add the system variable dispcount

Rich Bar Graph or 
Dial Gauge does not 
move 

 
in the background of the image to 
force the refresh. 

Tag minimum and maximum are not 
setup. 

Check the tag’s minimum and 
maximum values. These are used by 
both primitives for min and max. 

Trend Viewer curve 
stuck at the bottom. 

No minimum and maximum setup on 
the data tags displayed in the viewer. 

Check that all displayed tags in the 
trend viewer have a Minimum and a 
Maximum setup. 

Display shows 
“TIMEOUT” or 
“NOT READY” or 
“WORKING”. 

Program issue See program troubleshooting. 

USB Drivers location 
for Windows. 

Location of the drivers unknown. The drivers are located under 
MonicoView.0\Device installation 
folder. For example C:\Program 
Files\Monico 
Controls\MonicoView.0\Device. 

USB Driver 
installation. 

The operating system is unable to find 
the driver or the installation failed. 

In your operating system device 
manager, check if the device G3HMI 
is present. If so, uninstall that device. 

 

Upgrading 
MonicoView did not 
upgrade the software 
version. 

The option selected during the upgrade 
was Modify instead of Repair. 

Launch the upgrade again and choose 
Repair when prompted. 
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MONICOVIEW MESSAGES 

ERRORS POSSIBLE CAUSES POSSIBLE SOLUTIONS 

Device incompatible 
with file. 

The device you are trying to download 
into doesn’t match the database device. 

Create a new database file 
corresponding to your device  
(File > New). 

Unable to open 
communication port. 

The communication port you try to 
download with is unavailable. 

 

  Cable not connected Check if the cable is connected 
correctly to the PC and the device 
programming ports (USB or PG Port). 

 Incorrect download 
communication port 

Check that MonicoView is directed to 
the correct communication port (Link 
> Options). 

 Port already used Check that the communication port is 
not used by another service or software 
especially for serial ports. 

 Target device IP 
address incorrect 

If you download via Ethernet, Check 
the IP address of the target device in 
Link > Options. 

 No USB Drivers Check that the USB drivers were 
install successfully. Reinstall G3 HMI 
USB driver under the PC device 
manager if necessary. 

No Reply from 
terminal 

Cable is not connected Make sure the cable is connected or 
check above solutions 

If the message appears while 
downloading to the device 

Download again with Link > Update 
or F9 

CompactFlash 
required for upgrade. 

The version of MonicoView on the PC 
is different from the target device 
firmware version when attempting a 
download via Ethernet. 

Insert a CompactFlash Card in the 
target device. 

Use another communication port for 
download; USB or Serial. 

The window is too 
small to allow 
editing. 

The current User interface view is too 
small to allow editing. 

Change the panel view using View > 
Panel > Display only. 

The device returned 
an unexpected reply 
code. 

The device you are trying to download 
to is not supported by this version of 
MonicoView. 

Update MonicoView to the latest 
version  
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SERIAL COMMUNICATION 

This section is used to troubleshoot the communication between two devices linked via serial 
ports, i.e. RS232 or RS485. 

TIP: For communication troubleshooting, it is strongly advised to create a new 
MonicoView database including only one data tag mapped to a known register in the 
target device. 

PROBLEM POSSIBLE CAUSES POSSIBLE SOLUTIONS 

Values show “ Port settings do not match. ----” Check that the port settings of the 
MonicoView device match the target 
device (i.e. Baud, Parity, etc.). 

Incorrect target device address. Check that the target device address in 
MonicoView (in communications on 
the PLC symbol) matches the target 
device address setup. 

Incorrect cable Check the cable part number or 
cabling to match your protocol. 

Incorrect communication port Check if the cable is connected to the 
right communication port. 

If the above is correct, check that the 
protocol settings are on the right 
communication port in MonicoView. 

Communication port connector pins 
bent inward. 

Although unlikely, check the 
communication port connector pins on 
the Monico device in case some are 
bent inward resulting in a bad contact 
with the cable. 

Incorrect tag mapping Check that the tag is mapped to an 
existing register in the target device. 

Values blink between 
the data and “

Incorrect tag mapping on one of the 
tags on the display. ----” 

Delete tags one after another and 
download in-between. When the 
values on the screen stop blinking, the 
last deleted tag was mapped 
incorrectly or accessed an unknown 
register in the target device. 

Communications times-out. Increase the Slave Response or Device 
Timeout on the communication port or 
target device in MonicoView. 
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ETHERNET COMMUNICATION 

This section is used to troubleshoot the communication between two devices linked  
via Ethernet. 

TIP: For communication troubleshooting, it is strongly advised to create a new 
MonicoView database including only one data tag mapped to a known register in the 
target device. 

PROBLEM POSSIBLE CAUSES POSSIBLE SOLUTIONS 

Values show “ Incorrect target device IP address. ----” Check the target device IP address in 
MonicoView (in communications on 
the PLC symbol) to match the target 
device IP address setup. 

Incorrect cable or wrong connection. Check the LED on the MonicoView 
device Ethernet port. If none are lit, 
there are no connections. Check the 
cable or that the Ethernet port is 
enabled in MonicoView, see below. 

Ethernet port disabled. Check that the Ethernet port in 
MonicoView is enabled. 

MonicoView and target devices are in 
a different address domain. 

 

  If no routers are present 
on the network. 

Check that the target device IP address 
and MonicoView device IP address are 
different but in the same domain. (For 
example, both start with the same three 
first numbers; ex: 192.168.2.xxx if the 
mask is 255.255.255.0). 

 If a router is present on 
the network. 

Check the MonicoView device 
Ethernet port gateway address to 
match the router IP address. 

Incorrect tag mapping. Check that the tag is mapped to an 
existing register in the target device. 

Values blink between 
the data and “

Incorrect tag mapping on one of the 
tags on the display. ----” 

Delete tags one after another and 
download in-between. When the 
values on the screen stop blinking, the 
last deleted tag was mapped 
incorrectly or accessed an unknown 
register in the target device. 

Communications times-out. Increase the Slave Response or Device 
Timeout on the communication port or 
target device in MonicoView. 
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PROGRAMS 

PROBLEM POSSIBLE CAUSES POSSIBLE SOLUTIONS 

The program does 
not seem to run. 

Program not launched. Check if the program is called 
somewhere in the database (code: 
ProgramName()

 

). 

Some conditions in the program are not 
met (if, switch

If the MonicoView device has a 
beeper, use the  or loops). beep()

Otherwise, use a dummy tag and 
change its value at different places in 
the program to check where it stops. 

 function in 
the program to check if the program 
does go through the condition. 

Display shows  
“NOT READY” 

Program is launched but data are not 
available to run it yet. 

If the message disappears, the program 
was launched successfully however it 
seems to require time to fetch all the 
required data. Communication is too 
slow or your database program is 
getting too complex. 

Display shows 
“WORKING” 

The device is busy working on a 
program. 

The program takes too much time to 
run. Either run it in the background or 
reduce the workload. If it times-out, 
the program was stuck in a loop. 

Display shows 
“TIMEOUT” 

Program was unable to run due to 
unavailable data. 

Make sure that all the tags in the 
program exist in the target device. 
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WEB SERVER 

PROBLEM POSSIBLE CAUSES SOLUTIONS 

Internet Browser says 
“Cannot display the 

web page” 

Web Server not enabled. Check that the Web Server in 
MonicoView is enabled. 

Ethernet port disabled or Ethernet 
settings issue. 

Check that the Ethernet port in 
MonicoView is enabled and has a 
correct IP address. 

See Ethernet Communication 
troubleshooting. 

Incorrect MonicoView device IP 
address. 

Check that the IP address in the 
browser matches MonicoView’s 
Ethernet IP address. 

Incorrect PC IP Address. Check the PC Ethernet Settings for a 
valid IP address. 
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